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New Features
The following is a list of features and enhancements introduced in Kaleido-X version 8.20. 
Refer to the Release Notes for more information.

New Features and Enhancements in Kaleido-X Version 8.20
• KMX-4911:

• Expanded support for the KMX-4911 multiviewer, up to a 18 × 4 configuration.
• Support for external router control (routers or control systems).

• Kaleido-Modular-X 4K UHD prescaler: Support for 2160p29.97, and 2160p25 quad 
link, square division sources.
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Getting Started
This chapter provides an overview of the different Kaleido multiviewer models and their 
initial configuration process.

Summary
System Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
Detailed Directions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13
Cabling Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
RS-422 Connection Diagram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27
XEdit Application Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

About this Document
The Kaleido-X User’s Manual is intended to help you leverage the full working potential of 
the Kaleido-X software and XEdit application for controlling and monitoring audio, and 
video broadcast signal paths for interfacing, routing distribution and other peripheral 
devices.

Grass Valley's Kaleido family of multiviewers ranges from quad-splits to large-scale, multi-
room monitoring systems, with outstanding image quality and signal flexibility. The 
Kaleido multiviewers are available in different models: the Kaleido-MX, the Kaleido-MX 4K, 
the Kaleido-IP, the Kaleido-X (7RU), the Kaleido-X (4RU), the Kaleido-X16, and the 
Kaleido-XQUAD frames, as well as the KMX-4911 cards, the Kaleido-Modular-X cards, and 
the Kaleido-Modular KMV-3901/3911 cards.

For installation instructions, refer to the Quick Start Guide that shipped with your 
multiviewer. Once you have completed your multiviewer’s initial installation, perform a 
system verification (see Verifying your System Configuration on page 13), load a layout on 
the monitor wall if you haven’t done so already (see Loading a Layout on page 19), and then 
review the more advanced topics in Administration and Servicing, on page 461, to fine-
tune your initial system configuration.

After you have established that your basic configuration works as expected, move on to the 
other chapters in this manual, to complete your system configuration until it meets your 
monitoring requirements.
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System Overview
This section reviews the different multiviewer models that support the Kaleido-X software:

• For the Kaleido-X, see
• Kaleido-X (4RU), on page 4,
• Kaleido-X (7RU), on page 5, and
• Kaleido-X (14RU) Expansion, on page 6.

• For the Kaleido-X16-S (single head) and Kaleido-X16-D (dual head), see Kaleido-X16, on 
page 7.

• For the KMV-3901, and KMV-3911, see Kaleido-Modular KMV-3901/3911, on page 9.
• For the Kaleido-XQUAD and Kaleido-XQUAD-DUAL, see Kaleido-XQUAD, on page 10.
• For the Kaleido-IP X310, X110, X300, and X100, see Kaleido-IP, on page 10.
• For the Kaleido-MX, see Kaleido-MX, on page 11.
• For the Kaleido-MX 4K, see Kaleido-MX 4K on page 12.
• For the Kaleido-Modular-X, see Kaleido-Modular-X, on page 12.
• For the KMX-4911, see KMX-4911 on page 12.
• For a configuration combining several multiviewers operated as a single system, see 

Cluster, on page 13.
• For a system combining inputs from two or three multiviewers on a single monitor wall 

display, see Cascade, on page 13.

Kaleido-X (4RU)
The Kaleido-X (4RU) is a multi-room, multi-image display processor and router in a single, 
expandable chassis. Its unique mix of capabilities represents the most integrated 
monitoring and routing solution. As a multi-image processor, it offers the highest level of 
signal flexibility. Each chassis can display 32 HD, SD or Analog inputs any number of times, 
across 4 displays of any resolution and orientation.

Note: In line with our commitment to environmental preservation, only the 
Quick Start Guide for your multiviewer model, and some ancillary 
documents (e.g., welcome letters, warranty cards) are distributed in printed 
form. You can obtain the latest version of the Kaleido-X User’s Manual, 
database samples, Quick Start guides and hardware reference manuals for 
all multiviewer models, as well as the Release Notes, from the 
Documentation Library section of Grass Valley’s website. (Refer to the 
Documentation section of the Release Notes for a complete list.) Software, 
drivers, and useful data are available from the Downloads section of the 
website.
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Kaleido-X (4RU) system overview

Kaleido-X (7RU)
The Kaleido-X (7RU) is a multi-room, multi-image display processor and router in a single, 
expandable chassis. Its unique mix of capabilities represents the most integrated 
monitoring and routing solution. As a multi-image processor, it offers the highest level of 
signal flexibility. Each chassis can display 96 HD, SD or Analog inputs any number of times, 
across 8 displays of any resolution and orientation. As a router, it offers switching of 96 
unprocessed inputs to 48 HD/SD outputs for feeding monitors, test equipment and master 
control or production switchers.
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Kaleido-X (7RU) system overview

Kaleido-X (14RU) Expansion
Since version 3.00 of the Kaleido-X software, it is possible to expand the input connectivity 
of one Kaleido-X (7RU) frame to include that of a second. The two frames, each with its own 
expansion (KXO-EXP) card, are connected by a high bandwidth cable, such that all the 
output (KXO) modules on each frame (up to 6 in total) have access to all inputs (KXI) on 
each frame (up to 192 in total) without any blocking or bandwidth limitations.

Using XEdit, the two frames can be configured as a single system, allowing rooms to share 
input modules from either frame. The expansion card allows seamless sharing of video, 
audio monitoring output, time code inputs, reference input, metadata information (CC, 
XDS, alarms, etc.), and audio level meter data. Refer to the “Kaleido-X (7RU) Expansion” 
chapter in the Kaleido-X (7RU) Hardware Description & Installation Manual for more 
information.
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Kaleido-X16
The Kaleido-X16 is a compact, ultra-quiet multiviewer with 16 inputs, and one or two HDMI 
outputs. It offers the highest level of image quality, and can be used with 3Gbps/HD/SD and 
Analog video. It is ideal for small control rooms, although it can also be paired with routers 
to create the very largest combined multiviewer and routing systems.

There are two models: Kaleido-X16-S (single head) and Kaleido-X16-D (dual head).
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Kaleido-X16-D system overview

The 1RU Kaleido-X16 is ideal for smaller monitoring facilities, such as call letter television 
station master control rooms, mobile trucks and production fly cases, as well as community 
television. The Kaleido-X16’s super silent design is highly appreciated for use within studios 
and control rooms.

Kaleido-X16 provides a subset of the features of the Kaleido-X (4RU) and (7RU) models:
• 1RU non-modular frame
• 16 auto-sensing 3Gbps/HD/SD/Analog video inputs, one or two independent HDMI 

outputs
• Two 3Gbps/HD/SD router outputs
• 3Gbps with 3D support (SMPTE ST 425-1 Level A & B)
• Expansion through combination with upstream router
• 4 analog channel, 2 digital channel audio monitoring
• One or two HD-SDI monitoring outputs with support of 3Gbps signals 
• DVI and compressed (MPEG) video accepted with optional interfaces
8
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• DXF-100 optical DVI extension module simplifies long runs to monitors from frame, and 
is a single fiber solution for supporting high-resolution (1920 × 1200) displays over 
distances of up to 1000 m (3280 ft)

• Choice of multiviewer remote control panels: simple Kaleido-RCP2 and advanced RCP-
200 with router control

• Internal router control by NVISION control panel and NV9000 system controller
• Super silent for installation within studios and control rooms

Kaleido-Modular KMV-3901/3911
The Kaleido-Modular KMV-3901/3911 is an expandable, 8-input, dual-output multiviewer 
(3Gbps/HD/SD) on one Densité Series card. Hosted in a Densité 3 frame, the 
KMV-3901/3911 is the most space- and energy-efficient multiviewer system, with up to 
20 multiviewer outputs per 3 RU frame, or up to 288 multiviewer outputs when connected 
to an upstream router.

Overview of single card functionality

Kaleido-Modular KMV-3901/3911 features
With its unmatched space and energy efficiency, Kaleido-Modular is ideal for production 
monitoring in trucks. The multiviewer system integrates tightly with the highly space-
efficient NVISION 8288 Truck router (288 × 576 in 10 RU), as well as Densité signal 
processing cards, and third-party production switchers. Control of a highly integrated 
system is simplified with the RCP-200 panel, which can operate the router and multiviewer, 
as well as signal processing and distribution cards.

The KMV-3901/3911 provides a subset of the features of the Kaleido-X (4RU) and (7RU) 
models:

• Four or eight auto-sensing 3Gbps/HD/SD video inputs, one or two independent HDMI 
outputs

• Video signals can be repeated in up to eight windows, and scaled up to 1920 × 1200 
pixels

• Audio signal, and video time code and AFD/WSS data can be extracted for on-screen 
display
9
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• A reference signal from a REF-1801 Densité card can be used to minimize processing 
delay, and reference clocks on the monitor wall

• Expansion through combination with upstream router
• DXF-200 extension module simplifies long runs to monitors from Densité frame, and is 

a single fiber solution for supporting high-resolution (1920 × 1200) displays over 
distances of up to 1000 m (3280 ft)

• Choice of multiviewer remote control panels: simple Kaleido-RCP2 and advanced RCP-
200 with router control

• Control by NVISION control panel and NV9000 system controller
• Super silent for installation within studios and control rooms

Kaleido-XQUAD
The Kaleido-XQUAD is a standalone quad-split multiviewer that is ideal for truck and studio 
monitoring. It is available in two versions: the Kaleido-XQUAD features four 3Gbps/HD 
inputs and a single multiviewer output (HDMI/HD-SDI), and the Kaleido-XQUAD-DUAL 
offers eight 3Gbps/HD inputs and two multiviewer outputs. Both versions offer exceptional 
display flexibility and outstanding space and energy efficiency, using a 1RU half width 
frame with silent ventilation for installation within studios. The multiviewer can be used for 
small installations with one or two displays, and in much larger configurations using 
multiple Kaleido-XQUADs.

Kaleido-IP
The Kaleido-IP can monitor and display HD and SD television programs distributed over IP, 
across two HDTV displays. It supports MPEG-2 and H.264/AVC compressed video, and the 
AAC, AC-3, DD+, MPEG-1, MPEG-2, MPEG-4 AAC LC, and MPEG-4 HE-AAC compressed audio 
formats, within unencrypted DCII, DVB, or ATSC streams. The Kaleido-IP X310 supports 
concurrent decoding of up to 64 MPEG-2 or up to 32 H.264 HD video programs. In the case 
of SD signals, they support concurrent decoding of up to 128 MPEG-2 or up to 64 H.264 
programs. The Kaleido-IP X110 supports concurrent decoding of up to 16 MPEG-2 or up to 
12 H.264 HD programs, and up to 48 MPEG-2 or up to 24 H.264 SD programs. The 
Kaleido-IP X300 supports concurrent decoding of up to 24 MPEG-2 or up to 16 H.264 HD 
programs, and up to 64 MPEG-2 or up to 32 H.264 SD programs. The Kaleido-IP X100 
supports concurrent decoding of up to 8 MPEG-2 or up to 6 H.264 HD programs, and up to 
24 MPEG-2 or up to 12 H.264 SD programs.
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Kaleido-MX
The Kaleido-MX standalone multiviewer system is ideal for production control rooms, 
trucks and outside broadcast operations. Available in two form factors (1 RU, and 3 RU), the 
Kaleido-MX supports up to 64 video inputs, and up to four multiviewer outputs.
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Kaleido-MX system overview

Kaleido-MX 4K
Available in two form factors (1 RU, and 3 RU), and four configurations, the Kaleido-MX 4K 
ultra high-definition multiviewer can monitor up to 64 video inputs, on a 4K UHD display, 
without visible quadrants.

Kaleido-Modular-X
The Kaleido-Modular-X is a flexible and scalable 4K- and IP-ready multiviewer for TV 
production optimized for the space, power and weight considerations found in studios and 
outside broadcast trucks. FlexBridge coax cable bridging between the input and output 
modules allows for the installation of the input stage next to the router or sources, and the 
output stage next to displays, for simpler, cost-effective cabling with none of the risk 
associated with HDMI extenders. The Kaleido-Modular-X supports up to 64 video inputs, 
and up to four multiviewer outputs.

KMX-4911
The KMX-4911 multiviewer modules are part of the GV Node IP aggregation, processing, 
and edge routing platform, designed for live broadcast production. Each KMX-4911 card 
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can display up to nine SMPTE ST 2022-6, 3Gbps, HD, or SD inputs in up to nine video 
windows across one or two high-resolution outputs. Combine up to four KMX-4911 cards, 
to configure a dual- or quad-output system supporting up to 36 inputs.

Cluster
As of version 4.00 of the Kaleido-X software, it is possible to configure a cluster system, 
allowing operation of layouts sharing output signals from multiple multiviewers fed by a 
router, while using only one mouse, and one Kaleido-RCP2 or RCP-200. Refer to Creating a 
Cluster, on page 89, for more information.

Cluster system overview

Cascade
It is possible to configure up to three Kaleido-X16 or KMV-3901/3911 multiviewers as a 
cascade system. Unlike the cluster, whose purpose is to increase the number of output 
heads in a room, the cascade increases the maximum number of inputs that can be 
displayed to a single monitor wall display. It is also possible to configure a hybrid cascade 
system, involving one Kaleido-IP and one Kaleido-X, or one Kaleido-IP and one Kaleido-X16, 
to monitor both baseband and IP sources at once, on the same monitor wall display. For 
more information, refer to the appropriate Cascade Step-by-Step Configuration guide, 
available from the Documentation Library section of Grass Valley’s website.

Detailed Directions

Verifying your System Configuration
You can check internal system statuses via the Web-based XAdmin application.
13
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Verifying a Multiviewer’s Internal Statuses and Options

To perform a system verification
1 Open XAdmin. See Opening XAdmin on page 509.

XAdmin’s Status and Options page appears, showing the multiviewer model, and a list 
of all modules and their statuses.

For example, in the case of a Kaleido-X multiviewer, heading rows show the card type, 
serial number, firmware and safemode versions, a card status indicator, and input signal 
status indicators. The card status indicator shows whether the card is running normally 
(green) or in safe mode (red). The signal status indicators reveals the presence of a valid 
input signal at the corresponding connector.

2 Move the pointer to an input signal status indicator to view the associated signal 
format.

Notes 

• In XAdmin, Kaleido-XQUAD, and Kaleido-XQUAD-DUAL systems are 
identified as KMV-3911.

• Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X systems are identified 
as KMX-3901.

• In the case of a Kaleido-IP multiviewer, heading rows do not provide status 
information.
14
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3 Click the arrow button  at the end of a module’s heading row to view more detailed 
information about this module.

• At any time you can click the Refresh button  to make sure the data displayed for 
the selected module is up to date.

• In the case of a Kaleido-X, KMX-4911, or KMX-3901 system, click the “Reset card” 
button  at the end of a card’s heading row to reset the card remotely, directly 
from your Web browser.

• In the case of a Kaleido-X16 or KMV-3901/3911 multiviewer model, click the 
“Reset multiviewer” button  at the end of the multiviewer’s heading row to reset 
the multiviewer remotely, directly from your Web browser.

• In the case of a Kaleido-IP multiviewer, clicking arrow buttons  reveals 
information on bandwidth usage, network status, CPU/GPU usage and 
temperature, memory usage and PSU status. Clicking the “Reset multiviewer” 
button  is equivalent to the procedure described under Restarting a Kaleido-IP 
Multiviewer, on page 525, except that, in the first case, you get no feedback from 
XAdmin.

4 Review the enabled options for each module, and make sure that no error is reported.

Card type Serial number

Version information
Input signal status

Input signal format

Status indicator

Expand details
Refresh
Reset card
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5 If your system supports a GPI interface, you can check the main system statuses of the 
multiviewer, to make sure that there are no errors or alerts related to system 
temperature, power supply status, fan operation, or other card fault conditions.

Note: In the case of a Kaleido-IP multiviewer, there are currently no options 
that can be enabled via XAdmin. See Hardware and Software Options on 
page 464 for more information on the options available for the different 
multiviewer models.
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The other system-related statuses should all be normal, although if you left the door 
open when checking a GPI/Genlock card’s LEDs, you may see a warning under Chassis 
Door Open Status.

If you have a Kaleido-X (4RU) without a KXA-GPI-GEN card, then you will find the fan 
and power supply statuses listed with the master output card’s information.

Note: The KXA-GPI-GEN card, with support for GPI, is standard on the 
Kaleido-X (7RU), and optional for the Kaleido-X (4RU). GPI support is built-in 
on the Kaleido-X16, and Kaleido-Modular KMV-3901/3911 multiviewers. Not 
available on the Kaleido-IP.

Temperatures

PSU statuses

Fan statuses

Temperatures

PSU statuses

Fan statuses
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In the case of a Kaleido-X16, KMX-4911, KMX-3901, or KMV-3901/3911 multiviewer, the 
relevant indicators are found under the SYSTEM module.

Verifying a Kaleido-RCP2

To verify that the Kaleido-RCP2 is functioning normally
1 Log on to the appropriate room the Kaleido-RCP2 (see Logging on to the Kaleido-RCP2 

on page 490).
2 Test various operations using the Kaleido-RCP2 keyboard and the mouse (e.g., load 

layout presets).

Verifying an RCP-200

To verify that the RCP-200 is functioning normally
• Log on to the appropriate room from the RCP-200 (see Logging on to the RCP-200 on 

page 485).
On the RCP-200’s right-hand screen, you should see a thumbnail view of the room 
displays in the Room View navigation pane, with one of the displays selected, and a 
view of the monitor wall layout as it appears on the selected display.

Verifying an Audio Bridge Terminal

To verify that the ABT is functioning normally
• Inspect the ACTIVITY and front panel LEDs on the unit to make sure there are no error 

conditions.
The ACTIVITY indicator is located on the right-hand side of the rear panel. This LED 
reports the status of the Ethernet connection as follows:

Color Board Status

Off No link detected

Green Normal (good link)

Orange Activity

Red Hardware fault

Flashing red Upgrading firmware
18
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Two LEDs are visible on the front panel, one for each power supply. When lit, they both 
indicate the same status:

When the ABT is powered up, all three LEDs will be orange until the boot sequence is 
terminated. This is a visual indicator that the LEDs are functioning properly.

Loading a Layout
If your system was configured prior to shipment, then the designated layout will show up 
on all displays. Otherwise, a gray screen will appear with the following message in the 
middle:

“No layout has been assigned to this room. Please load a layout.”

To load a layout on the monitor wall
1 Connect a mouse to the Kaleido-RCP2 or RCP-200 (if available) and log on to the 

multiviewer from the control panel, if you have not already done so (see Logging on to 
the Monitor Wall Using a Remote Control Panel on page 35).
Alternatively, connect the mouse directly to one of the USB ports on the multiviewer.

2 Right-click anywhere on the monitor wall, point to Monitor wall (if you clicked a layout 
element), and then click Load layout on the menu.

Monitor wall menu

A layout browser appears on the displays associated with the current room.

Color Board Status

Green Normal

Flashing green Normal, rebooting

Orange Warning

Flashing Orange Warning, rebooting

Red Hardware fault

Flashing red Upgrading firmware

Note: By default, each room is associated with one multiviewer output or 
output card. Most predefined layouts are configured to show all video 
streams for a given input card (e.g., in the case of a Kaleido-X, or Kaleido-MX 
system) or all video streams connected to the multiviewer’s inputs (e.g., in 
the case of a Kaleido-X16, or Kaleido-Modular KMV-3901/3911 system).
19
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3 Choose a default layout from the layout browser. 
The video sources should appear on the room displays.

Example of a default layout showing 16 video streams

Note: You can also use the 10 LAYOUT PRESETS buttons on the Kaleido-
RCP2 to load the preconfigured default layout to the monitor wall.
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Cabling Diagrams

Kaleido-IP

Cabling diagram for a Kaleido-IP X310 with two additional DATA ports (LAN5–LAN6, not connected). The Kaleido-IP 
X110 rear panel is identical, except for LAN5 and LAN6, which are not available for this model.
21
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Kaleido-MX

Cabling diagram, showing the rear view of a Kaleido-MX (1RU) 16 × 2 system
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Kaleido-MX 4K

Cabling diagram, showing rear view of a Kaleido-MX 4K (3RU) 64 × 1 system
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Kaleido-Modular-X

Cabling diagram, showing rear view of a Kaleido-Modular-X 16 × 2 system
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KMV-3901/3911

Cabling diagram showing KMV-3911 rear panel.

Kaleido-X16
25
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Kaleido-X (4RU)
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Kaleido-X (7RU)

Kaleido-X (14RU)
Refer to the “Kaleido-X (7RU) Expansion” chapter in the Kaleido-X (7RU) Hardware 
Description & Installation Manual.

RS-422 Connection Diagram

In the case of a Kaleido-X multiviewer, each output card supports one RS-422 port over an 
RJ-45 connector. The Kaleido-X16 supports two RS-422 serial inputs over RJ-45 connectors. 
These inputs allow the multiviewer to connect to external serial devices such as a router, 
production switcher, or router controller.

Note: For information on the KMV-3911 multiviewer’s RS-422 interface, 
refer to the KMV-3901/3911 Guide to Installation and Operation, available 
from the Documentation Library section of Grass Valley’s website.
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The pinout for the RS-422 signals at the RJ-45 connectors on a Kaleido-X16—or on the 
output cards’ rear panel, in the case of a Kaleido-X—, and the wiring diagrams for the 
appropriate adapters, are shown here:

Standard wiring between multiviewer and devices wired to SMPTE “slave” specification (e.g. most 
routers, Ross Synergy switchers, Nevion ETH-CON)

Standard wiring between multiviewer and devices wired to SMPTE “master” specification (e.g. Philips 
Jupiter router control system, Grass Valley Presmaster PCS)

XEdit Application Shortcuts
The following is a list of shortcut keys available in XEdit to execute specific actions.

Note: The RS-422 ports each have an RJ-45 connector in order to preserve 
space on a busy panel. The RS-422 interface specifies a DE-9 connector, so if 
you are using this interface, you will require a DE-9-to-RJ-45 adapter. Grass 
Valley supplies two adapter models, correctly wired for this application: a 
straight adapter (part no. 1737-3000-102), and a crossover adapter (part no. 
1792-3700-100).

Note: The two RS-422 ports on the multiviewer side have no ground pin. 
Using the appropriate DE-9S-to-RJ-45 adapter, an external device should be 
able to communicate with a multiviewer despite the lack of a ground.

Pinout of an RS-422 
port’s RJ45 connector 

on the multiviewer

Pinout of straight adapter (Grass 
Valley part no. 1737-3000-102)

RJ45 DE-9 male DE-9 female
Pinout of RS-422 

connector on SMPTE 
slave device

Pinout of an RS-422 
port’s RJ45 connector 

on the multiviewer

RJ45 DE-9 male DE-9 female
Pinout of crossover adapter (Grass 

Valley part no. 1792-3700-100)
Pinout of RS-422 

connector on SMPTE 
master device

Action Shortcut key

Save Ctrl+S

Import sources from spreadsheeta Ctrl+I
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Toggle the status bar Ctrl+Shift+B

Toggle the layout navigator Ctrl+Shift+N

Toggle the grid Ctrl+Shift+G

Toggle the Tools pane Ctrl+Shift+T

Toggle the Properties pane Ctrl+Shift+P

Toggle the Tips pane Ctrl+Shift+H

Undo last operation Ctrl+Z

Redo last operation Ctrl+Y

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Delete selection Delete

Duplicate Ctrl+D

New Ctrl+N

Open Ctrl+O

Save as Ctrl+Shift+S

Close Ctrl+W

Create grid-type layout based on 
selection (Auto-layout)

Ctrl+M

Select all Ctrl+A

Send to back Ctrl+B

Send to front Ctrl+R

Unlock composite F2

Zoom in Ctrl+plus sign

Zoom out Ctrl+minus sign

a. Available for Kaleido-IP only (see Importing a stream 
lineup on page 96).

Action Shortcut key
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Operation of the Monitor Wall
This section introduces the Kaleido-X monitor wall features.

Key Concepts

Monitor wall The monitor wall refers to the group of display screens that are connected to 
the output modules of a specific Kaleido-X system.

Room A room is a visual grouping of display screens. A room represents the physical 
displays, positioned and sized as viewed by the user in an actual room. 
Rooms can include full screen zones, and are defined and configured by using 
the XEdit application. See Logging on to the Monitor Wall Using a Remote 
Control Panel on page 35.

Automatic 
resolution 
detection

Automatic resolution detection eases the initial setup of a new display monitor 
by automatically determining the best resolution supported by the display. 
This ensures that the multiviewer will be configured for the best video 
quality. When a new display is connected, the multiviewer will detect the 
EDID of the display on boot-up, and will set the correct resolution 
accordingly. This means that displays can be hot-swapped. If an existing 
display is replaced by a new one, the Kaleido-X will automatically change the 
resolution without the need for a system restart. See Setting a Display 
Monitor’s Output Resolution on page 65.
Note: The Kaleido-IP does not yet support automatic output resolution 
detection.

Layout A layout refers to a visual grouping of monitors on the monitor wall. Layouts 
are specific to a room, and created by using the XEdit application. Full screen 
layouts, also defined in XEdit, are specific to a full screen zone within a 
particular room. See Loading Layouts, on page 41, and Displaying a Source in 
Full Screen Mode, on page 43.

Dashboard The dashboard is a window that contains the system name, IP address and 
software build version. It also displays error messages. The dashboard is 
displayed at the bottom right of each display, on the monitor wall:

See Displaying the Dashboard, on page 39, and Hiding the Dashboard, on 
page 40.

Monitor A monitor is an element that is part of a layout. XEdit supports several types 
of primary elements (clocks, timers, video monitors, audio monitors, UMDs, 
time code monitors, alarm monitors, etc.), that can be grouped into 
composite monitors.
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Key Concepts
Logical source A logical source (called a channel, in earlier versions of the documentation) 
refers to a group of physical audio, video, or metadata sources, and text 
attributes. A logical source can be used as a whole, and assigned to a virtual 
monitor. See Assigning Sources to Monitors on page 52.

Video monitor A video monitor is a layout element used to define an area for displaying a 
video signal. Within a video monitor, the video window is the active area 
where the video signal is displayed, possibly including closed captions or 
teletext. See Displaying Subtitles and Closed Caption Text on page 46.

Composite 
monitor

A composite monitor (also referred to as a composite, a monitor or a tile) is a 
group of primary elements that can be seen as a single object within a layout. 
Composite monitors typically include a video window, one or more audio 
level meters, and a UMD with two tallies.

Safe area The safe area is a configurable region inside a video window. The safe area 
markers delimit this region (e.g., a 4:3 region inside a 16:9 window). 
See Toggling Safe Area Markers on page 45.

Audio monitor An audio monitor (also called audio level meter or ALM) is a layout element 
that provides a visual representation of sound. See Triggering Audio 
Monitoring on page 63.

UMD An under monitor display (UMD) has a text label that can be static or 
dynamically updated by a peripheral device. It can also have left and right 
tally indicators. The UMD typically indicates the name of the video source 
seen in a video monitor. You can edit static labels directly on the monitor 
wall: see Editing UMD Text, on page 51, and Selecting an Input Method, on 
page 51.

Time code 
monitor

A time code monitor displays the Ancillary Time Code (ATC) from an HD video 
signal, or the time code found in an embedded SDI video signal, part of the 
vertical interval of an analog signal (VITC), or other external Linear Time Code 
(LTC). This monitor also supports time code information from external 
providers. Time code monitors can be used for monitoring the duration of 
programs.

Timer A timer monitor is based on a timer defined within the Kaleido-X system.
Three timer modes are available: (1) UP: timer counts up starting from zero 
up to a preset time, (2) DOWN: timer counts down from a preset time to zero, 
and (3) REMAINING: timer counts down from the current time until it reaches 
a preset time.
Timers are defined and configured in XEdit. They can be slaved to production 
timers, assigned to logical sources, assigned to rooms or specific RCP users, 
and controlled from the Kaleido-RCP2. See Using Timers on page 58.

Clock A clock is the visual representation of time in a video or display. It can be 
based on a reference LTC signal or on the Kaleido-X system time. Clocks can 
be in a digital or analog format.
Note: The KMV-3901/3911 supports digital clocks only.
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Subtitling 
monitor

A subtitling monitor defines an area for displaying subtitles extracted from a 
video signal. By using a subtitling monitor you can monitor subtitling from a 
specific DVB or SCTE 27 stream, independently from the associated video 
stream. Requires the CC/XDS option (see Hardware and Software Options on 
page 464). See Setting the DVB Subtitling Language from the Monitor Wall, 
on page 49, and Setting the SCTE 27 Subtitling Language from the Monitor 
Wall, on page 49.
Note: With the current version of the Kaleido-X software, the subtitling 
monitor supports DVB subtitles and SCTE 27 subtitles, from Kaleido-IP 
sources only.

V-chip monitor The V-chip monitor provides a visual indication of the V-chip rating from the 
CC (608) metadata in an SD video signal, or from the CC (608) legacy caption 
data, when such data is present within an HD video signal. Requires the 
CC/XDS option (see Hardware and Software Options on page 464).

Metadata 
monitor

A metadata monitor defines an area for displaying XDS, or digital content 
advisory descriptor (CAD) information compliant with CEA-766-D, extracted 
from a video signal. Requires the CC/XDS option (see Hardware and Software 
Options on page 464).

Action An action is an operation automatically performed in response to a specific 
trigger. Monitor wall actions are directly associated with layout elements. 
Background (floating) actions are actions that are global to the Kaleido-X 
system. Unlike monitor wall actions, background actions are always available. 
See Triggering Actions on page 61.

Trigger A trigger is an event that triggers an action. An example of a trigger could be 
a double click on a monitor. Background actions are triggered by alarms or 
by Gateway commands. In XEdit, when defining an action for a layout 
element, you could specify, for instance, that a specific full screen layout be 
displayed on the monitor wall in response to the trigger.

Alarm monitor Alarm monitors help you see the status of global and virtual alarms, but their 
use is not limited to this type of alarms. When any alarm level is assigned to 
an alarm monitor, the status of this alarm will be shown. When using the 
global alarm at the text label level, it will display the text value of the alarm, 
which is a readable name.

Alarm latch To prevent operators from missing temporary alarms on the monitor wall, 
layout elements that are capable of displaying an alarm status (e.g., video 
monitors, subtitling monitors, UMDs, alarm monitors) can be configured with 
a latching mechanism. An alarm latch will keep the error state visible until 
someone acknowledges the associated alarm. See Acknowledging Alarms 
on page 62.

When you acknowledge an alarm, latched or current, the latched status is 
reset to normal (i.e., unlatched). If the alarm is acknowledged while its status 
indicates an error condition, the latched status is reset to normal, and will 
only go back to error if the alarm status returns to normal and then to error 
again.
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Note: If you have an iControl application server, you may use its GSM alarm 
browser to configure an acknowledgement snooze duration, which defines the 
period during which alarm status changes detected by your multiviewer are 
ignored, immediately after an alarm is acknowledged. Such a snooze period is 
typically not desirable in the context of multiviewer alarms. Therefore, a 
multiviewer’s GSM has its acknowledgement snooze duration set to 0 ms, by 
default. 

Video monitors can provide alarm status information through their borders’ 
color and blinking behavior, and show the latched state as small indicators in 
each corner of the video window. UMDs (text and tallies) and alarm monitors 
can change their text or background color and blinking behavior, to reflect 
the alarm status and show the latched state through their borders.

See Configuring a Video Monitor’s Alarm Reporting Behavior, on page 266, 
Configuring a UMD’s Alarm Reporting Behavior, on page 289, and 
Configuring Alarm Monitors, on page 295, for details on configuring the 
alarm reporting and latching attributes for these layout elements.

The Kaleido-X system tracks the latched state of all alarm levels in a logical 
source at all times, even when alarms are not being monitored on the wall, or 
via SNMP traps or background actions. It could thus happen that some layout 
elements will show a latched status indicator after a layout is loaded, even if 
the current state of the corresponding alarm is normal and the alarm was not 
monitored in the previous layout (the alarm occurred on the feed while the 
feed was not monitored).

• Latching only occurs when an alarm severity is above normal (i.e., minor, 
major, or critical). All other alarm states (unavailable, unassigned, pending, 
unknown, etc.) are not latched.

• Unlatching a global alarm unlatches all its contributing alarms. Unlatching 
the last alarm contributing to a global alarm unlatches the global alarm 
itself.

• The color of the latch indicator reflects the highest level of alarm received 
since the corresponding alarm was last unlatched.

Red border indicates

Red corners indicate

current alarm state

latched state
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Detailed Directions
This section describes the actions you can perform on the Kaleido-X monitor wall.

Logging on to the Monitor Wall Using a Remote Control Panel
As network devices, the RCP-200 advanced remote control panel, and the Kaleido-RCP2 
control panel provides access to any room, from any Kaleido-X system on the network. As a 
security measure, access is controlled by a login procedure. Multiple RCP-200 and Kaleido-
RCP2 can be used by different users to access the same room concurrently. When multiple 
RCP users are active in the same room, they each control a separate pointer on the monitor 
wall, and can use the monitor wall menu independently, as long as they limit their actions 
to separate displays.

In a default system configuration, a multiviewer’s video outputs are assigned to specific 
rooms:

• On a Kaleido-X (7RU), the two DVI/VGA outputs from each of the dual-head output 
cards A, B, C and D are assigned to ROOM1, ROOM2, ROOM3 and ROOM4 respectively.

• On a Kaleido-X (4RU), the two DVI/VGA outputs from each of the dual-head output 
cards A and B are assigned to ROOM1 and ROOM2 respectively.

• On a Kaleido-X (14RU) expansion system, the two DVI/VGA outputs from each of the 
dual-head output cards A, B and C of each of Frame A and Frame B are assigned to 
ROOM1, ROOM2, ROOM3, ROOM4, ROOM5 and ROOM6 respectively.

• On a Kaleido-X16-D, the HDMI outputs from each of the output modules are assigned 
to ROOMX16.

• On a Kaleido-X16-S, the HDMI output is assigned to ROOMX16.
• On a KMV-3901/3911, Kaleido-XQUAD, or Kaleido-XQUAD-DUAL, the HDMI outputs are 

assigned to ROOM1.
• On a Kaleido-IP, the multiviewer outputs are assigned to ROOM.
• On a Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X, the outputs are assigned to 

ROOM1.

Crosspoint A multiviewer can control upstream routers, and it can also be controlled as a 
router itself. In addition, some multiviewer models—Kaleido-X16, Kaleido-
X (7RU), and Kaleido-X (14RU)—can have optional router outputs. A 
crosspoint is the link inside a router between a source (input) and a 
destination (output). See Changing Crosspoints on page 55.
Note: As of Kaleido-X version 5.20, the preferred method of controlling 
sources, regardless of whether they are sources from an upstream router or 
physical multiviewer inputs, is to configure logical sources.

Gateway Kaleido multiviewers can execute commands received via the Kaleido Remote 
Control Protocol (Gateway) interface, allowing third-party developers and 
individual users remote access to some Kaleido functions. Refer to the 
Kaleido Remote Control Protocol (Gateway) User’s Guide, available from the 
Documentation Library section of Grass Valley’s website, for more 
information.
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Logging on to the Monitor Wall Using the Kaleido-RCP2

To log on to a Kaleido-X room from the Kaleido-RCP2
1 On a Kaleido-RCP2 with an active connection to the network, press and hold the ENTER 

button until the ESC button lights up. The Configuration menu appears, with the 
ROOM SELECTION option displayed.

2 Press ENTER again to obtain the list of rooms from the Kaleido-X systems that are 
currently available on the network.
The rooms are listed in the form [multiviewer name]/[room name]. If a room belongs to 
a cluster system, its name appears once for each of the member multiviewers (e.g., if 
two multiviewers, KX1 and KX2, are configured as a cluster, and ROOM1 includes 
displays fed by both multiviewers, then both KX1/ROOM1 and KX2/ROOM1 will be 
listed. You may select either one.

3 In the room list, select the room you wish to access by pressing the 2 key (to move up in 
the list) or the 8 key (to move down the list).

4 When the appropriate room name is highlighted, press ENTER to accept the new 
selection, and then press ESC to exit the Configuration menu.

5 Press the LOGIN key.
The following message will appear on the LCD display:
LOGIN Position 
Admin 

6 Select your user name by pressing the 2 key (to move up in the list) or the 8 key (to 
move down the list).

7 When you user name is highlighted, press ENTER.
8 When prompted, type the password for this user name, then press ENTER.

The message “Access granted” will appear on the LCD display if the login is successful. If 
a mouse is connected to the Kaleido-RCP2, then you should be able to see and move 
the mouse pointer on the monitor wall. Alternatively, use the Kaleido-RCP2’s mouse-
function keys.

Note: By default, the user “Admin” has no password.

Notes 

• If at any time the message “Target system is offline” or “No login list 
available” appears on the LCD display, press the ESC, ENTER and DEL keys 
simultaneously and go back to step 1.

• If the room you were logged on to is part of a cluster system, try accessing 
it from a different multiviewer (e.g., select KX2/ROOM1 instead of 
KX1/ROOM1, from the room list).

• The pointer may flicker when two RCP users access displays fed by the 
same multiviewer output.

• Two users accessing the same display will be limited to sharing a single 
pointer.
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For more information on the Kaleido-RCP2, please refer to the Kaleido-RCP2 Guide to 
Installation and Operation, available from the Documentation Library section of Grass 
Valley’s website.

Logging on to the Monitor Wall Using the RCP-200

To log on to a Kaleido-X room from the RCP-200
1 On an RCP-200 with an active connection to the network, press the LIST button.

All devices, and Kaleido-X rooms, detected by the RCP-200 appear on the left screen. 
Kaleido-X rooms are listed in the form [multiviewer name]\[room name].
If a room belongs to a cluster system, its name appears once for each of the member 
multiviewers (e.g., if two multiviewers, KX1 and KX2, are configured as a cluster, and 
ROOM1 includes displays fed by both multiviewers, then both KX1\ROOM1 and 
KX2\ROOM1 will be listed. To determine the one you should select, review the 
following:

• Has the RCP user configuration you wish to use been replicated on every member 
of the cluster (see Replicating RCP Users Across a Cluster System on page 94)?

• Do you need to control an external router whose configuration is available only 
from one or some specific members of the cluster?

• Does your system configuration include actions that were configured only on one 
or some specific members of the cluster?

• Do you need to control a timer from the monitor wall in a cascade room?
If any of the above elements is available only from one or some specific members, then 
make sure you select the room name prefixed with the appropriate multiviewer name. 
In the case of a cascade room, unless you remember which multiviewer you were 
connected to when you added the timer you need to control, you will have to proceed 
by trial and error.

2 Touch the room you wish to access (press the DOWN or UP soft keys to scroll the list as 
needed).

3 If the list of users assigned to this room appears on the right-hand screen, touch the 
user name under which you wish to log on, enter your password, and then touch LOG 
IN.

The room’s monitor wall control panel appears on the right-hand screen, with the 
ASSIGN CHANNEL category selected. If a mouse is connected to the RCP-200, then after 
touching WALL MOUSE you should be able to see and move the mouse pointer on the 
monitor wall.

Note: By default, the user “Admin” has no password.
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Using On-Screen Wall Control
For more information on the RCP-200, please refer to the RCP-200 Guide to Installation and 
Operation, available from the Documentation Library section of Grass Valley’s website.

Using On-Screen Wall Control

Locating the Mouse Pointer on the Monitor Wall
If you have a cluster system, the monitor wall may comprise a large number of display 
screens, where the mouse pointer location is not always obvious.

To locate the mouse pointer on the monitor wall
• Click the middle mouse button.

A more recognizable square shape appears around the pointer.

Using On-Screen Wall Control from the RCP-200
Once you have logged on to a room from the RCP-200 control panel, a mouse connected to 
one of the panel’s USB port automatically switches to the monitor wall, while the RCP-200’s 
touch screen features remain available. You can alternate using the mouse between the 
RCP-200’s right-hand screen, and the monitor wall.

To use the mouse on the RCP-200’s right-hand screen
• Touch the WALL MOUSE category.

The category’s background turns a darker shade (purple), and the mouse pointer 
appears on the RCP-200’s right-hand screen.

To use the mouse on the monitor wall
• Touch the WALL MOUSE category.

Notes 

• If the ROUTER SELECT category becomes selected instead of ASSIGN 
CHANNEL, showing the following message on the right-hand screen: 
“Please select a router from the left-hand screen,” then you still need to 
complete the correlation between some monitor wall destinations and the 
representation of the corresponding KX Router logical router. 
See Correlating Monitor Wall Destinations and KX Router Logical Routers 
for the RCP-200 on page 487.

• The RCP-200 will remember your user credentials until you log out 
explicitly (by touching LOG OUT at the upper-right corner of the control 
panel).

• The pointer may flicker when two RCP users access displays fed by the 
same multiviewer output.

• Two users accessing the same display will be limited to sharing a single 
pointer.

Note: Configuring a larger pointer may also help. See Enabling the Large 
Mouse Pointer for a Room on page 337, for details.
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The category’s background turns a lighter shade (mauve), and the mouse pointer 
appears on the monitor wall.

Synchronizing the RCP-200’s Head View with the Monitor Wall
The RCP-200’s Kaleido-X control panel does not automatically reflect changes to the current 
layout that were not performed from the RCP-200—for example, someone may have 
loaded a different layout, or changed assignments, from another control panel, from XEdit, 
or by using the monitor wall mouse.

To synchronize the RCP-200’s head view with the monitor wall
• Press the REFRESH knob.

Displaying the Dashboard
Whenever the Kaleido-X software detects an error, it will automatically display the 
dashboard on every monitor of the monitor wall. When all errors are resolved, then the 
system automatically closes the dashboard on every monitor. You can also display the 
dashboard as needed, to view your multiviewer’s system name, IP address, software version 
and current error messages. In such cases you must close the dashboard manually.

To display the dashboard
1 Right-click a monitor. On the menu, point to Monitor wall, and then click Show 

dashboard to display the dashboard associated with the current head.

Monitor wall menu (from composite monitor menu)

Note: It is possible to disable the automatic display of the dashboard on 
specific displays. See Disabling the Dashboard on page 227 for details on 
how to configure this option.

Show dashboard
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Hiding the Dashboard
After a brief delay, the dashboard appears at the bottom-right corner of the display 
monitor, and the command Hide dashboard replaces Show dashboard on the menu.

Dashboard on the monitor wall

Hiding the Dashboard
To hide the dashboard

• Click the × button at the bottom-right corner of the dashboard. Alternatively, right-click 
anywhere on the monitor wall, point to Monitor wall on the menu (if you clicked a 
layout element), and then click Hide dashboard to hide the dashboard on the current 
display.

To hide all the dashboards
• Right-click anywhere on the monitor wall, point to Monitor wall on the menu (if you 

clicked a layout element), and then click Hide all dashboards to hide the dashboard on 
every display in the room.

Note: If you right-click the monitor wall background directly, then the 
monitor wall menu appears immediately, and you can click Show 
dashboard directly:

i

Note: Clicking the × button closes the dashboards on every display 
monitor in the room if they were displayed automatically.

Hide dashboard

Hide all dashboards
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Loading Layouts

Loading a Layout by Using the Mouse

To load a layout on the monitor wall, by using the mouse
1 Right-click anywhere on the monitor wall, point to Monitor wall (if you clicked a layout 

element), and then click Load layout on the menu.

The layout chooser appears.

2 Select the layout you wish to load, from the set of layouts defined for this room, and 
then click OK.
The new layout appears on the monitor wall.

Loading a Layout by Using the Kaleido-RCP2

To load a layout on the monitor wall, by using the Kaleido-RCP2
1 Press LOAD on the Kaleido-RCP2.

The layout chooser appears.

Note: When a dashboard is closed while the system is in an error condition, 
it will automatically reappear after 60 minutes, or when a new error occurs.

Note: Due to a limitation in XEdit’s support for drag-and-drop operations, 
when you first load a new layout on the monitor wall, you may notice that a 
monitor’s source or destination assignment is incorrect. Open the layout in 
XEdit, click the corresponding monitor, verify the Source and Monitor wall 
destination attributes indicated in the Properties pane, and correct them as 
needed. See Assigning Logical Sources or Monitor Wall Destinations to 
Monitors on page 252.

Load layout
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2 Select the layout you wish to load, from the set of layouts defined for this room, and 
then click OK.
The new layout appears on the monitor wall.

Using Layouts Presets

To load a layout using the Kaleido-RCP2’s preset buttons
• Press the appropriate preset button (1-10) on the Kaleido-RCP2.

The button you just pressed starts flashing (while the button associated with the 
currently loaded layout, if any, remains lit). Once the layout associated with the preset 
button for the current user appears on the monitor wall, the button stops flashing, and 
becomes lit (while the previously lit button is not lit anymore). See Assigning Room 
Layouts to the Kaleido-RCP2 Preset buttons on page 336, for more information.

Loading a Layout by Using the RCP-200

To load a layout on the monitor wall, by using the RCP-200
1 Touch LAYOUT SELECT on the RCP-200’s right-hand screen.

The layout chooser view appears.
2 Rotate the TAKE knob to locate the layout you wish to load, scrolling the list as needed.
3 Once you have selected the layout you wish to load, press TAKE.

After a moment, the new layout appears on the monitor wall, and the RCP-200’s right-
hand screen returns to the ASSIGN CHANNEL panel.

Refreshing a Layout

To refresh a layout
• Right-click anywhere on the monitor wall, point to Monitor wall (if you clicked a layout 

element), and then click Refresh on the menu.

Note: Once the preset button has stopped flashing on the Kaleido-RCP2, if 
the new layout has source assignments from an upstream router, it may still 
take a moment before these sources appear on the monitor wall.
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Displaying a Source in Full Screen Mode
To display a source in full screen mode from the Kaleido-RCP2

1 Move the pointer over the video source you wish to display in full screen mode.
2 Press FULL SCREEN on the Kaleido-RCP2.

The full screen layout assigned to the current user is loaded into the full screen zone.

To display a source in full screen mode from the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the video source you wish to display in full screen mode on the monitor 
wall.

2 If you have yet to assign the FULL SCREEN wall function to one of the programmable 
knobs, rotate the knob you wish to program until FULL SCREEN is selected, and then 
press the knob.
FULL SCREEN appears above the programmed knob.

3 Press the FULL SCREEN knob.
The full screen layout assigned to the current user is loaded into the full screen zone.

To close the full screen view
• Move the pointer over the full screen zone, and then press FULL SCREEN again, on the 

Kaleido-RCP2 or RCP-200.

Changing a Source’s Aspect Ratio
To change the aspect ratio using the Kaleido-RCP2

• Move the pointer over the video source whose aspect ratio you wish to change, and 
then press ASPECT RATIO on the Kaleido-RCP2. Continue pressing ASPECT RATIO to 
alternate between the available aspect ratio options (4:3, 16:9, and possibly a third 
custom aspect ratio if one was defined in XEdit for the monitor).

To change the aspect ratio using the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the video source whose aspect ratio you wish to change on the monitor 
wall.

Refresh

Note: A full screen layout can also be loaded by configuring actions in 
XEdit. See Managing Layouts on page 240, for information on creating a full 
screen layout, and refer to Creating Actions, on page 323, for detailed 
instructions.
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Video Cropping/Zooming
2 If you have yet to assign the ASPECT RATIO wall function to one of the programmable 
knobs, rotate the knob you wish to program until ASPECT RATIO is selected, and then 
press the knob.
ASPECT RATIO appears above the programmed knob.

3 Press the ASPECT RATIO knob.
The video source’s aspect ratio changes. Continue pressing ASPECT RATIO to alternate 
between the available aspect ratio options (4:3, 16:9, and possibly a third custom 
aspect ratio if one was defined in XEdit for the monitor).

To change the aspect ratio using the mouse
1 Right-click the video source.
2 On the menu, point to Aspect Ratio, and then click 4:3 or 16:9.

The video is resized accordingly within the layout.

Video Cropping/Zooming

To toggle the cropping mode using the Kaleido-RCP2
• To change the current cropping mode, move the mouse pointer over the video source 

whose cropping mode you wish to change, and then press the UNDERSCAN button on 

Note: There may be one more choice on the menu if you set a custom 
aspect ratio in XEdit, for this monitor. See Setting a Video Monitor’s Aspect 
Ratio on page 259.

Notes 

• The Kaleido-IP does not yet support cropping and zooming.

• The overscan margins are set to 5% by default. They can be customized in 
XEdit (see Cropping Mode on page 236).

• Kaleido-MX and Kaleido-Modular-X configured for 4K UHD output, and 
Kaleido-MX 4K do not support the overscan mode for video sources 
spanned across multiple heads (see 4K UHD Spanning on page 239).

• Safe title area and aspect ratio markers follow the video signal (e.g., if the 
safe title area is within 5% of top, left, right and bottom, then when the 
video is in default overscan mode, the safe title area markers will not 
appear).
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the Kaleido-RCP2. Continue pressing UNDERSCAN to alternate between underscan and 
overscan mode.

To toggle the cropping mode using the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the video source whose cropping mode you wish to change on the 
monitor wall.

2 If you have yet to assign the UNDERSCAN wall function to one of the programmable 
knobs, rotate the knob you wish to program until UNDERSCAN is selected, and then 
press the knob.
UNDERSCAN appears above the programmed knob.

3 Press the UNDERSCAN knob.
The video source’s cropping mode changes. Continue pressing UNDERSCAN to 
alternate between underscan and overscan mode.

To toggle the cropping mode using the mouse
• Right-click the video source.

If the video is in underscan mode, then the menu will allow you to change to overscan.

If the video is in overscan mode, then the menu will allow you to change to underscan.

Toggling Safe Area Markers
To toggle the safe area markers on a video using the Kaleido-RCP2

• Move the pointer over the video source, and then press SAFE AREA on the Kaleido-
RCP2. Continue pressing SAFE AREA to toggle the markers.

Overscan

Underscan
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Displaying Subtitles and Closed Caption Text
To toggle the safe area markers on a video using the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the video source whose cropping mode you wish to change on the 
monitor wall.

2 If you have yet to assign the SAFE AREA wall function to one of the programmable 
knobs, rotate the knob you wish to program until SAFE AREA is selected, and then press 
the knob.
SAFE AREA appears above the programmed knob.

3 Press the SAFE AREA knob.
The safe area markers appear inside the video window. Continue pressing SAFE AREA 
to toggle the markers.

To toggle the safe area markers on a video using the mouse
1 Right-click the video source, and then click Safe Area on the menu.

The safe area markers appear inside the video window.

2 Click Safe Area again on the menu, to hide the markers.

Displaying Subtitles and Closed Caption Text

Safe area

Notes 

• The KMV-3901/3911, and Kaleido-XQUAD multiviewers do not support 
extraction of subtitles and closed captions.

• Only the Kaleido-IP supports extraction of SCTE 27 subtitles, DVB subtitles, 
and DVB teletext.

• The Kaleido-IP supports extraction of CEA-608 and CEA-708 closed 
captions, in addition to DVB subtitles, DVB teletext, and SCTE 27 subtitles.
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Setting the Text Mode

To change the text mode for a video, or subtitling monitor
1 Right-click the appropriate video, or subtitling monitor, on the monitor wall.
2 If the current text mode indicator is Text (CC/subtitling), then:

a Click Enable text on the menu, to first enable the display of subtitles and closed 
captions.

b Right-click the monitor again.
3 On the menu, point to the text mode indicator —either Text (CC/subtitling), CC (608), 

CC (708), Teletext & subtitling, DVB subtitling, or SCTE 27 subtitling, then point to 
Text mode, and click the text mode you wish to apply.

To prevent the menu from being too crowded by CC (608), CC (708), DVB subtitling, 
SCTE 27 subtitling, and Teletext/subtitling options, its content (label, icon and available 
choice) changes, depending on the current video format:

Signal type Text Mode Indicator Label Available choices

SD-SDI/CVBS 525, 
MPEG-2, H.264

Auto  CC (608) Off, CC1, Text mode sub-
menu

Any CC (608)
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Switching Closed Captioning On/Off

To switch CC (608) closed captioning on/off
• Right-click the appropriate composite or video monitor on the monitor wall, point to 

CC (608), and then click either CC1 or Off.

To switch CC (708) closed captioning on/off
• Right-click the appropriate composite or video monitor on the monitor wall, point to 

CC (708), and then click either the appropriate service number or Off.

SD-SDI/CVBS 625, 
MPEG-2, H.264

Auto  Teletext & 
subtitling

For a Kaleido-IP: Off, Page 
A to Page H, Text mode 
sub-menu
Other multiviewer 
models: Off, Page A, Edit 
pages, Text mode sub-
menu

Any Teletext & 
subtitling

HD-SDI, MPEG-2, 
H.264

Auto  CC (708) Off, Service 1 to Service 
63, Text mode sub-menu

Any CC (708)

MPEG-2, H.264 Auto  DVB subtitling Off, available language 
services, Text mode sub-
menu

Any DVB 
subtitling

MPEG-2, H.264 Auto SCTE 27 
subtitling

Off, available language 
services, Text mode sub-
menu

Any SCTE 27 
subtitling

Other / Unknown Auto  Text 
(CC/subtitling)

Enable text, Auto sense, 
CC (608), CC (708), 
Teletext & subtitling, 
DVB subtitling, SCTE 27 
subtitling.

Signal type Text Mode Indicator Label Available choices
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Setting the DVB Subtitling Language from the Monitor Wall

To set the decoded DVB subtitling language for a monitor on the wall
• Right-click the appropriate composite, video, or subtitling monitor, point to DVB 

subtitling, and then click the language you wish to monitor.

To switch DVB subtitling off
• Right-click the monitor, point to DVB subtitling, and then click Off.

Setting the SCTE 27 Subtitling Language from the Monitor Wall

To set the decoded SCTE 27 subtitling language for a monitor on the wall
• Right-click the appropriate composite, video, or subtitling monitor, point to SCTE 27 

subtitling, and then click the language you wish to monitor.

Note: The menu displays Service 1 to Service 6. Use the Extended services 
sub-menu to select from the Service 7 to Service 63 range. When an 
extended service is enabled it is added to the menu below Service 6.

Note: When monitoring a program that includes DVB subtitling based on a 
non-supported version of ETSI EN 300 743, the Kaleido-IP raises the DVB 
subtitle invalid alarm and no subtitling appears on the monitor wall.
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To switch SCTE 27 subtitling off
• Right-click the monitor, point to SCTE 27 subtitling, and then click Off.

Selecting a Teletext/Subtitling Page from the Monitor Wall

To change the decoded teletext/subtitling page for a Kaleido-IP
• Right-click the appropriate composite or video monitor, point to Teletext & Subtitling, 

and then click the page you wish to decode on the menu.
The menu displays Page A (###) to Page H (###) where “###” is the number of the 
actual page being monitored (from 100 to 899), or the word Disabled (if the page 
number associated with this page is not to be monitored).

The assignments of Page A to Page H are configured in XEdit.

To change the decoded teletext/subtitling page for a Kaleido-X, Kaleido-X16, 
Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X

• Right-click the appropriate composite or video monitor, point to Teletext & Subtitling, 
and then click Page A ([page number]) on the menu.

The menu displays Page A (###) where “###” is the number of the actual page being 
monitored (from 100 to 899).
It is possible to change the assignment using the Edit pages sub-menu. This menu 
allows you to configure the page selection for the current input.

To switch teletext/subtitling off
• Right-click the monitor, point to Teletext & Subtitling, and then click Off.
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Editing UMD Text
To edit the text on a UMD

1 Right-click the UMD whose text label you wish to modify, and then click Edit text on 
the menu.

The UMD text area becomes editable.

2 Type the new text, and then press ENTER on the Kaleido-RCP2, RCP-200, or external 
keyboard.
The UMD displays the new text.

Selecting an Input Method

To select an input method
1 Click the appropriate composite or video monitor on the monitor wall.
2 Press left Alt+Shift+1 on the external keyboard.

The Select Input Method menu appears.
3 On the Select Input Method menu, click the appropriate input method.

Note: In the case of a KMV-3901/3911 multiviewer, the current version of 
the Kaleido-X software does not support input methods on the monitor 
wall. As a workaround, you can use XEdit, open the layout that contains the 
text you wish to modify (e.g., static UMD text, logical source text level), and 
then use the appropriate input method from your client PC or laptop.
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You can now type text in your language of choice, using an external keyboard 
connected to the Kaleido-RCP2.

Assigning Sources to Monitors
Any monitor in a layout can be assigned a logical source in XEdit. It is possible to change 
the logical source assignment directly on the monitor wall.

Assigning a Logical Source to a Monitor by Using the Kaleido-RCP2

To assign a logical source to a monitor, by using the Kaleido-RCP2’s CHANNEL button
1 Move the pointer over the monitor that is to be assigned a logical source, and then 

press CHANNEL on the Kaleido-RCP2.
The Assign Source window appears.

The label of each category/index button in Assign Source is based on recurring strings 
found in the logical source names available for your system. The Src box shows the 
current assignment.

2 Click through the categories until the Pst box shows the logical source you wish to 
assign to the selected monitor. For example, if you wish to assign the logical source 
named “/Input B/Channel 16” to the monitor, click Input B, 1, and then 6.

3 Click Take.
The selected logical source is now assigned to the monitor.

4 Click the × button to close the Assign Source window.

Assigning a Logical Source to a Monitor by Using the RCP-200
Although logical source assignments can be accomplished via the CHANNEL monitor wall 
function (see page 53), you may find the RCP-200’s category/index router view more 
convenient. To use the RCP-200’s category/index panel, your multiviewer system must have 

Note: Logical source assignments can also be changed by configuring 
actions in XEdit. See Creating Actions on page 323 for more information.

Current assignment
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been configured to be controlled as a router. In a layout, the RCP-200 can only control 
monitors that have been assigned a monitor wall destination.

To assign a logical source to a monitor, by using the RCP-200’s Category/Index panel
1 Select the appropriate head from the room view, by rotating the HEAD knob (or by 

touching the DISPLAY SELECT category, and then touching the desired room display), if 
needed.

2 Touch the monitor whose source assignment you wish to change.
The monitor’s border turns yellow, indicating that this monitor is a monitor wall 
destination, and the RCP-200’s category/index panel appears on the left-hand screen.
The label of each category/index button is based on recurring strings found in the 
logical source names available for your system. The Src and Dst areas show the current 
source assignment and the monitor wall destination number for the selected monitor.

3 Touch through the categories until the Pst area shows the logical source you wish to 
assign to the selected monitor. For example, if you wish to assign the logical source 
named “/Input B/Channel 16” to the monitor, touch Input B, 1, and then 6.

4 Press Take.
The selected logical source is now assigned to the monitor.

To assign a logical source to a monitor, by using the RCP-200’s CHANNEL knob
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the composite or video monitor whose source assignment you wish to 
change.

2 If you have yet to assign the CHANNEL wall function to one of the programmable 
knobs, rotate the knob you wish to program until CHANNEL is selected, and then press 
the knob.
CHANNEL appears above the programmed knob.

3 Press the CHANNEL knob.
The Assign Source window appears on the monitor wall.

The label of each category/index button in Assign Source is based on recurring strings 
found in the logical source names available for your system. The Src box shows the 
current assignment.

4 Click through the categories until the Pst box shows the logical source you wish to 
assign to the selected monitor. For example, if you wish to assign the logical source 
named “/Input B/Channel 16” to the monitor, click Input B, 1, and then 6.

Current assignment
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5 Click Take.
The selected logical source is now assigned to the monitor.

6 Click the × button to close the Assign Source window.

Assigning a Logical Source to a Monitor by Using the Mouse

To assign a logical source to a monitor, by using the mouse
1 Right-click the monitor that is to be assigned a logical source.
2 On the menu, point to Assign source to [component] (where [component] will be 

monitor, video, UMD, tally, audio meter, status alarm, time code, metadata display, 
subtitling, or clock, depending on the monitor you clicked).

The Assign Source window appears.

The label of each category/index button in Assign Source is based on recurring strings 
found in the logical source names available for your system. The Src box shows the 
current assignment.

3 Click through the categories until the Pst box shows the logical source you wish to 
assign to the selected monitor. For example, if you wish to assign the logical source 
named “/Input B/Channel 16” to the monitor, click Input B, 1, and then 6.

Current assignment
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4 Click Take.
The selected logical source is now assigned to the monitor.

5 Click the × button to close the Assign Source window.

Changing Crosspoints

Changing Logical Sources Assignments on a Kaleido-X Configured as a 
Router

To change a monitor’s source assignment by using a router control device or application
• Apply a crosspoint change to route the desired Kaleido-X logical source to the video 

monitor whose source assignment you wish to change on the monitor wall, in the same 
way you would do for any router controlled by the device or application you have.
The video from the first video level assignment within the selected logical source 
appears in the video window.
When the current layout is reloaded, either of the following two situations may apply.

• No logical source: If there was no logical source associated with the monitor, then 
the Kaleido-X will remember the new source assignment.

• Not a monitor wall destination: If the monitor was not already configured as a 
monitor wall destination, then the layout will be reloaded in its initial state, as it 
was configured in XEdit.

Viewing Assignment Information

To view the current assignment information for a video monitor
• Right-click the video monitor, and then point to Info on the menu.
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The following information appears, as a submenu:

Dest Name associated with this monitor when considered as a 
destination in the context of the KX Router logical router

Src Name of the logical source currently assigned to this 
monitor.

Phy Identifier associated with the physical multiviewer input 
providing the current signal to this monitor.

Notes 

• In the case of a Kaleido-IP, the physical input information (Phy) is not 
relevant.

• The information shown is not dynamic. To view the latest information, 
close the menu, and then open it again.

• The physical input information (Phy) indicates “Unassigned” when there 
are no logical source assigned to the monitor, or when the current logical 
source does not include any video level.

• The physical input information (Phy) may indicate “Unresolved” in 
situations such as the following:
• the router that provides the current source to the multiviewer is not 

configured properly;
• the router interconnections are not configured properly;
• there is no communication between the router and the multiviewer;
• an input card was removed (in the case of a Kaleido-X, Kaleido-MX, or 

Kaleido-MX 4K multiviewer model);
• there are not enough multiviewer inputs connected to the router to 

handle all the signals being routed to monitor wall destinations.

Current logical source
Physical source ID

Monitor-wall destination
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Changing an Internal Router Crosspoint

To change a crosspoint in the internal router
1 Right-click the appropriate composite or video monitor on the monitor wall.
2 On the menu, point to Send to [router] output (where [router] will be the name of the 

first logical router mapped to your multiviewer’s router outputs), navigate to the 
appropriate logical output, and then select it.

The source signal displayed on the monitor is routed to the selected destination.

Notes 

• This feature is only available on Kaleido-X (7RU), Kaleido-X (14RU), and 
Kaleido-X16 multiviewers, with the SDI Router Output option, and whose 
internal router is properly configured within the first level of the KX Router 
logical router. See Configuring a Multiviewer’s Internal Router on page 385 
for more details.

• In the case of a Kaleido-X (14RU) expansion system, to be able to send a 
video signal to a router output on either frame, the internal routers must 
be connected by expansion cables, and router expansion must have been 
properly configured in XEdit. Refer to “Configuring Router Card Expansion” 
in the Kaleido-X (7RU) Hardware Description & Installation Manual, for 
more information.
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Changing an External Router Crosspoint

To change an external router crosspoint
1 Right-click a composite or video monitor on the monitor wall.
2 On the menu point to Assign [router] input (where [router] will be the name of a 

logical router whose outputs are connected to the multiviewer inputs), navigate to the 
input you wish to assign to the monitor, and then select it.

The multiviewer requests the specified source signal from the router.

Using Timers
Timers can be assigned to timer monitors in a layout. Any user can control such timers by 
using the timer monitor’s buttons and menu. An RCP user can be assigned a specific timer. 

Notes 

• As of version 5.20 of the Kaleido-X software, when a multiviewer manages 
an upstream router, you should manage the router’s physical sources as 
logical sources within the multiviewer system (see page 195). Router 
sources can thus be assigned to monitor wall elements transparently, just 
as sources connected directly to the multiviewer’s inputs (see Assigning 
Sources to Monitors on page 52).

• In the case of a multiviewer systems configured with an upstream router 
that has more than 288 sources, the Assign [router] input menu 
mentioned in the procedure below is not available, and you must therefore 
manage the router’s physical sources as logical sources within the 
multiviewer system.

• The KMV-3901/3911 multiviewers do not support the procedure described 
below.

Note: What you see on the wall is not a list of physical inputs, but of logical 
inputs (labels). Once you have established your configuration in XEdit, you 
always work with logical devices/levels.
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This allows using the numeric keypad on an external keyboard connected to the Kaleido-
RCP2 to control the timer.

Controlling a Timer by Using the Timer Monitor’s Buttons and the Menu

.

To configure an interactive timer monitor on the monitor wall
1 Right-click the timer you wish to configure.

2 On the menu, point to Mode, navigate to the appropriate timer mode, and then click 
the desired end behavior.

Notes 

• Timer monitors display time in HH:MM:SS format. Even if the monitor is 
synchronized with an LTC source, frame count is not displayed.

• Using a timer monitor’s Reset, Timer mode or End behavior buttons will 
stop the timer, if it was running.

Reset Timer mode End behaviorStart/Stop

Stop

Remaining

Loop

Down

Overrun Up
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Alternatively, you can set the mode and behavior directly, by clicking the timer 
monitor’s Timer mode, and End behavior buttons:

• Click the Timer mode button to select one of three modes: Overrun, Stop or Loop.
• Click the End behavior button to select one of three modes: Down, Up or 

Remaining.
The timer monitor is updated accordingly.

3 Use the Preset controls to set a new preset time.

4 Click the Reset button to reset the timer to its initial value (based on timer mode and 
preset time).

5 Click the Start button to start the timer.
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Controlling a Timer by Using an External Numeric Keypad
If a timer is assigned to the current RCP user, or else if a timer is assigned by default for the 
room, then the external keyboard’s numeric keypad controls this specific timer.

To configure your assigned timer, by using a numeric keypad
• Press the slash key (“/”) to set the timer mode and end behavior. Keep pressing the key 

to cycle through all the available options, until the buttons show the appropriate 
settings.

• Press the plus key (“+”) to reset the timer. (This will also stop the timer if it was running.)
• Press the Enter key to start/pause the timer.
• Use the number keys to set or modify the preset time.

Triggering Actions

Triggering an Action from the RCP-200

To trigger a background action from the RCP-200’s programmable knobs
1 If you have yet to assign the action you wish to trigger to one of the programmable 

knobs, rotate the knob you wish to program until the action is selected, and then press 
the knob.
The action’s name appears above the programmed knob.

2 Press the knob to trigger the action.

Note: The reserved keys are always enabled, whether Num Lock is set or 
not.

Notes 

• An Action’s trigger is determined when the Action is created in XEdit. 
See Creating Actions on page 323 for more information.

• To create background actions that can be triggered from the RCP-200’s 
programmable knobs, refer to Creating an Action that can be Triggered via 
a Gateway Command, on page 330.
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Triggering an Action from the Monitor Wall

To trigger a monitor wall action
1 Move the pointer over a monitor associated with the action you wish to trigger.

The pointer changes to a hand icon.
2 If the action is not triggered automatically, click or double-click the monitor.

Triggering GPI Output Events

To trigger a GPI output event
1 In XEdit, configure the appropriate GPI line’s direction as an output (system calibration).
2 Create an action to toggle the GPI output on/off state, and assign it to a monitor.
3 Export the database to the multiviewer.
4 Trigger the action by clicking the monitor.

The GPI line’s state changes.

Acknowledging Alarms

Acknowledging Alarms on the Monitor Wall

To acknowledge an alarm, by using the Kaleido-RCP2
• Move the pointer over the monitor whose alarm state you wish to acknowledge, and 

then press the UNLATCH STATUS button on the Kaleido-RCP2.

To acknowledge an alarm, by using the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the monitor whose alarm state you wish to acknowledge on the monitor 
wall.

2 If you have yet to assign the UNLATCH STAT wall function to one of the programmable 
knobs, rotate the knob you wish to program until UNLATCH STAT is selected, and then 
press the knob.
UNLATCH STAT appears above the programmed knob.

Note: This topic does not apply to the Kaleido-IP.

Note: GPI lines configured as outputs can have their state set manually for 
test purposes in XEdit’s System tab:
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3 Press the UNLATCH STAT knob.

To acknowledge an alarm, by using the mouse
• Right-click the monitor whose alarm state you wish to acknowledge, and then click 

Unlatch/Acknowledge on the menu.

To acknowledge all current alarms in a room
• Right-click the monitor wall, point to Monitor wall (if you clicked a monitor), and then 

click Unlatch/Acknowledge all on the menu.

This will acknowledge every alarm monitored in the current room.

Acknowledging Alarms by Using an Action

To acknowledge alarms, by using an action
• Create a Unlatch/Acknowledge all action. This action can be assigned to a monitor on 

the monitor wall, it can be triggered by loading or unloading a layout, or it can be a 
background action. See Creating Actions on page 323 for details.

Triggering Audio Monitoring

Unlatch/Acknowledge

Unlatch/Acknowledge all

Note: Before connecting a display or AV receiver to a Kaleido-IP 
multiviewer, make sure the multiviewer is powered off. In the advent that 
you have connected such a device while the multiviewer was running, you 
must restart the multiviewer for audio monitoring to be functional. 
See Restarting and Shutting Down a Kaleido-IP Multiviewer on page 524.
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Triggering Audio Monitoring by Using the mouse, the RCP-200, or the 
Kaleido-RCP2

To trigger audio monitoring, by using the mouse, the RCP-200, or the Kaleido-RCP2
• Move the pointer over an audio monitor, and then

• click the monitor
• press AUDIO MONITORING on the Kaleido-RCP2
• press the AUDIO MONITOR programmable knob on the RCP-200

This will route the monitor’s audio source to the monitoring output assigned to the 
current RCP user.

• Move the pointer over a video monitor, and then
• click the monitor
• press AUDIO MONITORING on the Kaleido-RCP2
• press the AUDIO MONITOR programmable knob on the RCP-200

This will route the specific audio level associated with the video monitor, based on the 
assigned logical source.

• Move the pointer over any other monitor, and then
• click the monitor
• press AUDIO MONITORING on the Kaleido-RCP2
• press the AUDIO MONITOR programmable knob on the RCP-200

This will route the first audio level of the associated logical source to the monitoring 
output.
Audio monitors that have an audio monitoring indicator (see Configuring Audio 
Monitors on page 273) and that are currently assigned the same audio level, will turn 
the color associated with the current display (see Calibrating the Audio Monitoring 
Color on page 162), showing that someone is listening at this specific display.

If multiple users are listening to the same audio source at the same time, then the 
indicator will show one color only: (1) the color associated with a display in the same 
room (2) the color associated with the display at the monitoring output that was 
enabled last in the room.

Note: If you have yet to assign the AUDIO MONITOR wall function to one of 
the RCP-200’s programmable knobs, rotate the knob you wish to program 
until AUDIO MONITOR is selected, and then press the knob. AUDIO 
MONITOR appears above the programmed knob.

Audio monitoring indicator
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Controlling the Volume at the Analog Audio Monitoring Output

Controlling the volume from the Kaleido-RCP2

To control the volume at the analog audio monitoring output, from the Kaleido-RCP2
• Adjust the audio volume for your assigned monitoring output by using the up and 

down volume buttons on the Kaleido-RCP2.
• Mute the audio by pressing the Mute button on the Kaleido-RCP2.
• Attenuate the volume by 20 dB by pressing the -20 dB button on the Kaleido-RCP2.

Controlling the volume from the RCP-200

On the RCP-200, pressing the VOL knob repeatedly alternates between the normal, mute, 
and -20 dB audio output mode.

To control the volume at the analog audio monitoring output, from the RCP-200
• Adjust the audio volume for your assigned monitoring output by rotating the VOL 

knob.
• Mute the audio by pressing the VOL knob until MUTE appears above the knob.
• Attenuate the volume by 20 dB by pressing the VOL knob until -20 dB appears above 

the knob.

Triggering Audio Monitoring by Using an Action

To trigger audio monitoring, by using an action
• Create a Monitor audio action, for the audio source you wish to monitor. This action can 

be assigned to a monitor on the monitor wall, or it can be a background action. 
See Creating Actions on page 323 for details.

Setting a Display Monitor’s Output Resolution

With a Kaleido-IP, Kaleido-X, or Kaleido-X16, you can set a display’s output resolution from 
the monitor wall. This is useful if you don’t have access to another computer. If there is no 
output on a display, you can reset the output resolution to 1280 × 1024 @ 60 Hz, by using a 
keyboard shortcut: hold down the Ctrl and Alt keys, and then press R.

• In the case of a Kaleido-X, connect the keyboard to a USB port on the output card 
associated with the display. If two displays are connected to this output card, then the 

Note: All audio and video monitors are configured by default, with a 
Monitor audio action triggered by a single click.

Note: This section does not apply to the KMV-3901/3911, Kaleido-XQUAD, 
Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X, which do not support 
setting a display output resolution from the monitor wall. For these 
multiviewers, you can set your displays’ output resolution by using XEdit, the 
Densité controller’s local control panel (or a control panel in iControl, if 
available). See Configuring Displays on page 219, or refer to the Quick Start 
Guide for your multiviewer, for details.
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resolution is applied to both. Alternatively, use a keyboard connected to the Kaleido-
RCP2.

• In the case of a Kaleido-X16, connect the keyboard to one of the USB ports on the 
multiviewer. If two displays are connected to the multiviewer, then the resolution is 
applied to both. Alternatively, use a keyboard connected to the Kaleido-RCP2 (if 
available).

Specifying a Display Output Resolution from the Monitor Wall

To set your display output resolution from the Monitor Wall
1 Right click the monitor wall background, and then click Display Resolution on the 

menu.

2 Choose a value from the Default DVI resolution list.

3 Click OK.

Enabling EDID Auto-Detection from the Monitor Wall

Note: If the keyboard is connected to a Kaleido-RCP2, the Keyboard 
attribute for the current RCP user must have been set to “US” in XEdit, 
otherwise the shortcut may not work (i.e., it could be parsed and converted 
to a special character, depending on the selected locale). In the case of a 
Kaleido-X, the shortcut will reset the resolution on the active display (the 
one where the mouse pointer is located) and on the other display connected 
to the same output card, if any.

Notes 

• The Kaleido-IP multiviewers do not yet support automatic output 
resolution detection.
66



Kaleido-X
User’s Manual
To enable EDID auto-detect for a display
1 Right-click the monitor wall background, and then click Display Resolution on the 

menu.

2 Select the Use detected monitor resolution check box.

3 Click OK.

Changing the IP Address of a Multiviewer from the Monitor Wall

With a Kaleido-X, or Kaleido-X16, you can set the IP address, system name, and other 
parameters via a control panel on the monitor wall.

• The monitor EDID auto-detection feature is enabled by default in order to 
facilitate the initial setup of a Kaleido-X system. Setting an output head to 
a specific resolution, from a multiviewer service panel in iControl (if 
available), from the monitor wall (Kaleido-IP, Kaleido-X, Kaleido-X16), or 
from a Densité controller’s local control panel (Kaleido-MX, Kaleido-MX 4K, 
Kaleido-Modular-X, KMV-3901/3911, Kaleido-XQUAD) disables the EDID 
auto-detection for this head.

Notes (continued)

Notes 

This section does not apply to the KMV-3901/3911, Kaleido-XQUAD, 
Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X. For these multiviewers, 
you can configure the network settings by using XAdmin, the Densité 
controller’s local control panel (or a control panel in iControl, if available). 
See Configuring a Multiviewer’s IP Settings on page 478, or refer to the Quick 
Start Guide for your multiviewer, for details.

In the case of a Kaleido-IP, changing the multiviewer’s network settings from 
the monitor wall is not yet supported.
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To change the IP address of the multiviewer from the monitor wall
1 Right-click anywhere on the monitor wall, point to Monitor wall, and then click System 

configuration.

The System Configuration window appears.
2 Click the Ethernet tab.
3 Type the required Frame IP address, network mask, and gateway address in the 

appropriate boxes.
4 Type the required addresses for all outputs.
5 Click OK.
6 When prompted to restart the system to apply your changes, click Yes.

The new configuration will become effective once the system restart has completed.
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This section explains what constitutes a Kaleido-X system, and the related workflow.

Key Concepts

Term Description

System A Kaleido-X system represents a grouping of equipment, including one or 
more multiviewers that have the Kaleido-X software, and a number of 
peripheral devices such as routers, production switchers, UMD 
controllers, or automation systems. In XEdit, you work against one 
system at a time. Each system is stored as a separate database.

Kaleido-X The Kaleido-X multiviewer is a multi-room, multi-image processor and 
router in a single, expandable frame. The compact Kaleido-X (4RU) 
multiviewer supports 32 inputs and 4 multi-image outputs. The 
Kaleido-X (7RU) multiviewer can display 96 inputs over up to 8 displays 
of any resolution and orientation. The Kaleido-X (7RU) built-in routing 
capability offers switching of 96 unprocessed inputs to 48 HD/SD 
outputs for feeding monitors, test equipment, master control or 
production switchers, ISO recorders, or other multi-image processors.

Expansion system By using a mid-plane expansion module, two Kaleido-X (7RU) frames can 
be connected to display up to 192 video inputs over up to 12 displays. In 
XEdit, an expansion system is identified as Kaleido-X (14RU).

KMX-4911 The KMX-4911 multiviewer modules are part of the GV Node IP 
aggregation, processing, and edge routing platform, designed for live 
broadcast production. Each KMX-4911 card can display up to nine 
SMPTE ST 2022-6, 3Gbps, HD, or SD inputs in up to nine video windows 
across one or two high-resolution outputs. Combine up to four KMX-
4911 cards, to configure a dual- or quad-output system supporting up to 
36 inputs. In XEdit, system presets are currently available for KMX-
4911 9 × 2, and KMX-4911 18 × 4.

Kaleido-MX The Kaleido-MX standalone multiviewer system is ideal for production 
control rooms, trucks and outside broadcast operations. Available in two 
form factors (1 RU, and 3 RU), the Kaleido-MX supports up to 64 video 
inputs, and up to four multiviewer outputs. In XEdit and XAdmin, a 
Kaleido-MX system is identified as KMX-3901.

Kaleido-MX 4K Available in two form factors (1 RU, and 3 RU), and four configurations, 
the Kaleido-MX 4K ultra high-definition multiviewer can monitor up to 
64 video inputs, on a 4K UHD display, without visible quadrants. In XEdit 
and XAdmin, a Kaleido-MX 4K system is identified as KMX-3901.
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Kaleido-Modular-X The Kaleido-Modular-X is a flexible and scalable 4K- and IP-ready 
multiviewer for TV production optimized for the space, power and 
weight considerations found in studios and outside broadcast trucks. 
FlexBridge coax cable bridging between the input and output modules 
allows for the installation of the input stage next to the router or sources, 
and the output stage next to displays, for simpler, cost-effective cabling 
with none of the risk associated with HDMI extenders. The 
Kaleido-Modular-X supports up to 64 video inputs, and up to four 
multiviewer outputs. In XEdit and XAdmin, a Kaleido-Modular-X system 
is identified as KMX-3901.

Kaleido-X16 The Kaleido-X16 is a compact, ultra-quiet multiviewer in a 1RU frame, 
with 16 inputs and two outputs. It provides a subset of the features of 
the Kaleido-X 4RU and 7RU models. There are two types of Kaleido-X16: 
Kaleido-X16-S (single head) and Kaleido-X16-D (dual head).

KMV-3901/3911 The KMV-3901, the first member of the Kaleido-Modular series, is a 
multiviewer on a single Densité card, with eight inputs and two outputs. 
Designed to address production-type applications, it supports a subset 
of the features offered by the other Kaleido multiviewer models:
• Processing: Video scaling, Video cropping, 3Gbps (level A only) 

support, KXI-DVI-Bridge support.
• Probing: Display of audio levels (up to 16 audio signals per head), time 

codes (based on URS signal from a REF-1801 Densité card, or on 
embedded reference signal), video format and audio format.

• GPIO interface: Support for 8 GPI inputs and 2 GPI outputs.
In addition to the features listed above, the KMV-3911 multiviewer 
supports up to two SDI monitoring outputs. In XEdit, all KMV-3901/3911 
models, with any number of inputs and outputs are identified as 
KMV-3911. In XAdmin they are identified as KMV-3911, or KMV-3901, 
depending on the model.

Term Description
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Kaleido-IP The Kaleido-IP can monitor and display HD and SD television programs 
distributed over IP, across two HDTV displays. It supports MPEG-2 and 
H.264/AVC compressed video, and the AAC, AC-3, DD+, MPEG-1, MPEG-
2, MPEG-4 AAC LC, and MPEG-4 HE-AAC compressed audio formats, 
within unencrypted DCII, DVB, or ATSC streams. The Kaleido-IP X310 
supports concurrent decoding of up to 64 MPEG-2 or up to 32 H.264 HD 
video programs. In the case of SD signals, they support concurrent 
decoding of up to 128 MPEG-2 or up to 64 H.264 programs. The 
Kaleido-IP X110 supports concurrent decoding of up to 16 MPEG-2 or up 
to 12 H.264 HD programs, and up to 48 MPEG-2 or up to 24 H.264 SD 
programs. The Kaleido-IP X300 supports concurrent decoding of up to 
24 MPEG-2 or up to 16 H.264 HD programs, and up to 64 MPEG-2 or up 
to 32 H.264 SD programs. The Kaleido-IP X100 supports concurrent 
decoding of up to 8 MPEG-2 or up to 6 H.264 HD programs, and up to 
24 MPEG-2 or up to 12 H.264 SD programs. In XAdmin and XEdit, a 
Kaleido-IP X100 or Kaleido-IP X300 with two network adapters is 
identified as Kaleido-IP-2. A Kaleido-IP X110, Kaleido-IP X310, or 
Kaleido-IP X300 with four network adapters is identified as Kaleido-IP-4, 
and a Kaleido-IP X310, or Kaleido-IP X300 with six network adapters is 
identified as Kaleido-IP-6.

Kaleido-XQUAD The Kaleido-XQUAD is a standalone quad-split multiviewer that is ideal 
for truck and studio monitoring. It is available in two versions: the 
Kaleido-XQUAD features four 3Gbps/HD inputs and a single multiviewer 
output (HDMI/HD-SDI), and the Kaleido-XQUAD-DUAL offers eight 
3Gbps/HD inputs and two multiviewer outputs. Both versions offer 
exceptional display flexibility and outstanding space and energy 
efficiency, using a 1RU half width frame with silent ventilation for 
installation within studios. The multiviewer can be used for small 
installations with one or two displays, and in much larger configurations 
using multiple Kaleido-XQUADs. In XEdit and XAdmin, the 
Kaleido-XQUAD and Kaleido-XQUAD-DUAL are identified as KMV-3911.

XEdit XEdit is the Kaleido-X layout editor, a software intended to be run on a 
remote computer. Its purpose is to define your Kaleido-X system 
components, including external devices, create rooms, logical sources, 
layouts, and RCP user definitions, and perform all the configurations 
required for successful operation of the multiviewer. XEdit has two 
modes of operation: you can work offline in a local workspace and then 
apply your changes by exporting them to the multiviewer, or you can 
connect to a multiviewer and work in online mode, directly on the 
system. Changes made in online mode take effect immediately on the 
monitor wall.

Term Description
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Database Layouts and related configurations for your Kaleido-X system are created 
in XEdit. All this information is stored in a database. When you work in 
offline mode, your load the appropriate database in a local workspace 
on the PC where XEdit is used. XEdit can export such a database to a 
multiviewer, or import the current layouts and configurations from a 
multiviewer into the local workspace on your PC. For changes you make 
in offline mode to take effect on the monitor wall, you must export the 
database to a multiviewer. Conversely, any configuration change you 
make in online mode must be imported from the multiviewer into your 
local workspace if you wish to be able to make further changes in offline 
mode.

Cluster A cluster refers to multiple multiviewers, configured so that they can be 
operated as a single system from a room comprising up to 48 displays 
fed by the different multiviewers’ outputs. The complete cluster system 
can include up to 128 displays. See Creating a Cluster on page 89.

Cascade A cascade refers to up to three Kaleido-X16 or up to three KMV-3901/3911 
multiviewers, configured so that they can be operated as a single system 
from a room. The cascade makes it possible to monitor up to 48 video 
inputs—in the case of a Kaleido-X16 cascade—, or up to 24 video 
inputs—in the case of a KMV-3901/3911 cascade—, on a single monitor 
wall display. Depending on your purposes, you may wish to monitor 
both baseband and IP sources at once, on the same monitor wall display. 
This can be achieved by configuring a hybrid cascade system, involving 
one Kaleido-IP multiviewer and one Kaleido-X or Kaleido-X16 multiviewer. 
Refer to the Cascade Step-by-Step Configuration guide for your 
multiviewer model, for more information.

Logical source A logical source (called a channel, in earlier versions of the software and 
documentation) refers to a group of physical audio, video, or metadata 
sources, and text attributes. A logical source can be used as a whole, and 
assigned to a virtual monitor. See Logical Sources on page 195, for 
details.

Cards Cards are added to, and removed from a Kaleido-X, Kaleido-MX, 
Kaleido-MX 4K, or Kaleido-Modular-X multiviewer (see Managing Cards 
in a Kaleido-X or KMX-3901 System Representation on page 112). There 
are different, specialized types of cards: input cards, output cards, a 
GPI/genlock card, expansion cards and internal router cards. Refer to the 
appropriate Hardware Description & Installation Manual, available from 
the Documentation Library section of Grass Valley’s website, for more 
information.

Virtual card slots The Kaleido-X16 introduced the concept of virtual card slots that 
represent a set of hardware features directly on the multiviewer’s main 
board. In XEdit, the Kaleido-X16 virtual card slots contain 
representations of GPI/genlock, input, output, and internal router cards 
that are equivalent to their physical counterparts on the Kaleido-X (4RU) 
and Kaleido-X (7RU) models. Likewise, the KMV-3901/3911 multiviewers 
have virtual card slots with representations of GPI/genlock, input, and 
output cards.

Term Description
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Detailed Directions
Creating and maintaining a Kaleido-X system involves a number of file management tasks, 
including backup and restore operations. The XEdit software is used to perform these tasks. 
Some tasks are done online, others in offline mode. Most are available in both modes.

A local database is used as a workspace to save layouts and related configuration data 
temporarily while you are building your Kaleido-X system in offline mode. If you need to 
build more than one system, you can keep working with the same database, and use the 
backup tool to save the data for each system separately. To further work on a specific 
system you would then use the restore backup tool. See Managing Multiple Databases 
Efficiently on page 119 for an overview of the recommended workflow.

Opening the XEdit Software
When using XEdit offline, you work inside a workspace located on your client PC. When you 
first open XEdit, a window will prompt you for the location for this workspace. It is 
recommended to consider this workspace as a sandbox into which you will always first 
import the database you wish to work on during the current session, and from which you 
will export the database at the end of the session.

To open XEdit
1 Double-click the XEdit icon on your desktop: .

There are, however, some differences in the Kaleido-X16 and 
KMV-3901/3911 multiviewer models are presented in XEdit, compared 
to the Kaleido-X models:
• Cards in virtual slots are always present by default, and cannot be 

removed in XEdit.
• There are no status icons next to a virtual card slot (e.g., inserted or 

empty card slot icon).

In XAdmin the virtual slot/card concept is represented as follows:
• Cards in virtual slots have no name.
• There is no reset button associated with each card. Instead, there is a 

single multiviewer reset button that sends a reboot command to the 
multiviewer.

• Cards in virtual slots have no serial number. Instead, there is one serial 
number for the multiviewer.

• Cards in virtual slots do not have individual IP addresses. There is only 
one IP address, which is associated with the multiviewer.

Calibration Calibration refers to the configuration of different card attributes. For 
example, an output card’s Brightness and Contrast attributes can be 
calibrated, or an input card’s Silence threshold attribute. See Calibrating 
the Kaleido-X on page 123, for details.

Peripheral devices A peripheral device is an external piece of equipment, such as a router or 
production switcher, that can be connected to the multiviewer.

Term Description
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A startup screen appears, followed by the Database Location window.

2 When prompted to specify the database location, click Browse.

3 From the window that opens, locate an appropriate directory for your workspace, and 
then click Open to close the Select the database location window.

Note: If you have installed multiple versions of 
XEdit, the launcher icon on your desktop opens 
the last version you installed. To open a specific 
version of XEdit, use the launcher icon on the Start 
menu (under All Programs).
74



Kaleido-X
User’s Manual
If it is not the first time you open XEdit, and you are satisfied with the location of your 
local workspace, then select the Don’t ask next time check box, to avoid being 
prompted every time you open XEdit.

4 Click OK to close the Database Location window.
XEdit’s main application window appears. This may take a few seconds.

When first opening XEdit in offline mode, the database contains the default 
configuration for a Kaleido-X (7RU) system, including a fully-populated frame (all cards 
present) and a set of predefined logical sources.
75



Managing Kaleido-X Systems
Using XEdit Online
To customize the layout of the XEdit application window
• Resize the window, and its three panes, by dragging the window’s borders, corners, and 

pane splitters.
• Move the Tips, Tools, and Properties panes between the left and right panes, and 

reorder them, by clicking their handle and dragging to the desired location.
• Close the Tips, Tools, and Properties panes by clicking their × button.
• Undock the Tips, Tools, and Properties panes from the main window, by clicking their 

square button.

To restore the default application layout
1 Dock the Tips, Tools, and Properties panes, if they are undocked, by clicking their × 

button.
2 On the View menu, point to Panes and tabs, and then click Restore default window 

settings.

To close XEdit
• On the File menu, click Exit. Alternatively, click the × button in the upper right corner of 

the main application window.

Using XEdit Online
When using XEdit in online mode, any changes made are applied and stored directly on the 
multiviewer. When using XEdit in offline mode, all changes are stored locally on your PC or 
laptop, and the database must be exported to the multiviewer for the changes to take 
effect.

When connected to a multiviewer, any change you make to your system’s configuration 
takes effect immediately on the multiviewer itself; your local database is not involved. The 
online mode is not limited to basic system configuration; changes can also be made to 
existing logical sources, rooms, layouts, RCP users, etc.

× button Handle Square button

Splitter

Note: In the case of a Kaleido-IP, you must work in online mode, at least 
once, to obtain the list of programs and elementary streams under each 
transport stream.
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Connecting to a Multiviewer

To connect to a multiviewer
1 On the Configure menu, click Connect.

The Connect to Multiviewer window appears.

IP addresses for all the multiviewers that are on the same subnet as your PC are 
automatically included in the list.

2 If your PC and the multiviewer are on the same subnet, then you can select the IP 
address of the multiviewer you wish to connect to from the list. Otherwise type the 
appropriate IP address in the box, and then click OK.

3 If access control is enabled for this multiviewer, then XEdit prompts you for a password. 
Type the password associated with the RCP user “Admin”, and then click Log on.

The selected system’s hierarchical list appears in XEdit’s main pane, showing the 
multiviewer model, system name and IP address, and the status bar shows the 
connection status.

It is also possible to verify which version of the Kaleido-X software is installed on this 
multiviewer, by moving to pointer to the system name in the System list. A tip appears, 
showing this information.

Connection status Multiviewer model System name System IP address
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In the case of a cluster system, cluster members are listed in alphabetical order based 
on the system name, which appears first, and the multiviewer you are currently 
connected to is highlighted.

Disconnecting from a Multiviewer

To disconnect from a multiviewer
• On the Configure menu, click Disconnect.

XEdit switches to its local workspace, and displays the OFFLINE status on the status bar.

Enabling Access Control in XEdit
XEdit supports a simple authentication mechanism to prevent unauthorized users from 
connecting or exporting to a multiviewer. When access control is enabled, the password 
associated with the RCP user Admin (see Changing an RCP User’s Name or Password on 
page 343) is enforced.

Notes 

• When using XEdit in online mode, some database functions, such as 
Export, Import, and Restore backup, are not available. Any changes made 
by the user are not kept locally on the user’s PC, but applied directly on the 
multiviewer. To retrieve the data set from the multiviewer, either 
disconnect from the multiviewer, and then use the Import function, or use 
the Create backup function to save a copy of the database. A database can 
be restored from a backup repository to your local workspace later. 
See Managing Multiple Databases Efficiently on page 119 for a description 
of the recommended workflow.

• It is not recommended to have two or more users simultaneously 
connected online to the same multiviewer system for editing.

Bold text indicates the
cluster member to which
XEdit is currently connected.

Connection status MultiviewerSystem name System IP address
model
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To enable access control in XEdit
1 Connect to the multiviewer you wish to protect (see Connecting to a Multiviewer on 

page 77).
2 On the Configure menu, click Access control.

XEdit prompts you for a password.

3 Type the password associated with the RCP user Admin, and then click Log on.
Access control is now enabled for this multiviewer.

Disabling Access Control in XEdit

To disable access control in XEdit
1 Connect to the multiviewer you wish to unprotect (see Connecting to a Multiviewer on 

page 77).
XEdit prompts you for a password.

2 Type the password associated with the RCP user Admin, and then click Log on.
3 On the Configure menu, click Access control.

Access control is now disabled for this multiviewer.
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Importing a Database
To import a database

1 On the Configure menu, point to Database, and then click Import.
A window appears, prompting you for the IP address of the multiviewer whose 
database you wish to import.

IP addresses for all the multiviewers that are on the same subnet as your PC are 
included in the list.

• If your PC and the multiviewer are on the same subnet, then you can select the IP 
address of the multiviewer from the list.

• Otherwise type the appropriate IP address in the box.
2 Click OK.

A window appears, prompting you to confirm that you really want to import data from 
the multiviewer.

3 Click Yes.
A progress window appears, followed by a message stating whether the import 
succeeded or not.

4 Click OK.
The imported data has replaced the former content in your local workspace. The 
originating system’s multiviewer model and IP address now appear in the System list.

Multiviewer model IP address
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In the case of a cluster system, the System list shows cluster members in alphabetical 
order based on their system name, which appears first and is followed by the 
multiviewer model and IP address.

Exporting a Database

Exporting a Single-Multiviewer Database

To export a single-multiviewer database
1 On the Configure menu, point to Database, and then click Export.

The Export to Multiviewer window appears, prompting you for the IP address of the 
multiviewer to which you wish to transfer the database.

IP addresses for all the multiviewers that are on the same subnet as your PC are 
included in the list.

2 If your PC and the multiviewer are on the same subnet, then you can select the IP 
address of the multiviewer from the list. Otherwise type the appropriate IP address in 
the box.

3 Click OK.
A window appears, prompting you to confirm that you really want to export data to the 
multiviewer.

Bold text indicates the
cluster member to which
XEdit is currently connected.

Connection status MultiviewerSystem name System IP address
model
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4 Click Yes.
5 If access control is enabled for this multiviewer, then XEdit prompts you for a password. 

Type the password associated with the RCP user “Admin”, and then click Log on.

A progress window appears, followed by a message stating whether the export 
succeeded or not.

6 Click OK.
All data on the remote system is now replaced with content from the local workspace.

Exporting a Cluster Database

To export a cluster database
1 On the Configure menu, point to Database, and then click Export.

The Export Cluster window appears, prompting you to confirm the set of multiviewers 
to which you wish to apply the database.

If you were working in offline mode, against a database imported from your existing 
cluster system, and all cluster members are currently available, then click OK to 
proceed.
On the other hand, if a cluster member happens to be unavailable, or if you are cloning 
a cluster configuration to a different set of multiviewers, you may need to remove 
members from the selection and change IP addresses.
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a To change an IP address, double-click an IP address, and then type the IP address of 
the actual multiviewer that is to receive this database.

b To remove a cluster member that is currently not available from the selection, clear 
the corresponding check box.
Similarly, you may remove members if your target cluster does not have as many, or 
if you wish to update members that were previously unavailable with the same 
database you already exported to other cluster members.

c Once the selected IP addresses match the actual multiviewers that are to receive 
the database, click OK. 
In the case of a partial export, a warning appears prompting you to confirm you 
intention; click OK to proceed.

A window appears, prompting you to confirm that you really want to export the 
database.

2 Click Yes.
3 If access control is enabled for a multiviewer, then XEdit prompts you for a password. 

Type the password associated with the RCP user “Admin”, and then click Log on.

A progress window appears, followed by a message stating whether the export 
succeeded or not.

4 Click OK.

IMPORTANT
Partial exports should be limited to cases where you had to replace a 
defective cluster member and need to bring its replacement into service 
without disrupting operations.
Before performing a partial export, you must verify that the cluster 
configuration has remained unchanged between your local version and the 
online version currently on the system.
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All cluster members now have the latest configuration from the local workspace.

Creating a Backup
Use the Create backup and Restore backup functions to manage copies of your system 
database. This is equivalent to the usual Save as and Open functions, and is useful not only 
for security purposes but also on sites where more than one system must be maintained.

Backing Up the Current Database

To back up the current system database
1 On the Configure menu, point to Database, then to Create backup and click All.

The Create Backup window appears.
2 In Create Backup, select the location where you wish to save a backup copy of the 

current database content, and then click Save.
The database is saved as a ZIP file.

Backing Up Resolutions

To back up resolutions from the current system
1 On the Configure menu, point to Database, then to Create backup and click 

Resolutions.
The Create Backup window appears.

2 In Create Backup, select the location where you wish to save a backup copy of the 
resolutions from the current database, and then click Save.
The resolutions are saved as an XEdit collection file, with a .xcol extension.

Backing Up Audio Scales

To back up audio scales from the current system
1 On the Configure menu, point to Database, then to Create backup and click Audio 

scales.
The Create Backup window appears.

2 In Create Backup, select the location where you wish to save a backup copy of the 
audio scales from the current database, and then click Save.
The audio scales are saved as an XEdit collection file, with a .xcol extension.

Restoring a Backup

Restoring a Database from a Backup

Note: When XEdit restores a database backup, it replaces the content of the 
local workspace with data from the backup. This cannot be undone. Always 
create a backup of the current data before restoring data from a different 
source. See Managing Multiple Databases Efficiently on page 119 for an 
overview of the recommended workflow.
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To restore a backup database
1 On the Configure menu, point to Database, and then click Restore backup.

The Select Backup window appears.
2 In Select Backup, navigate to the appropriate backup file (a ZIP archive, in the case of a 

full database backup), select it, and then click Open.
A message appears prompting you to confirm your intention.

3 Click Yes.
4 Click OK to dismiss the message that appears once the operation has completed.

The former content of the local workspace is entirely replaced with data from the 
backup.

Restoring Resolutions or Audio Scales from a Backup

To restore resolutions or audio scales from a backup
1 On the Configure menu, point to Database, and then click Restore backup.

The Select Backup window appears.
2 In Select Backup, navigate to the appropriate backup file (an XEdit collection file, with 

a .xcol extension), select it, and then click Open.
The content of the local workspace is updated with data from the backup.

Creating a Single Multiviewer System
When first opening XEdit in offline mode, the database contains the default configuration 
for a Kaleido-X (7RU) system, including a fully-populated frame (all cards present) as a 
starting point. If you have a different multiviewer model—i.e., a Kaleido-IP, KMV-3911, 
Kaleido-XQUAD, Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, a Kaleido-X16, a 
Kaleido-X (4RU) or a Kaleido-X (14RU) expansion system—, then you must replace this 
initial configuration with one that matches your actual system.

Note: XEdit will not prompt for confirmation.

Notes 

• In XEdit, KMV-3901/3911, Kaleido-XQUAD, and Kaleido-XQUAD-DUAL 
systems are identified as KMV-3911.

• Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X systems are identified 
as KMX-3901.

• KMX-4911 9 × 2, and KMX-4911 9 × 1are identified as KMX-4911-9x2.

• KMX-4911 18 × 4, KMX-4911 18 × 2, and KMX-4911 18 × 1are identified as 
KMX-4911-18x4.
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To create a system with a single multiviewer
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
The main pane displays the System hierarchical list, and the Tools pane displays the 
equipment library when the root of the System list is selected.

3 Right-click the current multiviewer in the System list, and then select the appropriate 
multiviewer model—Kaleido-X16-S, Kaleido-X16-D, Kaleido-X (4RU), Kaleido-X (7RU), 
Kaleido-X (14RU), KMV-3911, KMX-3901, KMX-4911 9 × 2, KMX-4911 18 × 4, 
Kaleido-IP-2, Kaleido-IP-4, or Kaleido-IP-6—, from the “replace with...” options on the 
menu.

• For the purpose of creating a system, an expansion system—
Kaleido-X (14RU)—is considered as a single multiviewer.

• For instructions on creating a cluster system, see Creating a Cluster, on 
page 89.

• For instructions on creating a cascade system, refer to the appropriate 
Cascade Step-by-Step Configuration guide, available from the 
Documentation Library section of Grass Valley’s website.

Notes (continued)
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A message appears, prompting you to confirm your intention.

Notes 

If you are working in online mode, the set of multiviewer models available 
from the menu varies according to the current model. If the current model is 
a Kaleido-IP, then only the other Kaleido-IP models are available for 
selection.

Conversely, if the current model is not a Kaleido-IP, then none of the 
Kaleido-IP models are available for selection.

Select... To represent...

Kaleido-X16-S A Kaleido-X16 (single output) frame

Kaleido-X16-D A Kaleido-X16 (dual output) frame

Kaleido-X (4RU) A Kaleido-X (4RU) frame

Kaleido-X (7RU) A Kaleido-X (7RU) frame

Kaleido-X (14RU) Two Kaleido-X (7RU) frames, with expansion cards

KMV-3911 Any KMV-3901/3911, Kaleido-XQUAD, or Kaleido-XQUAD-DUAL 
system

KMX-3901 Any Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X system

KMX-4911-9x2 A KMX-4911 9 × 2, or KMX-4911 9 × 1 system

KMX-4911-18x4 A KMX-4911 18 × 4, KMX-4911 18 × 2, or KMX-4911 18 × 1 system

Kaleido-IP-2 A Kaleido-IP X300, or X100 frame with two network adapters

Kaleido-IP-4 A Kaleido-IP X110, X310, or X300 frame with four network 
adapters

Kaleido-IP-6 A Kaleido-IP X310, or X300 frame with six network adapters
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4 Click Yes.
The next message prompts you about populating the database with a factory-default 
configuration for the selected multiviewer model.

5 Click Yes to have the system populated with factory defaults for the selected 
multiviewer model. See Restoring Factory Defaults on page 115.
Alternatively, click No, if this system is based on an existing multiviewer system whose 
room and layout configurations you wish to reuse. (For instance, you could be 
converting two 7RU multiviewers to an expansion system. Refer to the “Kaleido-X (7RU) 
Expansion” chapter in the Kaleido-X (7RU) Hardware Description & Installation Manual for 
more information.)

6 Select the relevant peripheral devices in the equipment library and drag them onto the 
root of the System hierarchical list in the main window. Alternatively, right-click the list 
root, and then select the appropriate peripheral device from the “insert...” options on 
the menu.
All peripheral devices added to the system appear in the System list.

7 If you are going to control the multiviewer, from a device using one of the supported 
TCP/IP router protocols (SW-P-02, SW-P-08, Network Modular, or NVISION Ethernet 
protocol - Compact router), then configure the router level to be controlled: click the 
multiviewer in the System list, and then, in the Properties pane, specify the logical 
router and level you wish to control, by selecting the appropriate values in the Router 
and Router level lists under TCP/IP Router control.

8 On the File menu, click Save. Alternatively, click the Save button on the toolbar.
Changes to the system are saved.

IMPORTANT
Databases created for different multiviewer models are not fully compatible 
with each other. It is important to select the proper model at this stage.

Notes 

• As of version 5.00 of the Kaleido-X software, the router selected by default 
for TCP/IP control is the KX Router logical router

• To control the KX Router logical router from an external device or 
application, this device or application must support the NVISION Ethernet 
protocol - Compact router protocol (see Built-in Communications Protocols 
on page 355, for more information).
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Creating a Cluster
As of version 6.50 of the Kaleido-X software, clusters can be created and configured in 
offline mode, in addition to the previously supported online mode. Creating a cluster 
involves the following steps:

1 add multiviewers to your system
2 configure new rooms that include displays fed by the different multiviewers
3 create layouts for the new rooms
4 replicate RCP users from one multiviewer to all other systems that are part of the cluster
5 replicate custom display resolutions from one multiviewer to all others
6 make a backup of your cluster configuration

Adding Multiviewers to a Cluster

IMPORTANT
It is important to follow the indicated sequence: first add the cluster 
members, then create new rooms, and only then create the layouts. 
Although first copying the same single-multiviewer database to the 
multiviewers you wish to join in a cluster may look like an option, this is not 
supported.

Notes 

• Any multiviewer you wish to add to a cluster must have the Kaleido-X 
software version 4.00 or later, and all members of a cluster must have the 
same Kaleido-X software version.

• Each multiviewer you wish to add to a cluster must have a unique name.

• If you change the system name or IP address of a cluster member while 
another cluster member is offline or otherwise unavailable, the cluster’s 
integrity will be broken. If you attempt to make such a change, XAdmin will 
alert you of the situation, prompting you to cancel the operation and try 
again later, when all cluster members are available. If you choose to force 
the change, then you will need to repair the cluster (see Repairing a Cluster 
System on page 94).

• Changing the system name or IP address of a KMV-3901/3911 multiviewer 
associated with a cluster, by using the card’s control panel on the Densité 
housing frame, or by using the KMV-3901/3911 control panel in iControl, is 
not supported. If this happens, then you will need to repair the cluster 
(see Repairing a Cluster System on page 94).

• A multiviewer can only be part of one cluster system at any time. XEdit will 
not let you add a multiviewer that is already included in a different cluster 
system.

• In XEdit, KMV-3901/3911, Kaleido-XQUAD, and Kaleido-XQUAD-DUAL 
systems are identified as KMV-3911.

• Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X systems are identified 
as KMX-3901.

• KMX-4911 9 × 2, and KMX-4911 9 × 1are identified as KMX-4911-9x2.
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Creating a cluster in online mode

To create a system with multiple multiviewers in online mode
1 Open XEdit, and then click Connect on the Configure menu, to access one of the 

multiviewers you wish to be part of the cluster system. See Connecting to a Multiviewer 
on page 77.
You are now ready to add more multiviewers to the system.

2 In the equipment library, select any multiviewer model, and then drag it onto the root 
of the System hierarchical list.

The Add Multiviewer to Cluster window appears.

IP addresses for all the multiviewer systems that are on the same subnet as your PC are 
included in the list.

3 If your PC and the multiviewer you wish to add are on the same subnet, then you can 
select the multiviewer’s IP address from the list. Otherwise enter the appropriate IP 
address in the box.
The multiviewer is added to the System list.

4 Repeat from step 2 until you have added all the required devices to the cluster.
5 If further system configuration is required on the individual members of the cluster, 

start with the current system (i.e., the one you are connected to). See Configuring the 

• KMX-4911 18 × 4, KMX-4911 18 × 2, and KMX-4911 18 × 1are identified as 
KMX-4911-18x4.

Note: The appropriate multiviewer model is automatically selected, based 
on the actual target system.

Notes (continued)
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System Representation on page 94, for detailed instructions on adding cards to a 
Kaleido-X (4RU, 7RU, or 14RU), or on adding streams to a Kaleido-IP configuration. Refer 
to Routers & Kaleido-X, on page 345, and Tally Interface Devices &Timer Systems, on 
page 395, for instructions on adding other routing and control devices.

6 Once you have completed the current system’s specific configuration, save it, and then 
connect to the next cluster member you need to configure: right-click the appropriate 
multiviewer node and then click Connect to this system.

Once the connection is established, the selected system becomes highlighted in the 
System list, and the message “Connected to...” appears in the status bar.

7 Repeat from step 5 until all cluster members are configured.

Creating a cluster in offline mode

To create a system with multiple multiviewers in offline mode
1 Open XEdit, and load the database for one of the multiviewers you wish to be part of 

the cluster system, if it is not already in your local workspace (see Restoring a Database 
from a Backup on page 84, or Importing a Database, on page 80).
You are now ready to add more multiviewers to the system.

2 In the equipment library, select the appropriate multiviewer model—Kaleido-X16-S, 
Kaleido-X16-D, Kaleido-X (4RU), Kaleido-X (7RU), Kaleido-X (14RU), KMV-3911, 

Note: Each member of a cluster has its own database where both common 
information about the cluster and information local to the individual cluster 
member are stored. Room and layout definitions are automatically 
replicated to all cluster members, whereas the logical sources and the 
configuration of devices connected to a specific cluster member are only 
stored in this member’s database.

Note: In the hierarchical list for a cluster, an unavailable system is indicated 
by a dimmed icon and cannot be expanded. It can take up to 15 seconds 
before a multiviewer’s status icon is updated in the System list.
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KMX-3901, KMX-4911 9 × 2, KMX-4911 18 × 4, Kaleido-IP-2, Kaleido-IP-4,or 
Kaleido-IP-6—, and drag it onto the root of the System hierarchical list.
Alternatively, right-click the list root, and then click the appropriate multiviewer model 
on the “insert...” menu.

A multiviewer of the selected model is added to the System list.

3 On the File menu, click Save.
A progress window appears while XEdit applies default settings to your new cluster 
configuration.

4 Repeat from step 2 until you have added all the required devices to the cluster.

5 If further system configuration is required on the individual members of the cluster, 
start with the current system (i.e., the one that is highlighted). See Configuring the 
System Representation on page 94, for detailed instructions on adding cards to a 
Kaleido-X (4RU, 7RU, or 14RU), or on adding streams to a Kaleido-IP configuration. Refer 
to Routers & Kaleido-X, on page 345, and Tally Interface Devices &Timer Systems, on 
page 395, for instructions on adding other routing and control devices.
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6 Once you have completed the current system’s specific configuration, save it, and then 
switch to the next cluster member you need to configure: right-click the appropriate 
multiviewer node and then click Switch to this system.

The selected cluster member becomes highlighted in the System list.

7 Repeat from step 5 until all cluster members are configured.
8 On the File menu, click Save.

Eventually, you will want to export this cluster configuration to the appropriate set of 
multiviewers. See Exporting a Cluster Database on page 82 for details.

Creating Rooms for a Cluster System
Create rooms for the cluster system, by adding displays associated with the different 
multiviewers as appropriate. See Setting Up Rooms on page 211, for details.

Creating Layouts for a Cluster System
It is possible to create a partial layout for a cluster system in offline mode, and then export it 
to the appropriate multiviewer for further online configuration. When configuring a layout 
for a room that is associated with a cluster system, you only work on one part at a time: the 
part that is associated with the current multiviewer’s output heads. See Creating Layouts on 
page 233 for detailed instructions.

Note: Each member of a cluster has its own database where both common 
information about the cluster and information local to the individual cluster 
member are stored. Room and layout definitions are automatically 
replicated to all cluster members, whereas the logical sources and the 
configuration of devices connected to a specific cluster member are only 
stored in this system’s database.

Notes 

• Each room must have a unique name across the cluster system. XEdit will 
not let you use a name if there is already a room with this name associated 
with one of the multiviewers within the cluster.

• All multiviewers associated with the cluster system must be available. If 
one of the member multiviewers becomes unavailable while you were 
configuring a room for the cluster system, then XEdit will not let you save 
the room. If you wish to save the room anyway, first remove any 
unavailable system from the cluster.
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Replicating RCP Users Across a Cluster System
Currently, RCP Users are not automatically propagated to all multiviewers. Before a user can 
log on to a room associated with a cluster system, the corresponding RCP user 
configuration must be manually replicated on all member multiviewers across the cluster.

Repairing a Cluster System

To repair the cluster configuration
1 In XEdit, connect to System B, the multiviewer that was unavailable when the change 

was made, once it is available again.
2 In the Description/Calibrations tab, remove System A from the cluster, and then add it 

back to the cluster.
3 If other cluster members were unavailable when the change was made (e.g., if System A 

is a KMV-3901/3911 whose name or IP address was changed from the Densité frame’s 
control panel, or from the KMV-3901/3911 control panel in iControl, then repeat the 
previous steps for each.
If only the IP address was changed then no further action is required. Otherwise, if the 
system name was changed, then proceed as follows.

4 Connect to System A.
5 Change something in every room (e.g., move a display and then bring it back to its 

initial position) to enable the Save button.
6 Save the room.

This will replicate the proper room configuration to the other members of the cluster. 
(At the same time, the layouts will also be updated on all multiviewers in the cluster.)

Configuring the System Representation
• The Kaleido-IP has two, four, or six network adapters, depending on the model, and 

two multiviewer outputs. Configuring your Kaleido-IP’s system representation in XEdit 
includes adding or removing transport streams until the representation matches the 
set of transport streams you wish to monitor. See Managing Transport Streams in a 
Kaleido-IP System Representation on page 95, for details.

• In the case of a Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, Kaleido-X (4RU), 
Kaleido-X (7RU), or Kaleido-X (14RU) expansion system, configuring your system’s 

Note: Each layout must have a unique name across the cluster system. 
XEdit will not let you export a layout to a cluster system if there is already a 
layout with this name associated with one of the multiviewers within the 
cluster. As a workaround, you could make a copy of one of the conflicting 
layouts under a different name, and then delete the original before 
proceeding with the export (see Copying layouts, on page 251, Deleting 
Layouts, on page 249).

Note: In the procedure below, System A refers to the system whose name or 
IP address was changed while another cluster member, referred to as System 
B, was unavailable.
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representation in XEdit includes adding or removing cards until the representation 
matches the hardware configuration of your actual multiviewer. In XEdit, Kaleido-MX, 
Kaleido-MX 4K, and Kaleido-Modular-X systems are identified as KMX-3901. 
See Managing Cards in a Kaleido-X or KMX-3901 System Representation on page 112, 
for details.

• This section does not apply to the KMX-4911, Kaleido-X16, Kaleido-XQUAD, and 
KMV-3901/3911, which have a set number of card slots. In the case of the Kaleido-X16, 
Kaleido-XQUAD, and KMV-3901/3911, these slots are virtual card slots that represent 
hardware features integrated within their main board. In XEdit, the virtual card slots are, 
for the most part, equivalent to their physical counterparts on the Kaleido-X models 
(see page 72).

Managing Transport Streams in a Kaleido-IP System Representation
Although it is possible to partly configure your Kaleido-IP system by using XEdit in offline 
mode, you must work in online mode, at least once, to obtain the list of programs and 
elementary streams under each transport stream (see Using XEdit Online on page 76). The 
supported stream types are any-source multicast, source-specific multicast, source-filtered 
multicast (filtering limited to a single source IP in include mode only), unicast, RTSP, and 
HTTP Live Streaming (HLS).

If you need to monitor a large number of programs, you may find it convenient to import 
related configuration information, from a spreadsheet in XLS or XLSX format. At the same 
time, the logical sources associated with the programs specified in the spreadsheet will be 
automatically added to the sources table. A sample spreadsheet is available from the 
Documentation Library section of Grass Valley’s website.

• To prepare your spreadsheet, see Preparing a spreadsheet with stream lineup 
information on page 98.

• Once you have prepared your spreadsheet, see Importing a stream lineup on page 96.
• To add ASM transport streams, manually, see Adding any-source multicast transport 

streams on page 100.
• To add SSM or SFM transport streams, manually, see Adding source-specific or source-

filtered multicast transport streams on page 102.
• To add unicast transport streams, manually, see Adding unicast transport streams on 

page 105.
• To add HTTP Live Streaming (HLS) playlists, see Adding HLS playlists on page 107.
• To add RTSP streams, see Adding RTSP transport streams on page 108.
• To modify stream information, see Modifying transport streams and HLS playlists on 

page 109.
• To remove streams from your system configuration, see Removing transport streams 

and HLS playlists on page 111.
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Importing a stream lineup

To import a set of streams from a spreadsheet file
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 On the File menu, click Import.

XEdit prompts you for confirmation.

3 Click OK to dismiss the warning, if you are confident that you have all the information 
to recover your system configuration if needed.

4 Navigate to the spreadsheet file you wish to import, select it, and then click Open.
XEdit validates the following: IP address range, network adapter number, protocol, 
consistency of stream name vs. stream information (group and source IP addresses + 
port), duplicate stream names, duplicate logical source information (category + name), 
duplicate logical source index, and will report any error. If no errors were found, then 
the following message appears.

5 Click OK to dismiss the message.
The streams appear under the specified network adapters.

WARNING
Grass Valley recommends making a backup of your system before importing 
stream configuration information from a spreadsheet. When you import 
streams from a spreadsheet, this erases all previously imported streams and 
associated logical sources. It may also overwrite streams that you had 
manually added (and logical sources) if they have the same name or index as 
a stream whose configuration is being imported.
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Example showing streams imported from the sample spreadsheet file.

After a few minutes, if XEdit is connected to the multiviewer, all programs included in 
the transport streams are discovered.

In addition, logical sources for the programs listed in the spreadsheet you imported are 
automatically added to the sources table. If XEdit is not connected to the multiviewer, 
then the new sources’ video levels appear in red in the sources table. In such case, the 
sources table will be updated when you work in online mode once you have exported 
the database to the multiviewer.

Should you wish to add audio, dynamic text, alarm and time code levels to these logical 
sources, you may complete all desired physical assignments for one logical source, 
which you can then designate as the template. By applying the template, you will be 
able to populate the remaining levels in a single operation. See Defining Physical 
Assignments on page 203, for more information.

Note: The set of discovered programs does not necessarily match the 
programs listed in the spreadsheet. The discovery being a dynamic process, 
it may find more (or less) programs.

Imported streams

Logical sources created
from imported programs
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Preparing a spreadsheet with stream lineup information

The spreadsheet file must contain the following:
• information about the programs you wish to monitor, and the transport streams to 

which they belong,
• information about the logical sources that will be added to the sources table for these 

programs, including any static text levels you may wish to add.

The spreadsheet is organized as follows:
• Two heading rows. The first heading row divides the spreadsheet into four main areas:

• Programs. This area occupies the first column (A).
• Transport streams. This area spans columns B – G.
• Logical sources. This area spans columns H – J.
• Additional static text levels (optional). This area starts at column K, and can extend 

to as many columns as you need. Text you enter on the second heading row in this 
area will be imported.

• One row for every program you wish to monitor.

To prepare the spreadsheet file
1 Using your spreadsheet software, either open a copy of the sample spreadsheet file or 

create a new spreadsheet.
2 Enter the information about a program, and the transport stream to which it belongs:

Notes 

• Kaleido-IP X310 and Kaleido-IP X110 multiviewers support 6000 logical 
sources.

• In the case of the Kaleido-IP X300, to support more than 1500 sources, the 
multiviewer’s RAM must be upgraded to 24 GB. Refer to the “Kaleido-IP 
X300 Memory Modules” section, in the Kaleido-X Release Notes, for 
installation instructions.

• The Kaleido-IP X100 is limited to 1500 sources.

• RTSP, HTTP or HTTPS streams cannot be imported from a spreadsheet.

In this column... Enter this information...

A Program number The program number (MPEG ID), for the program you wish to 
monitor.

B Stream name A name to identify the transport stream that includes this 
program. Alternatively, you can leave this cell blank, in which 
case a default name will be created. Stream names that only 
contain digits and have decimal positions that are all zeros must be 
preceded with an apostrophe in the spreadsheet.

C Multicast group 
IP address

The multicast group IP address. In the case of a unicast stream, 
leave the cell blank.

D Port number The appropriate port number.
98



Kaleido-X
User’s Manual
Sample spreadsheet: Programs, and Transport streams areas

3 Enter the information that will be used to create the logical source associated with this 
program:

E SSM/SFM source 
IP address

In the case of a source-specific multicast (SSM) or source-filtered 
multicast (SFM) transport stream, enter the source IP address.

F Protocol RTP, or UDP.

G NIC The network adapter identifier: LAN2 – LAN5, for a high-bitrate 
stream; LAN1, for a low-bitrate stream. The number of network 
adapters varies, depending on the Kaleido-IP model (see Kaleido-
IP on page 71).

In this column... Enter this information...

H Index If your system involves a control panel from which you control 
your multiviewer as a router, set a source number for the logical 
source associated with this program to be available through the 
KX Router logical router, by entering the appropriate number in 
this column. Source numbers must be unique.

I Category Text in this column can be used to group related logical sources 
together, when you sort the sources table in XEdit (see Sorting 
the Sources Table on page 208). The category text can have up to 
200 characters.

J Name The name of the logical source. Names are limited to 
48 characters. Logical source names that only contain digits and 
have decimal positions that are all zeros must be preceded with an 
apostrophe in the spreadsheet.

In this column... Enter this information...
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Sample spreadsheet: Logical sources area

4 Optionally, use the columns, starting at column K, to add static text levels. Enter the 
level name on the second heading row.

Sample spreadsheet: Additional static text levels area

Static text level names and data that only contain digits and have decimal positions that 
are all zeros must be preceded with an apostrophe in the spreadsheet.

5 Repeat this procedure until you have added the required information for all the 
programs you wish to monitor.

Adding any-source multicast transport streams

To add an any-source multicast (ASM) transport stream
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the appropriate network adapter 

element, for the stream you wish to add:
• NETWORK ADAPTER 2 for a high-bitrate stream;
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• alternatively, NETWORK ADAPTER 3, 4, 5, or 6, for a high-bitrate stream, in the case 
of a four-port or six-port Kaleido-IP model;

• optionally, NETWORK ADAPTER 1 for a low-bitrate stream.
The supported stream types (Multicast, Unicast, HTTP, RTSP) are listed in the Tools 
pane.

3 Drag Multicast from the Tools pane onto the network adapter.

The Multicast Stream Configuration window appears.
4 In Multicast Stream Configuration, replace the default stream name if desired, select 

the appropriate protocol (RTP, UDP), and type the multicast group address and port 
number associated with the transport stream you wish to add.

5 If the stream you wish to add is constrained to a virtual LAN, select Virtual LAN 
tagging, and then type the appropriate VLAN identifier.

Notes 

• The Kaleido-X software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.
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6 Click OK.
The Kaleido-IP establishes a connection with the selected stream. All programs that are 
part of the stream, and the elementary streams included in these programs, 
automatically appear under the transport stream element in the System list.

7 Repeat this procedure until you have added all required ASM transport streams to your 
system configuration.

8 On the File menu, click Save. Alternatively, click the Save button on the toolbar.
Changes to the system are saved.

Adding source-specific or source-filtered multicast transport streams

To add a source-specific multicast (SSM) or source-filtered multicast (SFM) transport 

Note: VLAN adapter settings must have been previously configured in 
XAdmin. See Configuring Virtual Network Adapters on a Kaleido-IP on 
page 529, for more information.

Note: Under the network adapter elements, transport streams are listed in 
alphabetical order.

Transport stream
Program 1
Elementary streams (audio)

Elementary stream (video)

Group address

Protocol
Port number (or range)

Program 2
Elementary stream (video)

Elementary streams (audio)
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stream
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the appropriate network adapter 

element, for the stream you wish to add:
• NETWORK ADAPTER 2 for a high-bitrate stream;
• alternatively, NETWORK ADAPTER 3, 4, 5, or 6, for a high-bitrate stream, in the case 

of a four-port or six-port Kaleido-IP model;
• optionally, NETWORK ADAPTER 1 for a low-bitrate stream.

The supported stream types (Multicast, Unicast, HTTP, RTSP) are listed in the Tools 
pane.

3 Drag Multicast from the Tools pane onto the network adapter.

The Multicast Stream Configuration window appears.

4 In Multicast Stream Configuration, replace the default stream name if desired, select 
the appropriate protocol (RTP, UDP), and type the multicast group address and port 
number associated with the transport stream you wish to add.

Notes 

• The Kaleido-X Software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".
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5 Select the Source specific multicast (SSM) check box, and then type the IP address 
associated with the specific source you wish to monitor in the Source IP address box.

6 If the stream you wish to add is constrained to a virtual LAN, select Virtual LAN 
tagging, and then type the appropriate VLAN identifier.

7 Click OK.
The Kaleido-IP establishes a connection with the selected SSM/SFM stream. All 
programs that are part of the selected stream, and the elementary streams included in 
these programs, automatically appear under the transport stream element in the 
System list.

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.

Note: In the case of streams that are available from the same multicast 
group address and port number, you must enter the source IP address 
associated with a stream before you can add the next one.

Note: VLAN adapter settings must have been previously configured in 
XAdmin. See Configuring Virtual Network Adapters on a Kaleido-IP on 
page 529, for more information.

Notes (continued)
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8 Repeat this procedure until you have added all required SSM/SFM transport streams to 
your system configuration.

9 On the File menu, click Save. Alternatively, click the Save button on the toolbar.
Changes to the system are saved.

Adding unicast transport streams

To add a unicast transport stream
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the appropriate network adapter 

element, for the stream you wish to add:
• NETWORK ADAPTER 2 for a high-bitrate stream;
• alternatively, NETWORK ADAPTER 3, 4, 5, or 6, for a high-bitrate stream, in the case 

of a four-port or six-port Kaleido-IP model;
• optionally, NETWORK ADAPTER 1 for a low-bitrate stream.

The supported stream types (Multicast, Unicast, HTTP, RTSP) are listed in the Tools 
pane.

3 Drag Unicast from the Tools pane onto the network adapter element.

Note: Under the network adapter elements, transport streams are listed in 
alphabetical order.

Transport stream
Program 1
Elementary streams (audio)

Elementary stream (video)

Group address

Protocol
Port number (or range)

Program 2
Elementary stream (video)

Elementary streams (audio)

Source IP address
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The Unicast Stream Configuration window appears.
4 In Unicast Stream Configuration, replace the default stream name if desired, select the 

appropriate protocol (RTP, UDP), type the port number associated with the transport 
stream you wish to add, and then click OK.

The Kaleido-IP establishes a connection with the selected stream. All programs that are 
part of the stream, and the elementary streams included in these programs, 
automatically appear under the transport stream element in the System list.

5 Repeat this procedure until you have added all required unicast transport streams to 
your system configuration.

6 On the File menu, click Save. Alternatively, click the Save button on the toolbar.
Changes to the system are saved.

Notes 

• The Kaleido-X software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.

• When adding unicast transport streams do not specify consecutive port 
numbers.

• Under the network adapter elements, transport streams are listed in 
alphabetical order.
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Adding HLS playlists

To add an HLS playlist
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click NETWORK ADAPTER 1.

The supported stream types (Multicast, Unicast, HTTP, RTSP) are listed in the Tools 
pane.

3 Drag HTTP from the Tools pane onto the network adapter element.

The HTTP Stream Configuration window appears.

4 In HTTP Stream Configuration, replace the default stream name if desired, type the 
URL of the playlist you wish to monitor, provide the appropriate authentication key if 
required, and then click OK.
The Kaleido-IP establishes a connection with the stream provider. In the System list, a 
master playlist element including all media playlists specified in the master playlist 
automatically appears under the network adapter. All programs that are part of a media 
playlist, and the elementary streams included in these programs, automatically appear 
under the media playlist element.

Note: HLS streams are handled via the multiviewer’s management port, 
based on your network’s configuration. Make sure the multiviewer’s DNS and 
proxy settings are properly configured for your network, and that NTP 
synchronization is enabled (refer to the Quick Start Guide that shipped with 
your Kaleido-IP, for more information).
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5 Repeat this procedure until you have added all required HLS playlists to your system 
configuration.

6 On the File menu, click Save. Alternatively, click the Save button on the toolbar.
Changes to the system are saved.

Adding RTSP transport streams

To add an RTSP transport stream
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the appropriate network adapter 

element, for the stream you wish to add:
• NETWORK ADAPTER 2 for a high-bitrate stream;
• alternatively, NETWORK ADAPTER 3, 4, 5, or 6, for a high-bitrate stream, in the case 

of a four-port or six-port Kaleido-IP model;
• optionally, NETWORK ADAPTER 1 for a low-bitrate stream.

The supported stream types (Multicast, Unicast, HTTP, RTSP) are listed in the Tools 
pane.

3 Drag RTSP from the Tools pane onto the network adapter element.

Notes 

• The Kaleido-X software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Both HTTP and HTTPS protocols are supported. If HTTPS is used, there 
must be a valid certificate for the connection to be established.

• Under the network adapter elements, HLS master playlists and media 
playlists are listed in alphabetical order.

Program
Elementary stream (audio)
Elementary stream (video)

Source URL

Media
Master playlist element

playlists
108



Kaleido-X
User’s Manual
The RTSP Stream Configuration window appears.

4 In RTSP Stream Configuration, replace the default stream name if desired, type the 
URL of the stream you wish to monitor, select the appropriate protocol (RTP, UDP), and 
then click OK.
The Kaleido-IP establishes a connection with the selected stream. All programs that are 
part of the stream, and the elementary streams included in these programs, 
automatically appear under the transport stream element.

5 Repeat this procedure until you have added all required RTSP transport streams to your 
system configuration.

6 On the File menu, click Save. Alternatively, click the Save button on the toolbar.
Changes to the system are saved.

Modifying transport streams and HLS playlists

To modify the settings for a transport stream or HLS playlist
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.

Notes 

• The Kaleido-X software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.

• Under the network adapter elements, transport streams are listed in 
alphabetical order.
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2 Expand the System hierarchical list, and then navigate to the transport stream or 
master playlist you wish to configure.

The settings for the selected stream or master playlist appear in the Properties pane.

Source settings (example showing settings for an any-source multicast stream)

Source settings (example showing settings for an HLS master playlist)

3 Replace the stream name if desired and then, depending on the stream type:
• Select the appropriate protocol (RTP, UDP).
• Enter the multicast group IP address (in the case of a multicast stream) and port 

number associated with the actual transport stream you wish to monitor.
• In the case of an SSM (or SFM) stream, enter the IP address associated with the 

specific source you wish to monitor in the SSM source IP address box.
• In the case of a multicast stream constrained to a virtual LAN, enter the appropriate 

VLAN identifier.
• In the case of an HLS master playlist or RTSP stream, enter the new URL.

Note: Under the network adapter elements, transport streams and HLS 
playlists are listed in alphabetical order.
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The Kaleido-IP establishes a connection with the stream provider. In the case of an HLS 
playlist, a master playlist element including all media playlists specified in the master 
playlist automatically appears under the network adapter, in the System list. All 
programs that are part of a transport stream or specified in a media playlist, and the 
elementary streams included in these programs, automatically appear under the 
transport stream or media playlist element.

Example showing programs and elementary streams for a single-source multicast stream

Removing transport streams and HLS playlists

To remove transport streams or HLS playlists from your system configuration
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then navigate to the master playlist or 

transport stream you wish to remove.
3 If you wish to remove multiple transport streams and master playlists in a single 

operation, then extend your selection by using the standard Shift+click or Ctrl+click 
keyboard shortcuts.

4 Right-click the selection, and then click Remove.

Notes 

• The Kaleido-X software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.

• For HLS playlists, both HTTP and HTTPS protocols are supported.
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5 When prompted to confirm, click Yes.
6 On the File menu, click Save.

Changes to the system are saved. If you are not planning on adding the removed 
streams back to your system, then you might now wish to remove logical sources that 
were based on them: see Removing logical sources for removed programs in a 
transport stream on page 198.

Managing Cards in a Kaleido-X or KMX-3901 System Representation

To configure a Kaleido-X or KMX-3901 system
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
The main pane displays the System hierarchical list, and the Tools pane displays the 
equipment library when the root of the System list is selected.

2 Expand the System root, and the multiviewer you wish to configure.

The card slots appear in the hierarchical list.

Note: In the case of a Kaleido-X (14RU) expansion system, then you need to 
first expand the dual frame element, under which both frames A and B are 
listed. You can then configure each of the two frames as described below.
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If you used the XEdit factory default configuration or the sample database for your 
multiviewer model (see Restoring Factory Defaults on page 115), then the appropriate 
slots may already be populated with cards.

3 Add or remove cards until the system’s card slots are populated with cards that match 
the hardware configuration of your multiviewer. See Emptying card slots, on page 113, 
and Populating card slots, on page 114, for details.

4 On the File menu, click Save.
You new system configuration is saved.

Emptying card slots

To empty card slots in a Kaleido-X or Kaleido-MX system representation
1 In the System list, right-click the populated slot you wish to empty.
2 If you wish to empty multiple slots in a single operation, extend your selection by using 

the standard Shift+click or Ctrl+click keyboard shortcuts. In this case, XEdit will prompt 
you to confirm your intention.

3 Right-click your selection and then click Remove on the menu.

Alternatively click the populated card slot, and then press Delete on your keyboard.

The slots are now empty and the card type does not appear any more next to the slot 
name.

Note: Pressing Delete to empty card slots is only supported in the case of a 
single-card selection.

Empty slots

Populated slots
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Populating card slots

To populate slots with cards in a Kaleido-X or Kaleido-MX system representation
1 In the System list, right-click the slot you wish to populate.
2 If you wish to populate multiple slots in a single operation, extend your selection to 

other slots of the same type by using the standard Shift+click or Ctrl+click keyboard 
shortcuts. In this case, XEdit will prompt you to confirm your intention.

3 Right-click your selection and then click Insert [card type] on the menu.

Alternatively drag the card from the equipment library onto the empty card slot.

The slot name is now appended with the card type. For example: INPUT D - KXI-16, or 
INPUT B - KMX-3901-IN.

Note: Dragging a card from the equipment library is only supported in the 
case of a single-card selection.

Empty slots

Populated slots
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Restoring Factory Defaults
A number of predefined rooms and layouts are available on the multiviewer itself when you 
first receive your system. However, if you start configuring a system in XEdit by using the 
default database XEdit creates for the multiviewer model you selected, you will need to 
create your own rooms and layouts. The default XEdit-created databases have a number of 
pre-populated cards and logical sources, as well as one predefined RCP user (“Admin”), but 
they do not include rooms or layouts. See Restoring the XEdit Factory Defaults for a 
Multiviewer on page 115.

Sample factory-default databases with rooms and layouts are available from the 
Documentation Library section of Grass Valley’s website. If you wish to use default rooms 
and layouts as a starting point for building your system, you can either import the factory-
default database from the multiviewer (see Restoring Factory Defaults from a Specific 
Multiviewer on page 117), or use XEdit’s Restore backup function to load the appropriate 
database from the website (see Restoring Factory Defaults from a Sample Database on 
page 118).

Restoring the XEdit Factory Defaults for a Multiviewer

To restore the XEdit factory defaults for a multiviewer model
1 Right-click the current multiviewer in the System list, and then select the appropriate 

multiviewer model—Kaleido-X16-S, Kaleido-X16-D, Kaleido-X (4RU), 
Kaleido-X (7RU), Kaleido-X (14RU), KMV-3911, KMX-3901, KMX-4911 9 × 2, KMX-4911 
18 × 4, Kaleido-IP-2, Kaleido-IP-4,or Kaleido-IP-6—, from the “replace with...” options 
on the menu.

IMPORTANT
If you already have rooms or layouts that you wish to keep, make sure to back 
up the XEdit database before restoring the factory defaults. The XEdit factory 
defaults do not include any rooms or layouts.
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A message appears, prompting you to confirm your intention.

Note: 

If you are working in online mode, the set of multiviewer models available 
from the menu varies according to the current model. If the current model is 
a Kaleido-IP, then only the other Kaleido-IP models are available for 
selection.

Conversely, if the current model is not a Kaleido-IP, then none of the 
Kaleido-IP models are available for selection.

Select... To represent...

Kaleido-X16-S A Kaleido-X16 (single output) frame

Kaleido-X16-D A Kaleido-X16 (dual output) frame

Kaleido-X (4RU) A Kaleido-X (4RU) frame

Kaleido-X (7RU) A Kaleido-X (7RU) frame

Kaleido-X (14RU) Two Kaleido-X (7RU) frames, with expansion cards

KMV-3911 Any KMV-3901/3911, Kaleido-XQUAD, or Kaleido-XQUAD-DUAL 
system

KMX-3901 Any Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X system

KMX-4911-9x2 A KMX-4911 9 × 2, or KMX-4911 9 × 1 system

KMX-4911-18x4 A KMX-4911 18 × 4, KMX-4911 18 × 2, or KMX-4911 18 × 1 system

Kaleido-IP-2 A Kaleido-IP X300, or X100 frame with two network adapters

Kaleido-IP-4 A Kaleido-IP X110, X310, or X300 frame with four network 
adapters

Kaleido-IP-6 A Kaleido-IP X310, or X300 frame with six network adapters
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2 Click Yes.
XEdit then prompts you to confirm that you want to restore the factory defaults for the 
multiviewer model you chose.

3 Click Yes.
The selected multiviewer model appears in the System hierarchical list.

4 On the File menu, click Save.

Restoring Factory Defaults from a Specific Multiviewer

To restore factory defaults from a multiviewer
1 On the Configure menu, point to Database, and then click Import.

A window appears, prompting you for the IP address of the multiviewer whose factory-
default database you wish to import.

IP addresses for all the multiviewers that are on the same subnet as your PC are 
included in the list.

2 If your PC and the multiviewer are on the same subnet, then you can select the IP 
address of the multiviewer from the list. Otherwise type the appropriate IP address in 
the box.
A window appears, prompting you to confirm that you really want to import data from 
the multiviewer.

3 Click Yes.
A progress window appears, followed by a message stating whether the import 
succeeded or not.

4 Click OK.

Note: See Importing a Database on page 80, for details.
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To restore factory defaults from a sample database
1 On the Configure menu, point to Database, and then click Restore backup.

The Restore backup window appears.
2 In Restore backup, navigate to the appropriate default database for your multiviewer 

model—for instance, Kaleido-X (7RU).zip, if you have a Kaleido-X (7RU)—, select it, 
and then click Open.
A message appears prompting you to confirm your intention.

3 Click Yes.

Factory Defaults by Multiviewer Model

Notes 

• The sample databases are also available from the Downloads section of 
Grass Valley’s website.

• See Restoring a Backup on page 84, for more information on restoring a 
database.

Model Database
Logical 
sources Rooms Layouts RCP users

Kaleido-IP-2 Kaleido-IP-2.zip 8 1 5 1 (Admin)

Kaleido-IP-4 Kaleido-IP-4.zip 8 1 5 1 (Admin)

Kaleido-IP-6 Kaleido-IP-6.zip 8 1 5 1 (Admin)

KMV-3901/3911 8 × 2, 
Kaleido-XQUAD-DUAL

Kaleido-Modular-
8X2_16_9_Displays.zip, 
Kaleido-Modular-
8X2_16_10_Displays.zip

8 1 30 1 (Admin)

KMV-3901/3911 8 × 1 Kaleido-Modular-
8X1_16_9_Display.zip

8 1 22 1 (Admin)

KMV-3911 4 × 2 Kaleido-Modular-
4X2_16_9_Displays.zip

4 1 22 1 (Admin)

KMV-3911 4 × 1, 
Kaleido-XQUAD

Kaleido-Modular-
4X1_16_9_Display.zip

4 1 22 1 (Admin)

KMX-4911 9 × 2 KMX-4911-9x2.zip 9 1 12 1 (Admin)

KMX-4911 18 × 4 KMX-4911-18x4.zip 18 1 9 1 (Admin)

Kaleido-MX 8 × 1, 
Kaleido-Modular-X 8 × 1

Kaleido-MX-8x1.zip 8 1 8 1 (Admin)

Kaleido-MX 8 × 2, 
Kaleido-Modular-X 8 × 2

Kaleido-MX-8x2.zip 8 1 9 1 (Admin)

Kaleido-MX 16 × 1, 
Kaleido-Modular-X 16 × 1

Kaleido-MX-16x1.zip 16 1 12 1 (Admin)

Kaleido-MX 16 × 2, 
Kaleido-Modular-X 16 × 2

Kaleido-MX-16x2.zip 16 1 12 1 (Admin)
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To avoid mistakes in managing databases, especially when multiple multiviewers are 
involved, it is recommended to follow the rules below:

• Back up the database for each system to a central repository, separate from the local 
workspace you use when working in XEdit offline.

• When using XEdit, limit yourself to a single workspace. When working online, the local 
workspace is not used. When working offline, first either import the database from the 
appropriate multiviewer into your XEdit workspace, or restore the latest backup for the 
system you wish to work on.

• When your work session in XEdit is complete, always create a new backup of the 
database, regardless of whether you were working online or offline.

Kaleido-MX 16 × 4, 
Kaleido-Modular-X 16 × 4

Kaleido-MX-16x4.zip 16 1 12 1 (Admin)

Kaleido-MX 24 × 1, 
Kaleido-Modular-X 24 × 1

Kaleido-MX-24x1.zip 24 1 13 1 (Admin)

Kaleido-MX 24 × 2, 
Kaleido-Modular-X 24 × 2

Kaleido-MX-24x2.zip 24 1 12 1 (Admin)

Kaleido-MX 32 × 2, 
Kaleido-Modular-X 32 × 2

Kaleido-MX-32x2.zip 32 1 12 1 (Admin)

Kaleido-MX 32 × 4, 
Kaleido-Modular-X 32 × 4

Kaleido-MX-32x4.zip 32 1 12 1 (Admin)

Kaleido-MX 48× 2, 
Kaleido-Modular-X 48 × 2

Kaleido-MX-48x2.zip 48 1 13 1 (Admin)

Kaleido-MX 48 × 4, 
Kaleido-Modular-X 48 × 4

Kaleido-MX-48x4.zip 48 1 12 1 (Admin)

Kaleido-MX 64 × 2, 
Kaleido-Modular-X 64 × 2

Kaleido-MX-64x2.zip 64 1 13 1 (Admin)

Kaleido-MX 64 × 4, 
Kaleido-Modular-X 64 × 4

Kaleido-MX-64x4.zip 64 1 12 1 (Admin)

Kaleido-MX 4K 16 × 1 Kaleido-MX-4K-16x1.zip 16 1 15 1 (Admin)

Kaleido-MX 4K 32 × 1 Kaleido-MX-4K-32x1.zip 32 1 15 1 (Admin)

Kaleido-MX 4K 48 × 1 Kaleido-MX-4K-48x1.zip 48 1 15 1 (Admin)

Kaleido-MX 4K 64 × 1 Kaleido-MX-4K-64x1.zip 64 1 15 1 (Admin)

Kaleido-X16-S Kaleido-X16-S.zip 16 1 21 1 (Admin)

Kaleido-X16-D Kaleido-X16-D.zip 16 1 21 1 (Admin)

Kaleido-X (4RU) Kaleido-X (4RU).zip 32 2 4 1 (Admin)

Kaleido-X (7RU) Kaleido-X (7RU).zip 96 4 24 1 (Admin)

Kaleido-X (14RU) Kaleido-X (14RU).zip 192 6 72 1 (Admin)

Model Database
Logical 
sources Rooms Layouts RCP users
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The next sections describe three typical situations, summarized below:

Working online

If you are connected to a multiviewer, and working online in XEdit, you are actually editing 
the database that is located inside the multiviewer’s file system. There is one database per 
multiviewer. An expansion system, comprising two Kaleido-X (7RU) frames, is also managed 
through a single database. A cluster system includes one database for each multiviewer in 
the cluster, which are backed up or restored as a single operation. When you have 
completed your changes, create a backup of the current system and store it in a secure 
location on your PC.

To back up the current Kaleido-X system
1 On the Configure menu, point to Database, to Create backup, and then click All.
2 Browse to the secure location on your PC where you store all your database backups 

(e.g., multiviewerDatabaseBackups), and type a name for the new backup, preferably 
a name that includes the multiviewer name and the date (e.g., KX_A&B_08_12_02.zip).

Working offline

When using XEdit offline, you work inside a workspace located on your client PC. You set 
the location for this workspace when you first opened XEdit. It is recommended to consider 
this workspace as a “sandbox” into which you import the database you wish to work on 
during this session, and from which you export the database at the end of the session.

See Importing a Database on page 80, for instructions on how to import the database from 
a specific multiviewer into your workspace. Once the import is completed, you can work 
locally, in your XEdit workspace. When you have completed your changes, export the 
database from the workspace, back to the multiviewer.

TIP
Once you are satisfied with the location of your local workspace, on the 
Configure menu, point to Database, and then select the Do not prompt for 
the database path check box, to avoid being prompted every time you 
open XEdit.

Online
1 Work in XEdit.
2 Back up database 

from multiviewer 
to central 
repository.

1 Import database from 
multiviewer into local 
workspace.

2 Work in XEdit.
3 Back up database from 

local workspace to 
central repository.

4 Export database from 
local workspace to 
multiviewer.

1 Restore backup from central 
repository into local workspace.

2 Work in XEdit, if needed... 
...and then back up database 
from local workspace to central 
repository.

3 Export database from local 
workspace to multiviewer.

Offline System restore from backup (offline)
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To restore a backup database, you must use XEdit in offline mode. A backup database must 
first be restored to your local workspace before it can be exported back to the appropriate 
multiviewer.

To restore a backup database
1 On the Configure menu, point to Database, and then click Restore backup.

A window appears, prompting you to locate a backup database.
2 Navigate to your central backup storage area, select the backup database you wish to 

restore, and then click Open.
A message appears prompting you to confirm your intention.

3 Click Yes.

Once the operation completes, your XEdit workspace area will contain the restored 
database. You can now work on this database in offline mode, or export it back to the 
multiviewer.
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A Kaleido-X system includes a number of cards or modules that process a variety of signal 
types. This section explains how to calibrate features related with the different signal types.

Key Concepts

Profiles

IMPORTANT 

Calibration changes are applied immediately
Unlike other elements in a multiviewer configuration, system calibrations do 
not need to be saved.
• When using XEdit in online mode, calibration changes become 

immediately effective.
• When using XEdit in offline mode, calibration changes are applied to the 

system representation in your local workspace.

Calibration changes are synchronized
When you export a database to a multiviewer, the latest calibrations prevail 
(i.e., if the database you export is from a backup that included earlier 
calibration changes, or if calibrations were changed by using XEdit in offline 
mode, then any calibrations that were also changed in the meantime on the 
multiviewer itself, by using XEdit in online mode, will remain effective after 
the export).

Profile With the current version of the Kaleido-X software, profiles are available 
for Kaleido-IP multiviewers only. A profile is a group of calibrations that 
you configure for a specific purpose, and then apply to specific 
elementary streams, or transport streams, as needed. A default audio 
profile, a default video profile, a default teletext profile, a default SCTE 35 
profile, and a default transport stream profile are available with set 
calibrations. You may add custom profiles to your system, and configure 
them as needed. See Managing Calibration Profiles on page 129.

Video profile Video profiles include video input calibrations: alarm debouncing, 
metadata holding time, and presence timeout parameters.

Audio profile Audio profiles include audio input calibrations: a zero VU reference level 
calibration, alarm threshold calibrations, alarm debouncing, and 
loudness calibrations.

Teletext profile Teletext profiles include calibrations for page selection, subtitling 
holding time, alarm debouncing, and text presence timeout parameters.
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SCTE 35 profile SCTE 35 profiles include calibrations for digital program insertion (DPI) 
signaling (e.g., splice events, DTMF break sequences, timing 
information), and a signaling timeout calibration.

Transport stream 
profile

Transport stream (TS) profiles include calibrations for TR 101 290 first- 
and second-priority fault-reporting indicators.

Brightness The green, red, and blue brightness parameters determine the black 
level of the RGB output signals shown on the corresponding display. 
See Calibrating the Brightness and Contrast on page 156. Available for 
Kaleido-X, and Kaleido-X16 only.

Contrast The green, red, and blue contrast parameters determine the white level 
of the RGB output signals shown on the corresponding display. 
See Calibrating the Brightness and Contrast on page 156. Available for 
Kaleido-X, and Kaleido-X16 only.

Color saturation The color saturation of an RGB output signal can be adjusted so that 
colors in the video windows will match the surrounding graphical 
elements on the corresponding display. See Calibrating Color Saturation 
on page 158. Available for Kaleido-X, and Kaleido-X16 only.

DVI keying mode Kaleido-X and Kaleido-X16 multiviewers have a DVI input connector for 
every output head. Using these connectors, it is possible to feed keying 
material to the multiviewer. Depending on your purposes, the content 
provided through the DVI input can be set either as a background or as a 
foreground for the layout shown on the monitor wall. See Calibrating the 
DVI Keying Mode, on page 159, and Setting up a Layout for Background 
Keying from the DVI Input, on page 255.

Audio monitoring 
delay

Each of the output heads in a Kaleido-X, or Kaleido-X16 multiviewer 
is associated with two audio output channels. The monitoring output 
is simultaneously available on one AES and two analog connections. 
For each head, output parameters can be adjusted to optimize the 
relative timing of the audio and video signals on the monitor wall 
display. The Audio monitoring delay calibration provides this 
function. See Calibrating the Audio Monitoring Delay on page 160. 
Available for Kaleido-X, and Kaleido-X16 only.

Audio monitoring 
color

Audio monitors can have an indicator that changes color depending on 
the output display where audio monitoring of the associated audio level 
is taking place. The default color is a shade of blue. See Calibrating the 
Audio Monitoring Color on page 162.
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Detail enhancer The purpose of the detail enhancer parameter is to recover sharpness 
that may have been lost in the de-interlacing and scaling process. 
See Calibrating Detail Enhancement and Dynamic Range on page 148.
Available for Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, Kaleido-X, 
and Kaleido-X16 only. Kaleido-MX and Kaleido-Modular-X configured for 
4K UHD output, and Kaleido-MX 4K do not support detail enhancement 
for video windows spanned across multiple heads (see 4K UHD Spanning 
on page 239).

Dynamic range The dynamic range parameter determines the color model to be 
applied: either full-range RGB (0-255) or video RGB (16-235). Full-range 
RGB is also called computer RGB; video RGB is also called studio RGB. 
See Calibrating Detail Enhancement and Dynamic Range on page 148. 
Available for Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, Kaleido-X, 
and Kaleido-X16 only.

Aspect ratio Unlike HD signals where aspect ratio information, when available, always 
follows the SMPTE ST 2016 standard, there are different standards for 
encoding aspect ratio information in SD signals. The AFD & WSS 
calibrations determine which standard will be applied by default to SD 
signals feeding the selected multiviewer input. The aspect ratio of video 
windows on the monitor wall can then be automatically adjusted, based 
on the current source assignment. See Calibrating Aspect Ratio 
Decoding on page 147.

Note: In the case of the Kaleido-IP, aspect ratio information can be 
extracted and monitored. No calibration is needed for the Kaleido-IP, 
since it supports decoding of a signal’s aspect ratio from AFD metadata 
only. However, the Kaleido-X software does not yet support automatic 
aspect ratio adjustment based on the decoded information for signals 
originating from these multiviewers.

NTSC standard The NTSC and NTSC-J standards are different with regard to their black 
level. This parameter determines which standard is to be applied to the 
selected analog input signal. Available for Kaleido-X, and Kaleido-X16 
only.

Subtitling/closed 
captioning

Presence alarms can be configured against up to four—up to eight, in 
the case of a Kaleido-IP—preset Teletext (WST) subtitle pages for each 
input signal. The subtitling page selection parameters determine which 
pages will be monitored. In the case of the Kaleido-MX, Kaleido-MX 4K, 
Kaleido-Modular-X, Kaleido-X, and Kaleido-X16 multiviewers, the 
teletext page set as page A will also be decoded, and its content can be 
displayed in a video window. In the case of a Kaleido-IP, all eight teletext 
pages (page A to page H) can be decoded. Requires the CC/XDS option 
(see Hardware and Software Options on page 464). There are also 
subtitling calibrations for the CEA-608 CC and the DTVCC alarms. 
See Calibrating Subtitling/Closed Captioning on page 149.
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Metadata holding 
time

The holding time parameters determine the delay after which decoded 
metadata such as closed captions, teletext subtitles, or XDS metadata 
will be cleared. Requires the CC/XDS option (see Hardware and Software 
Options on page 464). Refer to Calibrating Metadata Holding Time, on 
page 151 for details.

Zero VU (dBu) The Zero VU (dBu) parameters determine the reference level to be 
applied to the selected analog input signal, from an Audio Bridge 
Terminal (ABT). Its default value is 4 dBu, on a range of -24 dBu to 8 dBu. 
See Calibrating Zero VU Reference Level for an ABT Audio Source on 
page 146.

Zero VU (dBFS) The Zero VU (dBFS) parameters determine the reference level to be 
applied to the selected digital (embedded, or from ABT) audio signal. 
dBFS stands for decibels full scale. Zero dBFS corresponds to the 
maximum possible level. By default the reference level for a it is set to 
-20 dBFS, on a range of -24 dBFS to -8 dBFS. The extraction of digital 
audio requires the KXS-HD-EMB or KXS-SD-EMB option (see Hardware 
and Software Options on page 464). Refer to Calibrating Zero VU 
Reference Levels for Embedded Audio Sources, on page 145 for details.

Audio program In the case of Kaleido-X16 and Kaleido-X with second-generation input 
cards (KXI-16SV rev. 600 and later, KXI-16HS3, and KXI-16HSV3), you can 
define up to two groups of audio channels, for each video input—each 
group, itself, constituting an audio program. Loudness measurement is 
based on audio program calibrations for these multiviewer models. 
See Configuring Audio Programs on page 138.

Audio loudness A measure of the perceived loudness of a group of audio channels (an 
audio program). Various measurement modes are available depending 
on the hardware being used. It is possible to configure an alarm that will 
be triggered when the measured loudness deviates too far from a target 
specified either by a standard or by your organization.

In the case of the Kaleido-X, and Kaleido-X16 multiviewers, an alarm can 
also be triggered when the measured loudness deviates too far from the 
dialnorm value found in the VANC audio metadata (SMPTE ST 2020-A).

Depending on the hardware, the loudness measurement mode will 
either be:

• Compliant with recommendations from Dolby regarding dialog 
loudness measurement (ATSC A/53) and provide a short term value 
referred to as loudness, with a limit of one measurement per video 
channel. This applies to Kaleido-X with first-generation input cards (KXI-
16SV rev. 599 and earlier, KXI-16HS, and KXI-16HSV), only. 
See Calibrating Dolby Dialog Loudness Measurement on page 143.

OR,
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• Compliant with recent standards (EBU R128, ATSC A/85, ARIB TR-B32) 
and provide two measures (short term, and momentary) per audio 
program. This applies to Kaleido-IP, Kaleido-X16, and Kaleido-X with 
second-generation input cards (KXI-16SV rev. 600 and later, KXI-16HS3, 
and KXI-16HSV3). See Calibrating Loudness Measurement on 
page 139.
• The Kaleido-IP supports loudness probing of audio streams with a 

sampling rate of 48 kHz only.
• For the Kaleido-X and Kaleido-X16, although two audio programs 

can be defined per video input, there is a limitation on the number of 
concurrent measurements that can be made. See Calibrating 
Loudness Probe Assignments on page 142.

Dolby E selection In the case of the Kaleido-X, and Kaleido-X16 multiviewers, Dolby E 
audio can be decoded from two of eight AES pairs within a signal’s 
embedded audio stream. The Dolby E selection parameters determine 
which AES pairs will be used. See Configuring Sources for Dolby E Audio 
Metadata, on page 145 for details.
Notes
• Dolby E decoding requires the Dolby E option. In the case of a 

Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, or Kaleido-X 
multiviewer model, one license is needed per input card. See Enabling 
Options on page 493.

• Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X support decoding 
of Dolby E metadata from all eight embedded pairs within a video 
source.

• Dolby E decoding is not supported on the Audio Bridge Terminal (ABT).

Switch field 
selection

The switch field parameter determines whether the router module will 
perform clean crosspoint changes on the odd (field 1) on the even 
(field 2) field, or on any field. See Calibrating Switch Field Selection on 
page 163. Available for Kaleido-X16, Kaleido-X (7RU), and Kaleido-X 
(14RU) expansion systems only.

SDI output 
reclocking

The SDI output reclocking parameter determine whether digital video 
signals will have their timing restored at the selected output, to 
eliminate jitter. Reclocking is typically used in installations with large 
routing devices or long cables in the signal path. See Calibrating SDI 
Signal Reclocking on page 164. Available for Kaleido-X16, Kaleido-X 
(7RU), and Kaleido-X (14RU) expansion systems only.
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Alarm Debouncing
Alarm debouncing allows the filtering of false alarms. Two parameters can be calibrated: 
the time required for an alarm event to be present before the system considers it to be valid 
(to avoid false triggering of alarms), and the time required for an alarm state to be normal 
before the system actually clears the alarm (to avoid false releasing of alarms).

An alarm is triggered when a probe is in a continuous error state for the number of seconds 
specified in the Set duration debouncing parameter. In most cases, the alarm status will 
revert to normal by default, as soon as the probe returns a normal state. To delay the 
releasing of an alarm, you can change its Clear duration parameter.

• For TR 101 290 fault-reporting indicators, the default debouncing parameters are as 
follows:

• For all other alarms, the default debouncing parameters are as follows:

GPI line direction On Kaleido-X systems with a GPI/genlock module, GPI lines can be 
configured as inputs or outputs. On the Kaleido-X16 and 
KMV-3901/3911 multiviewer models, the GPI lines are unidirectional 
(4 out and 32 in for the Kaleido-X16, 2 out and 8 in for the 
KMV-3901/3911). In all cases, the state of any GPI output can be set 
manually for test purposes, by using their ON/OFF calibration. 
See GPI/Genlock Calibrations on page 164.

Attribute Default value Range Description

Set duration 0 seconds 0 s – 300 s By default, TR 101 290 faults are reported as 
soon as they are detected.

Clear duration 5 seconds 0 s – 90 s Once the fault condition is no longer 
detected, this is the time interval to wait 
before resetting the alarm.

Attribute Default value Range Description

Set duration 15 seconds 0 s – 300 s This is the time interval to wait before 
triggering an alarm once a probe has been in a 
continuous error state.

Clear duration 0 seconds 0 s – 90 s Once a probe has returned to a normal state 
(the alarm condition is no longer detected), 
this is the time interval to wait before 
resetting the alarm.
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Detailed Directions

Managing Calibration Profiles

Creating Calibration Profiles

To create a calibration profile
1 In XEdit’s main window, click the System tab, and then click Calibrations (Kaleido-IP) 

on the second-level tab bar.
2 On the File menu, click Add TS profile, Add video profile, Add audio profile, Add 

teletext profile, or Add SCTE 35 profile depending on the type of calibration profile 
you wish to create.
The new profile appears in the Tools pane.

3 Click the profile to rename it as desired.

Deleting Calibration Profiles

To delete a calibration profile
1 In XEdit’s main window, click the System tab, and then click Calibrations (Kaleido-IP) 

on the second-level tab bar.
2 In the Tools pane, click the profile you wish to delete.

Notes 

• In the case of video freeze alarms, the default debouncing settings are 
appropriate for most purposes, when the intention is to detect a freeze. 
Note, however, that it may take up to one second (two seconds, in the case 
of a Kaleido-IP) more than the value of the Set duration parameter to 
trigger a video freeze alarm. On the other hand, if your situation requires 
detecting movement (e.g, to detect that nothing is put on air during an off-
air period) then you may need to set an appropriate reset delay for this 
alarm (e.g., 5 seconds) by using the Clear Duration parameter.

• In the case of video black, video luma too high, and teletext presence alarms, 
it may take up to one second more than the value of the Set duration 
parameter to trigger these alarms, and it may take up to one second more 
than the value of the Clear duration parameter before the system clears 
them.

• In the case of V-chip loss alarms, the Set duration parameter should be at 
least 3 seconds, in order to avoid false alarms.

• As of version 6.60 of the Kaleido-X software, the former Occurrences and 
Detection window debouncing parameters have been removed. You may 
need to revise your system’s alarm debouncing calibrations when you 
upgrade to version 6.60 (or later) from version 6.50 (or earlier). Refer to the 
upgrade instructions in the Kaleido-X Release Notes, for details.
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3 On the File menu, click Delete profile.

Configuring Calibration Profiles

To configure a calibration profile
1 In XEdit’s main window, click the System tab, and then click Calibrations (Kaleido-IP) 

on the second-level tab bar.
2 In the Tools pane, click the profile you wish to configure.

A hierarchical list representing all applicable calibrations appears in the main window.
3 Navigate to the element you wish to calibrate, and select it.

The related attributes appear in the Properties pane.
• See Configuring Alarm Debouncing on page 137, if you need to change 

debouncing parameters for teletext, audio, video, or transport stream alarms, and 
see Configuring Alarm Thresholds on page 131, to adjust alarm thresholds.

• For a TS profile:
• Refer to Transport Calibration, on page 136, if you need to change alarm 

thresholds for TR 101 290 fault indicators.
• For an audio profile:

• Refer to Audio Calibrations, on page 135, if you need to change audio alarm 
thresholds.

• See Calibrating Loudness Measurement on page 139, for detailed instructions 
on calibrating loudness measurement.

• See Calibrating Zero VU Reference Levels for Embedded Audio Sources on 
page 145, if you need to change the Zero Vu reference level for all sources 
associated with the current profile.

• For a video profile:
• See Calibrating Metadata Holding Time on page 151, if you need to change the 

holding time for XDS metadata, CC or DTVCC captions.
• Refer to Metadata Calibration, on page 136, if you need to change the 

presence timeout value for DTVCC services and text.
• For a teletext profile:

• See Calibrating Metadata Holding Time on page 151, if you need to change the 
holding time for teletext subtitles.

• See Calibrating Subtitling/Closed Captioning on page 149, to configure the 
teletext page selection parameters.

• For a SCTE 35 profile:
• Refer to Metadata Calibration, on page 136, if you need to change the 

presence timeout value for SCTE 35 signaling.
• See Calibrating DTMF Tone Sequences on page 154, to register the out-of-

network, and in-network DTMF sequences you need to monitor.
• See Calibrating SCTE 35 Event Reporting Duration on page 155, if you wish to 

adjust the delay after which alarms triggered when SCTE 35 commands are 
detected return to normal.

4 Repeat step 3 until the profile is properly configured for your purposes.
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To assign a calibration profile
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list.
2 Navigate to the elementary stream, or transport stream you wish to calibrate and select 

it.
3 In the Properties pane, click Profile, and then select the calibration profile you wish to 

apply to this stream.

Elementary stream profile assignment example

Transport stream profile assignment example

4 To apply the same profile to all elementary streams of a compatible type (e.g., all audio 
elementary streams), click Apply to all.
Alternatively, you can drag a profile from the Tools pane, onto the desired elementary 
stream, or transport stream in the System list.

Configuring Alarm Thresholds

To configure the threshold for an alarm
1 Connect to the multiviewer you wish to configure, if you wish to apply the changes in 

real time (see Connecting to a Multiviewer on page 77).

2 In the main window, click the System tab, and then:

Note: With the current version of the Kaleido-X software, the 
KMV-3901/3911, and Kaleido-XQUAD support audio alarm threshold 
calibrations only. The Kaleido-IP supports threshold calibrations for audio, 
teletext, SCTE 35, and TR 101 290 alarms.

Note: If this step is omitted, then you will need to export the database to 
apply the calibration changes.
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• In the case of a Kaleido-IP, click Calibrations (Kaleido-IP) on the second-level tab 
bar, select the appropriate calibration profile in the Tools pane, and then click the 
alarm whose threshold you wish to calibrate in the main pane.

A transport stream profile

Elementary stream profiles

• For all other multiviewer models, click Description/Calibrations on the second-
level tab bar, navigate to the alarm whose threshold you wish to calibrate, by 
expanding the appropriate multiviewer input, one of its Video elements, and then 
the alarm-related elements (or the ABT element, and then one of the ABT’s audio 
elements).
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Example of alarms related to video and embedded audio input signals, 
for Kaleido-X, Kaleido-X16, and KMV-3901/3911 multiviewers.

3 In the Properties pane, set the relevant values under Calibration.
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Video Calibrations

Black detection 
threshold

Set the level (in IRE or mV) below which the signal will be considered 
to be black. By default the threshold is set at 8 IRE.

Freeze sensitivity Freeze detection is done by comparing successive frames. Noise in 
the signal could disrupt this process, so filtering is added to remove it. 
Adjust the sensitivity according to the signal being monitored, on a 
range of 0 (for a noisy signal) to 16 (for a clean signal). By default the 
sensitivity is set at 8, and the alarm will be triggered after at least 15 
seconds of continuous freeze. Once the alarm is triggered it will only 
be released if no other freeze condition is detected over the period 
determined by the Clear duration parameter (by default, there is no 
delay), to avoid unwanted alarm flickering that could be caused by 
glitches on the signal.

Note that when setting the Clear duration parameter to any value 
other than 0, it may happen that the freeze alarm will only be released 
after a long time (longer than the value of the period determined by 
the Clear duration parameter) if the video has short-duration freezes 
during this period.

SD/HD detection 
zone

Determine the video window area to be monitored for Freeze and 
Black detection. Two detection zones can be configured: one for SD 
signals, one for HD signals.

Luma too high 
detection 
threshold

Set the level (in IRE or mV) above which Luma too high will be 
reported. By default the threshold is set at 100 IRE.
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Silence 
left/right/center

Select the level (in dB or dBFS for digital audio sources, in dB or dBu 
for analog audio sources) below which the audio signal will be 
considered silenced. The default value is –55 dBFS, on a range of -63 
to 0.

All silent / All silent 
program 2

Select the level (in dB or dBFS for digital audio sources, in dB or dBu 
for analog audio sources) below which an audio signal will be 
considered silenced. An alarm is raised if all available channels are 
below the threshold. The default value is –55 dBFS, on a range of -63 
to 0.

Overload left/right Select the level (in dB or dBFS for digital audio sources, in dB or dBu 
for analog audio sources) above which the audio signal will be 
considered overloaded. The default value is –5 dBFS, on a range of -63 
to 0.

Overall audio 
overload

Select the level (in dB or dBFS) above which an audio signal will be 
considered overloaded. An alarm is raised if any available speaker is 
above the threshold. The default value is –5 dBFS, on a range of -63 
to 0. Available for Kaleido-IP only.

Out of phase Select the sensitivity level below which the audio signal will be 
considered out of phase. The sensitivity is a value between -1 and +1, 
where -1 means completely out of phase and +1 means perfectly in 
phase. The default value is 0.

Mono An audio source is considered to be mono if the left and right signals 
are perfectly in phase (i.e., more likely to be the same). Select the 
sensitivity level above which audio will be considered mono. The 
sensitivity is a value between -1 and +1, where -1 means that 
everything is considered to be mono, and +1 means that only 
perfectly in phase audio will be considered mono. The default value is 
1 (Perfectly in phase).
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Transport Calibration

DTVCC service 
presence timeout

Set the delay (in seconds) after which a service presence timeout 
alarm will be triggered. This calibration applies to the six standard 
services. The default value is 30 seconds, on a range of 1 to 360.

DTVCC text 
presence timeout

Set the delay (in seconds) after which a text presence timeout alarm 
will be triggered. This calibration applies to the six standard services. 
The default value is 30 seconds, on a range of 1 to 360.

Text loss Set the delay (in seconds) after which a text presence timeout alarm 
will be triggered for the configured WST subtitling page. The default 
value is 30 seconds, on a range of 1 to 360.

SCTE 35 loss Set the delay (in minutes) after which a timeout alarm will be 
triggered to report that no new SCTE 35 messages were detected 
during this much time. The default value is 60 minutes, on a range of 
1 to 360.

1.3a PAT timeout Set the delay (in millisecond) after which a timeout alarm will be 
triggered to report that no Program Association Table (PAT) was 
found in the transport stream during this much time. The default 
value is 500 ms, on a range of 10 to 2500.

1.5a PMT timeout Set the delay (in millisecond) after which a timeout alarm will be 
triggered to report that no Program Map Table (PMT) was found on 
the Packet Identifier (PID) specified in the PAT during this much time. 
The default value is 500 ms, on a range of 10 to 2500.

1.6 PID error Set the delay (in millisecond) after which an alarm will be triggered to 
report that the data stream associated with a PID has not occurred in 
the transport stream during this much time. The default value is 
5000 ms, on a range of 10 to 25000.
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To configure alarm debouncing

1 Connect to the multiviewer you wish to configure, if you wish to apply the changes in 
real time (see Connecting to a Multiviewer on page 77).

2 In the main window, click the System tab, and then:
• In the case of a Kaleido-IP, click Calibrations (Kaleido-IP) on the second-level tab 

bar, select the appropriate calibration profile in the Tools pane, and then click the 
alarm whose debouncing you wish to calibrate in the main pane.

A transport stream profile

2.3a PCR 
repetition error

Set the delay (in millisecond) after which an alarm will be triggered to 
report that the interval between two consecutive Primary Clock 
Reference (PCR) values has exceeded the specified time. The default 
value is 40 ms, on a range of 10 to 200.

2.5 PTS error Set the delay (in millisecond) after which an alarm will be triggered to 
report that no Presentation Time Stamp (PTS) was found in the 
transport stream during this much time. The default value is 700 ms, 
on a range of 10 to 3500.

Note: If this step is omitted, then you will need to export the database to 
apply the new calibrations to the multiviewer.
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Elementary stream profiles

• For all other multiviewer models, click Description/Calibrations on the second-
level tab bar, navigate to the alarm whose debouncing you wish to calibrate, by 
expanding the appropriate multiviewer input, one of its Video elements, and then 
the alarm-related elements (or the ABT element, and then one of the ABT’s audio 
elements).

3 In the Properties pane, under Debouncing, set appropriate values (see page 128) for 
the Set duration and Clear duration attributes.

Multiviewer Input Calibrations
To calibrate your multiviewer inputs, you navigate a hierarchical representation of your 
system in XEdit, and set parameters to match your monitoring purposes.

• In the case of a Kaleido-IP, default audio, video, teletext, SCTE 35, and transport stream 
profiles are available with preset calibrations, which cannot be modified. You may add 
custom profiles, and configure them as needed, from XEdit’s Calibrations (Kaleido-IP) 
tab. You can apply a profile to an elementary stream in the Description/Calibrations 
tab. See Profiles on page 123.

• For all other multiviewer models, you can modify calibrations for every multiviewer 
input, from the System list in XEdit’s Description/Calibrations tab. To apply a specific 
calibration to all inputs at once, click the corresponding Apply to all button.

Configuring Audio Programs

Note: This section applies to the Kaleido-X16, and to Kaleido-X 
multiviewers with second-generation input cards (KXI-16SV rev. 600 and later, 
KXI-16HS3, and KXI-16HSV3), only.
If you have a Kaleido-X with first-generation input cards (KXI-16HSV, KXI-
16HS, or KXI-16SV rev. 599 and earlier), see Calibrating Dolby Dialog 
Loudness Measurement, on page 143.
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To configure an audio program
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose inputs you wish to calibrate.
3 Expand the appropriate input.
4 Expand Audio programs & loudness, and then click Program 1.

5 In the Properties pane, select the embedded audio channels that you want to be part 
of the audio program.

Each channel is assigned a specific role in the program (left, right, center, etc).
6 Repeat the procedure to define a second audio program (Program 2), if you wish.

Audio channels can be reused to define the second program or they can be made 
mutually exclusive as desired.

Calibrating Loudness Measurement

Note: This section applies to Kaleido-IP, Kaleido-X16, and Kaleido-X with 
second-generation input cards (KXI-16SV rev. 600 and later, KXI-16HS3, and 
KXI-16HSV3).
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To calibrate loudness measurement
1 Navigate to the appropriate input’s Loudness element in the System list or audio 

profile, and select it.
• In the case of a Kaleido-IP, see Navigating to the loudness calibration in a 

Kaleido-IP calibration profile, on page 141.
• For a Kaleido-X16 or a Kaleido-X, see Navigating to the loudness calibration in a 

Kaleido-X16 or Kaleido-X System list, on page 141.
2 In the Properties pane, set the appropriate values for your installation.

The following values are involved:

Parameter Description

Mode Select the loudness standard you wish to apply: EBU R128, 
ATSC A/85, or ARID TR-B32. Alternatively, you can define a custom 
mode to gain more control.

Short term window This parameter determines the integration time of the short term 
loudness measurement. It is configurable when using ATSC A/85 or a 
custom measurement mode, with a value on a scale ranging 
between 1 and 15 seconds.

Max. lower 
deviation

The Max. lower deviation parameter determines the tolerated 
excursion range of the short term loudness below the target value. 
The measured short term loudness and the encoded dialnorm can be 
compared against each other and against a standard or your 
organization's target value, and alarms will be triggered in case of too 
much deviation. In custom mode, possible values range from -70 dB 
to 0 dB.a

a. Setting this parameter to its lowest value (-70 dB) will prevent the short term/Target alarm from 
being triggered when silence is detected.

Max. upper 
deviation

The Max. upper deviation parameter determines the tolerated 
excursion range of the short term loudness above the target value. 
The measured short term loudness and the encoded dialnorm can be 
compared against each other and against a standard or your 
organization’s target value, and alarms will be triggered in case of too 
much deviation. In custom mode, the possible values range from 0 dB 
to 15 dB.

Target Type the appropriate loudness value for your custom standard, in the 
box, or set it using the slider. The default value is -24, on a scale of 
-70 LUFS/LKFS to 0 LUFS/LKFS.b This value can then be compared 
against the measured loudness, and against the encoded dialnorm 
found in the VANC audio metadata (SMPTE ST 2020-A).
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Navigating to the loudness calibration in a Kaleido-IP calibration profile

To navigate to the loudness calibration in a Kaleido-IP calibration profile
1 In XEdit’s main window, click the System tab, and then click Calibrations (Kaleido-IP) 

on the second-level tab bar.
2 On the Tools tab, select the audio profile whose loudness measurement you would like 

to calibrate.
A hierarchical list representing all applicable calibrations for this profile appears in the 
main window.

3 Expand the list, and then click Loudness.

Navigating to the loudness calibration in a Kaleido-X16 or Kaleido-X System list

To navigate to the loudness calibration in a Kaleido-X16 or Kaleido-X System list
1 In the main window, click the System tab, and then click the Description/Calibrations 

second-level tab.
2 Expand the appropriate input module, then the video input you wish to calibrate, the 

Audio programs & loudness element, the Program element you wish to configure 
(Program 1, or Program 2), and then click Loudness.

b.On the monitor wall, loudness monitors using a custom measurement mode have their scale 
labeled LU, or LUFS. There is no functional difference between the LU vs. LK, or LUFS vs. LKFS 
scales.
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Calibrating Loudness Probe Assignments

To calibrate loudness probe assignments
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose inputs you wish to calibrate.
3 Expand the appropriate input, and then click Loudness probe assignment.

4 In the Properties pane, assign an audio program to one of the 16 available probes.
The default is Program 1 for all video inputs.

Note: This section applies to Kaleido-X16, and Kaleido-X with second-
generation input cards (KXI-16SV rev. 600 and later, KXI-16HS3, and KXI-
16HSV3). In the case of a Kaleido-IP, all audio programs can be measured 
simultaneously.
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To calibrate loudness measurement for an audio source
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose inputs you wish to calibrate.
3 Expand the appropriate input, and then click Loudness - dialnorm (legacy).

4 In the Properties pane, set the appropriate values for your installation.

Note: If you choose to measure the second program for a specific video 
input, you will not be able to measure audio programs on all inputs.

Note: This section applies to Kaleido-X with first-generation input cards 
(KXI-16SV rev. 599 and earlier, KXI-16HS, and KXI-16HSV), only.
If you have a Kaleido-X16, and to Kaleido-X multiviewers with second-
generation input cards (KXI-16SV rev. 600 and later, KXI-16HS3, and KXI-
16HSV3), see Configuring Audio Programs, on page 138.
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The following values are involved:

Parameter Description

Loudness standard Select the standard you wish to apply: either the A-weighted Leq 
(LEQ(A)) or the ITU-R BS.1770 filter.
Note: Mixing standards for different inputs is not supported.

Loudness channel 
selection

Select the check boxes corresponding to the audio channels that 
should contribute to the loudness measurement.
Note: The Kaleido-X software can measure loudness against a 
maximum of 8 channels. If you select more than 8 channels, only the 
first 8 will be used.

Target Type your organization’s reference dialnorm value in the box, or set 
it using the slider. The default value is -27 dB, on a scale of -60 dB to 
0 dB. This value can then be compared against the measured 
loudness, and against the encoded dialnorm found in the VANC 
audio metadata (SMPTE ST 2020-A).

Max. lower 
deviation

The Max. lower deviation parameter determines the tolerated 
excursion range below the reference value. The measured levels and 
the encoded dialnorm can be compared against each other and 
against your organization's target, and alarms triggered in case of 
too much deviation. The default value is -5.4 dB, on a scale of -64 dB 
to 0 dB.
Note: Setting this parameter to its lowest value (-64 dB) will prevent 
the Loudness/Target alarm from being triggered when silence is 
detected.

Max. upper 
deviation

The Max. upper deviation parameter determines the tolerated 
excursion range above the reference value. The measured levels and 
the encoded dialnorm can be compared against each other and 
against your organization's target, and alarms triggered in case of 
too much deviation.The default value is 2.4 dB, on a scale of 0 dB to 
15 dB.
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To configure sources for Dolby E audio metadata
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose inputs you wish to calibrate.
3 Expand the appropriate input, and then click Dolby E selection.

4 In the Properties pane, select the AES pairs (among Embedded audio 1 to Embedded 
audio 8) associated with the two Dolby E programs to be decoded, from the two lists: 
Dolby E selection 1 and Dolby E selection 2.

Calibrating Zero VU Reference Levels for Embedded Audio Sources

To calibrate a Zero VU reference level
1 In the main window, click the System tab, and then:

• In the case of a Kaleido-IP, click the Calibrations (Kaleido-IP) tab, select the audio 
profile you wish to configure, and then click Zero VU.

Note: This section applies to the Kaleido-X and Kaleido-X16 multiviewer 
models only.
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• For all other multiviewer models, click Description/Calibrations on the second-
level tab bar, expand the appropriate input, then one of its embedded audio 
elements, and select Zero VU.

2 In the Properties pane, set the reference level to the appropriate value (in dBFS), using 
the Zero VU slider, under Calibration.
Alternatively, type the value directly in the Zero VU box.

Calibrating Zero VU Reference Level for an ABT Audio Source

Notes 

• The KMV-3901/3911 only supports embedded audio, not discrete audio 
sources from an ABT.

• This section does not apply to the Kaleido-IP.
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To calibrate an ABT audio source
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose inputs you wish to calibrate.
3 Expand the appropriate input, its ABT element, and then one of the ABT’s audio 

elements. Select Zero VU.

4 In the Properties pane, set the reference levels to the appropriate values (in dBFS, and 
in dBu), using the Zero VU sliders, under Calibration. Alternatively, type the values 
directly in the Zero VU boxes.

Calibrating Aspect Ratio Decoding

Aspect ratio information can be encoded following different standards: AFD 2016, AFD VI, 
or WSS. The following table shows the different standards and their availability according to 
the signal type:

AFD VI information can be encoded as 4 bits or 3 bits (legacy).

To select the AFD source for an SD signal
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.

Note: This section applies to multiviewers that are used to monitor 
SD signals. In the case of HD signals, since the AFD information always 
follows AFD 2016, no calibration is needed. No calibration is needed for the 
Kaleido-IP either, since it supports decoding of a signal’s aspect ratio from 
AFD metadata only. See page 125 for more information.

Signal type AFD 2016
Video index 
(AFD VI)

Wide screen 
signaling 
(WSS)

HD Yes — —

SD 525 Yes Yes —

SD 625 Yes Yes Yes
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A hierarchical list representing the current system appears.
2 In the list, expand the multiviewer whose inputs you wish to calibrate.
3 Expand the appropriate input, and then click AFD & WSS.

4 In the Properties pane, select Legacy AFD 3 bits to support the legacy AFD 3-bit 
format for the video index, if appropriate.

5 Select the appropriate value from the SD AFD source list.

The default value is Auto, which means that the multiviewer will automatically detect 
what is present in the signal and use it to report AFD. If more than one AFD type is 
present in the signal, and SD AFD source is set to Auto, then the AFD type is selected in 
this order: (1) AFD 2016, (2) AFD VI, or (3) WSS.

Calibrating Detail Enhancement and Dynamic Range

To configure detail enhancement and dynamic range for a video input
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.

Notes 

• This section applies to the Kaleido-X, Kaleido-X16, Kaleido-MX, 
Kaleido-MX 4K, and Kaleido-Modular-X multiviewers, only.

• Kaleido-MX and Kaleido-Modular-X configured for 4K UHD output, and 
Kaleido-MX 4K do not support detail enhancement for video windows 
spanned across multiple heads (see 4K UHD Spanning on page 239). Make 
sure the corresponding multiviewer inputs are calibrated with the Detail 
Enhancer parameter set to 0, which is the default value.
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A hierarchical list representing the current system appears.
2 In the list, expand the multiviewer whose inputs you wish to calibrate.
3 Expand the appropriate input, then one of its Video elements.
4 Under Video calibrations, click Detail enhancer.

5 In the Properties pane, set the appropriate value (between 0 and 15).

6 Click Apply to all to apply the associated setting to all video inputs on your 
multiviewer.

7 In the system list, click Dynamic range.

8 In the Properties pane, set the appropriate value (either Full range or Video range).

Calibrating Subtitling/Closed Captioning
This section does not apply to the KMV-3901/3911, or Kaleido-XQUAD multiviewers. For a 
Kaleido-IP, see Configuring Teletext/Subtitling Page Selection for a Kaleido-IP, on page 149. 
For other multiviewer models, see Configuring Teletext/Subtitling Page Selection for a 
Kaleido-X, Kaleido-X16, Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X, on page 150.

Configuring Teletext/Subtitling Page Selection for a Kaleido-IP

To configure Teletext/Subtitling page selection for a Kaleido-IP
1 In the main window, click the System tab, and then click the Calibrations (Kaleido-IP) 

tab.
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2 Select the teletext profile you wish to configure, expand the Page A element, and then 
click Page selection.

3 In the Properties pane, type the page number you wish to be the default selection for 
Page A, in the Teletext page A selection box. Alternatively, use the slider to set the 
page number.

4 If you wish to enable or disable teletext decoding for this page, then select or clear the 
Enabled check box accordingly.
Only decoding of Page A is enabled by default.

5 Repeat the procedure for the Page B, to Page H elements.

Configuring Teletext/Subtitling Page Selection for a Kaleido-X, Kaleido-X16, 
Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X

To configure Teletext/Subtitling page selection for a Kaleido-X, Kaleido-X16, 
Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose inputs you wish to calibrate.
3 Expand the appropriate input, then one of its Video elements.
4 Under Teletext & subtitling alarms, expand the Page A element, and then click Page 

selection.

Note: Alarms can be configured for all eight preset pages (see Configuring 
Alarm Debouncing on page 137 for instructions on how to configure the 
alarms).
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5 In the Properties pane, type the page number you wish to be the default selection for 
Page A, in the Teletext page A selection box. Alternatively, use the slider to set the 
page number.

6 Click Apply to all if you wish this setting to be the default Page A selection for every 
video signal on your system.

7 Repeat the procedure for the Page B, C, and D elements.

Calibrating Metadata Holding Time

To calibrate metadata holding time
1 In the main window, click the System tab, and then:

• In the case of a Kaleido-IP, click the Calibrations (Kaleido-IP) tab, select the video 
or teletext profile you wish to configure, and then click CC Caption holding time, 
XDS filtering, DTVCC holding time (for a video profile), or Subtitling holding time 
(for a teletext profile).

Note: Alarms can be configured for all four preset pages (see Configuring 
Alarm Debouncing on page 137 for instructions on how to configure the 
alarms). The Teletext page set as Page A will also be decoded, and its content 
can be displayed in a video window.

Note: This section does not apply to the KMV-3901/3911, or Kaleido-XQUAD 
multiviewers.
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• For all other multiviewer models, click Description/Calibrations on the second-
level tab bar, expand the appropriate input module, then the video input you wish 
to calibrate, and select the metadata element whose holding time you wish to 
configure.

2 In the Properties pane, set the desired value by typing it directly in the box, or by using 
the slider (refer to the table below as needed).
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Subtitling holding time Set the delay (between 5 and 360 seconds, default value is 
16 seconds) after which subtitles are cleared:

XDS filtering Set the holding time (between 5 and 360 seconds, default 
value is 30 seconds) for each XDS metadata element (APS, 
ASB, CGMS-A; channel number; elapsed time; network 
name; program description, ID, name, length, and type; 
station ID; TSID name; time of day; time zone; V-chip 
rating).
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Calibrating DTMF Tone Sequences
The Kaleido-IP can detect 16 specific DTMF sequences in a SCTE 35 stream, to trigger up 
to 8 DTMF break alarms and to return their status to normal. Define the sequences, 
matching those used in the actual programs you wish to monitor.

To calibrate out-of-network, and in-network DTMF tone sequences
1 In the main window, click the System tab, and then click the Calibrations (Kaleido-IP) 

tab on the second-level tab bar.
2 In the Tools pane, select the SCTE 35 profile you wish to configure, and then click DTMF 

break 1 sequences.

CC holding time Set the delay (between 5 and 360 seconds, default value is 
16 seconds) after which closed captions (608) are cleared:

DTVCC holding time Set the delay (between 15 and 360 seconds, default value 
is 30 seconds) after which closed captions (708) are 
cleared:
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3 In the Properties pane, set the appropriate values for the out-of-network, and in-
network DTMF sequences.

Allowed characters: 0–9, A–D, *, and #.
4 Proceed in the same fashion with DTMF break 2 sequences to DTMF break 8 

sequences, as needed, to define the remaining DTMF sequences you wish to monitor.

Calibrating SCTE 35 Event Reporting Duration
When the Kaleido-IP detects a SCTE 35 command in a transport stream, it momentarily 
triggers the corresponding alarm. The alarm status returns to normal after a delay, which 
you can configure for your specific purposes if needed.

To calibrate SCTE 35 event reporting duration
1 In the main window, click the System tab, and then click the Calibrations (Kaleido-IP) 

tab on the second-level tab bar.
2 In the Tools pane, select the SCTE 35 profile you wish to configure.
3 In the main pane, click Splice received, Splice null received, Time signal received, or 

Unsupported command received.

4 In the Properties pane, set the relevant values under Calibration.
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Multiviewer Output Calibrations

Calibrating the Brightness and Contrast

Each of the output heads in the multiviewer can drive a monitor wall display. For each head, 
output parameters can be adjusted to optimize the image on the monitor wall display: the 
brightness parameters set the black offsets of the RGB output signals; and the contrast 
parameters set the gain offsets of these signals.

To calibrate the brightness and contrast parameters
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose output heads you wish to calibrate.

Splice received 
timeout

Set the delay (in seconds) after which the splice received alarm will be 
cleared. The splice received alarm is triggered immediately whenever 
the Kaleido-IP detects a splice insert command. The default value is 
120 seconds, on a range of 1 to 3600.

Splice null 
received timeout

Set the delay (in seconds) after which the splice null received alarm will 
be cleared. The splice null received alarm is triggered immediately 
whenever the Kaleido-IP detects a splice null command. The default 
value is 60 seconds, on a range of 1 to 3600.

Time signal 
received timeout

Set the delay (in seconds) after which the time signal received alarm 
will be cleared. The time signal received alarm is triggered 
immediately whenever the Kaleido-IP detects a time signal command. 
The default value is 60 seconds, on a range of 1 to 3600.

Unsupported 
command 
received timeout

Set the delay (in seconds) after which the unsupported command 
received alarm will be cleared. The unsupported command received 
alarm is triggered immediately whenever the Kaleido-IP detects a 
command that does not belong to the set of supported commands. 
The default value is 60 seconds, on a range of 1 to 3600.

Note: This section applies to the Kaleido-X and Kaleido-X16 multiviewer 
models only.
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3 Expand the appropriate output module.
The expanded module will show the output heads. (Depending on the multiviewer 
model, other items may also appear.)

4 Select the head you wish to calibrate.
The brightness and contrast adjustment controls appear in the Properties pane.

5 Expand the headings to show the controls if they are not visible.

6 Use the sliders to adjust the brightness and contrast until you obtain a pleasing 
presentation of the video elements on the monitor wall display driven by the selected 
head.
Alternatively, type values directly in the Red, Green (master), and Blue boxes.

Note: Moving the Green (master) slider will move the Red and the Blue 
sliders by the same amount. 
The values must be between 0 and 100. 
A good approach is to set all values the same using the Red and Blue sliders, 
then to adjust for the best overall presentation using the Green (master) 
slider, and finally to fine-tune the color balance using the Red and the Blue 
sliders.

Output heads 1 and 2
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7 If appropriate, you may copy settings from this head to every output head in the system. 
For each value you wish to apply globally throughout your system, click the 
corresponding Apply to all button.
This has the same effect as selecting every output head one by one, and adjusting the 
sliders to the same value for the selected parameter.

Calibrating Color Saturation

Each of the output heads in the multiviewer can drive a monitor wall display. The image on 
the monitor wall contains both graphical elements created by the Kaleido-X system, and 
video signals that are passed through the system. It is often useful to be able to modify the 
color saturation of the video so that its appearance within the graphical environment is 
pleasing. The Color saturation calibration control provides this function.

The color saturation calibration does not affect the graphical elements within the monitor 
wall display. 

To calibrate the color saturation
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose output heads you wish to calibrate.

3 Expand the appropriate output module.
The expanded module will show the output heads. (Depending on the multiviewer 
model, other items may also appear.)

Note: If you want to apply the same values to all the other output heads in 
your system, you must click the Apply to all button for Green (master) FIRST, 
and then the Apply to all buttons for blue and red in any order. Otherwise 
the values for blue and red would be modified following the application of 
the value for green.

Note: This section applies to the Kaleido-X and Kaleido-X16 multiviewer 
models only.
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4 Select the head you wish to calibrate.
The color saturation adjustment control appears in the Properties pane.

5 Expand the Calibration heading to show the control if it is not visible.

6 Use the slider to adjust the color saturation until you obtain a pleasing presentation of 
the video elements on the monitor wall display driven by the selected head. 
Alternatively, type a value (between 0 and 100) directly in the Color saturation box.

7 If appropriate, you may copy the settings from this head to every output head in the 
system. To apply the color saturation settings globally throughout your system, click 
Apply to all.
This has the same effect as selecting every output head one by one, and adjusting the 
Color saturation slider to the same value.

Calibrating the DVI Keying Mode

To calibrate the DVI keying mode
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose output heads you wish to calibrate.

Note: All videos on the monitor wall display controlled by the selected 
head are adjusted simultaneously.

Notes 

• This section applies to the Kaleido-X and Kaleido-X16 multiviewer models 
only.

• Background keying is enabled by default, and should remain enabled 
when no actual keying is involved. Enabling the foreground keying mode 
when there is no signal at the associated DVI input is not supported.

• For more information about using content from the DVI input as 
background, see Setting up a Layout for Background Keying from the DVI 
Input, on page 255.
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3 Expand the appropriate output module.
The expanded module will show the output heads. (Depending on the multiviewer 
model, other items may also appear.)

4 Select the head you wish to calibrate.
5 In the Properties pane, select the appropriate value from the DVI Input Keying Mode 

list.

6  If appropriate, you may copy the settings from this head to every output head in the 
system: to apply the selected DVI input keying mode globally throughout your system, 
click Apply to all.
This has the same effect as configuring every output head one by one, and selecting 
the same keying mode for each.

Calibrating the Audio Monitoring Delay

Note: By design, the audio signal is approximately 37 ms ahead of the 
video.
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To calibrate the audio monitoring delay for a head
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose output heads you wish to calibrate.

3 Expand the appropriate output module.
The expanded module will show the output heads. (Depending on the multiviewer 
model, other items may also appear.)

4 Select the head you wish to calibrate.
The audio monitoring delay adjustment control appears in the Properties pane. 
Expand the Calibration heading to show the control if it is not visible.

5 Select the appropriate unit (milliseconds or AES samples), and then use the slider to 
adjust the audio monitoring delay until the audio and video are well synchronized on 
the monitor wall display driven by the selected head.
Alternatively, type a value (between 0 and 100 ms, or between 4 and 4800 AES 
samples) directly in the Audio monitoring delay box.
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6 If appropriate, you may copy the settings from this head to every output head in the 
system. To apply the audio monitoring delay calibration globally throughout your 
system, click Apply to all.
This has the same effect as selecting every output head one by one, and adjusting the 
audio monitoring delay settings to the same values.

Calibrating the Audio Monitoring Color

To calibrate the audio monitoring color
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose output heads you wish to calibrate.

3 Expand the appropriate output module.
The expanded module will show the output heads. (Depending on the multiviewer 
model, other items may also appear.)

4 Select the head you wish to calibrate.
5 In the Properties pane, click the Audio Monitoring Color box, and then click the 

button that appears at the end of the line.

Note: All videos on the monitor wall display controlled by the selected 
head are adjusted simultaneously.
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The color picker window opens.

6 In Colors, click the tab that corresponds to the color space you wish to use, and then 
choose the color that will be associated with the selected output head.

7 Click OK to close the color picker window.

Router Output Calibrations

Calibrating Switch Field Selection

To calibrate switch field selection for a router module
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer you wish to calibrate.
3 Expand the appropriate router module, and then click Switch field selection.

Click to open the
color picker window

Note: This section applies to the Kaleido-X16, Kaleido-X (7RU), and 
Kaleido-X (14RU) expansion systems only.
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4 In the Properties pane, click the Switch field selection box, and then select the 
appropriate field value from the list.

Calibrating SDI Signal Reclocking

To calibrate reclocking of a router module’s output signal
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer you wish to calibrate.
3 Expand the appropriate router output, and then click SDI output reclocking.

4 In the Properties pane, click the SDI output reclocking box, and then select ON or OFF 
from the list.

5 Click Apply to all to apply the chosen value throughout the system.

GPI/Genlock Calibrations
You can define actions that change the state of a GPI output line, and assign them to a 
monitor. GPI lines configured as outputs can have their ON/OFF state set manually in XEdit, 
for test purposes.
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To configure a GPI line’s direction as an output
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer you wish to calibrate.
3 Expand the GPI/GENLOCK module, and then click the desired GPI line element.

4 In the Properties pane, click the GPI direction box, and then select output from the list.

5 Click Apply to all, if every GPI line in your system is to be configured as an output.
6 To set this GPI output line’s ON/OFF state set manually for test purposes, click the GPI 

output box, and then select either ON or OFF from the list.

Note: This section applies to Kaleido-X multiviewers, only.
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Your Kaleido-X system can help you monitor alarm conditions efficiently. This section 
describes how to configure alarm detection and alarm sharing parameters for your system. 
This configuration is made in XEdit.

Key Concepts

Alarm
An alarm is a report on a single, defined condition (generated by a device or service) within 
a multiviewer system. A multiviewer analyses the signals that pass through it, and can 
detect and flag problems by raising alarms. Each alarm can be individually configured. Most 
alarm definitions specify detection thresholds, a set duration, and a clear duration, in order 
to exclude transient events. See Configuring Alarm Thresholds on page 131, and 
Configuring Alarm Debouncing, on page 137.

When XEdit is connected to a multiviewer in online mode, alarms generated by the current 
multiviewer are displayed in the System list and you can review their status in real time. You 
can manage additional alarms, including health monitoring alarms, or alarms generated by 
external devices, by using an alarm browser such as iControl’s GSM alarm browser or the 
alarm browser pane in XEdit’s Build Virtual Alarm window (see Virtual Alarm on page 171).

As part of the alarm calibration process, you can specify that an alarm, when triggered, be 
sent as an SNMP trap. See Simple Network Management Protocol (SNMP) on page 172.

General Status Manager (GSM)
The general status manager (GSM) is the service responsible for central management of all 
alarm conditions within a monitoring and control system. Every Kaleido multiviewer has a 
GSM and can be configured to share GSM information with other multiviewers and iControl 
systems. For example:

• Display alarm status information from Densité cards on the monitor wall.
• Display alarms detected within a Kaleido-X system on an iControl Web page.
• Display EdgeVision alarms along with the stream coming from the EdgeVision on a 

Kaleido-IP multiviewer.
• Display alarm status information in XEdit (online mode).
• Create virtual alarms that combine a number of alarm statuses, not only within a single 

system, but also from different devices within multiple Kaleido-X and iControl systems. 
See Creating Virtual Alarms on page 179.

In addition, as of version 6.40 of the Kaleido-X software, it is possible to assign elements 
from any GSM alarm browser to alarm levels in the sources table, directly, by a drag-and-
 167



Configuring Alarms
Alarm Logging
drop operation (see Configuring logical sources based on external alarm providers on 
page 205).

Alarm Logging
As part of the alarm calibration process, you can specify that an alarm, when triggered, be 
logged to an iControl application server. This requires adding a log plug-in to your 
multiviewer’s GSM configuration (see Adding a GSM log plug-in on page 186). As of version 
6.50 of the Kaleido-X software, alarms logged to an iControl application server include time 
code information from the corresponding video signal (ATC or VITC, depending on the 
signal format).

• By default, native alarms are not logged. See Enabling logging for a native alarm on 
page 189.

• Virtual alarms are logged by default. See Disabling logging for a virtual alarm on 
page 190. When a virtual alarm status changes, then the native sub-alarms that 
triggered the change are logged even if logging is disabled for these sub-alarms.

• Global alarms are always logged. It is possible, however, to disable alarm logging for a 
global alarm, by editing the corresponding plug-in from the iControl application 
server’s GSM alarm browser. Refer to the iControl User Guide, for more information.

Alarm Browser
The alarm browser is a window, accessible from within iControl Navigator and other 
iControl applications. XEdit’s Build Virtual Alarm window features an alarm browser pane. 
The information that appears in the Alarm Browser is generated by a specific GSM. The 
alarm browser displays a hierarchical view of all the alarms that have been discovered by 
the GSM. The alarms may be related to Grass Valley devices, or other supported third-party 
devices, and are organized into folders. The current status of each alarm is shown as an icon 
next to its name. These status are dynamically updated.

Alarm Status
The current status of an alarm determines the color of the LED-like icon to the left of its 
name, in XEdit, in GSM alarm browsers, and in iControl log viewers. Video monitors, UMDs 
and alarm monitors have alarm reporting features (e.g., border color and thickness, blink 
mode, latch) that can be customized in XEdit, when you create a layout.

Each possible alarm status is represented by a color. Alarm statuses are dynamically 
updated. The Kaleido-X software supports the following alarm status values, described in 
the table below: pending, normal (or OK), warning (or minor), major, critical, unknown, 
nonexistent, and disabled. In a multiviewer’s System list and on the monitor wall, nonexistent 
and unknown alarms are considered disabled.

Status Color Description

Pending White Alarm exists but was not reported yet: The software is waiting for 
the hardware or driver to update the alarm.

Normal (or OK) Green No error detected.
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A multiviewer alarm status is only visible in iControl’s GSM alarm browser when at least one 
of the following conditions apply:

• The alarm is already monitored on the monitor wall.
• Someone navigated to this alarm by expanding the System list in iControl or XEdit.
• The alarm is associated with a background action.
• The alarm contributes to a virtual alarm.

When navigating a multiviewer’s GSM, by using the alarm browser in iControl, some alarm 
folders may show a disabled (black) status, until you expand them to reveal the alarms they 
contain, at which point the folder color will be updated to reflect the status of the alarms.

In the case of a Kaleido-IP, alarm status and text information for a source is available only 
when the corresponding source is being monitored on the wall. For SCTE 35 alarm status 
and text information to be available (and logged to iControl, if applicable), make sure to 
assign at least one text or alarm level from every SCTE 35 stream you wish to monitor, to UMD 
components (tally or text) on the monitor wall layout. Alarms associated with sources that 
are currently not assigned to any layout element on the monitor wall appear with a 
pending (white) status in a Kaleido-IP System list or GSM alarm browser.

Warning (or 
Minor)

Yellow Supported for Gateway alarms only (see Gateway on page 325).

Major Orange Supported for Gateway alarms only (see Gateway on page 325).

Critical Red Error detected.

Unknown Gray Could not get status: Failed to communicate with device to get 
status. It could happen for example, if the network connection is 
lost. Another example is a loss of signal that would trigger a 
critical alarm for signal presence while the alarm state for all 
other parameters would become unknown. The freeze or black 
status is disabled if the signal is not present.

Nonexistent Blue Alarm that has been removed (or was never added): It can 
happen if the alarm reference in XEdit does not exist on the 
multiviewer — for example, if an input card is removed from a 
Kaleido-X multiviewer. All associated alarms will disappear from 
the GSM and become disabled on the multiviewer.

Disabled Black No alarm assigned to the status indicator: Alarm exists but is 
disabled at the source by the user. The Kaleido-X software has the 
ability to deactivate some alarms on the multiviewer hardware 
itself.

TIP
Create a virtual alarm, based on the alarms whose status you want to be able 
to monitor in real time. See Virtual Alarm on page 171.

Status Color Description
169



Configuring Alarms
External Alarm Provider
External Alarm Provider
Once you have declared a device (e.g., an iControl application server, an EdgeVision quality 
of experience monitoring system, another multiviewer) as an external alarm provider to 
your multiviewer system, any alarms registered with this device’s GSM, in addition to the 
alarms generated by the current multiviewer system, can contribute to your monitoring 
and control purposes. See Managing Alarm Providers on page 178.

Lookup Service
Grass Valley’s monitoring and control products implement a lookup service for discovery 
and information sharing over a network. A program on one device can use a lookup service 
to obtain information from remote applications or devices, including alarm-related 
information from a device’s GSM. By default, every multiviewer has a lookup service and can 
therefore be considered a lookup server. For example, before you can use an RCP-200 
control panel to operate your monitor wall, the multiviewer must be specified as a lookup 
server in the RCP-200’s configuration (see Specifying lookup servers for the RCP-200 on 
page 485).

Alarm Suppression
Alarms that are not relevant—momentarily or on a recurrent basis—can be squelched, 
either manually or by defining schedules, so that only meaningful alarm information 
remains to be monitored. A schedule can put an alarm in either of the following operational 
modes: offline, in maintenance, or inverted.

Global Alarms
A logical source comprises different level categories, including alarms (see Logical source 
on page 195). Each logical source can include multiple alarm levels: one for each alarm state 
that can be reported to the Kaleido-X system. In many cases, a single, combined status, 
based on all the alarms in every alarm level for a logical source, is more useful than having 
to individually assess each and every alarm condition detected. Such a global alarm 
combines all the individual alarm statuses into an overall status, where the most critical 
events take precedence.

IMPORTANT
iControl application server requirement
In the case of an iControl system involving multiple application 
servers, there will typically be only one or two of the servers with a 
lookup service enabled. To qualify as an external alarm provider, an 
iControl application server must have its lookup service enabled (i.e., 
it must be a lookup server). Refer to the iControl User Guide for more 
information.

Note: A background action triggered by an alarm is executed, regardless of 
the alarm’s operational mode (see Creating Background Actions on 
page 327).
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Example: Three alarms occur, two of which can be acknowledged without further 
action, while the other one is considered an Error. In such a case, the overall alarm status 
would be Error.

The Kaleido-X software creates one global alarm for every logical source. The global alarms 
are not directly exposed in the Channels/Sources tab, but you can configure which alarm 
levels contribute to them (see Configuring an alarm level’s contribution on page 201). If you 
have disabled global alarm contribution for all alarm levels, then the global alarms are not 
generated.

In the Layouts tab, you can assign a global alarm to a layout element that supports alarm 
reporting, like a UMD or an alarm monitor: in the Properties pane, the lists of alarm levels 
that can be assigned to a monitor include the item GlobalAlarm, along with all the 
individual alarm levels.

You can select this global alarm not only as an alarm status, but also as a text label. When an 
individual alarm is in Error, its friendly name will contribute to the global alarm text value. 
When the global alarm level is assigned to an alarm monitor, the text values for all 
contributing alarms currently in Error will be visible.

See Configuring Video Monitors, on page 257, Configuring UMDs, on page 288, 
Configuring Alarm Monitors, on page 295, and Configuring Subtitling Monitors, on 
page 298), for detailed instructions.

Virtual Alarm
A virtual alarm allows you to derive a result from the status of one or more existing alarms. 
Any alarms — including other virtual alarms — can be combined together to form a new, 
higher-level virtual alarm. Since a virtual alarm can be composed of virtual alarms other 
than itself, there can be many levels of virtual alarms within a particular virtual alarm. At this 
time there is no limit to the number of levels that a virtual alarm can have. See Creating 
Virtual Alarms on page 179.

Note: If you choose to configure your multiviewer system with a large 
number of logical sources (i.e., more than 1500), you should disable global 
alarm contribution for all alarm levels in the sources table, to improve the 
system performance.

Notes 

• Do not include the reserved text GlobalAlarm in a virtual alarm name.

• Creating a virtual alarm that includes itself as a sub-alarm, directly or 
indirectly, creates a cyclical dependency. XEdit does not automatically 
check for this dependency. Your multiviewer will, however, perform cycle 
validation and will record an error in vroom.log if such a condition is 
detected.
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Sub-Alarm
A sub-alarm is an alarm that contributes to the status of a higher-level virtual alarm. The 
effect of a sub-alarm’s contribution is determined by the way in which the higher-level 
alarm is configured.

Alarm Monitor
Alarm monitors help you see the status of global and virtual alarms, but their use is not 
limited to this type of alarms. When any alarm level is assigned to an alarm monitor, the 
status of this alarm will be shown. When using the global alarm at the text label level, it will 
display the text value of the alarm, which is a readable name. See Configuring Alarm 
Monitors on page 295, for more information.

Simple Network Management Protocol (SNMP)
All multiviewers, except for the KMV-3901/3911 and Kaleido-XQUAD, support at least one 
SNMP agent, which is capable of sending SNMP traps to notify external SNMP managers of 
significant events. Within your multiviewer system, these significant events are reported as 
alarms (see Alarm on page 167).

Some text status data (e.g., AFD/WSS format, Dolby E or Dolby VANC encoded dialnorm or 
program config, etc.) only become available to SNMP managers once they have been 
displayed on the monitor wall. In the case of a Kaleido-IP multiviewer, the SNMP status for 
an alarm is only valid, if the corresponding source is monitored on the monitor wall.

SNMP traps
Setting up your multiviewer’s SNMP trap process involves the following actions:

• Identify the targets (SNMP managers) to which SNMP traps will be sent (see Identifying 
Target SNMP Managers on page 190).

• Choose the traps that will be sent to the selected SNMP managers (see Enabling SNMP 
Traps on page 192). Not available for Kaleido-IP.

Traps are automatically sent for all logical sources’ global alarms (see Global Alarms on 
page 170), and for virtual alarms (see Virtual Alarm on page 171). Each trap contains a 
cause, and the name of the logical source. Health-related traps for Kaleido-X, Kaleido-X16, 
Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X are also automatically sent. Kaleido-IP 
X100 and Kaleido-IP X300 multiviewers cannot send health-related SNMP traps. To send 
health-related traps, a Kaleido-IP X110 or Kaleido-IP X310 requires advanced server 
configuration, for which you might need assistance from Technical Support (see Contact 
Us, on page 551).

TIP
To make text status available to SNMP managers
1 In XEdit, add the text status element from the appropriate source signal to 

a logical source (channel).
2 Assign the logical source to a UMD.
3 Load the layout that includes this UMD on the monitor wall.
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MIB documents
Before you can use a network management system (NMS) to send SNMP requests (e.g., 
Get, GetNext, Set) to your multiviewer, and to process the multiviewer’s responses and 
traps, you need to download the appropriate MIBs from your multiviewer, and then load 
them into the NMS.

To obtain MIBs from your multiviewer, point your browser to the URLs indicated below.

Kaleido-X, Kaleido-X16, Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X

To manage these multiviewers (via port 161), or process any SNMP traps they might send, 
NMSs require both KALEIDO-KX-MIB, and MIRANDA-MIB.

• http://<your multiviewer’s IP address>/pub/KALEIDO-KX-MIB.mib
• http://<your multiviewer’s IP address>/pub/MIRANDA-MIB.mib

Kaleido-IP

To manage these multiviewers (via port 161), or process any SNMP traps they might send, 
NMSs require both KALEIDO-IP-MIB, and MIRANDA-MIB.

• http://<your multiviewer’s IP address>/pub/KALEIDO-IP-MIB.mib
• http://<your multiviewer’s IP address>/pub/MIRANDA-MIB.mib

In addition, health-related status information from a Kaleido-IP X310, or Kaleido-IP X110 
multiviewer is available via port 1161, for which your NMS will need the basebrd7_v5.mib 
MIB.

• http://<your multiviewer’s IP address>/pub/basebrd7_v5.mib

TIP 

Create virtual alarms based on health-related alarms from your Kaleido-IP to 
make this information automatically available to your target SNMP 
managers.

To make Kaleido-IP health-related status available to SNMP managers

1 Connect XEdit to the Kaleido-IP.

2 On the Tools menu, click New virtual alarm.

3 In Build Virtual Alarm, select your Kaleido-IP from the list in the left-hand 
part of the GSM alarm browser pane.

4 In the right-hand part of the alarm browser pane, expand the 
MULTIVIEWER OUTPUTS element to navigate to the health-related alarms 
you wish to monitor.

5 Proceed with the creation of the new virtual alarm (see Creating Virtual 
Alarms on page 179, for detailed instructions).

Note: The Kaleido-X software does not support the SNMP v2 GetBulk 
command. Performing a GetBulk on kxVideoTable returns “There is no 
such instance in this MIB” instead of the data for the table.
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Health-related status information from a Kaleido-IP X300, or Kaleido-IP X100 multiviewer 
is available via port 1161, for which your NMS will need the SUPERMICRO-HEALTH-MIB, and 
SUPERMICRO-SMI MIBs.

• http://<your multiviewer’s IP address>/pub/SUPERMICRO-HEALTH-MIB.my
• http://<your multiviewer’s IP address>/pub/SUPERMICRO-SMI.my

In the case of a Kaleido-IP, publishing signal/service probing alarms to SNMP managers is 
not fully supported. KALEIDO-IP-MIB is a subset of KALEIDO-KX-MIB. The Kaleido-IP can 
report service/signal status to an SNMP manager via the KALEIDO-IP-MIB file's 
kxVirtualAlarmTable. This table includes entries for all virtual alarms and logical sources 
created in XEdit for your multiviewer. For each logical source, the global alarm and 
associated text information is available. Refer to the MIB-embedded descriptions for 
exceptions.

Teletext, Subtitles, and Closed Captions
In the case of a Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, Kaleido-X, or Kaleido-X16 
multiviewer, teletext subtitling (compliant with WST, or SMPTE RDD 8 / Free TV Australia 
OP-47), NTSC closed captioning (CEA-608), and ATSC Digital Television Closed Captioning 
(CEA-708 DTVCC) can be displayed on the monitor wall, allowing visual monitoring of 
decoded text from an analog or SDI video source. Kaleido-X, and Kaleido-X16 multiviewers 
also support teletext subtitling compliant with SMPTE ST 2031. The lines of text extracted 
from the video source metadata are displayed within the corresponding video window.

The Kaleido-IP can monitor teletext and subtitling from DVB streams, and subtitling from 
SCTE 27 streams. The lines of text extracted from a DVB subtitling stream compliant with 
ETSI EN 300 743 V 1.2.1 (2002-10), or from a SCTE 27 subtitling stream can be displayed 
within the corresponding video window, or in a subtitling monitor. In the case of DVB 
teletext streams, the lines of text are displayed within the corresponding video window.

Teletext may comprise up to 799 pages of displayable data (numbered from page 100 to 
899). Teletext subtitles are decoded as described by the ETSI EN 300 472 V1.3.1 (2003-05) 
standard (for Kaleido-IP) or ETSI ETS 300 706 (for the other multiviewer models). The 
Kaleido-IP can decode up to eight pages from a DVB teletext stream, and monitor teletext, 
subtitle, and text presence for each of the selected pages. In the case of the Kaleido-X, 
Kaleido-X16, Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X, only one page can be 
decoded per video monitor and only one page can be decoded per video source, for 
monitoring purposes. However, these multiviewers can monitor the presence of up to four 
pages. Refer To Setting a Video Monitor’s Text Mode, on page 269, and Displaying Subtitles 
and Closed Caption Text, on page 46, for more information.

The CEA-708 standard supports legacy CEA-608 data. In the case of an HD-SDI source 
carrying both 708 captions and 608 legacy caption data, the multiviewer will display the 
708 captions, and automatically fall back to displaying the 608 captions only if the 708 data 
becomes unavailable.

TIP
If an iControl Application Server is available to your system, configure it to 
relay your Kaleido-IP alarm status information to the target devices. 
See General Status Manager (GSM) on page 167, and refer to iControl and 
SNMP in the iControl User Guide, for more information.
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In the case of a Kaleido-IP, when a video or subtitling monitor’s text mode is set to Auto 
sense, and the associated source carries more than one type of captioning, teletext or 
subtitling data, decoding precedence is a follows: DVB subtitling, SCTE 27 subtitling, DVB 
teletext (WST), CC (608). For example, DVB teletext is only decoded if there is no DVB 
subtitling, and no SCTE 27 subtitling available.

For the other multiviewer models, the following table shows which of captioning, teletext, 
or subtitling data is decoded by default for each supported video format, when a video 
monitor’s text mode is set to Auto sense: DTVCC (708), CC (608), teletext (RDD 8/OP-47, 
ST 2031, or WST).

Dolby E/AC-3 Metadata
In the case of a Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, Kaleido-X, or Kaleido-X16 
multiviewer, metadata contained in a Dolby E audio stream can be exposed on the monitor 
wall in text form. Dolby E and PCM audio levels can be displayed via audio monitors. The 
Kaleido-X, and Kaleido-X16 also support decoding of audio metadata embedded as 
ancillary data (VANC) compliant with SMPTE ST 2020-A, in the video stream.

• If multichannel audio (up to 8 channels) is coded in a Dolby E stream and transported 
over a single AES channel, metadata and audio levels are extracted from the Dolby E 
stream:

• in the case of Kaleido-X and Kaleido-X16, extraction is limited to two embedded 
audio sources, selectable

• Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X support extraction of Dolby E 
metadata from all 8 embedded audio source

• no ABT support
• VU and Peak meters (8 channels), for each source
• Program config, for each source
• Dialnorm for program 1, for each source

Video format Decoded data Video format Decoded data

SDI 525 CC (608) 1080i59.94 DTVCC (708)

SDI 625 Teletext 1080PsF23.98 N/A

NTSCa

a. All supported NTSC formats.

CC (608) 1080PsF24 N/A

PALb

b.All supported PAL formats.

Teletext 1080PsF25 Teletext

SECAM Teletext 1080PsF29.97 DTVCC (708)

720p24 N/A 1080p23.98 N/A

720p25 N/A 1080p24 N/A

720p29.97 DTVCC (708) 1080p25 N/A

720p50 Teletext 1080p29.97 DTVCC (708)

720p59.94 DTVCC (708) 1080p50 Teletext

1080i50 Teletext 1080p59.94 DTVCC (708)
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• If multichannel audio (up to 16 channels) is transported as regular AES channels (up 
to 8) in the SDI embedded audio, metadata is extracted from VANC packets:

• Program config
• Dialnorm for program 1
• VU and Peak meters come from the AES in PCM

Definitions

Audio Format
The format of each audio channel (PCM, Dolby AC-3, Dolby E, other or Unavailable) is 
reported as a text attribute, that can be assigned to a text level within a logical source.

Audio Metadata
The metadata extracted from the VANC and from the Dolby E is available as text in the XEdit 
hierarchical system list, and therefore can be exposed via any layout element capable of 
displaying text levels from logical sources (currently only UMDs).

Dialnorm is displayed as a numeric value between -31 and -1 dB. Program Config is 
displayed as the Dolby E Program Config description. Unavailable is displayed if the source 
is not being decoded, or is not Dolby E.

Logical Source Assignment
Logical source assignment is performed by dragging an AES pair onto a logical source’s 
audio level.

If the AES pair is calibrated as a Dolby E source, then the 8 channels are available to be 
displayed by an audio monitor. The channel displayed by the audio monitor depends on 
how the monitor was configured.

For Dolby VANC, if the audio monitor is set to Auto or Dolby VANC, the VANC metadata 
from the video of the assigned AES will be decoded. The audio monitor will have access to 
all amended audio peaks depending on VANC program configuration (regardless of which 
AES pair was assigned to the logical source).

Term Definition

Dolby E stream A coded (compressed) 8-channel digital stream that fits inside an AES 
channel (L/R)

Dolby E metadata Metadata such as dialnorm and program config extracted from a 
Dolby E stream. Includes audio level data from encoded audio data

VANC metadata Audio metadata extracted from SMPTE ST 2020-A VANC packets. 
Audio level data is probed directly from the PCM AES signal

Embedded audio 
source or channel

Any of the 8 SDI or HD-SDI embedded audio AES signals

AES signal or source A bitstream for audio service

Multichannel audio Audio service or essence composed of more than 2 channels of audio 
(more than Left and Right)
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Microphone Loudness Measurement
Kaleido-X and Kaleido-X16 multiviewers are capable of providing microphone loudness 
measurement as dynamic text values, for Audio Bridge Terminal (ABT) sources. Values are 
available for every ABT channel, and can be displayed in a UMD (or in an alarm status 
monitor), provided you configured logical sources with the appropriate text levels 
(see Configuring Dynamic UMD Text on page 293, for example). Support is limited to one 
ABT per multiviewer. Playout is assumed to be mono. The measurement is optimized for 
voice content. The values (in dBFS) are updated every second, and have a precision of 0.5 
dB.

SCTE 35 Digital Program Insertion (DPI) Signaling
The Kaleido-IP can monitor digital program insertion (DPI) signaling from SCTE 35 streams. 
It supports a splice break alarm, eight DTMF break alarms, and text information for logging 
purposes.

Bit Rate Measurement
The Kaleido-IP reports bit rate measurements as text values, for every type of elementary 
streams. Measurements are performed based on guidelines from ETSI TR 101 290. A 
188-byte packet format is assumed. (With the current version of the Kaleido-X software, bit 
rate values reported for streams encoded with a 204-byte packet format are therefore not 
accurate.)

Transport Stream Monitoring
The Kaleido-IP reports TR 101 290 first- and second-priority faults, as alarms and text values, 
for every type of transport streams. Measurements are performed based on guidelines from 
ETSI TR 101 290. Second-priority indicator 2.5 (PTS_error) is available for video and audio 

Note: Do not confuse the video bit rate (measured value) with the bit rate 
reported under Video encoder metadata (extracted information).

Measured bit rate

Encoded bit rate
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elementary streams, only. Second-priority indicator 2.4 (PCR_accuracy_error) is not 
available.

Detailed Directions

Managing Alarm Providers
To add alarm providers to your Kaleido-X system

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar.
A hierarchical list representing the current system appears.

2 Click the multiviewer whose alarm providers you wish to define.
3 In the Properties pane, click the Alarm providers list box.

4 Click the button that appeared at the end of the box to open the External Alarm 
Providers Configuration window.

5 In External Alarm Providers Configuration, review the alarm providers list, and then 
add or remove devices, as required.

Note: Text values are not persisted and should not be displayed in monitor 
wall layouts. They are suitable for logging purposes only.
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• To add a device to the providers list, select the device from the Host address list, or 
type the appropriate IP address in the box, and then click Add.

• To remove a device from the alarm providers list, select it, and then click Remove.

6 Once you have added all devices required for your purposes, click OK to close the 
window.

7 On the File menu, click Save.

Managing Virtual Alarms

Creating Virtual Alarms

To create a virtual alarm
1 Connect XEdit to the multiviewer (see Using XEdit Online on page 76).
2 On the Tools menu, click New virtual alarm.

Alternatively, after clicking the Actions tab, or while a text or alarm level is selected in 
the sources table you can:

• Right-click Virtual alarms in the filtered System list, point to Virtual alarm, and 
then click New.

Note: To qualify as an external alarm provider, an iControl application 
server must have its lookup service enabled. See External Alarm Provider on 
page 170.
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• Expand Virtual alarms in the filtered System list, right-click any existing virtual 
alarm, point to Virtual alarm, and then click New.

The Build Virtual Alarm window appears.

3 In the Status logic section, select one of the following three options:
Virtual alarm status is best status among selected alarms (AND) — Choose this 
option to have the contribution of the sub-alarms calculated using the optimistic 
version of the alarm logic tables.
Virtual alarm status is worst status among selected alarms (OR) — Choose this option 
to have the contribution of the sub-alarms calculated using the pessimistic version of 
the alarm logic tables. This is the most common option, since it brings changes in the 
status of any sub-alarms to the attention of the operators.
Virtual alarm status is critical if selected alarms differ (XOR) — Choose this option to 
have the contribution of the sub-alarms calculated using the XOR version of the alarm 

Alarm providers Alarm browser
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logic tables. This causes the virtual alarm to reflect whether or not all of its sub-alarms 
have the same status. If all sub-alarms are the same, the virtual alarm will be green. 
Otherwise, it will be red.
For a more detailed description of the difference between these options, refer to 
“Understanding the Alarm Logic Tables” in the iControl User Guide.

4 In the Text logic section, determine what to include in this virtual alarm’s text attribute 
by selecting one of the following three options:
Ignore texts — No text logic (default).
Concatenate texts — Concatenate the text attributes from all sub-alarms.
List errors — List the text attributes from the sub-alarms that are in error.

5 Select the alarm provider you wish to use from the list in the left-hand part of the GSM 
alarm browser pane.

6 In the right-hand part of the alarm browser, select the alarms that are to be sub-alarms 
of the new virtual alarm, and then click the large down arrow button to transfer them 
to the table in the bottom half of the window.

7 The table displays various details about the sub-alarms you have selected, including 
their contribution, which defines how a sub-alarm will pass its status on to the virtual 
alarm. The default contribution value is Passthrough, which means the sub-alarm will 
pass its status unaltered to the overall calculation of the virtual alarm.
It is possible to override the error status of sub-alarms when they are triggered. This is 
useful when, for example, a device is only able to report a status of either normal 
(green) or error (red), but you want the error condition to be considered as minor 
(yellow) in the virtual alarm calculation. To change a sub-alarm’s contribution, click in 
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the Contribution column, and then select the status you want the virtual alarm to use 
when an error occurs.

For example, if a sub-alarm goes from green to orange or red, but the selected 
contribution is yellow, the virtual alarm will “see” yellow (the virtual alarm’s overall 
status may still depend on other sub-alarms).
The Invert contribution allows performing a logical “NOT” calculation on sub-alarms. 
This feature can be used, for example, to report alarms from GPI inputs. It can also be 
used to handle cases where an error is expected, and not seeing an error is a sign that 
something probably went wrong. The table below describes the result of inverting sub-
alarms:

Selecting the Faults only contribution causes a sub-alarm to be mapped to NORMAL 
unless it is in one of the fault statuses—usually CRITICAL, MAJOR, and MINOR. Refer to 
the iControl User Guide for more information.

8 Repeat from step 5, until you have added all the required sub-alarms.
9 Specify a name for the new virtual alarm in the Name box.

10 Adjust the default path, if you wish, so that alarms be grouped in the desired way.

Sub-alarm status Inverted contribution

NORMAL ERROR

MINOR NORMAL

MAJOR NORMAL

CRITICAL NORMAL

NON-EXISTENT NON-EXISTENT

PENDING PENDING

DISABLED DISABLED

UNKNOWN UNKNOWN

Note: If the sub-alarm’s fault condition is cleared, its contribution will 
always be green (NORMAL), unless the value specified in the Contribution 
column is black (DISABLED).

Note: Do not include the reserved text GlobalAlarm in a virtual alarm name.
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11 Configure logging behavior as required (see Alarm Logging on page 168):
• If you wish to disable logging for this virtual alarm, then select Not logged.
• If you wish to have occurrences of this virtual alarm logged as incidents, select This 

virtual alarm is an incident template. Refer to the iControl User Guide for more 
information.

• To add relevant information for your logging purposes, click Edit metadata.
The Virtual Alarm Metadata window appears.

The information you provide for this virtual alarm can be used to sort and locate 
events and incidents in the iControl log viewers. For example, a meaningful Source 
ID may help you distinguish this virtual alarm’s sub-alarms from other alarms. Click 
OK to close the window.

12 Click OK.
The Build Virtual Alarm window closes and the newly created alarm appears at the 
specified path, under Virtual alarms, in your multiviewer’s filtered System list (e.g., 
when a text or alarm level is selected in the sources table).

If the multiviewer’s IP address was added to an iControl applications server’s Service 
and alarm discovery table1 you will also be able to manage your multiviewer’s virtual 
alarms from the multiviewer’s GSM, by using the iControl GSM alarm browser.
183



Configuring Alarms
Managing Virtual Alarms
Modifying Virtual Alarms

To modify a virtual alarm
1 In the sources table, select a text or alarm level.

Alternatively, click the Actions tab.
2 Expand the filtered System list, and navigate to the virtual alarm you wish to modify.
3 Right-click the alarm, point to Virtual alarm, and then click Edit.

The Build Virtual Alarm window appears.

1.To access the iControl Lookup locations page, where you can review and update the Service and alarm 
discovery table, click System tools on the Startup page, and then click Edit service locations.
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4 Modify your virtual alarm, by adding or removing sub-alarms, changing their 
contribution, the alarm name or path, etc. Refer to Creating Virtual Alarms, on 
page 179, as needed. For example:

• after selecting the sub-alarms you wish to remove from the table in the bottom half 
of the window, click the large up arrow button.

• after selecting the appropriate alarm provider from the list in the left-hand part of 
the GSM alarm browser pane, select the sub-alarms you wish to add, from the 
right-hand part of the alarm browser, and then click the large down arrow button 
to transfer them to the table in the bottom half of the window.

5 Once you have completed your changes, click OK to close the Build Virtual Alarm 
window.

Deleting Virtual Alarms

To delete a virtual alarm
1 In the sources table, select a text or alarm level.

Alternatively, click the Actions tab.
2 Expand the filtered System list, and navigate to the virtual alarm you wish to delete.
3 Right-click the alarm, point to Virtual alarm, and then click Delete.
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XEdit prompts you to confirm.

4 Click Yes to proceed.
The selected virtual alarm is removed from your configuration.

Managing Alarm Logging

Adding a GSM log plug-in

To add a log plug-in to your multiviewer’s GSM
1 Make sure your multiviewer is specified as a lookup server in the iControl application 

server’s configuration. See Specifying your multiviewer as a lookup server for iControl, 
below.

2 Open iC Navigator (refer to Starting iC Navigator, in the iControl User Guide, if needed).
3 On the View menu, click General status managers.

The General Status Managers window appears.
4 In the left pane, click your multiviewer’s GSM.
5 In the main pane, click the Admin tab, and then click Actions on the second-level tab 

bar.
186



Kaleido-X
User’s Manual
6 Click Add global.
The New Action window appears.

7 Click Event and Incident log, and then click New.
The Event and Incident Log Configuration window appears.

8 In Host name (or IP address), type the iControl application server’s IP address.
9 Under Advanced options, clear Enable incident log.

10 Click OK.
Your new log plug-in appears under Global actions.
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11 Close General Status Managers.
In iControl Navigator, you may now open Event Log Viewer, and search the application 
server’s event log database for any relevant alarm information logged by your 
multiviewer. Refer to the iControl User Guide for more information.

Specifying your multiviewer as a lookup server for iControl

To specify your multiviewer as a lookup server for iControl
1 Open a Web browser window, and enter the IP address or host name of the iControl 

application server whose event log you wish to use, in the address bar.
iControl’s Startup page appears.

2 Click iControl admin.
3 If the iControl admin login page appears, type the appropriate user name and 

password, and then click Log In.
The iControl admin page appears.

4 Click Lookup locations.
188



Kaleido-X
User’s Manual
The Lookup location page appears.
5 In the Service and alarm discovery area, type your multiviewer’s IP address, and then 

click Add lookup.

Your multiviewer’s IP address appears as a lookup entry, at the bottom of the Service 
and alarm discovery area.

Enabling logging for a native alarm

To allow an alarm to be logged to the GSM log plug-in configured for this system
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 Expand the multiviewer whose alarms you wish to log, navigate to the appropriate 
alarm, and then click the alarm to select it.

Lookup
locations
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3 In the Properties pane, select the Logging enabled check box to have the multiviewer 
publish this alarm to the application server’s log, each time this alarm is triggered.

4 Click Apply to all if you wish to apply this setting to all other alarms with the same name, 
throughout the system.
In the example, clicking Apply to all will enable logging for the Video Loss alarm on 
every multiviewer input in your system.

5 Repeat the procedure until logging is enabled for all desired alarms.
6 On the File menu, click Save.

Disabling logging for a virtual alarm

To prevent a virtual alarm from being logged to the GSM log plug-in
1 In the sources table, select a text or alarm level.

Alternatively, click the Actions tab.
2 Expand the filtered System list, and navigate to the virtual alarm you wish to modify.
3 Right-click the alarm, point to Virtual alarm, and then click Edit.

The Build Virtual Alarm window appears.
4 In the bottom area of the window, select Not logged.
5 Click OK to close the Build Virtual Alarm window.

Publishing Alarms to SNMP Managers

Identifying Target SNMP Managers

Note: This section does not apply to the KMV-3901/3911 and 
Kaleido-XQUAD multiviewer models, which do not support an SNMP agent.
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To identify the target SNMP managers
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 Click the multiviewer whose SNMP trap targets you wish to identify.
3 If your target SNMP managers filter traps based on a specific community string, then 

the Properties pane, click the Community box (which contains “public” by default), 
and type the appropriate string.

4 Click the Trap targets box.

5 Click the button that appeared at the end of the box 
to open the SNMP Configuration window.
The trap targets list shows all trap targets currently 
identified for the selected multiviewer.
SNMP Managers that are trap targets for this 
multiviewer are identified by their host address and 
port number.

6 Add, remove, or modify trap targets as needed, and 
then click OK to confirm and apply the changes, or 
click Cancel to close the SNMP Configuration 
window without saving your changes to the trap targets list.

To add a trap target to the list
1 In the Host address box, type the IP address of the device that has the target SNMP 

manager.
2 In the Port box, type the port number through which the SNMP manager will be 

accessed.
3 Click Add.

The new trap target is added to the list.
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To modify an existing trap target
1 Click the trap target you wish to modify in the list.

It becomes highlighted and its host address and port 
number appear in the data boxes, and the Edit button 
is available.

2 Type new or revised data in the data boxes.
3 Click Edit.

The revised data appears in the target list.

To remove a trap target from the list
1 Click the trap target you wish to remove in the list.

It becomes highlighted and its host address and port number appear in the data boxes.
2 Click Delete.

The trap target is removed from the list.

Enabling SNMP Traps

To choose the traps that will be sent to the selected trap targets for this system
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 Expand the multiviewer whose traps you wish to enable, navigate to the appropriate 
alarm, and then click the alarm to select it.

TIP
The host address and port number remain in the data boxes. Hence the trap 
target can easily be added back to the list, by clicking Add, if it was removed 
in error.

Notes 

• This section applies to Kaleido-X, Kaleido-X16, Kaleido-MX, Kaleido-MX 4K, 
and Kaleido-Modular-X multiviewers, only.

• Kaleido-X: Traps for individual physical inputs are disabled by default. 
These traps only provide physical input information, with no correlation to 
a logical source. Enabling a large number of SNMP traps can degrade the 
performance of a Kaleido-X multiviewer system. If you must monitor a 
large number of traps, then avoid setting the related alarm thresholds to 
short durations—for example, 1 second for a freeze detection is too low; 
10 seconds is adequate (see Alarm Debouncing on page 128).
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3 In the Properties pane, select the Trap enabled check box to have the multiviewer 
issue an SNMP trap each time this alarm is triggered.

4 Click Apply to all to apply this setting to all other alarms with the same name, 
throughout the system.
In the example, clicking Apply to all will enable Video Loss SNMP traps for every input 
in your system. This is particularly useful for audio input errors, because of the large 
number of channels arriving at the multiviewer.

5 Repeat the procedure until all desired SNMP traps have been enabled.
6 On the File menu, click Save.
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This chapter explain how to configure logical sources for your multiviewer system.

Key Concepts

Term Description

Logical source A logical source (called a channel, in earlier versions of the Kaleido-X 
software user interface, and related documentation) refers to a group of 
physical audio, video, or metadata sources, and text attributes. A logical 
source can be used as a whole, and assigned to a virtual monitor. The 
Kaleido-X software supports 7000 logical sources.
Notes
• The KMV-3901/3911, Kaleido-MX, Kaleido-MX 4K, and 

Kaleido-Modular-X do not yet support more than 1500 logical sources.
• Kaleido-IP X310 and Kaleido-IP X110 multiviewers support 6000 logical 

sources. In the case of the Kaleido-IP X300, to support more than 
1500 sources, the multiviewer’s RAM must be upgraded to 24 GB. Refer 
to the “Kaleido-IP X300 Memory Modules” section, in the Kaleido-X 
Release Notes, for installation instructions. The Kaleido-IP X100 is 
limited to 1500 sources.

• If you choose to configure your multiviewer system with a large 
number of logical sources (i.e., more than 1500), you should disable 
global alarm contribution for all alarm levels in the sources table 
(see Global Alarms on page 170), to improve the system performance.

Level Within a logical source, attributes are organized by levels belonging to 
either of the following categories: Source info, Video, Audio, Text, Alarm, 
Time code, and Color. For example, the video level category may 
comprise multiple levels, each representing a specific physical part of a 
video signal.

Incremental copy Once a logical source (channel) is configured, it is possible to use 
incremental copy to automatically propagate appropriate physical 
assignments to other adjacent logical sources. For instance, if the current 
logical source’s levels are assigned from Video 1, then the incremental 
copy tool will automatically assign corresponding physical elements 
from Video 2 to the next logical source’s levels, and so on. Alternatively, if 
only one or a few specific levels are to be similarly configured, it is 
possible to use incremental copy on the corresponding level column 
only.

Incremental copy 
handle

In the sources table, the incremental copy handle is indicated by a small 
square  at the bottom right of the selected cell.
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Detailed Directions

Creating and Configuring Logical Sources
When opening XEdit in offline mode, the initial database is populated with the default 
configuration for a Kaleido-X (7RU) system, including a fully-populated frame (all cards 
present) and a set of predefined logical sources. The KX Router logical router is also created 
as a 96 × 80 router where the 96 inputs are the multiviewer’s logical sources, the first 48 
outputs are those from the two router cards, and the last 32 outputs are monitor wall 
destinations.

Likewise, when you replace the initial Kaleido-X (7RU) with the appropriate multiviewer 
model that matches your actual system, you can choose to have your local database 
populated with a default set of logical sources and a preconfigured KX Router logical router.

Automatically Adding Logical Sources
A set of logical sources based on external video router sources or on multiviewer inputs can 
be added to the sources table, as a single operation, by clicking Create logical sources on 
the menu that appears when you right-click supported elements in the filtered system list. 
From the same menu, you can also enable automatic sources creation, which means that 
the logical sources associated with the selected element will be kept in sync with the 
corresponding external sources. For example, when sources are added or modified in a 
router’s own configuration environment, logical sources will be added or updated 
automatically in the multiviewer’s sources table.

Alternatively, in the case of a Kaleido-IP, a set of logical sources is also automatically created 
if you import the stream lineup from a spreadsheet file (see Importing a stream lineup on 
page 96).

This section explains how to add logical sources for transport stream sources in the context 
of a Kaleido-IP multiviewer system. The same procedure applies to all types of multiviewer 
inputs, including inputs from upstream routers.

To define logical sources for a transport stream
1 In the main window, click the Channels/Sources tab.

2 In the Tools pane, expand the multiviewer, and navigate to the transport stream for 
which you wish to define logical sources.

3 Right-click the transport stream, and then click Create logical sources on the menu.
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Logical sources are automatically created for every program signal found in the 
selected transport stream.

4 Repeat until you have added logical sources for every stream you wish to monitor.
5 If your system involves a control panel from which you will control your multiviewer as 

a router, then configure source numbers for the KX Router logical router, by typing the 
appropriate numbers in the first column (#) under Source info, and using the 
incremental copy tool as needed.

6 On the File menu, click Save.

Managing Logical Sources Associated with Programs in a Transport Stream
In the case of a Kaleido-IP system, you may need to add or remove sources, from time to 
time, when programs are added or removed from a transport stream.

Adding logical sources for new programs in a transport stream

To add a logical source for a new program in a transport stream
1 Connect XEdit to the Kaleido-IP (see Using XEdit Online on page 76), and then click the 

Channels/Sources tab.

Notes
• Under Source info, dynamic and static names resulting from the Name 

level assignments are limited to 48 characters and automatically 
truncated as needed.

• In the case of a Kaleido-IP system, do not select Activate automatic 
sources creation.

• If the case of router sources, if the router is subject to frequent dimension 
changes, then you may want to select Activate automatic sources 
creation.
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2 In the Tools pane, navigate to the transport stream that includes the new program.
3 Right-click the program, and then click Create logical sources on the menu.

A new entry appears in the sources table, with all assignments based on the logical 
source template (see Defining Physical Assignments on page 203).

4 On the File menu, click Save.

Removing logical sources for removed programs in a transport stream

To remove logical sources associated with programs that are not present anymore
1 Connect XEdit to the Kaleido-IP (see Using XEdit Online on page 76) and then click the 

Channels/Sources tab.
Logical sources associated with programs that have been removed from a transport 
stream will have elements marked in red.

2 Select these sources (using the standard Shift+click or Ctrl+click keyboard shortcuts to 
extend your selection as needed).

3 Right-click the selection, and then click Delete selected sources on the menu.

Note: Under Source info, dynamic and static names resulting from the 
Name level assignments are limited to 48 characters and automatically 
truncated as needed.
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4 On the File menu, click Save.
5 Click the Layouts tab, open the appropriate layouts, locate any monitors that included 

assignments based on the sources you just deleted, and update their configuration as 
required (see Assigning Logical Sources or Monitor Wall Destinations to Monitors on 
page 252).

Manually adding a Logical Source

To add a logical source
1 Click the Channels/Sources tab in the main window.

The sources table appears.

Note: The sources table is preconfigured with a set of default assignments, 
including at least one level under each level category. A symbol indicates 
the physical source for each assignment: for example, “A16” indicates input 
signal 16 on input card A. In the case of an expansion system, the symbol is 
prefixed with a frame identifier: either “FRA-” or “FRB-”. On the Kaleido-X16, 
only the input numbers 01 to 16 appear. On a KMV-3901/3911, the input 
numbers 1 to 8 (or 1 to 4, in the case of the 4 × 1 and 4 × 2 models) appear.
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2 On the File menu, click New.
Alternatively right-click the Channels/Sources column heading, and then click Add 
source on the menu.

A logical source is added at the bottom of the sources table.

3 On the File menu, click Save.
The sources table is saved.

Managing Levels

Adding a level

Notes
• Under Source info, you can change the logical source name and path, 

resulting from the Name and Cat. level assignments. For example, 
“Channel 1” can be renamed “Cam 1” or assigned a dynamic name. You 
can group related logical sources together, by adding static or dynamic 
text elements to the Cat. level, and then sorting the table as needed, to 
suit your purposes (see Sorting the Sources Table on page 208). You can 
also apply a filter to the table, so that sources that do not match the filter 
be hidden from view (see Filtering the Sources Table on page 208).

• When a logical source’s name or category changes, the row header is 
updated accordingly.

• When applying an overall incremental copy (from the row header), the 
Source info columns and the Video levels are excluded. These columns 
must be incremented individually. The overall incremental copy features 
relies on a video level having been populated first.

Note: To be able to monitor a 3D stereoscopic signal, you must first add a 
second video level to your logical sources (so you have a level for each eye), 
and then for each video monitor or composite you wish to use for 
3D monitoring, you must assign the left-eye and right-eye levels.
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To add a level
1 Click the Channels/Sources tab in the main window.

The level categories Video, Audio, Text, Alarm, Time code, and Color appear as main 
column headings in the sources table.

2 Right-click the appropriate level category, and then click Add level on the menu.

A new level appears under the selected category.

3 If you wish to change the level name, click the level header, and then, in the Properties 
pane, type the new name in the Level name box.
In the case of an alarm level, you may also set its contribution to your system’s global 
alarms. See Configuring an alarm level’s contribution below.

4 On the File menu, click Save.
The sources table is saved.

Configuring an alarm level’s contribution

You can select which alarm levels contribute to the global alarm associated with every 
logical source (see Global Alarms on page 170), and rank their individual contribution.

To configure an alarm level’s contribution to your system’s global alarms
• In the sources table, click the column header for the level you wish to configure.

The Properties pane shows the name of the selected alarm level, and its current 
contribution settings.

Level
categories

Add level
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• If you wish to exclude alarms in this level from the global alarm calculation, then 
clear the Include in global alarm check box.

• To rank this level’s contribution to your system’s global alarms, click the Global 
alarm contribution box, and then select the appropriate value from the list.

• Passthrough: This is the default value. Alarms in this level will pass their status 
unaltered to the global alarms.

• Critical, Major, Minor, Disabled: It is possible to override the error status of 
alarms when they are triggered. This is useful when, for example, a device is 
only able to report a status of either normal or error, but you want the error 
condition to be considered as minor in the global alarm calculation.

• Invert: Alarms in this level will pass the opposite of their status to the global 
alarms. This can be used, for example, to report alarms from GPI inputs, or to 
handle cases where an error is expected, and not seeing an error is a sign that 
something probably went wrong. The table below describes the result of 
inverting sub-alarms:

Alarm status Inverted contribution

NORMAL ERROR

MINOR NORMAL

MAJOR NORMAL

CRITICAL NORMAL

NON-EXISTENT NON-EXISTENT

PENDING PENDING

Selected alarm level
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• Faults only: Alarms in this level will be mapped to normal unless their status is 
one of the fault statuses—usually critical, major, and minor.2

Defining Physical Assignments
Once you have created a logical source, you must make the physical assignments. This is 
required before you can create a layout.

To make the physical assignments for a logical source
1 In the sources table, click the cell that corresponds to the level you wish to define for 

this logical source.
2 In the Tools pane, expand the filtered System list, and then drag the appropriate 

element from the list, to the selected level in the sources table.
For a typical logical source, you will normally start by making a video assignment, set 
the appropriate category and source ID (under Source info) if you wish to control your 
multiviewer system as a router, and then proceed with the audio, text, alarm, time code, 
and color levels. See, for example, Configuring text level assignments, on page 204, 
Configuring alarm level assignments, on page 204, Configuring logical sources based 
on external alarm providers, on page 205, and Configuring color level assignments, on 
page 206.

Sources table with a selected cell in the Video level category for Channel1

3 Repeat the procedure until all desired physical assignments are completed for this 
logical source.

4 If you wish to be able to use this logical source as a template, right-click the source 
header and then click Set source as template on the menu.

DISABLED DISABLED

UNKNOWN UNKNOWN

2.The list of fault status can be modified by scripting.

Note: Under Source info, dynamic and static names resulting from the 
Name level assignments are limited to 48 characters and automatically 
truncated as needed.

Alarm status Inverted contribution
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Once you have added the required number of logical sources, and made appropriate 
video assignments, you will be able to populate remaining levels in a single operation 
by applying the template. If you have enabled automatic sources creation for an 
external router, then automatically-created logical sources will be based on the 
template.

Configuring text level assignments

To assign a text element to a logical source’s text level
1 Click the Channels/Sources tab in the main window.
2 In the sources table, click the cell that corresponds to the logical source and text level 

you wish to configure.
3 Expand the filtered System list in the Tools pane, locate the text element, and then drag 

it onto the selected cell in the sources table.

4 On the File menu, click Save.
The sources table is saved.

Configuring alarm level assignments

To assign an alarm to a logical source’s alarm level
1 Click the Channels/Sources tab in the main window.
2 In the sources table, click the cell that corresponds to the logical source and alarm level 

you wish to configure.

Note: Under Source info, dynamic and static names resulting from the 
Name level assignments are limited to 48 characters and automatically 
truncated as needed.
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3 Expand the filtered System list in the Tools pane, locate the alarm, and drag it onto the 
selected cell in the sources table.

4 On the File menu, click Save.
The sources table is saved.

Configuring logical sources based on external alarm providers

To have access to alarms and text elements from an external alarm provider, you must have 
specified this provider in your multiviewer system configuration (see Managing Alarm 
Providers on page 178).

To assign an alarm or a text element from an external provider
1 Open a GSM alarm browser associated with the alarm provider you wish to use.

For example, after opening iControl Navigator, click General status managers on the 
View menu. Refer to the iControl User Guide for more information.

2 In XEdit, click the Channels/Sources tab in the main window.
3 In the GSM alarm browser, navigate to the element you wish to assign, and then drag it 

onto the cell that corresponds to the alarm or text level you wish to configure in the 
sources table.
In the selected cell, the prefix “EXT” indicates that the assignment is from an external 
source and is followed with information such as the device class and a name.
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4 On the File menu, click Save.
The sources table is saved.

Configuring color level assignments

You may configure sources with color levels so that you can distinguish them at a glance on 
the monitor wall. For example, your sources could have three color levels: one that you 
would apply to a monitor’s border color, one to a UMD’s background, and one to the UMD 
text.

To configure a logical source’s color levels
1 Click the Channels/Sources tab in the main window.
2 In the sources table, double-click the cell that corresponds to the logical source and 

color level you wish to configure.
The color picker window opens.

3 In Colors, click the tab that corresponds to the color space you wish to use, and then 
choose the color that will be associated with the selected source and color level.

Notes
• You can select multiple elements in the GSM alarm browser (by pressing 

Shift+click or Ctrl+click as needed) and assign them to consecutive logical 
sources at once, by dragging the multiple selection to the appropriate 
level for the first logical source you wish to configure. The elements are 
inserted in the same order you selected them.

• Drag an alarm folder to an alarm level to monitor the folder’s status. 
Dragging an alarm folder to a text level is not supported.

• GSM alarms are not available as triggers for background actions 
(see Creating Background Actions on page 327).

• Incremental copy is not supported in the case of assignments from 
external providers (see Making Further Assignments by Incremental Copy 
on page 207).
206



Kaleido-X
User’s Manual
4 Click OK to close the color picker window.
The color you chose appears in the sources table.

5 Repeat from step 2 until you have configured all color levels for this source.
6 On the File menu, click Save.

The sources table is saved.

Making Further Assignments by Incremental Copy
Once done with a first logical source, if the next logical source is to be similar to the first 
one, it is possible to use incremental copy to automatically create it. Alternatively, if only 
one or a few specific levels are to be similarly configured, it is possible to use incremental 
copy on the corresponding level column only.

To use the incremental copy tool to propagate physical assignments to adjacent logical 
sources

1 Click the row header for the logical source whose assignments you wish to propagate.
A small square, the incremental copy handle, appears in the bottom right corner of the 
header cell.

2 Move the pointer to the incremental copy handle. The pointer changes to crosshairs.

3 Click and drag to propagate the selected logical source’s physical assignments to the 
next logical sources’ levels.
The source cells are highlighted with a green border and the target cells with a red 
border.

Note: Color levels are not subject to incremental copy.

Incremental copy handle
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4 Release the mouse button once you have reached the last logical source to be 
configured.
The level cells are now populated with “incremented” physical assignments.

Sorting the Sources Table

To sort the sources table
• Right-click the heading of the column you wish to sort by (i.e., either Source ID, or any 

of the level headings), and then click Sort on the menu.

The sources table is sorted, based on the elements in the selected level.

Filtering the Sources Table

To filter the sources table
• Type in the Cat./Name filter box, located above the sources table.

Note: It is possible to drag the incremental copy handle up, or down. The 
physical assignments will be decremented or incremented accordingly.

Cat./Name
filter
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Logical sources with categories and names that do not match the text or regular 
expression are hidden as you type.

Resizing the Sources Table’s Columns

To resize a column manually
• In the category or level heading row, point the column boundary you wish to move 

until the pointer becomes a resize pointer ( ), and then drag the boundary until the 
column is the desired width.

To resize a column to the width of its content
• In the category or level heading row, point either boundary for the column you wish to 

resize to fit, until the pointer becomes a resize pointer ( ), and then double-click.
The column width is adjusted to fit the content.

To resize all columns to the width of their content
• In the category or level heading row, point any column boundary until the pointer 

becomes a resize pointer ( ), and then triple-click.
All columns are resized to fit their content.

Notes 

• The filter is not applied to new logical sources that have yet to be saved. 
They will remain visible, until you saved the sources table.

• It is always possible to apply the template source to other logical sources, 
even when this specific source is hidden.

• Apply template to all sources affects all logical sources, regardless of 
filtering.

• The incremental copy tool affects visible sources only.

Note: If there are more than 250 rows in the sources tables, when you 
double- or triple-click, the columns are adjusted to fit the content of the 
currently visible rows only.

Filter text

Example: Type “input f” 
to view only the sources 
that belong to Input F.
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Monitoring Internal-Router Outputs on the Monitor Wall (Sample Scenario)
It is possible, for specific monitoring purposes, to configure a video monitor so that it 
displays the current signal at a physical output from the multiviewer's internal router, by 
assigning this router output to a logical source’s video level.

To configure a monitor to follow an internal-router output on the monitor wall
1 Click the Channels/Sources tab in the main window.
2 Add a logical source to the table (see Manually adding a Logical Source, on page 199).
3 In the new logical source row, click the cell that corresponds to the first video level.
4 Expand the filtered System list in the Tools pane, locate the router output you wish to 

monitor, and then drag it onto the selected cell in the sources table.
5 On the File menu, click Save. 

The sources table is saved.
6 Click the Layouts tab, and open the appropriate layout.
7 From the Channel/Sources list in the Tools pane, drag the new logical source onto the 

monitor you wish to configure, and then save the layout.

Once such a logical source is available, you can also assign it to other composite or 
video monitors, directly on the monitor wall, and their video window will dynamically 
follow the video signal sent to that router output.

Note: The current version of the Kaleido-X software does not support 
monitoring of the associated audio signal.
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This section describes Kaleido-X rooms and their configuration.

Key Concepts

Detailed Directions

Managing Rooms
In XEdit, a room represents a grouping of displays on the monitor wall driven by your 
Kaleido-X system. When creating a room, you add displays, and assign each of them an 
output head. You can also define full screen zones. To configure a 4K UHD room, see 
Creating a 4K UHD Room, on page 212; otherwise, proceed with Creating a Room, on 
page 212.

Term Description

Room A room is a visual grouping of displays that represent the physical 
displays positioned and sized as they are installed in an actual room. 
Multiple operators can share the same room. The grouping of display 
creates a large virtual monitor wall that operators see as a single large 
display. The room definition specifies display resolutions and sizes, as 
well as zones that are used to display full screen layouts.

Display versus 
monitor

Within the XEdit workflow, a display refers to the representation of a 
physical display monitor (such as a CRT) within a room, whereas a 
monitor represents a physical signal within a layout: for example, a video 
monitor displaying a specific video signal.

Full screen zone A full screen zone is a sub-section of a room. It can be any size and it can 
be positioned on any of the displays in the room. A full screen zone can 
be associated with one or more full screen layouts assigned to specific 
users.

Display library A display library contains a collection of predefined displays that can be 
conveniently reused to configure your system’s rooms. More than one 
display library can exist.

Note: In the case of a cluster system, it is possible to view a room 
configuration in offline mode. However, to create and configure a room, 
XEdit must be connected to one of the cluster members (see Using XEdit 
Online on page 76).
 211



Setting Up Rooms
Managing Rooms
Creating a Room

To create a room
1 Click the Rooms tab in the main window.
2 On the File menu, click New.

An empty room with a black background appears in the main window.
3 Add the appropriate number of displays, and configure them to match your actual 

installation. See Adding Displays, on page 215, and Configuring Displays, on page 219.
4 Optionally add full screen zones (see Adding Full Screen Zones on page 218).
5 On the File menu, click Save.

The Save Room window appears.

6 Type a name for the new room, and then click Save.

Creating a 4K UHD Room
Whether your Kaleido-MX, or Kaleido-Modular-X is to feed 4K UHD output to four 1080p 
borderless displays, or to a single quad link 4K UHD display, the room you configure in XEdit 
requires four output heads assigned to four 1080p displays: one for each quadrant. The 
same requirement applies to Kaleido-MX 4K systems as well.

Notes
• A room name cannot exceed 7 characters.
• A room can only be saved once every display has been assigned an output 

head (see Adding Displays on page 215).
• In a cluster system, each room must have a unique name across the whole 

system. XEdit will not let you use a name if there is already a room with this 
name associated with one of the multiviewers within the cluster.

• In a cluster system, if one of the member multiviewers becomes 
unavailable while you were configuring a room, then XEdit will not let you 
save the room. If you wish to save the room anyway, first remove any 
unavailable multiviewer from the cluster.

Notes 

• 4K UHD rooms do not support rotated displays.
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To create a 4K UHD room
1 Click the Rooms tab in the main window.
2 On the File menu, click New.

An empty room with a black background appears in the main window.
3 Add four displays, and assign your system’s four output heads as illustrated below.

See Adding Displays on page 215, for more information.

4 Make sure all four displays are configured with the same 1080p output resolution (see 
Changing Room Display Resolutions, on page 225, and Configuring the SDI Monitoring 
Output Format, on page 225).

5 Position the four displays as a tight 2 × 2 grid, using the Remove horizontal space, 
Remove vertical space, and the appropriate Align toolbar buttons as needed, to make 
sure there is no gap between the displays (see also: Changing a Display’s Position, on 

• On the monitor wall, you may notice a lack of fluidity in the mouse pointer 
movement at the junctions between quadrants.

• If you are configuring this room for a single quad link 4K UHD display, you 
may want to disable the dashboard for the displays associated with the 
top-left, top-right and bottom-left quadrants in XEdit, and leave it enabled 
for the display associated with the bottom-right quadrant only 
(see Disabling the Dashboard on page 227).

Top left OUTPUT A, Head 1 Top right OUTPUT B, Head 1

Bottom left OUTPUT A, Head 2 Bottom right OUTPUT B, Head 2

Note: A seamless output is only supported at the SDI monitoring outputs, 
which must be configured for a progressive scan format. If you connect a 
4K UHD monitor to the multiviewer’s HDMI outputs instead, you might 
notice a discontinuity in the image at the junctions between the quadrants.

Notes (continued)
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page 229).
6 On the File menu, click Save.

The Save Room window appears.
7 Type a name for the new room (maximum 7 characters), and then click Save.

Opening Rooms

To open an existing room
1 Click the Rooms tab in the main window.
2 On the File menu, click Open.

The Open Room window appears.

3 Select the room you wish to open, and then click Open.
The selected room appears in the Rooms tab.
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Closing Rooms

To close a room
• On the File menu, click Close. Alternatively, click the Close button  on the toolbar.

Deleting Rooms
Before deleting a room, make sure there are no layouts left for that room in your system 
configuration. If there are still layouts for this room, then XEdit will issue an error message 
and prevent you from deleting the room. See Deleting Layouts on page 249.

To delete a room
1 Open the room you wish to delete (see Opening Rooms on page 214).
2 On the File menu, click Delete. Alternatively, click the Delete button  on the toolbar.

The system prompts you to confirm.

3 Click Yes to proceed.
The room is removed from your system configuration.

Adding Displays

To add a display to a room
1 Select a display from the display library and drag it onto the room area.

Alternatively, click the Display button  on the toolbar, and then click the room area to 
add a custom display.

Notes 

• When you have more than one room open, you can switch from one to 
another by clicking the tabs at the bottom of the window.

• In the case of a cluster system, it is possible to view a room configuration 
in offline mode, but any changes must be made in online mode.
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2 Expand the filtered System list in the Tools pane, and then drag the appropriate output 
head onto a display in the Rooms tab.

The name of the output head is indicated on the display. In the case of a 
Kaleido-X (4RU) or Kaleido-X (7RU), the card slot is also indicated. In the case of a cluster 
system, the name of the originating multiviewer also appears.

Note: All currently open display libraries appear on the Tools pane. Custom 
display libraries are stored separately from the XEdit workspace. 
See Managing Display Libraries on page 230 for details.

Filtered Display Room Selected
selected displaySystem list library area display
Properties of the
216



Kaleido-X
User’s Manual
One output head cannot be assigned to more than one display at a time. When 
different displays are assigned the same output head, if the displays are part of the 
same room, then XEdit will issue an error message and prevent you from saving the 
room until the head assignment is corrected.
However, to facilitate room management — for example, in a cluster system where 
rooms and layouts have been created based on configurations from earlier standalone 
systems — XEdit will let you assign the same head to displays that are located in 
different rooms, but such conflicting assignments will be marked in red in the filtered 
System list displayed in the Tools pane, and should be resolved by removing a 
conflicting display (see Removing Displays on page 218), or by deleting the conflicting 
room (see Deleting Rooms on page 215).

Card slot letter (A, B, etc.)
Output head (1, or 2)

System name (cluster systems only)

Conflicts
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3 On the File menu, click Save.
The updated room configuration is saved.

Removing Displays
Before removing a display, make sure there are no room layouts and no full screen layouts 
associated with this display in your system configuration. If there are still layouts for this 
display, then XEdit will issue an error message and prevent you from saving the room. 
See Deleting Layouts on page 249.

To remove a display from a room
1 Open the room that contains the display you wish to remove (see Opening Rooms on 

page 214).
2 If there is a full screen zone associated with this display, click its border and then press 

Delete on your keyboard to remove it.
3 Click the display and then press Delete on your keyboard.
4 On the File menu, click Save.

The updated room configuration is saved.

Adding Full Screen Zones

To add a full screen zone to a room
1 Click the Full screen zone button  on the toolbar, and then click the room area to 

create the full screen zone.
2 Position and resize the zone as appropriate.

IMPORTANT
Conflicting head assignments
Neglecting to resolve conflicting head assignments could result in 
distorted layout elements on the monitor wall (which would 
happen, for example, if the same output head is assigned to two 
displays with different resolutions), or, in the case of a cluster, in the 
dashboard showing the wrong room name (from one of the earlier 
standalone configurations you may have used to create the 
cluster).
To prevent this from happening, open the old room configuration, 
and look for red Head elements in the filtered System list that 
appears at the bottom of the Tools pane. Clear the unwanted head 
assignments, either by removing the corresponding displays from 
the room layout (see Removing Displays on page 218), or by 
completely deleting the old room configuration if you do not need 
it anymore (see Deleting Rooms on page 215).

Notes
• Adding full screen zones to a room is optional.
• Do not span a full screen zone across more than one display; use spanned 

video monitors instead. See Spanning on page 237 for more information.
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3 In the Properties pane, click the Friendly name box, and then type a name for the 
zone.

4 Press Enter on your keyboard to validate the new name, and then click Save on the File 
menu.
The room configuration is saved.

Removing Full Screen Zones
Before removing a full screen zone, make sure there are no full screen layouts associated 
with this zone in your system configuration. If there are still full screen layouts for this zone, 
then XEdit will issue an error message and prevent you from saving the room. See Deleting 
Layouts on page 249.

To remove a full screen zone from a room
1 Open the room that contains the full screen zone you wish to remove (see Opening 

Rooms on page 214).
2 Locate the full screen zone, click its border and then press Delete on your keyboard.
3 On the File menu, click Save.

The updated room configuration is saved.

Configuring Displays
The monitor wall driven by your Kaleido-X system may include displays of various shapes 
and sizes, each with its specific characteristics. The displays you add to your rooms in XEdit 
must be configured to match the attributes of their physical counterparts. The Kaleido-X 
software includes a set of predefined resolutions that cover most standard displays. Any 
custom resolutions you add to this set will be available throughout the system, and can be 
reused when configuring any display in any room.

You can manually configure display resolutions in two ways: either globally, from the Tools 
menu, or by clicking a specific display in a room.

In addition to monitor wall displays, your system can include other monitors connected to 
the multiviewer’s SDI monitoring outputs (one for each output head, available with the SDI 
monitoring output option). The SDI monitoring output format on a given head depends on 
the resolution configured for the corresponding multiviewer output, and, in the case of a 
1080-line resolution, on the selected scan format (interlaced, progressive) for this output 
head. In the case of a KMV-3911 or Kaleido-X16 multiviewer, you can enable phase-locking 
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at the output head level, to support production switchers (or other equipment) connected 
to the multiviewer’s SDI monitoring outputs.

Viewing Room Display Properties

To view the properties for one of the display in a room
1 Click the display whose properties you wish to view.
2 Review the attributes and values that appear in the Properties pane.

Enabling EDID Auto-Detection in XEdit
The monitor EDID auto-detection feature is enabled by default in order to facilitate the 
initial setup of a Kaleido-X system. Setting an output head to a specific resolution, from a 
multiviewer service panel in iControl (if available), from the monitor wall (Kaleido-IP, 
Kaleido-X, Kaleido-X16), or from a Densité controller’s local control panel (Kaleido-MX, 
Kaleido-MX 4K, Kaleido-Modular-X, KMV-3901/3911, Kaleido-XQUAD) disables the EDID 
auto-detection for this head.

To enable EDID auto-detection for a display
1 In the Rooms tab, click the display you wish to configure.
2 In the Properties pane, select the Override with native display resolution check box.

3 On the File menu, click Save.

Configuring Custom Resolutions from the Tools Menu

To create a custom display resolution from the Tools menu
1 On the Tools menu, click Edit resolutions.

Select to enable automatic 
detection of EDID information
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The Edit Resolution Settings window appears.

2 Select the resolution you wish to customize (or the one on which you wish to base a 
new resolution), from the list at the bottom of the window.

3 Under either the Porch or the Modeline section—depending on whether you prefer to 
specify front porch, back porch, sync, and active values, or blank start, sync start, sync 
end and blank end—, set the refresh rate and other timing parameters so that they 
match those of the physical display you need to configure.

Note: When you modify one of the default resolutions, you can only save 
your changes as a new resolution. On the other hand, custom resolutions 
can be tweaked and saved repeatedly until the desired configuration is 
achieved. However, make sure that the active width and active height values 
you specify match those of one of the default resolutions, otherwise your 
custom resolution will be ignored.
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Example: Suppose you want to configure the display that is connected to head 1 of a 
Kaleido-X multiviewer’s OUTPUT A card. The image below shows the relevant data you 
need to copy to the Modeline section of the Edit Resolution Settings window.

Note: In XAdmin’s Status and Options page, these parameters are listed 
under the corresponding output card information, according to the 
blank/sync start/end modeline system, and with the sync polarity expressed 
as a number between 0 and 3. Refer to Viewing a Multiviewer’s Status 
Information, on page 536 for details.
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4 Type a name for the new resolution in the Friendly name box, and then click Save as to 
close the Edit Resolution Settings window. Alternatively, if you are modifying an 
existing custom resolution, you can click the Save button.

Configuring a Custom Resolution from a Specific Display in a Room

To configure a custom resolution from a specific display in a room
1 Click the display whose resolution you wish to configure.
2 Click the Display resolution box in the Properties pane, and then click the button that 

appeared on the right of the resolution presets.

The Edit Resolution Settings window appears.

Frequency 
and timing 
information

Type a name

Edit resolution 
settings button
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3 Under either the Porch or the Modeline section—depending on whether you prefer to 
specify front porch, back porch, sync, and active values; or blank start, sync start, sync 
end and blank end—, set the refresh rate and other timing parameters so that they 
match those of the physical display you need to configure.

Example: Suppose you want to configure the display that is connected to head 1 of a 
Kaleido-X multiviewer’s OUTPUT A card. The image below shows the relevant data you 
need to copy to the Modeline section of the Edit Resolution Settings window.

Frequency and timing information, as listed in XAdmin

Note: In XAdmin’s Status and Options page, these parameters are listed 
under the corresponding output card information, according to the 
blank/sync start/end modeline system, and with the sync polarity expressed 
as a number between 0 and 3. Refer to Viewing a Multiviewer’s Status 
Information, on page 536 for details.
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4 Type a name for the new resolution in the Friendly name box, and then click Save as to 
close the Edit Resolution Settings window. Alternatively, if you are modifying an 
existing custom resolution, you can click the Save button.

5 On the File menu, click Save.

Changing Room Display Resolutions

To change the resolution for a display in a room
1 Click the display you wish to configure.
2 In the Properties pane, expand the Display resolution list, and then select the 

appropriate resolution from the list.

3 On the File menu, click Save.

Configuring the SDI Monitoring Output Format
The SDI monitoring output format on a given head depends on the resolution configured 
for the corresponding multiviewer output (see Changing Room Display Resolutions on 
page 225), and, in the case of a 1080-line resolution, on the selected scan format 
(interlaced, progressive) for this output head. In addition, EDID auto-detection must be 
disabled (see Enabling EDID Auto-Detection in XEdit on page 220). The following 
multiviewer output resolutions are supported: 1920 × 1080 (for an SDI output in the 1080i 
or 1080p format) and 1280 × 720 (for an SDI output in the 720p format). Any other 
resolution selected for the multiviewer output will result in the SDI monitoring output 
being disabled. The following table summarizes what is available at the SDI monitoring 
output, depending on the multiviewer output resolution and selected scan format.

Multiviewer output 
resolution

Selected scan format

Interlaced Progressive

1280 × 720 720p 720p
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To configure the scan format for a 1080-line signal at the SDI monitoring output
1 In the Room area, click the display associated with the multiviewer output head whose 

properties you wish to configure.
2 In the Properties pane, verify that the selected display resolution for the multiviewer 

output head is compatible with the desired format at the SDI monitoring output for 
this head (see table above), and make sure that the Override with native display 
resolution option is disabled.

3 Click the Scan format box, and then select the appropriate scan format: Progressive, or 
Interlaced.

4 On the File menu, click Save.

Enabling Phase Locking at the SDI Monitoring Output
KMV-3911 and Kaleido-X16 multiviewers can feed production switchers (or other 
equipment) via their SDI monitoring output. If your downstream equipment requires input 
signals that are in phase with the facility’s genlock reference, then you need to enable 
phase locking at the corresponding output head. This increases the processing delay 
equally at the SDI monitoring output and corresponding HDMI output.

To enable phase locking at the SDI monitoring output for a specific output head
1 Click the display associated with the head whose SDI monitoring output you wish to 

configure, and then select the Phase locking check box in the Properties pane.

2 On the File menu, click Save.

1920 × 1080 1080i 1080p

Any other HDMI 
resolutions

No output No output

Note: Phase locking is disabled by default, to allow for a minimal 
processing delay. Leave it disabled for all other multiviewer models, or if 
your system does not involve downstream equipment requiring phase-
locked signals.

Multiviewer output 
resolution

Selected scan format

Interlaced Progressive

EDID auto-detection disabled

Scan format for a 1080-line signal
at the SDI monitoring output
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Disabling the Dashboard
A room can be configured to prevent the dashboard from appearing on specific displays. 
For instance, in a production control room, or if the multiviewer is used in the studio 
backdrop you may not want the dashboard to pop up, regardless of alarm conditions.

To disable the dashboard for a specific display
1 Click the display on which you do not want the dashboard to appear, and then clear the 

Allow dashboard display check box in the Properties pane.

2 On the File menu, click Save.

Changing a Display’s Aspect Ratio

To change the aspect ratio of a display in a room
1 Click the display whose aspect ratio you wish to set.
2 In the Properties pane, expand the Aspect ratio list, and then select the appropriate 

aspect ratio preset from the list.

Alternatively, type the desired ratio directly in the box.
3 On the File menu, click Save.

Changing a Display’s Diagonal Size

To change the diagonal size of a display in a room
1 Click the display whose size you wish to configure.
2 Click the Diagonal size box in the Properties pane.

Note: Make sure the dashboard remains enabled on a least one display, in 
a room where alarm conditions can be monitored, since it is your only way 
to be notified in case of a card booting in offline mode, a duplicate 
IP address, a defective fan, a power supply alarm, etc.

Notes
• It is important to properly set the aspect ratio of a display, since this will 

affect the proportions of every component you will use to create layouts 
for this room. For instance, if the aspect ratio of a display does not match 
the aspect ratio of the actual display in the physical room, then a video 
window inside a layout will show distorted images.

• If you change the display aspect ratio later in the process, layouts created 
before the change will be broken.
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3 Select the appropriate unit of measurement from the list that appears inside the 
Diagonal size box, and type the size.

4 On the File menu, click Save.

Changing a Display’s Height

To change the height of a display in a room
1 Click the display whose height you wish to configure.
2 Click the Height box in the Properties pane.

3 Select the appropriate unit of measurement from the list that appears inside the 
Height box and type the height.

4 On the File menu, click Save.

Changing a Display’s Width

To change the width of a display in a room
1 Click the display whose width you wish to configure.
2 Click the Width box in the Properties pane.

3 Select the appropriate unit of measurement from the list that appears inside the Width 
box and type the width.

4 On the File menu, click Save.

Changing a Display’s Rotation

Notes 

• The following systems do not support display rotation:
• Kaleido-MX, and Kaleido-Modular-X systems configured with a 4K UHD 

room
• Kaleido-MX 4K
• KMV-3901/3911, and Kaleido-XQUAD
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To change the rotation setting for a display in a room
1 Click the display you wish to configure.
2 In the Properties pane, expand the Rotation list, and then select the configuration that 

matches the way the actual display is mounted in the physical room:
• normal
• rotated 90 degrees clockwise
• rotated 90 degrees counterclockwise

3 On the File menu, click Save.
If you already had created layouts for the room associated with the display whose 
rotation setting you just changed, you may need to adjust layout elements in these 
layouts (see Creating Layouts on page 233).

Changing a Display’s Position

To change position of a display in a room
1 Click the display whose position you wish to configure.
2 Click the Position box in the Properties pane, then click the button that appears inside 

the box.

• For rotation to work properly on the monitor wall, the Display Rotation 
option must be enabled on the corresponding output card (in the case of 
a Kaleido-X, Kaleido-MX, or Kaleido-Modular-X multiviewer) or HDMI 
output port (in the case of a Kaleido-X16). The option can be enabled and 
verified in XAdmin’s Status and Options page (see Hardware and Software 
Options on page 464).

• The Kaleido-IP supports display rotation. If two displays are connected to 
the multiviewer, then they must both have the same orientation. It is not 
yet possible to enable or verify the rotation option in XAdmin’s Status and 
Options page, for this multiviewer model. Contact Technical Support for 
activation and configuration instructions (see Contact Us, on page 551).

• In the case of a Kaleido-MX or Kaleido-Modular-X system, every time the 
orientation of a display has changed in XEdit, the multiviewer 
automatically restarts after the room is saved (or, if you were working in 
offline mode, once you have exported the database).

Notes (continued)
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The Specify Position window appears.

3 Type the appropriate values in the X (mm), and Y (mm) boxes, and then click OK.
The values appear in the Position box.

4 On the File menu, click Save.

Managing Display Libraries
The default display library includes configurations for the most popular display models. You 
can also create your own display configurations, and add them to custom display libraries. 
All open display libraries appear on the Tools pane. The default display library is always 
open. Custom display libraries are stored separately from the XEdit workspace, and must be 
opened explicitly.

Creating Custom Display Libraries

To create a custom display library
1 Click the Rooms tab in the main window.
2 On the File menu, click New. Alternatively, click Open to open an existing room.
3 On the File menu, click New display library.

Alternatively, right-click anywhere inside the Tools pane’s display library area, and then 
click New display library on the menu.

The new display library appears below the default display library area in the Tools pane.

4 Right-click anywhere in the display library area, and then click Save Display Library on 
the menu.
The Save Display Library window appears.

New (empty) display library
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5 Type a name for the new custom display library, and then click Save.
Custom display libraries are stored separately from the XEdit workspace. They have 
a.dlib extension.

Adding Displays to Custom Libraries

To add a display to a custom display library
1 Click the Display button  on the toolbar, and then click the room background to add 

a display. Alternatively drag a display from a display library onto the room, or choose a 
display within an existing room.

2 Customize the display as needed, and then drag it onto the display library while holding 
the Ctrl key.

Note: It is not possible to further customize a display once it is inside a 
library. Should you need to do so, drag the display to the room area, apply 
the required changes, and then Ctrl+drag the modified display to the 
display library. You can then remove the obsolete display from the library.

Ctrl+click to drag display
to custom library
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Removing Displays from Custom Libraries

To remove a display from a custom library
• Click the display you wish to remove and then press Delete.
• Alternatively, right-click its icon and then click Delete entry on the menu.

Closing Display Libraries

To close a display library
• Once the custom library is saved, you can right-click in the library area, and then click 

Close display library on the menu.
• Alternatively, click Close display library, on the File menu.

Opening Display Libraries

To open a custom display library
• In the Tools pane, right-click anywhere in the display library area, and then click Open 

display library on the menu.
• Alternatively, click Open display library, on the File menu.

Note: It is possible to have multiple custom libraries open at the same time.
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This section describes layout elements and their purposes, and provides detailed 
configuration instructions.

Key Concepts

Layouts and Layout Elements
Layout elements

Term Description

Layout A layout is a visual grouping of monitors that appear on displays within a 
room. A layout includes different types of monitors in a variety of placements 
and sizes. There are two types of layouts: room layouts and full screen 
layouts. See Managing Layouts on page 240.
Note: Before creating layouts, you may want to review your room 
configurations. Should a display be rotated in a room (see Changing a 
Display’s Rotation on page 228), some layout elements in your existing room 
layouts may require adjustments.

Monitor A monitor is an element that is part of a layout. The Kaleido-X software 
supports several types of primitive layout elements (e.g., clocks, video 
monitors, audio monitors, UMDs, time code monitors, etc.), as well as 
composite monitors. All primitive layout elements, except for the video 
monitors and subtitling monitors are graphical layout elements. See Adding 
Monitors to a Layout on page 249.

Video monitor A video monitor is a layout element used to define an 
area for displaying a video signal. It is represented in 
XEdit by the boundary box made visible by clicking 
the element.
Within a video monitor, the video window is the active 
area where the video signal is displayed, possibly 
including closed captions or teletext. The video 
window is represented in XEdit by the blue rectangle inside a video monitor. 
The video window does not necessarily cover the complete video monitor’s 
area. See Configuring Video Monitors on page 257.

Composite 
monitor

A composite monitor is a group of primary elements that can be seen as a 
single object within a layout. Composite monitors typically include a video 
window, one or more audio level meters, and a UMD with two tallies.
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Time code 
monitor

A time code monitor displays the Ancillary Time Code (ATC) from an HD video 
signal, or the time code found in an embedded SDI video signal, part of the 
vertical interval of an analog signal (VITC), or other external Linear Time Code 
(LTC). This monitor also supports time code information from external 
providers (see Configuring logical sources based on external alarm providers 
on page 205). Time code monitors can be used for monitoring the duration 
of programs. See Configuring Time Code Monitors on page 280. 

Timer A timer can be slaved to a production timer, controlled from the Kaleido-
RCP2 (with start, stop and reset control via GPI inputs), and/or used for 
monitoring the duration of programs.
Three timer modes are available: (1) UP: timer counts up starting from zero up 
to a preset time, (2) DOWN: timer counts down from a preset time to zero, 
and (3) REMAINING: timer counts down from the current time until it reaches 
a preset time.
A timer monitor is based on a timer defined within the Kaleido-X system. 
Timers are defined and configured in XEdit. Timer monitors can be 
configured directly on the monitor wall. See Configuring Timers on page 282.

Audio monitor An audio monitor (also called audio level meter or ALM) is a graphical layout 
element that provides a visual representation of sound. See Configuring 
Audio Monitors, on page 273, and Configuring Audio Scales, on page 277.

Loudness 
monitor

A loudness monitor is a graphical layout element that provides a visual 
representation of the perceived loudness of an audio program. It provides 
two measures (short-term, and momentary loudness) per audio program. 
See Configuring Loudness Monitors on page 276.

UMD An under monitor display (UMD) has a text label that can be static or 
dynamically updated by a peripheral device. It can also have left and right 
tally indicators. The UMD typically indicates the name of the video source 
seen in a video monitor. See Configuring UMDs on page 288.

Alarm monitor Alarm monitors help you see the status of global and virtual alarms, but their 
use is not limited to this type of alarms. When any alarm level is assigned to 
an alarm monitor, the status of this alarm is shown. When using the global 
alarm at the text label level, the alarm monitor displays the text value of the 
alarm, which is a readable name. See Configuring Alarm Monitors, on 
page 295 and Alarm latch, on page 33 for more information. 

Subtitling 
monitor

A subtitling monitor defines an area for displaying subtitles extracted from a 
video signal. By using a subtitling monitor you can monitor subtitling from a 
specific DVB or SCTE 27 stream, independently from the associated video 
stream. Requires the CC/XDS option (see Hardware and Software Options on 
page 464). See Configuring Subtitling Monitors on page 298.
Note: With the current version of the Kaleido-X software, the subtitling 
monitor supports DVB and SCTE 27 subtitles, from Kaleido-IP sources only.

Metadata 
monitor

A metadata monitor defines an area for displaying XDS, or digital content 
advisory descriptor (CAD) information compliant with CEA-766-D, extracted 
from a video signal. Requires the CC/XDS option (see Hardware and Software 
Options on page 464). See Configuring Metadata Monitors on page 303.

Term Description
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Aspect Ratio
Aspect ratio information can be encoded within a video signal following different 
standards: AFD 2016, AFD VI, or WSS. The Kaleido-X software may use this information to 
render the video raster in the target video window on the monitor wall.

The aspect ratio of video displayed on the monitor wall can be automatically adjusted. With 
multiple video players (monitors) on a monitor wall, in multiple formats/aspect ratios, this 
makes it easy to switch from one format to another in the same player. Automatic 
adjustment can be accomplished in two ways:

• Video monitor slaved to input: A video monitor can be slaved to the input format such 
that the video monitor will change its aspect ratio according to the input signal type 
(e.g., SD, HD, DVI).

• Video raster follows AFD/WSS: A video monitor can be configured so that WSS, AFD VI, 
or AFD 2016 metadata is used to crop (and/or add black bars to) the video signal, giving 
the video raster the correct aspect ratio.

V-chip monitor The V-chip monitor provides a visual indication of the V-chip rating from the 
CC (608) metadata in an SD video signal, or from the CC (608) legacy caption 
data, when such data is present within an HD video signal. Requires the 
CC/XDS option. See Hardware and Software Options, on page 464, and 
Configuring V-Chip Monitors, on page 304.

Clock A clock is the visual representation of time in a video or display. It can be 
based on a reference LTC signal or on the multiviewer system time. Clocks 
can be in a digital or analog format. See Configuring Clocks on page 306.
Note: The KMV-3901/3911 supports digital clocks only.

Monitor library A monitor library is a collection of predefined layout elements. Monitors from 
a library can be used to help construct a layout. Default monitor libraries are 
available from XEdit’s Tools pane. You can also create your own libraries. 
See Managing Monitor Libraries on page 320.
Note: As of version 7.40 of the Kaleido-X software, two new 16:9, and 4:3 
composite monitor libraries with proportional elements are available. In these 
libraries, the primary monitors within each composite have all their 
dimensions defined as a percentage, which allows intuitive resizing, whereas, 
in the legacy maximum video area libraries, some primary monitors have fixed 
height or width, to allow more space for the video window. The new 
composite monitors with proportional elements suit most purposes. It is 
preferable to always use them, unless you specifically require monitors with 
fixed dimensions.

Term Description

Term Description

AFD VI Active format description encoded in the video index.

AFD 2016 Active format description encoded in the ancillary data (according to the 
SMPTE ST 2016 standard).

WSS Wide Screen Signaling.

Video raster Video signal that is displayed inside the video monitor on a monitor wall.
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This metadata can be reported as text inside a UMD. Its presence can also be made 
available in alarms as well as via SNMP traps.

See Configuring Automatic Aspect Ratios on page 265, for more information.

Cropping Mode
The display of a video signal can be cropped to remove unwanted portions, or to zoom in 
on a specific portion of the image. In XEdit, you can configure a video monitor to display 
signals in underscan or overscan mode (see Video Cropping/Zooming on page 263). Not 
supported on Kaleido-IP.

Underscan: When a video window is in underscan mode, it displays the full signal without 
cropping any of the image.

Overscan: When a video window is in overscan mode, it displays a selected area of the 
image, typically zoomed and cropped to fit the window. By default, the overscan mode 
crops the left, right, top and bottom margins by 5% each.

Changing the underscan/overscan mode dynamically
It is possible to dynamically change the overscan/underscan mode based on the current 
feed assigned to a video monitor. For example, you can change logical sources in a video 
monitor using Gateway commands, where a video source requires the monitor to be in 
overscan mode but a graphics source requires the monitor to be in underscan mode to 
avoid cropping the image. A custom action script can make the monitor change its scan 
mode depending on the format detected. For information on how to create such a script, 
contact Technical Support (see Contact Us, on page 551).

Custom overscan
The amount of overscan applied can be customized to some extent, which will depend on 
the original signal resolution, relative to the size of the video window where the image is 
displayed. Excessive cropping may result in a loss of video image on the monitor wall. 
Likewise, when a layout has several monitors with heavy cropping settings on the same 
display head, some video windows may turn blank.

Note: The Kaleido-X software does not yet support automatic aspect ratio 
adjustment based on decoded AFD/WSS information for signals originating 
from Kaleido-IP multiviewers.

Note: Aspect ratio decoding can also be configured for each multiviewer 
input, based on decoded AFD or WSS metadata when such information is 
available within the input signal (see Calibrating Aspect Ratio Decoding on 
page 147).

Note: Kaleido-MX, and Kaleido-Modular-X configured for 4K UHD output, 
and Kaleido-MX 4K do not support the overscan mode for video windows 
spanned across multiple heads (see 4K UHD Spanning on page 239).
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The examples listed below may be used as guidelines. Unless specified otherwise, these are 
based on a 1080p display resolution. Displays with a lower resolution can afford more 
cropping.

• In the case of a full screen video window:
• The KMV-3901/3911 supports cropping up to 6% in both directions (i.e., 6% 

vertically, and 6% horizontally).
• The Kaleido-X and Kaleido-X16 support cropping up to 18% in both directions.
• Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X support cropping up to 40% in 

both directions, for SD 525 sources in a 1920 × 1200 monitor.
• In the case of a video window occupying 1/16th of the display area:

• The KMV-3901/3911 supports cropping up to 17% in both directions for a 1080i HD 
source, or up to 38% for an SD source.

• The Kaleido-X and Kaleido-X16 support cropping up to 42% in both directions.

Spanning
Graphical layout elements (UMDs, audio monitors, etc.) and video monitors can be made to 
span across multiple heads, on up to 4 displays, portrait or landscape, in any combination. 
On displays that fit perfectly side by side, this gives the impression of having one large 
screen. When any layout element is spanned across displays, an icon automatically appears 
in the top right corner.

To avoid pixel cropping on spanned monitors, you must position room displays so that 
there is no gap between them. Use XEdit’s Remove horizontal space and/or Remove 
vertical space buttons to make sure your displays are perfectly positioned for spanning.

You must also ensure that each display has the same pixel-per-inch (or -per-mm) ratio, 
calculated as horizontal resolution (pixels) divided by display width (inches or mm) and 
vertical resolution divided by display height. Ideally, you should use displays that have the 
same physical size and resolution.

The figure below shows two displays properly sized and positioned for monitor spanning.

Warning icon appears even if monitor
is one pixel over the edge

Video monitor spanned over two displays
with warning icon in top right corner
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Notes 

• The Kaleido-IP does not yet support spanned monitors.

• In the case of KMV-3901/3911 and Kaleido-XQUAD multiviewers, which 
support a maximum of eight video monitors over two displays, a spanned 
video monitor counts as two (i.e., if you have one spanned video monitor, 
you can only add six other video monitors to your layout; if you span two 
video monitors, you can add only four other video monitors.

• Monitors can extend outside the edge of a display, but not completely.

• The use of a mouse is not completely supported with spanned video 
monitors.

• Do not span a layout element beyond a maximum of 3000 × 1800 pixels. 
When spanning or scaling video monitors in a layout, avoid heavy 
cropping settings (generally avoid exceeding 15% in any direction).

Horizontal: 1600 pixels ÷ 800 mm = 2 pixels/mm
Vertical: 1200 pixels ÷ 600 mm = 2 pixels/mm

Horizontal: 1366 pixels ÷ 683 mm = 2 pixels/mm
Vertical: 768 pixels ÷ 384 mm = 2 pixels/mm
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4K UHD Spanning
Kaleido-MX, and Kaleido-Modular-X multiviewers support seamless 4K UHD output, to 
either four 1080p borderless displays, or a single quad link 4K UHD display. Kaleido-MX 4K 
multiviewers support seamless 4K UHD output to a single quad link 4K UHD display. For 
best results, avoid spanning layout elements across multiple heads. For example, a layout 
with 9 or 25 monitors positioned as a 3 × 3 or 5 × 5 grid will require more processing.

If you must use a layout with composite monitors spanning multiple heads, you should 
make sure that any video windows horizontally straddling head boundaries have at least ¼ 
of their width on either side, and that graphical elements such as time code monitors and 
audio monitors, within the composites, are placed in a way that they do not straddle head 
boundaries.

See Creating a 4K UHD Room on page 212, Creating 4K UHD Upscale Layouts, on page 243, 
and Creating Layouts to Monitor 4K UHD Quad Link Sources, on page 245.

• There is no special configuration to be done in XEdit.

Notes (continued)

Maximum size of spanned video 
element = 3000 × 1800 pixels

Maximum horizontal 
cropping = 15%

Maximum vertical 
cropping = 15%

Notes 

• Kaleido-MX and Kaleido-Modular-X configured for 4K UHD output, and 
Kaleido-MX 4K do not support the overscan mode for video windows 
spanned across multiple heads (see Cropping Mode on page 236).

• Kaleido-MX and Kaleido-Modular-X configured for 4K UHD output, and 
Kaleido-MX 4K do not support detail enhancement for video windows 
spanned across multiple heads (see Detail enhancer on page 125).

• Kaleido-MX and Kaleido-Modular-X configured for 4K UHD output to a 
single quad link 4K UHD display, and Kaleido-MX 4K do not support 
spanning SD or 720p sources across multiple heads.
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Detailed Directions

Managing Layouts 

Opening Layouts

To open an existing layout
1 Click the Layouts tab.
2 On the File menu, click Open. Alternatively, click the Open button  on the toolbar.

The Open Layout window appears.

• Double-click Full screen layout, if you wish to open a full screen layout.
• Double-click Multihead layout, if you wish to open a room layout.

3 Double-click the appropriate room.

4 Click the layout you wish to open, and then click Open.

• 4K UHD spanning is not supported for sources that are not referenced 
within the multiviewer system.

Notes (continued)

Note: Before creating or modifying a layout for a Kaleido-IP system, review 
the guidelines listed in Network Considerations, on page 473.
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The selected layout appears in the Layouts tab.
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Loading a Layout on the Monitor Wall

To load the current layout on the monitor wall, directly from XEdit, in online mode
• Click the LOAD button on the toolbar.

The current layout appears on the monitor wall.

Closing Layouts

To close the current layout
• On the File menu, click Close. Alternatively, click the Close button  on the toolbar.

Creating Room Layouts

To create a room layout
1 Click the Layouts tab in the main window.
2 On the File menu, click New.

TIP
When you have more than one layout open, you can switch from one to 
another by clicking the tabs at the bottom of the window.
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The Create a New Layout window appears. It lists all the existing rooms and full screen 
zones in your system.

3 Click the name of the room where this layout will be displayed.

An empty layout appears.
4 Add at least one monitor to the layout (see Adding Monitors to a Layout on page 249).
5 Assign every monitor a logical source (see Assigning Logical Sources or Monitor Wall 

Destinations to Monitors on page 252).
6 On the File menu, click Save.

The Save Layout window appears.

7 Type a name for the layout, and then click Save.

Creating 4K UHD Upscale Layouts
This section applies to Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X multiviewers 
only. It explains how to create a layout, to monitor an HD source (1080i, 1080p, or 720p) 
upscaled to 4K UHD. You must have first created your 4K UHD room (see Creating a 4K UHD 
Room on page 212).

• To configure a layout you might use to monitor a 4K UHD quad link (square division) 
source in a 4K UHD room, see Creating Layouts to Monitor 4K UHD Quad Link Sources, 
on page 245.

• To configure a regular layout, see Creating Room Layouts, on page 242.
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• To configure a layout for a full screen zone, see Creating Full Screen Layouts, on 
page 247.

To create a 4K UHD upscale layout
1 Click the Layouts tab in the main window.
2 On the File menu, click New.

The Create a New Layout window appears. It lists all the existing rooms and full screen 
zones in your system.

3 Click the name of the 4K UHD room where this layout will be displayed.

An empty layout appears.
4 Add a single video monitor to the layout (see Adding Monitors to a Layout on page 249), 

and make it span the entire area of the four room displays.
5 Verify the dimensions and position of the monitor by switching to the expert view:

a Click the View filters button at the top of the Properties pane, and then select the 
Expert view check box.

b Open the region editor, and set the monitor’s position to Left = 0, Right = 0, and its 
dimensions to Width = 200%, Height = 200% (see Using the Region Editor on 
page 316).
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c Click OK to close the region editor.
6 Assign the monitor a logical source (see Assigning Logical Sources or Monitor Wall 

Destinations to Monitors on page 252).
7 On the File menu, click Save.

The Save Layout window appears.
8 Type a name for the layout, and then click Save.

Creating Layouts to Monitor 4K UHD Quad Link Sources
This section applies to Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X multiviewers 
only. It explains how to create a layout, to monitor a 4K UHD quad link (square division) 
source in a 4K UHD room. You must have first created your 4K UHD room (see Creating a 4K 
UHD Room on page 212). If there are two 4K UHD quad link sources connected to your 
multiviewer’s inputs, you will need to use a router control application or device configured 
with salvos to change the source assignments.

• To configure a layout you might use to monitor an HD source (1080i, 1080p, or 720p) 
upscaled to 4K UHD, see Creating 4K UHD Upscale Layouts, on page 243.

• To configure a regular layout, see Creating Room Layouts, on page 242.
• To configure a layout for a full screen zone, see Creating Full Screen Layouts, on 

page 247.

To create a layout to monitor a 4K UHD quad link source
1 Click the Layouts tab in the main window.
2 On the File menu, click New.

The Create a New Layout window appears. It lists all the existing rooms and full screen 
zones in your system.
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3 Click the name of the 4K UHD room where this layout will be displayed.

An empty layout appears.
4 Add a video monitor to the layout (see Adding Monitors to a Layout on page 249), and 

make it span the entire area of one room display, by switching to the expert view:
a Click the View filters button at the top of the Properties pane, and then select the 

Expert view check box.

b Open the region editor, and set the monitor’s position to Left = 0, Right = 0, and its 
dimensions to Width = 100%, Height = 100% (see Using the Region Editor on 
page 316).

c Click OK to close the region editor.
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d With the monitor still selected in the main pane, remove the preconfigured 
borders, at least for the Normal/OK alarm state, by clicking the Border thickness – 
Normal/OK thickness box, and then selecting “0” from the list.

5 Add three more video monitors to the layout in the same fashion.

6 Assign each monitor the logical source associated with the matching quadrant 
(see Assigning Logical Sources or Monitor Wall Destinations to Monitors on page 252).

7 Also assign each monitor the monitor wall destination you will use when making 
crosspoint changes, if needed.

8 On the File menu, click Save.
The Save Layout window appears.

9 Type a name for the layout, and then click Save.

Creating Full Screen Layouts

To create a full screen layout
1 Click the Layouts tab in the main window.
2 On the File menu, click New.

The Create a New Layout window appears. It lists all the existing rooms and full screen 
zones in your system.

3 Click the name of the full screen zone in which this layout will be displayed.

Note: Each video monitor must span an entire room display. This is the only 
supported configuration for monitoring 4K UHD sources on a 4K UHD 
display.
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An empty layout area appears.
4 Add at least one monitor to the layout (see Adding Monitors to a Layout on page 249).

If the full screen layout includes more than one composite monitor, you can designate 
one of them who will receive its source assignments from the monitor under the mouse 
pointer on the monitor wall, by selecting the Full screen layout monitor option in the 
Properties pane.

Make the appropriate assignments for the other elements in the layout (see Assigning 
Logical Sources or Monitor Wall Destinations to Monitors on page 252).

5 On the File menu, click Save.
The Save Layout window appears.

6 Type a name for the full screen layout, and then click Save.
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Deleting Layouts

To delete a layout
1 Open the layout you wish to delete (see Opening Layouts on page 240).
2 On the File menu, click Delete.

The system prompts you to confirm.

3 Click Yes to proceed.
The layout is removed from your system configuration.

Adding Monitors to a Layout 

Notes 

• When adding monitors to a layout, avoid overlapping graphical layout 
elements with one another. For example, making sure that there be no 
overlap between UMDs and audio monitors in a layout will ensure optimal 
performance.

• Before creating or modifying a layout for a Kaleido-IP system, review the 
guidelines listed in Network Considerations, on page 473.

• In the case of a KMV-3901/3911 or Kaleido-XQUAD multiviewer, layouts 
are subject to the following limitations:
• up to eight video monitors over two displays (overlapping is not 

supported),
• up to four stereo audio level meters per video monitor,
• one time code per video monitor,
• only digital clocks are supported,
• XDS metadata monitors are not supported.

• In the case of the Kaleido-X, Kaleido-X16, and Kaleido-IP multiviewers, 
every output head supports up to 64 video monitors, across both the 
current layout and a full screen layout when used.

• In the case of a Kaleido-X or Kaleido-X16, the minimum width supported 
for a video window is 1/16th of the original signal’s horizontal resolution.

• In the case of a Kaleido-X, the minimum height supported for a video 
window is 91 pixels.

• In the case of a Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X 
multiviewer, every output head supports up to 64 video monitors. 
However, if every monitor is associated with audio meters and a time code 
monitor, then the maximum is 24 video windows per output head. If a 
layout is used to monitor color teletext, then it should be limited to 
16 windows per output head. The image can be scaled down to 1/8 of the 
original signal’s resolution. The minimum width supported for a video 
window is 128 pixels.
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To add monitors to a layout
1 Drag components from the monitor libraries onto the layout, or create custom 

components, using the toolbar buttons ( ).

2 Resize, move and configure the monitors until the desired layout is achieved.
For detailed configuration instructions on the different monitor types, see:

• Configuring Video Monitors, on page 257
• Configuring Audio Monitors, on page 273
• Configuring Loudness Monitors, on page 276
• Configuring Time Code Monitors, on page 280
• Configuring Timers, on page 282
• Configuring UMDs, on page 288
• Configuring Alarm Monitors, on page 295
• Configuring Subtitling Monitors, on page 298
• Configuring Metadata Monitors, on page 303
• Configuring V-Chip Monitors, on page 304
• Configuring Clocks, on page 306
• Working with Composite Monitors, on page 310
• Managing Monitor Libraries, on page 320

Removing Monitors

To remove a monitor from a layout
• Click the monitor you wish to remove, and then press Delete on your keyboard.

Duplicating Monitors

To duplicate a monitor within a layout
1 Click the monitor you wish to duplicate.
2 On the Edit menu, click Duplicate. Alternatively, press Ctrl+D.

A copy of the monitor is added to the layout.
3 Move the new monitor to the appropriate position on the layout.
4 Press Ctrl+D again, and repeat until the desired number of copies of the monitor are 

added to the layout.
The new copies are automatically positioned at intervals matching the relative 
positions of the original monitor and its first duplicate.

Note: All open monitor libraries appear in the Tools pane. See Monitor 
library on page 235.

TIP
To remove multiple monitors in a single operation, extend your selection by 
using the standard Ctrl+click keyboard shortcut.
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Automatically Populating a Grid-Type Layout
Use the Auto-layout tool, to quickly create a layout containing several rows of up to 256 
identical composites.

To automatically populate a grid-type layout
1 Add a first monitor to the layout (see Adding Monitors to a Layout, on page 249, and 

Working with Composite Monitors, on page 310).
2 Position the monitor so that its upper left corner marks the location where you wish to 

start populating the grid.
3 Click the monitor, and then click the Auto-layout button ( ) on the toolbar.
4 In the Auto-Layout window, type the total number of monitors you wish to spread over 

the area delimited by the upper left corner of the current monitor and the bottom right 
corner of the current head, and then click OK.
The first monitor is resized and replicated until the grid area is populated with the 
specified number of monitors.

Copying layouts

To copy a layout
1 Open the layout you wish to duplicate.
2 On the File menu, click Copy layout to, point to the appropriate room, and then either 

select an existing layout from the list, or click Empty layout.

A two-pane window appears. The left pane represents the source layout, and the right 
pane represents the destination room where the new layout is to be used.

Note: To undo this action, you will need to press Ctrl+Z twice: once to 
remove the copies, and then once more to restore the first monitor’s initial 
size.
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3 Drag one head from the source pane to the destination pane.
4 Repeat until every part of the source layout you wish to copy has been dragged to the 

appropriate head in the destination pane, and then click Copy layout.
The Save Layout window appears.

5 In Save Layout, type a name for the new layout, and then click Save. Alternatively, you 
can replace an existing layout with the new layout.

Assigning Logical Sources or Monitor Wall Destinations to Monitors 
When you load a layout to the monitor wall, monitors that are not configured with a logical 
source assignment may be blank (until you manually set the assignment) but, if a monitor 
was configured as a monitor wall destination, then it will remember its last source 
assignment (if any). Keep in mind that, if two monitors are assigned the same monitor wall 
destination, they will both reflect source assignments made to any of them during 
operation. You may want to keep track of already assigned monitor wall destinations, if this 
is something you wish to avoid, and carefully review any layouts you create or modify based 
on elements from other layouts.

The Tools pane includes lists from which you can make assignments by dragging logical 
sources and monitor wall destinations onto monitors (you do not need to select the 
monitor first).

To assign a logical source to a monitor
• Select a logical source from the Channels/Sources list, in the Tools pane, and then drag 

it onto the appropriate monitor.

To assign a monitor wall destination to a monitor
• Select a destination from the Monitor wall destinations list, in the Tools pane, and 

then drag it onto the appropriate monitor.
252



Kaleido-X
User’s Manual
Type in the filter box located above the Channels/Sources, and Monitor wall destinations 
lists, to hide sources or destinations that do not match the filter text or regular expression.

When assigning logical sources or monitor wall destinations to monitors in a layout, it may 
happen that the selection migrates to an adjacent element from the Channels/Sources or 
Monitor wall destinations list during the drag-and-drop operation. Once you selected a 
logical source or monitor wall destination from the corresponding list, dragging the 
selected element horizontally until the pointer exits the Tools pane, or performing a slower 
drag-and-drop may help.

To assign different monitor wall destinations to individual components within a 
composite monitor

1 Click the composite monitor.
The current assignments for this composite appear in the Properties pane.

2 Make sure Monitor wall destination is set to None.

3 Double-click the composite monitor to unlock it.
4 Click a component you wish to configure as a monitor wall destination, within the 

unlocked composite.
5 In the Properties pane, click the Monitor wall destination box, and then select the 

appropriate destination from the list.
6 Repeat from step 4 until you have made the required assignments for this composite.
7 Click outside the composite monitor to lock it.

Selecting a Background Image for a Layout
For some purposes, you may wish to display a layout’s elements against a specific static 
image.

Filter text

Example: Type “f” to 
view only the sources 
that belong to Input F.
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To select a background image for a layout
1 Click the Layouts tab, and open the layout whose background you wish to set.
2 Click the display background on the layout.
3 In the Properties pane, click the Background image box, under Appearance, and then 

click the button that appeared at the end of the box.
The Select Image window appears.

4 If the image you wish to use is not already listed in Select Image, then click the Open 
button  to open the Browse Image window. Locate the image, select it, and 
then click Open.

The image is imported into the database.

Notes 

• The maximum size for each image is 256 KB, and the maximum overall size 
(for all images) is 10 MB. The image can be in PNG, GIF, or JPEG format. 
Images can be used on multiple layouts and only need to be imported to 
the database once.
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5 In Select image, select the image from the Image selection list, and then click OK.

The image appears in the layout background.

Setting up a Layout for Background Keying from the DVI Input
This section explains how to set up a layout’s background to be keyed out and replaced 
with content from the DVI input (see DVI keying mode on page 124).

To use the DVI input as the background in a layout
1 Click the background of the layout.
2 In the Properties pane, click the Background color box, and then click the button that 

appears inside the box to open the color picker window.

• With a KMV-3901/3911 multiviewer, a layout background image in a PNG 
format that includes embedded metadata may fail to appear on the 
monitor wall. Workaround: Remove the metadata from the PNG image file, 
recreate the image without metadata, or convert the PNG file to another 
format such as JPEG.

Notes 

• The Kaleido-IP, Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, 
KMV-3901/3911, and Kaleido-XQUAD multiviewers do not support DVI 
keying.

• Since the DVI input cannot be resized, the resolution on the PC that feeds 
this input is best set to match the selected display’s (head) resolution. The 
DVI background is always positioned from the top-left corner of the 
display and is drawn pixel for pixel. If the resolutions do not match, some 
part of the DVI input might be missing or noise might be displayed.

Notes (continued)
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3 In Colors, click the RGB tab, and then set the Red to 254, Green to 0 and Blue to 254.

4 Click OK.
5 If the area you wish to configure for background keying covers more than one head, 

repeat the procedure for the remaining heads, by clicking the corresponding areas in 
the layout.

6 On the File menu, click Save.

Zooming and Panning a View

To adjust the portion of a layout or room that is shown in the main window
• Press and hold the Ctrl key, then press the plus key (+) to zoom in or the minus key (–) 

to zoom out.
• Press and hold the Ctrl key, then rotate the mouse wheel to zoom in or out.
• Type the zoom factor you wish to apply (in the range of 2% to 1600%) directly in the 

zoom box.
• Press and hold the spacebar, then click and drag to pan.
• Use the scroll bars at the right side and bottom of the Layouts or Rooms tab.
• In the case of a layout view, click and drag the layout navigator’s red rectangle in the 

Tools pane.

Note: Since bright pink colors matching the RGB values listed below are 
considered pass-through colors, and since background keying is always 
enabled, if a layout's background color (or any monitor's color attribute) is 
set to any of these RGB values, the DVI input will be displayed in the 
corresponding areas on the monitor wall. If there is no signal at the 
associated DVI input (or the multiviewer does not support DVI keying), 
residual data may be visible in such areas.
• Pass-through colors: RGB (254,0,254), (254,0,255), (254,1,254), 

(254,1,255), (255,0,254), (255,0,255), (255,1,254), (255,1,255)
Do not use these colors for any monitor's color attributes. A layout's 
background should only be set to such a color if a DVI input will be 
contributing the actual background for this layout on the monitor wall.
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Showing and Hiding the Layout Navigator

To show or hide the layout navigator
• On the View menu, click Navigator. Alternatively, press Ctrl+Shift+N.

The layout navigator will appear in the Tools pane if it was hidden, and vice versa.

Configuring Video Monitors
In XEdit, you can configure several properties for a video monitor in a layout.

To configure a video monitor
1 In XEdit, click the Layouts tab, and then open the desired layout.
2 Unlock the appropriate composite monitor if applicable (see Unlocking a Composite 

Monitor on page 316).
3 Click the video monitor you wish to configure.
4 To pre-assign a logical source to be monitored by default, to configure a video monitor 

as a monitor wall destination, or to configure reporting behaviors, see:
• Assigning Logical Sources or Monitor Wall Destinations to Monitors, on page 252.
• Setting Monitored Levels for a Video Monitor, on page 258.
• Setting a Video Monitor’s Text Mode, on page 269.
• Configuring a Video Monitor’s Alarm Reporting Behavior, on page 266.
• Configuring a Video Monitor’s Source Reporting Behavior, on page 267.

5 To configure dimensions, and resizing behavior, see:
• Resizing a Video Monitor, on page 258.
• Setting a Video Monitor’s Aspect Ratio, on page 259.
•  Adding Safe Area Markers, on page 260.
• Adding a Custom Safe Area Image, on page 260.
• Video Cropping/Zooming, on page 263.
• Configuring Automatic Aspect Ratios, on page 265.

6 Click outside the composite monitor to lock it, if applicable.
7 On the File menu, click Save.
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Setting Monitored Levels for a Video Monitor
When a system’s logical sources include more than one level under a given category, the 
first level is selected by default for monitoring. In the case of a video monitor, you may 
change the default assignments for video, audio, and alarm levels.

To change the default levels selected for a video monitor
1 If your system’s logical sources include more than one video level (e.g., to monitor 3D 

stereoscopic signals), select the ones you wish to monitor from the Video level 
(left/mono), and Video level (right) lists.

2 To monitor a different alarm level, or the source’s global alarm, select the appropriate 
level from the Border alarm level list.

3 If you wish the default Monitor audio action associated with this video monitor to use a 
different audio level, select the desired level from the Audio level list.

Resizing a Video Monitor

To resize a video monitor
• Drag any of the corner handles, inwards or outwards.

The video monitor, and the associated video window, will become smaller or larger, 
and they will both keep their aspect ratio.

• Drag any of the side handles, inwards or outwards.
The bounds of the video monitor will change, while the video window will still keep its 
aspect ratio.

• Change the aspect ratio property of the video monitor. See Setting a Video Monitor’s 
Aspect Ratio below.
The video monitor will keep its bounds, and the video window will be resized to fill as 
much of the video monitor area as possible, given the new aspect ratio.
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Setting a Video Monitor’s Aspect Ratio

To set a video monitor’s aspect ratio
1 Click the video monitor whose aspect ratio you wish to configure.

Video monitor with an aspect ratio of 16:9

2 In the Properties pane, click the Current aspect ratio box, and then select the 
appropriate aspect ratio from the list.

The selected aspect ratio is applied to the video window, within the video monitor.

Video window’s aspect ratio changed to 4:3, within a 16:9 video monitor

Note: In the case of a Kaleido-X or Kaleido-X16, the minimum width 
supported for a video window is 1/16th of the original signal’s horizontal 
resolution. In the case of a Kaleido-X, the minimum height supported for a 
video window is 91 pixels. For a Kaleido-MX, Kaleido-MX 4K, or 
Kaleido-Modular-X, the minimum width is 128 pixels. In the case of a 
KMV-3901/3911, Kaleido-XQUAD, or Kaleido-IP, there is no minimum size.

Note: Double-click the video monitor, if it is part of a composite monitor.
259



Creating Layouts
Configuring Video Monitors
To set a custom aspect ratio for a video monitor
1 In the Properties pane, click the Custom aspect ratio box.

The box becomes editable.
2 Type the appropriate aspect ratio, and then press Enter.

The new aspect ratio is applied to the video window, within the video monitor, and it is 
added to both the Current aspect ratio, and Custom aspect ratio lists.

Adding Safe Area Markers

To add safe area markers for a video monitor in a layout
• In the Properties pane, select the appropriate options, under Safe area markers.

Adding a Custom Safe Area Image
XEdit allows you to superimpose an image, e.g., a brand graphics, on top of a video monitor 
in such a way that a video signal will show through the transparent areas in the graphics. 
This is accomplished by adding a free-form safe area image to the video monitor. The image 
can be in PNG, GIF, or JPEG format.

To add a free-form safe area image to a video monitor
1 In the Properties pane, select the Show markers check box, under Safe area markers.

Note: The custom values are appended to the Custom aspect ratio list on 
an ongoing basis. They can then be applied to other monitors in other 
layouts. Current aspect ratio only lists the current custom ratio, if any, in 
addition to the default 16:9, and 4:3 values.

Notes 

• The maximum size for each image is 256 KB, and the maximum overall size 
(for all images) is 10 MB. Images can be used on multiple layouts and only 
need to be imported to the database once.

• To ensure that the aspect ratio of the imported image is preserved, you 
should position the graphics on a fully transparent background with the 
same aspect ratio as the video monitor on which it is to appear.

• In the case of a cascade system, XEdit must be connected to the 
multiviewer that will provide the source for the corresponding video 
monitor. A monitor that is not associated with a specific source is displayed 
by the system closest to the display.
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2 Click the Custom safe zone image box.
A button appears inside the box.

3 Click the button to open the Select Image window.

Select image 
button
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4 If the image you wish to use is not already listed in Select Image, then click the Open 
button  to open the Browse Image window. Locate the image, select it, and 
then click Open.

The image is imported into the database.
5 In Select image, select the image from the Image selection list, and then click OK.
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6 The image appears on the video monitor.

7 To adjust the transparency level of the image, click the Unsafe zone transparency box, 
then move the slider or type the desired transparency value directly in the box. At 0% 
the portions of the image that correspond to the unsafe area are opaque; at 100% the 
entire image is transparent.

Video Cropping/Zooming

To set the underscan/overscan properties of a video monitor
1 In the Properties pane, scroll down to the Underscan/Overscan section.

Note: When a custom safe zone image is selected, the following attributes 
are not available: Marker color, Safe title offsets, Safe zone aspect ratio, 
and Unsafe zone color.

Note: The Kaleido-IP does not yet support cropping and zooming.
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2 In the Mode list, select Underscan (to display the entire video signal) or Overscan (to 
display a cropped video signal).

3 To specify custom crop settings, click in the white area to the right of Custom overscan, 
then click the button that appears.

4 In the Custom Overscan window, specify new percentage values for Left, Right, Top, 
and Bottom overscan margins, then click OK.
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When the layout is loaded on the monitor wall, the updated overscan/underscan 
properties become available.

Configuring Automatic Aspect Ratios

To slave a video monitor to the input signal aspect ratio
• In the Properties pane, select the appropriate value from the Automatic Aspect Ratio 

list.

• The default value is OFF.
• If the Automatic Aspect Ratio property is set to Follow Input Format, then the 

video monitor will change its aspect ratio based on the input feed’s format.
• If the Automatic Aspect Ratio property is set to Follow Input Format and AFD 

Coded Frame, then the video monitor will change its aspect ratio according to the 
AFD coded frame. If there is no AFD present, the default value for the current 
format will be used (see Configuring the default aspect ratio for HD and SD signals 
on page 266):

• the default HD AFD value, if the input is HD;
• the default SD AFD/WSS value if the input is not HD;
• if the default value for the current input format is None, then the video 

monitor will change its aspect ratio based on the input feed’s format.

Note: Generally avoid exceeding 15% in any direction. You can click 
Restore defaults to enter the default overscan values (left, right, top and 
bottom = 5%). Safe title area and aspect ratio markers follow the video 
signal (e.g., if the safe title is within 5% of top, left, right and bottom, then 
when the video is in default overscan mode, the safe title will not appear).

Note: In the case of the Kaleido-IP, aspect ratio information can be 
extracted and monitored. However, the Kaleido-X software does not yet 
support automatic aspect ratio adjustment based on the decoded information 
for signals originating from these multiviewers.
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Configuring the default aspect ratio for HD and SD signals

To have a video raster follow a video signal’s AFD/WSS metadata
1 Click to put a check mark in the box labeled Follow AFD/WSS.

2 In the Default SD AFD/WSS value list, select the aspect ratio to use when there is no 
AFD or WSS in an SD signal. Select Keep Last to have the video window maintain the 
last decoded AFD or WSS value if the signal is paused.

3 In the Default HD AFD value list, select the aspect ratio to use when there is no AFD or 
WSS in an SD signal. Select Keep Last to have the video window maintain the last 
decoded AFD value if the signal is paused.

Configuring a Video Monitor’s Alarm Reporting Behavior
To prevent users from missing temporary alarms on the monitor wall, monitors that are 
capable of displaying an alarm status (e.g., video monitors, subtitling monitors, UMDs, alarm 
monitors) can be configured with a latching mechanism. An alarm latch will keep the error 
state visible until someone acknowledges the associated alarm. Video monitors can 
provide alarm status information through their borders’ color and blinking behavior, and 
show the latched state as small indicators in each corner of the video window. See also: 
Configuring a Video Monitor’s Source Reporting Behavior, on page 267.
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To set the alarm reporting features for a video monitor
1 In the Properties pane, scroll down to the Alarms/Tallies section.

2 Set the appropriate border color scheme and associated thickness attributes.
3 Click the Blink mode box, and then select the appropriate blinking behavior, for your 

purposes.

4 The Kaleido-X supports the following blinking modes:

5 Select the Display alarm latch check box to enable the latched status indicators in each 
corner of the video window.

Configuring a Video Monitor’s Source Reporting Behavior
To help you distinguish which sources are currently active on the monitor wall, monitors 
that are capable of displaying an alarm status (e.g., video monitors, subtitling monitors, 
UMDs, alarm monitors) can have their borders, background or text configured to appear in 
a specific color, based on their current source. Video monitors can provide this information 
through their borders’ color. See also: Configuring a Video Monitor’s Alarm Reporting 
Behavior, on page 266.

Blink mode Description

Off The status indicator will never blink.

Follow Latch The status indicator’s blinking will follow the latch status. 
The indicator will blink until someone unlatches the 
alarm.

Critical The status indicator will blink when the current status is 
critical.

Critical or Major The status indicator will blink when the current status is 
critical or major.

Critical, Major and 
Minor

The status indicator will blink when the current status is 
critical, major or minor.

Blink mode selection
Display alarm latch check box
267



Creating Layouts
Configuring Video Monitors
To configure a video monitor’s border colors for source reporting
1 In the Properties pane, scroll down to the Alarms/Tallies section.

2 Set the border thickness attributes as desired.
3 Click the border color box for an alarm state you want associated with a distinctive 

color, based on the monitor’s current source.
4 Click the button that appeared at the end of the box.

5 In Colors, select the appropriate level from the Source color level list. See Configuring 
color level assignments on page 206, for more information.

6 Set the color’s transparency as desired.
7 Set the color to be used for sources whose color levels might not be defined, by clicking 

the tab that corresponds to the color space you wish to use, and then choosing the 
desired color (see Configuring a Video Monitor’s Alarm Reporting Behavior on 
page 266, for more information).

8 Click OK to close the color picker window.
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In the Properties pane, the name of the selected source-based color level appears next 
to the fallback color (and transparency, if used).

9 Repeat from step 3 for the remaining colors you wish to set.

Setting a Video Monitor’s Text Mode

To set the subtitling properties of a video monitor
1 In the Properties pane, scroll down to the CC/Subtitling section.

2 Select the Text enabled check box.

3 Select a value from the Text mode list.

Notes 

• Closed captioning/subtitling text services can be enabled by purchasing 
the CC/XDS option. In the case of a Kaleido-X, Kaleido-MX, Kaleido-MX 4K, 
and Kaleido-Modular-X multiviewer system, one license is needed per 
input card. See Hardware and Software Options on page 464 for more 
information.

• The Kaleido-IP supports extraction of CC/subtitling and XDS data 
(1 license/program). It is not yet possible to enable or verify the CC/XDS 
option in XAdmin’s Status and Options page, for this multiviewer model. 
Contact Technical Support for activation and configuration instructions 
(see Contact Us, on page 551).

• The KMV-3901/3911, and Kaleido-XQUAD multiviewers do not support 
extraction of subtitles and closed captions.
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4 Select the appropriate option from the Text colors list.

• Auto: To display text in colors, as defined in the signal.
• Black & white: To display white characters against a black background, regardless 

of what is specified in the signal.
5 To adjust the transparency level of the text background, click the Text background 

transparency box, and then move the slider, or type the desired transparency value 
directly in the box.

At 0% the text will appear against an opaque background; at 100% the fully 
transparent background will let the text appear directly against the video. This applies 
to CEA-608, CEA-708 captions, WST, ST 2031, and RDD 8/OP-47 text.

6 Specify a CEA-708 service value, if necessary, and then click Apply.

7 In the case of a Kaleido-IP, if you wish to pre-select a specific DVB teletext subtitling 
language for this monitor, select the desired page from the Subtitling page list.
Make sure the selected page is configured (see Configuring Teletext/Subtitling Page 
Selection for a Kaleido-IP on page 149). For other multiviewer models, make sure 
page A remains selected.
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8 If you wish to pre-select a specific DVB subtitling language for this monitor, click to 
expand the DVB subtitling language list and then select the appropriate language or 
DVB stream you wish to monitor.

The list of subtitling streams and languages contains the following:
• A series of DVB streams identified by their relative number: DVB stream 1 to DVB 

stream 12. Choose from this series if you wish to always monitor the third available 
subtitling stream, for example.

• A list of all supported languages, in alphabetical order based on the English name, 
which is followed with the corresponding ISO 639-2 alpha-3 code. Choose from this 
series if you wish to monitor subtitling in a specific language.

When XEdit is connected to the multiviewer, the available languages are indicated in 
bold text. The ISO 639-2 alpha-3 code for each available language, and the 
corresponding PID appear in the list of relative subtitling streams.
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Then, following DVB stream 12, for each of the currently available languages, the 
name, the 3-letter code, and the corresponding PID appear in bold text before the list 
of all supported languages.

9 If you wish to pre-select a specific SCTE 27 subtitling language for this monitor, click to 
expand the SCTE 27 subtitling language list and then select the appropriate language 
or SCTE 27 stream you wish to monitor.

The list of subtitling streams and languages contains the following:
• A series of SCTE 27 streams identified by their relative number: SCTE 27 stream 1 

to SCTE 27 stream 12. Choose from this series if you wish to always monitor the 
third available subtitling stream, for example.

• A list of all supported languages, in alphabetical order based on the English name, 
which is followed with the corresponding ISO 639-2 alpha-3 code. Choose from this 
series if you wish to monitor subtitling in a specific language.

When XEdit is connected to the multiviewer, the available languages are indicated in 
bold text. The ISO 639-2 alpha-3 code for each available language, and the 
corresponding PID appear in the list of relative subtitling streams.
Then, following SCTE 27 stream 12, for each of the currently available languages, the 
name, the 3-letter code, and the corresponding PID appear in bold text before the list 
of all supported languages.

Notes 

• The current version of the Kaleido-X software supports foreground colors 
for teletext (WST, OP-47) only. Closed captions (CC, DTVCC) will appear in 
white against a black background.
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10 If you wish to see CC/subtitling text in a larger, more readable font size, select the Large 
font (experimental) check box.

Configuring Audio Monitors

To configure an audio monitor
1 In the Layouts tab, click the audio monitor you wish to configure.
2 In the Properties pane, click the Audio scale box, under Appearance, and then select 

the appropriate audio scale from the list.

• If you do not need teletext to be displayed in colors, then you may find that 
selecting Black & white will improve your system’s performance.

• In the case of the Subtitling (WST) text services, the Kaleido-IP supports 
decoding of up to eight preset pages (page A to page H) per video signal 
on the monitor wall. The other multiviewer models support decoding of a 
single preset page (i.e., page A) per video signal.

• In the case of CEA-608, only CC1 subtitles can be decoded.

• The current version of the Kaleido-X software supports DVB and SCTE 27 
subtitles, from Kaleido-IP sources only.

Note: The large font option is in a beta stage, and works best with an aspect 
ratio of 16:9.

Notes (continued)

Note: To decode Dolby E audio metadata, the Dolby E option is required. 
See Enabling Options on page 493, for more information.

Note: See Configuring Audio Scales on page 277 for more information.
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3 The Monitoring indicator check box is selected by default. Audio monitors with a 
monitoring indicator show by their color that someone is listening to the same audio 
level. There could be a distinctive color for each of the displays at the site, or one for 
each room, etc., telling you in more or less details, where the audio is currently being 
monitored. Clear the check box if you do not need this.

4 If you wish your audio monitor to include a stereo phase meter: under Phase meter, 
select the Meter check box, and then configure the threshold and colors as needed.

5 Under Assignments, click the Audio format box, and then select the appropriate 
format from the list: Auto, PCM, Dolby E or Dolby VANC.

By default, audio monitors added to a layout by using the toolbar button have this 
attribute set to Auto.

6 Choose an Audio level.

7 Choose a value from the Channels list to indicate which channel to display.

Notes
• If the actual audio source assigned to this audio monitor is not of the same 

format configured here, then the audio data will not be shown.
• In the case of a Kaleido-IP, the current version of the Kaleido-X software 

does not support audio monitors configured to monitor PCM audio 
signals. For every audio monitor in your layout, the Audio format property 
should be set to Auto.

Monitoring indicator check box

Meter check box
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• If the Audio format is set to PCM, then the available choices are (L) Left, (R) Right, 
and Stereo.

• If the Audio format is set to Auto, Dolby E or Dolby VANC, then the available 
choices are (L) Left, (R) Right, Stereo, (S) Surround, (Ls) Left surround, (Rs) Right 
surround, (LFE) Low-frequency effects, (C) Center, (Bsl) Back surround left, (Bsr) Back 
surround right, (Le) Left extra, and (Re) Right extra.

8 If your monitoring purposes may involve decoding Dolby E audio metadata, then 
select the appropriate program number (1–8) from the Dolby program list.

9 Make the appropriate assignments (see Assigning Logical Sources or Monitor Wall 
Destinations to Monitors on page 252).

10 Set the other attributes, as needed (see Creating Actions on page 323 for more 
information).

11 On the File menu, click Save.

Note: The number of programs included in a Dolby E metadata bitstream 
depends on the program configuration. For example, a Dolby E stream with 
the 7.1 program configuration only has one program available for selection 
in its metadata bitstream; a 5.1+2 stream has two programs; a 8x1stream has 
eight program selections possible.
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Configuring Loudness Monitors
To configure a loudness monitor

1 In XEdit, click the Layouts tab, and then open the desired layout.
2 Unlock the appropriate composite monitor if applicable (see Unlocking a Composite 

Monitor on page 316).
3 Click the loudness monitor you wish to configure.

4 In the Properties pane, click the Audio scale box, under Appearance, and then select 
the appropriate audio scale from the list.

Three predefined audio scales are available for loudness monitors:
• Full scale (default)
• EBU +9
• EBU +18

5 Choose the Audio level you wish to monitor.

Note: The audio scales applicable to loudness monitors have fixed upper 
and lower limits. Only the colors can be changed (see Configuring Audio 
Scales on page 277).

Note: The selected audio level must be associated with an audio program 
(not with an embedded audio pair). See Audio program on page 126.
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6 Make the appropriate source and destination assignments (see Assigning Logical 
Sources or Monitor Wall Destinations to Monitors on page 252).

7 Set other attributes, as needed (see Creating Actions on page 323 for more 
information).

8 On the File menu, click Save.

Configuring Audio Scales
You can configure audio scales in two ways: either globally, from the Tools menu, or by 
clicking a specific audio monitor in a layout.

Configuring Audio Scales from the Tools Menu

To configure an audio scale from the Tools menu
1 On the Tools menu, click Edit audio scales:

The Edit Audio Scale window appears.

2 Select the audio scale you wish to customize (or the one on which you wish to base a 
new audio scale), from the list at the bottom of the window.
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3 Click one of the Top, Middle or Bottom Color buttons to set the top, middle, and 
bottom color.
The color picker window appears.

4 In Colors, click the tab that corresponds to the color space you wish to use, and then 
choose the desired color.
Swatches in the selected color appear under Preview.

5 Click OK to close the color picker window.
In Edit Audio Scale, the corresponding button and the corresponding part of the audio 
monitor preview show the selected color.

6 Repeat the procedure until all three colors are set as desired.
7 Enter the audio thresholds in Upper limit and Lower limit.
8 Type a name for the new audio scale in the box at the bottom, and then click the Save 

as button. Alternatively, if you are modifying an existing custom audio scale, you can 
click the Save button.

Configuring an Audio Scale from a Specific Audio Monitor

To configure an audio scale from a specific audio monitor
1 In the Layouts tab, click the audio monitor you wish to configure.
2 In the Properties pane, click the Audio scale box, under Appearance, and then click 

the button that appeared at the end of the box.
The Edit Audio Scale window appears.

Note: When you modify one of the default audio scales, you can only save 
your changes as a new audio scale. On the other hand, custom audio scales 
can be tweaked and saved repeatedly until the desired configuration is 
achieved.
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3 Click one of the Top, Middle or Bottom Color buttons to set the top, middle, and 
bottom color.
The color picker window appears.

4 In Colors, click the tab that corresponds to the color space you wish to use, and then 
choose the desired color.
Swatches in the selected color appear under Preview.

5 Click OK to close the color picker window.
Swatches in the selected color appear under Preview.

6 Click OK to close the Choose Background Color window.
In Edit Audio Scale, the corresponding button and the corresponding part of the audio 
monitor preview show the selected color.

7 Repeat the procedure until all three colors are set as desired.
8 Enter the audio thresholds in Upper limit and Lower limit.
9 Type a name for the new audio scale in the box at the bottom, and then click the Save 

as button.
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Removing Audio Scales from the System

To remove a custom audio scale from the system
1 On the Tools menu, click Edit audio scales.

The Edit Audio Scale window appears.
2 In Edit Audio Scale, select the custom scale you wish to remove, from the list at the 

bottom of the window, and then click Delete.

Configuring Time Code Monitors
To configure a time code monitor in a layout

1 To add a time code monitor to a layout, click the “Time code monitor” button  on the 
toolbar, and then click and drag to draw a time code monitor on the layout.
Alternatively, you can drag a time code monitor from a monitor library to the layout.

2 Click the time code monitor you wish to configure.
The time code’s attributes appear in the Properties pane.

Note: When you modify one of the default audio scales, you can only save 
your changes as a new audio scale. On the other hand, custom audio scales 
can be tweaked and saved repeatedly until the desired configuration is 
achieved.

Note: The default audio scales cannot be removed from the system.
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• To replace the default name, type a new name in the Name box.

• If you wish to assign a logical source, drag the appropriate element from the 
Channels/Sources list that appears in the Tools pane, to the time code monitor.

The selected logical source’s name appears in the Source box.

• If you wish to assign time code information from an external provider 
(see Configuring logical sources based on external alarm providers on page 205), 
then select the appropriate text level from the Time code text level list.

Note: The first time code level applies by default. If your system’s logical 
sources include more than one time code level, select the one you wish to 
apply from the Time code level list.
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If the time code monitor is configured with both a time code level and a text level, 
it will show the most recently updated value (i.e., if the multiviewer received time 
code data, followed by a text update from the GSM, then the monitor will display 
the GSM alarm text). If a text value from the GSM does not meet the supported 
formats, then the value is ignored. The supported formats are:

• HH:MM:SS (showing the hours, minutes, and seconds, as 2-digit values)
• HH:MM:SS:FF (showing the hours, minutes, seconds, and frames, as 2-digit 

values)
• HH:MM:SS;FF (showing the hours, minutes, seconds, and drop frames, as 2-

digit values)

Configuring Timers
Building a countdown timer involves defining the timer itself (name, behavior, time 
reference, etc.), and then creating one or more timer monitors to display the timer on a 
monitor wall. Timers can be created, modified, deleted, added to a layout, assigned to 
logical sources, rooms or individual RCP users, and controlled from the Kaleido-RCP2.

Adding Timers to the System

To define a timer
1 On the Tools menu, click Edit timers.

2 In Timer Editor, click New.

Note: With the current implementation of this feature, you may observe a 
200-270 ms delay, depending on your multiviewer system topology, and on 
the network load.

Note: In addition to timer monitors, Gateway commands (see Gateway on 
page 325) can be used to interact with timers. Refer to the Kaleido Remote 
Control Protocol (Gateway) User’s guide, available from the Documentation 
Library section of Grass Valley’s website, for details.
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3 Type a name for your new timer in the Timer name box.

4 Choose the appropriate mode, from the Timer mode list.

• Up: The timer counts up starting from zero up to the Preset time.
• Down: The timer counts down from the Preset time to zero.
• Remaining: The timer counts down from the current time until it reaches the Preset 

time. This mode is a one-shot mode—the timer will not automatically restart the 
next day at the same start time. To restart it, you must either reset the timer 
monitor on the monitor wall, or set and specify a new start time.

5 Choose what happens when the timer reaches the end of its countdown period, from 
the Timer end list.

• Loop: The timer restarts and repeats its cycle (not available with the Remaining 
timer mode).

• Stop: The timer stops.
• Overrun: The timer counts through its specified end point, and then continues 

(when Overrun is specified, the timer always counts up).
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6 If you chose Loop as a timer end mode, specify the number of times the loop should 
repeat.

7 Specify a Preset duration.

8 Specify a Start time.

9 Choose a synchronization source from the Time code reference list— either an 
embedded time code signal from a video source, an LTC input (if available), or the 
internal clock time (default).

IMPORTANT
Before setting a timer’s start time in XEdit, review the following:

• If the selected time code reference includes time zone 
information, then make sure that the PC or laptop that has XEdit 
is configured for the same time zone.
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10 Click Save to save your new timer and close the Timer Editor window.
11 Under the Channels/Sources tab, create a new logical source to associate with the 

timer, and name it.

12 Click a cell in the time code level of the new logical source, and drag the timer you wish 
to assign to this logical source from the filtered System list that appears in the Tools 
pane, to the selected cell in the sources table.

13 Click Save.

Adding a Timer Monitor to a Layout

To create a timer monitor
1 In XEdit, open a layout and click the Timer button .
2 Click and drag to draw a timer monitor on the layout.

• If the selected time code reference does not include time zone 
information, or you chose to bind the timer to the multiviewer’s 
internal clock, then the multiviewer's system time will apply. 
• In the case of a Kaleido-X or Kaleido-X16 multiviewer model, 

make sure the time zone settings are the same, on the 
multiviewer, and on the PC or laptop that has XEdit.

• In the case of a KMV-3901/3911, when you save or export the 
timer to the multiviewer, XEdit automatically converts the 
start time you specified to UTC, based on your computer’s time 
zone settings.

Note: In the case of a Kaleido-X or Kaleido-X16 multiviewer 
model, the system's time zone is configured in XAdmin. In the case 
of a KMV-3901/3911, time is always based on UTC. On a Windows 
PC or laptop, the time zone is configured in the Date and Time 
control panel.
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Alternatively, you can drag a timer monitor from the Timers library to the layout.
The timer’s attributes appear in the Properties pane.

3 Replace the default name, by typing a new name in the Name box.

4 If you wish to assign a logical source, drag the appropriate element from the 
Channels/Sources list that appears in the Tools pane, to the timer monitor.

The selected logical source’s name appears in the Source box, and the Timer source 
box shows the value of the corresponding time code level.

5 Click the button beside Timer source.

Note: The first time code level applies by default. If your system’s logical 
sources include more than one time code level, select the one you wish to 
apply from the Time code level list.

Assigned logical source name

Time code level value from assigned
logical source
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The Timer Editor window appears.
6 Choose a timer (see Configuring Timers on page 282) from the Timer List.

It is also possible to assign a timer to a timer monitor by dragging an existing logical 
source (containing a timer assignment) to the monitor.

7 Click Save.
8 Modify the timer’s Appearance properties as needed.

9 To attach an action to the timer, click the button beside Mouse click.

The Action Editor window appears.
10 Drag an action from the left pane to the middle pane, then specify the action’s behavior 

in the right pane.

Note: Each timer monitor is assigned to exactly one timer. Multiple timer 
monitors can be assigned to the same timer. Start/stop/reset or mode 
changes applied to one monitor affect all other monitors assigned to the 
same timer.
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For more information on creating actions, refer to Creating Actions, on page 323.
11 Click OK to save the action assignment and close the Action Editor window.
12 Click Save to save the layout with the new timer monitor.
13 Export the database to a Kaleido-X, and load the layout.

The interactive timer monitor appears on the monitor wall. See Using Timers, on 
page 58, Assigning a Timer to a Room, on page 338, and Assigning a Timer to an RCP 
User, on page 342, for more information.

Configuring UMDs 
UMDs can serve various purposes: in addition to displaying the name of the video source 
seen in a video monitor, they can report operational status and error conditions in real time, 
by showing dynamic alarm and text attributes associated with a source.

To configure a UMD
1 In XEdit, click the Layouts tab, and then open the desired layout.
2 Unlock the appropriate composite monitor if applicable (see Unlocking a Composite 

Monitor on page 316).
3 Click the UMD you wish to configure.
4 To pre-assign a logical source to be monitored by default, to configure the selected 

UMD as a monitor wall destination, or to configure its reporting behaviors, see:
• Assigning Logical Sources or Monitor Wall Destinations to Monitors, on page 252.
• Setting Monitored Alarm and Text Levels for a UMD, on page 289.
• Configuring a UMD’s Alarm Reporting Behavior, on page 289.
• Configuring a UMD’s Source Reporting Behavior, on page 291.

5 To configure UMD text properties, see:
• Configuring Static UMD Text, on page 293.
• Configuring Dynamic UMD Text, on page 293.
• Setting the Text Font, on page 294.

6 Click outside the composite monitor to lock it, if applicable.
7 On the File menu, click Save.
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Setting Monitored Alarm and Text Levels for a UMD
When a system’s logical sources include more than one level under a given category, the 
first level is selected by default for monitoring. In the case of a UMD, you may change the 
alarm levels associated with the UMD itself, and with its left and right tallies, and the text 
level from which the UMD label will be retrieved.

To change the default alarm and text levels selected for a UMD
1 To monitor a different alarm level, or the source’s global alarm, select the appropriate 

level from the UMD alarm level list.

2 To have the UMD report alarm text (or other dynamic text), select the desired level from 
the Text label level list.

See Configuring Dynamic UMD Text on page 293, for more information.
3 If you wish to monitor tallies, select the desired levels from the Left tally source level, 

and Right tally source level lists.
See Tally Interface Devices &Timer Systems on page 395, for examples of such 
configurations.

Configuring a UMD’s Alarm Reporting Behavior
To prevent users from missing temporary alarms on the monitor wall, monitors that are 
capable of displaying an alarm status (e.g., video monitors, subtitling monitors, UMDs, alarm 
monitors) can be configured with a latching mechanism. An alarm latch will keep the error 
state visible until someone acknowledges the associated alarm. For UMDs, the latch color 
can be set to follow the background or the text color configuration. See also: Configuring a 
UMD’s Source Reporting Behavior, on page 291.

To set the alarm reporting features for a UMD (text and tallies)
1 In XEdit, open a layout, and click the UMD whose alarm reporting behavior you wish to 

configure.

Note: Double-click the UMD, if it is part of a composite monitor.
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2 If you wish to use the UMD’s alarm latching mechanism, make sure the UMD is 
configured with a bevel.
In the Properties pane, the UMD bevel attribute should be set to either lowered, or 
raised.

3 Scroll down to the Alarms/Tallies section, in the Properties pane, to set the 
appropriate text and background color scheme.

4 Click the Blink mode boxes, and then select the appropriate blinking behavior, for your 
purposes:

Blink mode Description

Off The status indicator will never blink.

Follow latch The status indicator’s blinking will follow the latch status. 
The indicator will blink until someone unlatches the alarm.

Critical The status indicator will blink when the current status is 
critical.

Blink mode selection

Display alarm latch check box

Display alarm latch check box

Display alarm latch check box

Blink mode selection

Blink mode selection

Latch colors selection
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5 Select the Display alarm latch check box to enable the latched status indicators.

Configuring a UMD’s Source Reporting Behavior
To help you distinguish which sources are currently active on the monitor wall, monitors 
that are capable of displaying an alarm status (e.g., video monitors, subtitling monitors, 
UMDs, alarm monitors) can have their borders, background or text configured to appear in 
a specific color, based on their current source. UMDs can provide this information through 
their text and background colors. See also: Configuring a UMD’s Alarm Reporting Behavior, 
on page 289.

To configure a UMD’s background or text colors for source reporting
1 In XEdit, open a layout, and click the UMD whose source reporting behavior you wish to 

configure.

2 In the Properties pane, scroll down to the Alarms/Tallies section.

3 Click the text or background color box for a state you want associated with a distinctive 
color, based on the monitor’s current source.

4 Click the button that appeared at the end of the box.

Critical and major The status indicator will blink when the current status is 
critical or major.

Critical, major and 
minor

The status indicator will blink when the current status is 
critical, major or minor.

Note: Double-click the UMD, if it is part of a composite monitor.

Blink mode Description
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5 In Colors, select the appropriate level from the Source color level list. See Configuring 
color level assignments on page 206, for more information.

6 Set the color’s transparency as desired.
7 Set the color to be used for sources whose color levels might not be defined, by clicking 

the tab that corresponds to the color space you wish to use, and then choosing the 
desired color (see Configuring a UMD’s Alarm Reporting Behavior on page 289, for 
more information).

8 Click OK to close the color picker window.
In the Properties pane, the name of the selected source-based color level appears next 
to the fallback color (and transparency, if used).

9 Repeat from step 3 for the remaining colors you wish to set.
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Configuring Static UMD Text
A UMD can show two types of static text:

• static text that you typed directly on a layout, in XEdit (see below), or on the monitor 
wall (see Editing UMD Text on page 51);

• static text associated with the current logical source assigned to the UMD, which you 
entered in the sources table.

In the first case, the static text is tied to a specific layout whereas, in the other case, the text 
is tied to a specific input signal.

To configure static text for a specific UMD in a layout
1 In the Layouts tab, double-click the UMD whose static text you wish to set.
2 Make sure the appropriate input language and method are set in your operating 

system.
3 Type the desired static text.

To configure static UMD text from the sources table
1 In the Channels/Sources tab, click the cell that corresponds to the appropriate text 

level of the logical source that is assigned to the UMD whose static text you wish to set.
2 Type the new static text.

Configuring Dynamic UMD Text
Assuming you have created logical sources (see Creating and Configuring Logical Sources 
on page 196) and a layout in XEdit, you can further configure UMDs in your layout to report 
dynamic text labels, associated with the sources you wish to monitor.

To configure dynamic UMD text
1 In the Channels/Sources tab, click a cell that corresponds to the appropriate text level 

of a logical source.
2 In the filtered System list, navigate to the text element you wish to monitor, and drag it 

onto the selected cell.

3 Make corresponding assignments to other logical sources by incremental copy, if 
desired (see Making Further Assignments by Incremental Copy on page 207).

4 On the File menu, click Save.
Changes to the sources table are saved.

5 Click the Layouts tab, and then open the layout you wish to configure.
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6 Unlock the appropriate composite monitor if applicable (see Unlocking a Composite 
Monitor on page 316), and then click the UMD whose dynamic text reporting behavior 
you wish to set.

7 In the Properties pane, click the Text label level box, and then select the text level you 
configured in step 2.

8 Click outside the composite to lock it, if applicable.
9 Repeat step 6 – step 8 until you have configured all UMDs that are to display dynamic 

text when this layout is loaded on the monitor wall.
10 On the File menu, click Save.

Setting the Text Font

To set the text font for a UMD in a layout
1 In the Layouts tab, click the UMD whose text font you wish to set.
2 In the Properties pane, click the Text font box, under Appearance, then click the 

button that appeared at the end of the box.
The Select a Font window appears.

3 Select the appropriate values from the Font, Font Style and Size lists.
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4 Click OK.

Configuring Alarm Monitors
To add an alarm monitor to a layout

1 Click the Alarm monitor button ( ) on the toolbar, click the layout, and then move or 
resize the monitor as needed.
You may choose to layer this monitor on top of the video window within a composite. 
See Working with Composite Monitors on page 310, for instructions on how to add 
elements to a composite.

2 In the Properties pane, set the transparency attribute to the appropriate value for your 
purposes, by clicking the Transparency box, and then using the slider or typing the 
desired value directly into the box.

Set the other appearance attributes as desired.
3 In the Alarms/Tallies section, set the appropriate color and video transparency scheme 

for the text and background, to achieve the desired alarm reporting and source 
reporting behaviors (see Configuring an Alarm Monitor’s Source Reporting Behavior, 
on page 296, for details).

Note: On a monitor wall display connected to a KMV-3901/3911 
multiviewer output, there is no difference in the rendering between bold 
and regular text.

Note: On the monitor wall, an alarm monitor positioned over a video 
window has the following default behavior:
• If the source assigned to the alarm monitor is an active alarm (red), the 

alarm monitor is visible. The video transparency settings configured in 
XEdit for this alarm monitor apply to the part of the monitor that overlaps 
the video window.

• If the source assigned to the alarm monitor is an inactive alarm (green), 
the alarm monitor is not visible on the monitor wall. If the alarm monitor 
partially overlaps the video window, then the part of the monitor that 
does not cover the video window remains visible (green).

Alarm monitor
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4 Click the Blink mode box, and then select the appropriate blinking behavior, for your 
purposes:

5 To enable the latched status indicators, select the Display alarm latch check box, click 
the Latch colors box, and then select the appropriate color scheme for your purposes: 
either Same as text colors, or Same as background colors.

6 Choose from two display modes: Cycle and Marquee.
In cycle mode, the alarm monitor displays text from each alarm, one after the other. In 
marquee mode, the alarm text scrolls across the monitor. In addition, you can control 
the cycling speed and the scroll rate by setting the cycling period, in milliseconds.

7 Make the appropriate assignments (see Assigning Logical Sources or Monitor Wall 
Destinations to Monitors on page 252), and select the desired alarm and text label 
levels, if necessary.

8 On the File menu, click Save.

Configuring an Alarm Monitor’s Source Reporting Behavior
To help you distinguish which sources are currently active on the monitor wall, monitors 
that are capable of displaying an alarm status (e.g., video monitors, subtitling monitors, 
UMDs, alarm monitors) can have their borders, background or text configured to appear in 

Blink mode Description

Off The status indicator will never blink.

Follow latch The status indicator’s blinking will follow the latch status. 
The indicator will blink until someone unlatches the alarm.

Critical The status indicator will blink when the current status is 
critical.

Critical and major The status indicator will blink when the current status is 
critical or major.

Critical, major and 
minor

The status indicator will blink when the current status is 
critical, major or minor.

Display alarm latch check box

Blink mode selection
Latch colors selection

100% video transparency to keep the status
indicator hidden when there is no alarm.
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a specific color, based on their current source. Alarm monitors can provide this information 
through their text and background colors.

To configure an alarm monitor’s background or text colors for source reporting
1 In XEdit, open a layout, and click the alarm monitor whose source reporting behavior 

you wish to configure.

2 In the Properties pane, scroll down to the Alarms/Tallies section.

3 Click the text or background color box for a state you want associated with a distinctive 
color, based on the monitor’s current source.

4 Click the button that appeared at the end of the box.

5 In Colors, select the appropriate level from the Source color level list. See Configuring 
color level assignments on page 206, for more information.

Note: Double-click the alarm monitor, if it is part of a composite monitor.
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6 Set the color’s transparency as desired.
7 Set the color to be used for sources whose color levels might not be defined, by clicking 

the tab that corresponds to the color space you wish to use, and then choosing the 
desired color.

8 Click OK to close the color picker window.
In the Properties pane, the name of the selected source-based color level appears next 
to the fallback color (and transparency, if used).

9 Repeat from step 3 for the remaining colors you wish to set.

Configuring Subtitling Monitors
To monitor subtitling from a DVB or SCTE 27 stream

1 To add a subtitling monitor, click the Subtitling monitor button ( ) on the toolbar, 
click the layout, and then move or resize the monitor as needed.

2 Click the subtitling monitor you wish to configure.

The subtitling monitor’s attributes appear in the Properties pane.
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The first alarm level is selected by default for alarm reporting.
3 If you wish to monitor a different alarm level, or the source’s global alarm, select the 

appropriate level from the Border alarm level list.

The first video level applies by default.
4 If your system’s logical sources include more than one video level, select the one you 

wish to monitor from the Video level list.

5 If you wish to replace the default name, type a new name in the Name box.

6 If you wish to assign a logical source, drag the appropriate element from the 
Channels/Sources list that appears in the Tools pane, to the subtitling monitor.
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The selected logical source’s name appears in the Source box.

7 If you wish to pre-select a specific text mode for this monitor, select the desired value 
from the Text mode list (see Teletext, Subtitles, and Closed Captions on page 174).

8 If you wish to pre-select a specific DVB subtitling language for this monitor, click to 
expand the DVB subtitling language list, and then select the appropriate language or 
DVB stream you wish to monitor.

The list of subtitling streams and languages contains the following:
• A series of DVB streams identified by their relative number: DVB stream 1 to DVB 

stream 12. Choose from this series if you wish to always monitor the third available 
subtitling stream, for example.

• A list of all supported languages, in alphabetical order based on the English name, 
which is followed with the corresponding ISO 639-2 alpha-3 code. Choose from this 
series if you wish to monitor subtitling in a specific language.

When XEdit is connected to the multiviewer, the available languages are indicated in 
bold text. The ISO 639-2 alpha-3 code for each available language, and the 
corresponding PID appear in the list of relative subtitling streams.
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Then, following DVB stream 12, for each of the currently available languages, the 
name, the 3-letter code, and the corresponding PID appear in bold text before the list 
of all supported languages.

9 If you wish to pre-select a specific SCTE 27 subtitling language for this monitor, click to 
expand the SCTE 27 subtitling language list, and then select the appropriate language 
or SCTE 27 stream you wish to monitor.

The list of subtitling streams and languages contains the following:
• A series of SCTE 27 streams identified by their relative number: SCTE 27 stream 1 

to SCTE 27 stream 12. Choose from this series if you wish to always monitor the 
third available subtitling stream, for example.

• A list of all supported languages, in alphabetical order based on the English name, 
which is followed with the corresponding ISO 639-2 alpha-3 code. Choose from this 
series if you wish to monitor subtitling in a specific language.

When XEdit is connected to the multiviewer, the available languages are indicated in 
bold text. The ISO 639-2 alpha-3 code for each available language, and the 
corresponding PID appear in the list of relative subtitling streams.
Then, following SCTE 27 stream 12, for each of the currently available languages, the 
name, the 3-letter code, and the corresponding PID appear in bold text before the list 
of all supported languages.

10 Modify the subtitling monitor’s Appearance properties as needed.
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11 If you wish to use the subtitling monitor’s background color for source reporting:
a Click the Background color box, and then click the button that appeared at the 

end of the box.

b In Colors, select the appropriate level from the Source color level list. 
See Configuring color level assignments on page 206, for more information.

c Set the color’s transparency as desired.
d Set the color to be used for sources whose color levels might not be defined, by 

clicking the tab that corresponds to the color space you wish to use, and then 
choosing the desired color.

e Click OK to close the color picker window.
f In the Properties pane, the name of the selected source-based color level appears 

next to the fallback color (and transparency, if used).

12 Change the Default aspect ratio as needed.

This value is used in the absence of aspect ratio information in the DVB or SCTE 27 
subtitling stream, when the associated video stream is not decoded. When the video is 
decoded, the video signal’s aspect ratio is used, in the absence of aspect ratio 
information in the subtitling stream. See Setting a Video Monitor’s Aspect Ratio on 
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page 259 for more information, including on selecting a custom aspect ratio.
13 Refer to Configuring a Video Monitor’s Alarm Reporting Behavior, on page 266, and to 

Configuring a Video Monitor’s Source Reporting Behavior, on page 267, to configure 
the subtitling monitor’s other alarm reporting, and source reporting features.

14 Refer to Creating Monitor Wall Actions, on page 325 to configure mouse-click actions 
for this subtitling monitor.

15 On the File menu, click Save.

Configuring Metadata Monitors
To monitor XDS data, or digital content advisory descriptor (CAD) information

1 Click the Metadata monitor button ( ) on the toolbar, click the layout, and then move 
or resize the monitor as needed.

Alternatively, you may choose to layer this monitor on top of the video window within 
a composite. See Working with Composite Monitors on page 310, for instructions on 
how to add elements to a composite.

2 In the Properties pane, select the check boxes that correspond to the data elements 
you wish the monitor to display.

• XDS data: APS, ASB, CGMS-A; channel number; elapsed time; network name; 
program description, ID, name, length, and type; station ID; TSID; time/date; time 
zone; V-chip rating

• CAD information: US rating, Canadian rating
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3 You can also set appearance properties, including the font and size of the text labels, or 
choose not to display the labels by clearing the Display legend check box.

The selected monitor is updated accordingly on the layout.
4 Make the appropriate assignments (see Assigning Logical Sources or Monitor Wall 

Destinations to Monitors on page 252), and select the desired video level, if necessary.

5 Click the Save button on the toolbar.

Configuring V-Chip Monitors
A V-chip monitor provides a visual indication of the V-chip rating from the CC (608) 
metadata in an SD video signal, or from the CC (608) legacy caption data when such data is 
present within an HD video signal.

To add a V-chip monitor to a layout
1 Click the V-chip monitor button ( ) on the toolbar, click the layout, and then move or 

resize the monitor as needed.
You may choose to layer this monitor on top of the video window within a composite. 
See Working with Composite Monitors on page 310, for instructions on how to add 
elements to a composite.

Note: Extraction of CC (608) captions and CC (608) legacy captions is 
available with the Extraction of CC, Subtitling and XDS metadata option 
(CC/XDS).
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2 In the Properties pane, set the transparency attribute to the appropriate value for your 
purposes, by clicking the V-chip transparency box, and then using the slider or typing 
the desired value directly into the box.

3 If you wish to preview the logo associated with a specific V-chip rating, select it from 
the V-chip rating preview list. For example:

4 Make the appropriate assignments (see Assigning Logical Sources or Monitor Wall 
Destinations to Monitors on page 252), and select the desired video level if necessary.

5 On the File menu, click Save.

Note: As its name implies, the V-chip rating preview is only a preview, and 
its value is not saved with the layout.

Notes 

• Unlike alarms, the V-chip rating associated with a video signal that is 
currently monitored on the monitor wall is not relayed to the XEdit user 
interface, when working in online mode.

• The V-chip monitor uses the holding time configured with the XDS 
filtering calibrations for the associated video source (see Calibrating 
Metadata Holding Time on page 151). Once the specified holding time has 
expired, the V-chip monitor displays the N/A logo ( ).

• When V-chip data cannot be extracted from the current video signal, the 
V-chip monitor displays the N/A logo ( ).
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Configuring Clocks
In addition to the default combo-type clock that can be added to a layout by using the 
Clock button ( ) on the toolbar, the predefined monitor library includes a selection of 
analog and digital clocks.

To configure a clock
1 In the Layouts tab, click the clock you wish to configure.

2 In the Properties pane, make the appropriate assignments:
• Determine the time source (see Assigning Logical Sources or Monitor Wall 

Destinations to Monitors on page 252), and select the desired time code level if 
necessary.

• Select the appropriate time zone for your purposes.

Notes
• The KMV-3901/3911 and Kaleido-XQUAD do not support analog clocks.
• In the case of a KMV-3901/3911, Kaleido-XQUAD, Kaleido-MX, 

Kaleido-MX 4K, or Kaleido-Modular-X, the system time is always based on 
UTC. However, if you wish to see the time from different time zones on the 
monitor wall, you can configure different clocks accordingly.
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If you select Autodetect, then the clock will use the time zone from the assigned 
source, based on the following rules:

• If the clock is bound to an LTC or DVITC time code that includes time zone 
information, then the time zone is decoded from the time code.

• If the clock is bound to the system time, or to an LTC or DVITC time code that 
does not include time zone information, then:
– in the case of a Kaleido-X or Kaleido-X16 multiviewer model, the time zone 

configured in XAdmin applies;
– in the case of a KMV-3901/3911 or Kaleido-MX, the system time is always 

based on UTC.
3 If the clock is bound to an LTC or DVITC time code, and you wish it to momentarily use 

the multiviewer’s internal clock for reference should the assigned time code become 
unavailable, then select Fall back to internal pulse.

When a clock configured with this option loses its time reference, it will not stop but 
keep working to the beat of the multiviewer internal clock instead.

Notes 

• When a clock switches between the LTC or DVITC signal, and the 
multiviewer’s internal clock reference, you may notice a one-second offset 
on the monitor wall.
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4 Modify the clock’s Appearance properties as needed:
• From the Clock type list, select between a digital, an analog or a combo-type clock.

• Resize the clock as needed, set color attributes, and select the appropriate date and 
time formats.

• In the case of a digital or combo-type clock, select the Display leading zero check 
box, if you wish to see the time with a leading zero when it is before 10:00 a.m. or 
10:00 p.m.

• In the case of an analog or combo-type clock, you can also add a clock logo 
(see Inserting a Clock Logo on page 309).

• In the case of an analog or combo clock, if the clock is to be displayed against a 
pink background— RGB (255, 0, 255) or similar—, or if the current layout belongs 
to a cascade room (see page 72), then make sure to clear the Border antialiasing 
check box.

• Refreshing the current layout (or switching to another layout and then 
back) cancels the fallback mechanism. When this happens, the clock that 
had lost its time reference halts, showing the time it was at the moment 
the layout was refreshed (or loaded again), based on the multiviewer 
system clock.

Notes (continued)
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In such cases, if border antialiasing remains enabled, the clock will have a pink 
outline on the monitor wall.

5 Define actions associated to this layout element (see Creating Monitor Wall Actions on 
page 325).

6 On the File menu, click Save.

Inserting a Clock Logo

To insert a clock logo
1 In the Properties pane, click the Logo box, under Appearance.
2 Click the button that appeared at the end of the box.

The Select Image window appears.
3 If the logo you wish to use is not already listed in Select Image, then click the Open  

button to open the Browse Image window. Locate the image, select it, and then click 
Open.

Notes 

• The maximum size for each image is 256 KB, and the maximum overall size 
(for all images) is 10 MB. The image can be in PNG, GIF, or JPEG format. 
Images can be used on multiple layouts and only need to be imported to 
the database once.

• In the case of a cascade system, XEdit must be connected to the 
multiviewer that will provide the source for the corresponding clock. A 
clock that is not associated with a specific source is displayed by the 
system closest to the display.
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The image is imported into the database.
4 In Select image, select the logo you wish to use from the Image selection list, and then 

click OK.

The logo appears on the clock background.

Working with Composite Monitors

Creating a Composite Monitor
Composite monitors encapsulate a number of primary elements (e.g., a video monitor, one 
or two audio monitors, a UMD, and a time code) that can then be managed as a single 
object. The following example outlines the basic rules to follow, in order to create 
composite monitors that can be resized elegantly.

To create a composite monitor
1 Open an existing layout or create a new one.
2 Click the Composite button  on the toolbar, and then click the layout. Resize the 

empty composite box approximately, to a size that will be appropriate for the display 
where it is to appear.
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Empty composite

3 Right-click the empty box, and then click Unlock on the menu.
Notice that the handles around the box boundary line become orange.

Unlocked empty composite

4 Add a monitor to the composite, either using a button on the toolbar or dragging an 
element from a monitor library. For example, click the Video monitor button  on the 
toolbar, and then click inside the composite to add a video monitor.

Video monitor within unlocked composite

5 Click the Audio monitor button  on the toolbar, and then click inside the composite 
to add an audio level meter.

Note: If you double-click a composite monitor, the handles also become 
orange. However, in such a case, you cannot move or resize individual 
components within the composite (see Unlocking a Composite Monitor on 
page 316).

Note: Only primary monitors (not composite) can be part of a composite.
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Audio level meter within unlocked composite

6 Click the UMD button on the toolbar, and then click inside the composite to add a 
UMD.

UMD within unlocked composite

7 Move the audio level meter to the very edge of the composite, using the mouse and 
then finishing with the arrow keys, and resize it as appropriate.

Audio level meter resized and moved to the side

8 Move the UMD to the very bottom of the composite, using the mouse and then finishing 
with the arrow keys, and resize it if needed.
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UMD resized and moved to the bottom, with its upper right handle matching the audio level 
meter’s lower left handle

9 Move the video monitor to the top-left corner of the composite, then click its bottom-
right corner handle, and drag it to stretch the video until one of its dimensions 
completely fills the empty area (vertically or horizontally).

Video monitor stretched to fill the remaining horizontal area

10 Drag the video monitor’s bottom-center handle until it meets the UMD’s bounds.

Notes 

• Making sure that UMDs and audio monitors do not overlap one another in 
a composite monitor will ensure optimal performance of any layout where 
several copies of this composite might appear. As a rule, avoid overlapping 
graphical elements in a layout.

• To align a monitor more precisely against another, select one of them, and 
then click the second one while holding the Shift key. It is then possible to 
drag any of the sizing handles (the larger grey dots) to resize any of the 
selected monitors, while their relative position remains visible. Whenever 
appropriate, matching adjacent monitors’ corner or center handles 
together will help achieve a composite that can be resized elegantly.
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Video monitor stretched vertically with its bounds matching the UMD’s

11 Adjust the size and position of the components some more if needed, making sure to 
keep the peripheral monitors at the very edges of the composite’s boundary box, while 
minimizing empty space within the composite.

12 Click outside the composite to lock it.

Locked composite

13 Drag the composite’s top or bottom center handle inwards, until there is no more 
empty space above and below the video monitor.

Composite resized to remove remaining empty space around video monitor

14 To be able to reuse the new composite in other layouts, drag it onto the appropriate 
monitor library while holding the Ctrl key. See Creating a Monitor Library on page 320 
for more information.

15 On the File menu, click Save.

Note: Resizing the video monitor is easier with the UMD’s bounds visible: 
first click the video monitor, and then click the UMD while holding the Shift 
key.
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Resizing a Composite Monitor

To resize a composite
• Click the composite monitor, and drag any of its corner handles outwards or inwards.

The composite expands or shrinks while its individual elements maintain their relative 
position and aspect ratio.

Larger and smaller copies of the original composite

Composite monitors configured for maximum video area

In the case of composite monitors from the legacy maximum video area monitor libraries, or 
that were created with a version of XEdit earlier than 7.40, individual monitors within a 
composite are resized according to the following rules:

• Video monitors are scaled proportionally, in both width and height.
• Vertical audio monitors are scaled vertically, but their width does not change.
• Horizontal audio monitors, time codes, timers, and UMDs are scaled horizontally, but 

their height does not change.
• Clocks are not resized.

The following table summarizes these rules:

Note: In the case of a Kaleido-X or Kaleido-X16, the minimum width 
supported for a video window is 1/16th of the original signal resolution. In 
the case of a Kaleido-X, the minimum height supported for a video window 
is 91 pixels. For a Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X, the 
minimum width is 128 pixels. In the case of a KMV-3901/3911, 
Kaleido-XQUAD, or Kaleido-IP, there is no minimum size.
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Unlocking a Composite Monitor
Since a composite monitor functions as a single entity, its individual components are 
locked together. If you wish to configure individual components within a composite 
monitor, you need to first unlock the monitor. There are two ways in which a composite 
monitor can be unlocked, one of which prevents you from moving or resizing individual 
components. An unlocked composite monitor has orange handles around its boundary 
line.

If you wish to configure properties for individual components within a composite 
monitor

• Double-click the composite monitor whose primary elements you wish to configure.
Notice that the handles around the boundary line become orange. When using this 
method, you cannot move or resize the monitor’s individual components.

If you wish to add, move, or resize individual components within a composite monitor
• Right-click the composite monitor you wish to modify, and then click Unlock on the 

menu. Alternatively, click the monitor, and then press F2.
Notice that the handles around the boundary line become orange.

Using the Region Editor

Opening the Region Editor

Monitor type Height Width

Video Scalable Scalable

Vertical audio monitor Scalable Fixed

Horizontal audio 
monitor, UMD, time 
code, timer

Fixed Scalable

Clock Fixed Fixed

Orange handles

Note: The region editor is part of the expert view. To show the expert view, 
click the View filters button on the Properties pane’s toolbar, and then 
select the Expert view check box. Using the region editor is not 
recommended. To accomplish most configurations, the standard tools 
available in the layout editor are sufficient.
316



Kaleido-X
User’s Manual
To open the region editor
1 Click the monitor whose properties you wish to see.
2 In the Properties pane, click the Bounds box, under Size & Position.

Click the button that appeared inside the box to open the Region Editor window.

Configuring a Monitor’s Position Using the Region Editor

To set a monitor’s position on the layout
1 For each position, first select the appropriate unit.

2 Type values in the Left, Top, Right, and Bottom boxes, relative to the upper-left corner 
of the display.

3 Click OK to close the editor.
4 On the File menu, click Save.

Configuring a Monitor’s Dimensions Using the Region Editor

To configure a monitor’s dimensions
1 For each dimension, first select the appropriate unit.
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2 Type values in the Width and Height boxes.
3 Click OK to close the editor.
4 On the File menu, click Save.

Format Painting

Copying Properties from one Monitor to Another
Every monitor in a layout has properties related to its appearance that you can configure in 
the Properties pane. The Copy properties tool  copies most of these properties from one 
monitor to another of the same type (e.g., audio monitor to audio monitor, clock to clock, 
etc.). Assignments, and actions are not copied. Size is not copied by default (see TIP, below). 
To copy actions, use the Copy actions tool (see Copying Actions from one Monitor to 
Another on page 319). To copy size only, use the Copy size tool (see Copying Size from one 
Monitor to Another on page 318).

To use the Copy properties tool
1 In the Layouts tab, click the monitor whose properties you wish to copy to another 

monitor of the same type.
The monitor’s boundary box appears.
The Copy properties button  becomes available on the toolbar.

2 Click the Copy Properties button to switch to format-painting mode.
3 Point to another monitor of the same type in the layout.

The pointer changes to a hand with the index finger pointing , indicating that the 
properties of the first monitor (whose boundary box is still shown) can be copied onto 
the monitor beneath the pointer.

4 Click the monitor beneath the pointer to copy the properties onto that monitor.
The monitor’s appearance changes to reflect the new properties.

5 Repeat this for every monitor whose properties you wish to change.
6 Click the Select button  on the toolbar to exit format-painting mode when you have 

finished.

Copying Size from one Monitor to Another
The size of every monitor in a layout can be adjusted by the user, by dragging handles on 
the boundary box that appears when the monitor is selected. The Copy size tool  copies 

TIP
To have the width and height copied as well, press and hold the Ctrl key 
while clicking the monitor.
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the size from one monitor to another monitor of the same type. The Copy size tool does not 
copy any other properties from one monitor to another.

To use the Copy size tool
1 In the Layouts tab, click the monitor whose size you wish to copy to another monitor of 

the same type.
The monitor’s boundary box appears.
The Copy size button  becomes available on the toolbar.

2 Click the Copy size button to switch to size-painting mode.
3 Point to another monitor of the same type in the layout.

The pointer changes to a hand with the index finger pointing , indicating that the 
size of the first monitor (whose boundary box is still shown) can be copied onto the 
monitor beneath the pointer.

4 Click the monitor beneath the pointer to copy the size onto that monitor.
The monitor’s size changes to match that of the first monitor.

5 Repeat this for every monitor whose size you wish to change.
6 Click the Select button  on the toolbar to exit size-painting mode when you have 

finished.

Copying Actions from one Monitor to Another
The Copy actions tool  copies the single-click and double-click actions from one monitor 
to another monitor of the same type. The Copy actions tool does not copy any other 
properties from one monitor to another.

To use the Copy actions tool
1 In the Layouts tab, click the monitor whose actions you wish to copy to another 

monitor of the same type.
The monitor’s boundary box appears.
The Copy actions button  becomes available on the toolbar.

2 Click the Copy actions button to switch to action-painting mode.
3 Point to another monitor of the same type in the layout.

The pointer changes to a hand with the index finger pointing , indicating that the 
actions of the first monitor (whose boundary box is still shown) can be copied onto the 
monitor beneath the pointer.

4 Click the monitor beneath the pointer to copy the actions onto that monitor. 
The monitor’s actions change to match that of the first monitor.

5 Repeat this for every monitor whose actions you wish to change.
6 Click the Select button  on the toolbar to exit action-painting mode when you have 

finished.
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Managing Monitor Libraries

Creating a Monitor Library

To create a monitor library
1 Click the Layouts tab.
2 In the Tools pane, click My monitors.
3 Right-click inside the custom monitor libraries area, and then click New monitor library 

on the menu. Alternatively, click New monitor library on the File menu.

The new monitor library appears in the custom monitor libraries area in the Tools pane.
4 On the File menu, click New. Alternatively, click Open to open an existing layout. 
5 Click the appropriate button on the toolbar, then click the layout to add a monitor of 

the selected type. Alternatively drag a monitor from one of the existing libraries onto 
the layout, or choose an existing monitor within the layout.

6 Customize the monitor if necessary, and then drag it onto the new monitor library 
while holding the Ctrl key.

7 Right-click anywhere inside the monitor library, and then click Save monitor library on 
the menu.
The Save Monitor Library window appears.

8 Type a name for the new custom monitor library, and then click Save.

Closing a Monitor Library

To close a monitor library
• Once the custom library is saved, you can right-click in the library area, and then click 

Close monitor library on the menu. Alternatively, on the File menu, click Close 
monitor library.

Note: It is not possible to customize a monitor once it is inside a library.
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Opening a Monitor Library

To open a custom library
• Right-click inside the custom monitor libraries area, in the Tools pane, and then click 

Open monitor library on the menu.
• On the File menu, click Open monitor library.
• On the File menu, point to Open recent, and then select from the list of recently used 

monitor libraries.

Note: It is possible to have multiple custom libraries open at the same time.
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Creating Actions
This chapter describes how to configure and trigger monitor wall actions, and background 
actions.

Overview
An action is an operation automatically performed in response to a specific trigger. A 
monitor wall action is associated with a monitor belonging to a specific layout or directly 
with a specific layout. It can only be activated when that layout is loaded on the monitor 
wall, whereas a background action can be triggered at any time by any alarm on the 
multiviewer. Unlike monitor wall actions, background actions are always available within a 
multiviewer system, regardless of what layouts are currently loaded.

Examples of actions:
• Unlatch/Acknowledge all
• Load layout
• Assign logical source (channel)
• Set GPI output
• Show/Hide full screen layout
• Reset/Pause/Start a timer
• Monitor audio
• Toggle destination overlay
• Switch router crosspoint
• Custom (JavaScript)

Note: Version 5.30 of the Kaleido-X software introduced a bug fix that 
required changes to the JavaScript code associated with all predefined 
actions elements in XEdit. For the fix to be applied to actions created with an 
earlier version of XEdit, open them with version 5.30 or later, and view the 
underlying JavaScript code by selecting every action element in turn, and 
then clicking the View source button in the Properties pane. XEdit will 
automatically update the JavaScript code. Verify that the first lines in the 
code start with var param_<xxx> = <value>, before saving the action.
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Term Description

Layout A group of monitors (or composite monitors) arranged for display on a 
monitor wall.

XAdmin The application used to perform administrative functions (e.g., configure 
network settings) on a Kaleido-X monitoring system.

XEdit The application used to create and modify rooms, layouts and other 
components of a Kaleido-X monitoring system.

Composite monitor A group of primary monitors.

Monitor A graphical component used in the creation of a layout. Typical monitors 
include UMDs, time code monitors, audio monitors, video monitors, and 
clocks.

Action item Action elements that are associated with a specific action (e.g., Load 
Layout, Set GPI Out, etc.).

System list Refers to the hierarchical list visible under XEdit’s System tab, which 
gives a virtual representation of the system hardware (i.e., multiviewers 
and peripheral devices).

Trigger Refers to the event that causes an action to be invoked. For a monitor 
wall action, a trigger could be a double click on a monitor. Background 
actions are triggered by alarms or by a Gateway command. When 
defining an action for a monitor, you could specify, for instance, that a 
specific full screen layout be displayed on the monitor wall in response 
to the trigger.
On Change: background action is triggered by any change in alarms 
status
On Disabled: background action is triggered when an alarm is disabled
On Normal/OK: background action is triggered when an alarm reverts to 
normal
On Minor/Warning: supported for Gateway alarms only
On Major: supported for Gateway alarms only
On Critical/Error: background action is triggered by a critical alarm
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Detailed Directions

Creating Monitor Wall Actions
Monitor wall actions can be assigned to a monitor on a specific layout. Such actions can 
only be triggered when that layout is loaded on the monitor wall.

To assign a monitor wall action to a monitor
1 Open the layout that contains the monitor to which you wish to assign an action, or 

create a new layout.
2 In the Layouts tab, unlock the appropriate composite monitor if applicable 

(see Unlocking a Composite Monitor on page 316), and then click the monitor you wish 
to configure.

3 In the Properties pane, click the Mouse click box, under Actions/Scripts.

Triggering of 
actions

Any multiviewer alarm can be used as a trigger to invoke a background 
action.
The end event of any countdown timer can be used as a trigger to invoke 
a background action.
Any GPI input from the multiviewer can trigger a background action.
The system verifies alarm states after a multiviewer has restarted, and 
every time you create or modify a background action. Consequently, if—
for example—an alarm’s Normal state was selected as the trigger for a 
background action, and this alarm’s state is Normal, when the action is 
created, or when the multiviewer has restarted, the action will be 
executed.
Gateway commands sent by an external device can be used to trigger 
actions created in XEdit.
Note: A background action triggered by an alarm is always executed, 
regardless of the alarm’s operational mode (see Alarm Suppression on 
page 170).

Triggering of GPI 
outputs

Any multiviewer alarm can be used to trigger a GPI output change.

Gateway Kaleido multiviewers can execute commands received via the Kaleido 
Remote Control Protocol (Gateway) interface, allowing third-party 
developers and individual users remote access to some Kaleido 
functions. Refer to the Kaleido Remote Control Protocol (Gateway) User’s 
Guide, available from the Documentation Library section of Grass 
Valley’s website, for more information.

Term Description
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4 Click the button that appeared at the end of the box you clicked.
The Action Editor window appears.

5 In Action Editor, drag the appropriate action item from the Action List pane to the 
middle pane under either the Single Click or Double Click tab.

6 Select the action in the middle pane.
7 In the right pane, specify the attributes of the action.
8 Repeat the procedure if you wish to add action items. If multiple actions are specified, 

the trigger (e.g., single click on UMD) will cause all of these actions to be executed in 
order.

9 When finished, click OK to close the window, and then click the Save button on the 
toolbar.
The next time the layout is loaded on the monitor wall, the actions will be available.

Note: For a UMD, three action types can be set, and there is a box for each 
under Actions/Scripts: Left tally - Mouse click, Right tally - Mouse click, and 
UMD click.
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Creating a Background Action from the Actions Tab

To create a background action
1 Open XEdit and load the database associated with the multiviewer for which you wish 

to create a background action. Alternatively, click Connect on the Configure menu, to 
work online (see Using XEdit Online on page 76).

2 Click the Actions tab.

3 Click the New button on the toolbar.

4 In the Tools pane, click and drag an alarm from the filtered System list onto the new 
action. This defines the alarm as the trigger for the action.

Note: When you click a monitor on the monitor wall, all the actions 
associated with the single-click event are triggered. When you double-click 
a monitor, all the actions associated with the single-click AND the double-
click events are triggered.

New
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5 From the Action list area of the Tools pane, drag one of the available action items onto 
one of the six columns at the bottom of the Actions tab.

6 Configure the action’s properties in the Properties pane.

Note: You do not have to perform this step for actions triggered by 
Gateway commands, because the Gateway alarm itself acts as the trigger. 
See Creating an Action that can be Triggered via a Gateway Command, on 
page 330.
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7 Repeat step 5 and step 6 as necessary.

8 Click the Save button on the toolbar.
9 Export the database to the multiviewer.

Creating a Background Action from the System List

To create a background action from the System list
1 In the Description/Calibration tab (or in any other tab that shows a filtered System list 

with alarms), right-click the alarm you wish to associate with an action.

2 On the Set action menu, select the appropriate trigger condition:
• On Change
• On Disabled
• On Normal/OK
• On Critical/Error

Note: If you assign multiple action items to a trigger, you can change the 
order of execution by dragging items to higher or lower positions in the list. 
When the background action is triggered, its associated action items are 
executed in order from top to bottom.

Note: The trigger conditions on Minor/Warning and on Major are 
supported for Gateway alarms only.
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The Action Editor window appears.
3 From the Action list pane, drag one of the available action items to the middle column, 

and then set the action item’s properties in the Properties pane.

4 Repeat step 3 as needed.
5 Click OK to close the window, and then click the Save button on the toolbar, to save the 

action.
6 Export the database to the multiviewer.

Creating an Action that can be Triggered via a Gateway Command

To create an action that can be triggered via the Gateway
1 Perform step 1 to step 3 from Creating Background Actions, on page 327.
2 From the Action list area of the Tools pane, drag one of the available action items onto 

the On Change / Gateway column at the bottom of the Actions pane.
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3 Under Properties > General, type a Friendly name for the Action.

Editing an Action

To edit an action
1 Select an action under the Actions tab, or in the middle pane of the Action Editor 

window.
2 Under the Properties pane, modify the action item’s parameters
3 Click Save on the toolbar if you modified the action under the Actions tab, or click OK if 

you modified the action in the Action Editor window.
4 Export the database to the multiviewer.

Removing Action Items from an Action

To remove an action item from an action
1 Select an action under the Actions tab, or in the middle pane of the Action Editor 

window.
2 Select one or more action items associated with the action.
3 Press the Delete key.
4 Click Save on the toolbar if you modified the action under the Actions tab, or click OK if 

you modified the action in the Action Editor window.
5 Export the database to the multiviewer.

Note: The Friendly name is used with the setKFireAction command to 
trigger the action. Refer to the Kaleido Remote Control Protocol (Gateway) 
User’s Guide, available from the Documentation Library section of Grass 
Valley’s website, for details.
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Deleting an Action

To delete an action
1 Select the action you wish to delete under the Actions tab.
2 Click the Delete button on the toolbar.
3 Click Save on the toolbar if you modified the action under the Actions tab, or click OK if 

you modified the action in the Action Editor window.
4 Export the database to the multiviewer.
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Managing RCP Users
This chapter explains the configuration of a Kaleido multiviewer for use with a Kaleido-
RCP2, an RCP-200 Remote Control Panel, or from the Gateway.

Summary
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XEdit Quick Start Task List
Follow these steps in XEdit, to set up your RCP users’ profiles:

1 Create an RCP user. See Managing RCP Users on page 334.
2 Grant room access to the RCP user. See Managing Room Access on page 335.
3 Select the configuration of the external keyboard for this user. See Setting the 

Keyboard Language on page 341.

Key Concepts

Kaleido-RCP2
The Kaleido-RCP2 is a multi-function remote control panel designed for use with Grass 
Valley's Kaleido-X software. Ethernet connectivity allows multiple RCP users to access 
multiple Kaleido-X systems, allowing convenient access to their real-time operating 
features.

The XEdit application is used to manage certain aspects of the Kaleido-RCP2.

RCP-200
The RCP-200 advanced remote control panel for Densité cards, Kaleido multiviewers, and 
NVISION/third party routers provides a highly intuitive graphical interface. It simplifies 
video/audio signal processing and control in both single and multi-user environments.

The XEdit application is used to manage certain aspects of the RCP-200.

Gateway
Kaleido multiviewers can execute commands received via the Kaleido Remote Control 
Protocol (Gateway) interface, allowing third-party developers and individual users remote 
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access to some Kaleido functions. Refer to the Kaleido Remote Control Protocol (Gateway) 
User’s Guide, available from the Documentation Library section of Grass Valley’s website, for 
more information.

Detailed Directions

Managing RCP Users

Adding RCP Users

To add an RCP user to the system
1 In the main window, click the RCP users tab.
2 In the Tools pane, right-click anywhere in the RCP users area, and then click New user 

on the menu.

A new user is added to the RCP users list.

Removing RCP Users from the System

To remove an RCP user from the system
1 In the main window, click the RCP users tab.
2 In the Tools pane, select the user you wish to remove from the system’s RCP users list.
3 Right-click the selection, and then click Delete user on the menu.

Notes
• New users are called UserN, where N = 1, 2, 3 etc.
• RCP users can be renamed. See Changing an RCP User’s Name or Password 

on page 343.
• New users are saved automatically; it is not necessary to click the Save 

button after adding a user to the system.
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A confirmation window appears.

4 Click Yes.
5 On the File menu, click Save.

Managing Room Access

Granting Room Access to RCP Users

To grant RCP users access to a room
1 In the main window, click the RCP users tab.
2 In the Tools pane, select the appropriate users from the RCP users list.

3 Drag the selected users onto the appropriate room in the RCP users tab.
4 Expand the room (if it is not expanded already) to verify that the users were added.

RCP user “User2” has been granted access to Room2

5 On the File menu, click Save.

Removing RCP Users from Rooms

To remove RCP users from rooms
1 In the main window, click the RCP users tab, expand the appropriate rooms if needed, 

and then select the users you wish to remove.

2 On the File menu, click Remove user from room. Alternatively, click the Remove button 
 on the toolbar, or right-click and then click Remove user from room on the menu.

Note: The user Admin cannot be removed.

Note: Use Shift+click or Ctrl+click to select multiple users.

Note: Use Shift+click or Ctrl+click to select multiple users.
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The selected user is removed access to the room.
3 On the File menu, click Save.

Setting Room Preferences
Room preferences will apply by default for any user who log on to the room from a Kaleido-
RCP2, or RCP-200 control panel. See Setting RCP User Preferences on page 338, to learn 
how to configure preferences for a specific user.

To set default preferences for a room
1 In the main window, click the RCP users tab, and then select the appropriate room.

The selected room’s preferences (layout presets, audio monitoring output, mouse 
pointer size, and timer) are listed in the Properties pane.

2 Modify the room preferences as needed.

3 On the File menu, click Save.

Assigning Room Layouts to the Kaleido-RCP2 Preset buttons

To assign room layouts to the Kaleido-RCP2 preset buttons
1 In the main window, click the RCP users tab, and then select the room for which you 

wish to configure layout presets.
2 For each Kaleido-RCP2 preset button, click the corresponding box in the Properties 

pane, and then select the appropriate layout from the list.

Note: The user Admin cannot be removed.

Note: An asterisk (*) will appear beside the room in the main pane, if any of 
its properties are modified. The asterisk will disappear when the changes are 
saved.
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Assigning an Audio Output to the Remote Control Panel’s AUDIO 
MONITORING Button

To assign an audio output to the Remote Control Panel’s AUDIO MONITORING button for 
a room

1 In the main window, click the RCP users tab, and then select the room for which you 
wish to configure the remote control panel’s AUDIO MONITORING button.

2 In the Properties pane, click the Audio monitoring output box, and then select the 
output used to monitor audio signals, from the list.

Enabling the Large Mouse Pointer for a Room

To display a larger pointer on the monitor wall for a room
1 In the main window, click the RCP users tab, and then select the room where you wish 

to use a large pointer on the monitor wall.
2 In the Properties pane, select the Use large mouse pointer check box.
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Assigning a Timer to a Room

To assign a default timer for all RCP users in a room
1 In the main window, click the RCP users tab, and then select the room to be assigned a 

timer.
2 In the Properties pane, click the Timer box, and then select the appropriate timer to be 

controlled by default from this room.

Setting RCP User Preferences
To modify the preferences for an RCP user

1 In the main window, click the RCP users tab, and then select the user whose 
preferences you wish to set, from under the appropriate room.
The selected RCP user’s preferences (layout presets, full screen assignment, audio 
monitoring output, external keyboard configuration, and timer) are listed in the 
Properties pane.

Note: When the large mouse pointer option is enabled for a room, the 
menus also appear in a larger font size on the monitor wall displays 
associated with this room.
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2 Modify the preferences as needed. See:
• Assigning Room Layouts to a Kaleido-RCP2 User’s Presets, on page 339,
• Assigning a Full Screen Layout to an RCP User, on page 340,
• Assigning Audio Output to an RCP User, on page 341, and
• Setting the Keyboard Language, on page 341.

3 Modify the system-level attributes for this user (user name, description, password) as 
needed. See Changing an RCP User’s Name or Password on page 343.

4 On the File menu, click Save.

Assigning Room Layouts to a Kaleido-RCP2 User’s Presets

To assign a room layout to a Kaleido-RCP2 user’s preset button
1 In the main window, click the RCP users tab, and then select the user for whom you 

wish to configure the remote control panel’s preset buttons, from under the 
appropriate room.

Note: User preferences are specific to an RCP user in a specific room. If no 
preferences have been specified for an RCP user, then the corresponding 
room preferences apply. They appear in gray in the Properties pane.

Note: These system-level attributes are specific to a user, independent of 
the room to which the user is assigned.

Notes 

• The Admin user name cannot be modified.

• An asterisk (*) will appear beside the RCP user in the main window if any of 
the user properties are modified. The asterisk will disappear when the 
changes are saved.

• The message “Cannot find reference” indicates that a full screen layout, full 
screen zone, or layout associated with a Room or RCP user has been 
deleted.
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2 For each Kaleido-RCP2 preset button, click the corresponding box in the Properties 
pane, and then select the appropriate layout from the list.

Assigning a Full Screen Layout to an RCP User

To assign a full screen layout to an RCP user
1 In the main window, click the RCP users tab, and then select the user for whom you 

wish to configure the remote control panel’s FULL SCREEN button, from under the 
appropriate room.

2 In the Properties pane, click the Full screen settings box, and then click the button that 
appeared at the end of the box.

The Full Screen Settings window appears.
3 In Full Screen Settings, select the appropriate full screen layout, and then click OK.

Note: If no layout is specified for this user preset, the layout that has been 
selected for this preset in the room’s preferences will apply. It will appear in 
gray in the Preset [n] box. See Setting Room Preferences on page 336.

Full screen settings button
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Assigning Audio Output to an RCP User

To assign an audio output to an RCP User
1 In the main window, click the RCP users tab, and then select the user for whom you 

wish to configure the remote control panel’s AUDIO MONITORING button, from under 
the appropriate room.

2 In the Properties pane, click the Audio monitoring output box, and then select the 
output used to monitor audio signals by this user in this room, from the list of available 
outputs.

Setting the Keyboard Language

To set the input language for an external keyboard connected to the Kaleido-RCP2 or 

Note: Before XEdit 2.00, full screen layouts were not associated with a 
specific full screen zone. In the case of such legacy layouts, you must also 
select the appropriate full screen zone from the Zone list.

Note: If no audio monitoring output is specified for this user, the output 
signal that has been selected in the room’s preferences will apply. It will 
appear in gray in the Audio monitoring output box. See Setting Room 
Preferences on page 336.
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RCP-200
1 In the main window, click the RCP users tab, and then select the user for whom you 

wish to set the keyboard, from under the appropriate room.
2 In the Properties pane, click the Keyboard box, and then select the keyboard to be 

used by this user in this room, from the list of available keyboard configurations.

Assigning a Timer to an RCP User

To assign a timer to an RCP User
1 In the main window, click the RCP users tab, and then select the user to whom you 

wish to assign a timer, from under the appropriate room.
2 In the Properties pane, click the Timer box, and then select the appropriate timer to be 

controlled by this user in this room, from the list of available timers.

Note: This setting applies to the selected user, in the current room only. A 
keyboard configuration must be selected for each user, in every room, 
unless the system default is suitable.
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To change an RCP user’s name and password
1 In the main window, click the RCP users tab, and then select the user whose user name 

or password you wish to change, from under any of the rooms.

2 In the Properties pane, click the User name box, and then type the new name.

3 In the Properties pane, click the Password box, and then click the button that 
appeared at the end of the box.

Note: If no timer is specified for this user, the timer that has been selected 
in the room’s preferences will apply. It will appear in gray in the Time box. 
See Setting Room Preferences on page 336.

Note: A user’s name or password cannot be changed from within the Tools 
pane. They can only be changed from within the rooms list, in the main 
pane. The user can be removed from the room after the name or password 
change. The change will be retained. See Granting Room Access to RCP 
Users on page 335.

Note: The name must be no more than 8 characters in length, and consist 
of only letters and numbers (no spaces or special characters).
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The Password Modification window appears.

4 In Password Modification, type the new password (only numbers, up to 8 digits) and 
then type it again to confirm.

5 Click OK.

Password modification button
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Routers & Kaleido-X
This chapter describes how a multiviewer can be configured to control external routers, to 
act as a router itself, and to be controlled from an upstream router control panel or 
software.

Overview
The Kaleido-X, Kaleido-MX, Kaleido-MX 4K, Kaleido-X16, Kaleido-Modular-X, and Kaleido-
Modular KMV-3901/3911 multiviewers are designed for flexible integration with a variety of 
routing devices. A multiviewer can be configured to control, or to be controlled by a variety 
of routing devices. The Kaleido-X (7RU) and Kaleido-X16 have an internal router option, 
which offers switching of up to 192 unprocessed inputs to 96 HD/SD outputs (16 inputs to 2 
outputs, in the case of the Kaleido-X16), for feeding monitors, test equipment and master 
control or production switchers. A multiviewer can also be configured as a router and 
provide switching of its logical sources to router card outputs (if available) or monitor wall 
destinations.

The Kaleido-X software interfaces with most routing devices, via Ethernet or serial 
connection, for router control and dynamic text label tracking. The interface allows 
dynamic source updates from the router, and quick access to any router sources directly 
from the monitor wall user interface. Kaleido-X can also save source assignments to the 
layout presets, and reconfigure the router by recalling a layout preset.

For quality control applications, the monitor wall pointer (controlled by a mouse connected 
via a Kaleido-RCP2 control panel) can be used to assign a selected source to a monitoring 
output bus. This creates a highly intuitive and rapid quality control capability. Grass Valley 
(Miranda) has been working closely with SAM (Snell/Pro-Bel), and NVISION (eventually 
acquired by Miranda), to provide a cost-reduced, multi-image/routing solution, with 
compelling integration and a direct download of sources text databases from routers and 
production switchers to the multiviewer system.

See Tally Interface Devices &Timer Systems on page 395 for more information on 
configuring supported production switchers to interact with the Kaleido-X software.
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Term Description

External Router In XEdit’s Equipment library, External Router refers to an upstream router 
that will be controlled by the multiviewer. For example, the multiviewer can 
request a specific source from the external router to be routed to a specific 
video monitor on the monitor wall.

Physical router In XEdit, a physical router is a software representation of router equipment. 
Physical routers hold information on how to communicate with the 
equipment, as well as the number of physical levels associated with the 
router.

Physical level Some router equipment can have multiple physical levels, which are subsets 
of the physical router’s inputs and outputs.

Protocol The instruction set and parameters used to communicate with and control a 
device. The router protocols supported in iControl are also supported by 
Kaleido-X, and vice-versa (although there might be a slight lag between the 
time the latest software versions are released).

Router 
controller

Router controller refers to any software or hardware that can request a 
crosspoint change on a router. The Router Control Software Single Bus and 
Matrix View applications (also part of the iRouter Router Control Software 
packaged with iControl Application Servers) are examples of router 
controllers. They are integrated with the Kaleido-X software, and can be 
launched from the Kaleido-X home page.

Logical router A logical router is a software abstraction that permits the control of multiple 
physical routers/levels as a single entity. Logical routers have a unique matrix 
ID within a router manager.

Logical level A logical level defines the mapping between logical and physical inputs, and 
the mapping between the logical and physical outputs.

Matrix ID A unique identifier used by a router controller to identify which router is the 
target of a switching command.

KX Router 
logical router

Independent from the routing capabilities obtained by adding 
KXO-24Router cards to a Kaleido-X (7RU) multiviewer or by enabling the 
router output ports on a Kaleido-X16, any multiviewer can be used as a 
router in itself.
The logical sources defined in XEdit’s Channels/Sources tab (see page 195) 
are considered sources for the KX Router logical router, whose destinations 
are either monitors on the monitor wall, or the multiviewer’s own router 
outputs (if applicable).a Source IDs to be used for routing purposes are 
assigned in XEdit’s Channels/Sources tab. These IDs can be used by external 
router control software or devices. The logical destinations for the KX Router 
logical router are configured in the Destinations tab.
The KX Router logical router configuration is automatically shared between 
multiviewers and iControl systems, and also between multiviewers and 
RCP-200 devices with version 1.70 or later.
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Router service The Kaleido-X router service is the software component responsible for 
communicating with physical routers, and for managing crosspoint change 
requests coming from router controllers.

Internal Router The Kaleido-X (7RU) and Kaleido-X16 multiviewers feature built-in routing 
which eliminates the need for separate routing in control rooms, and 
provides a significant cost saving. Up to 48 unprocessed, baseband outputs 
can be provided from any of the 96 HD / SD-SDI inputs to each Kaleido-X 
(7RU) processor. In the case of a Kaleido-X16, up to 2 baseband outputs can 
be provided from any of the 16 inputs. These outputs can be used to feed 
high quality CRT monitors, test equipment such as waveform scopes, as well 
as ISO recorders. The outputs can even feed other multiviewers.

The router outputs can be controlled from the monitor wall menu, by a 
Nevion (Network Electronics) remote control panel via a serial connection, by 
a Grass Valley (Miranda/NVISION) system controller via a TCP/IP connection, 
or by a production switcher’s auxiliary bus controls. The router outputs can 
be controlled by external controllers via the following protocols: VikinX 
Compact (serial), VikinX Modular (TCP/IP), NVISION (TCP/IP), SAM (Snell/Pro-
Bel) (serial, TCP/IP) or manually from the Router Control Matrix application 
available from the Kaleido-X Web page.

The built-in router improves integration, and reduces cabling and equipment 
costs. The routing capability eliminates the need for a separate router for the 
following applications:
• feeding baseband high quality monitors anywhere in a facility
• feeding test equipment for quality control monitoring
• feeding a secondary multiviewer for output expansion
• feeding an ISO recorder in production studios

Profile A logical view of an NV9000 routing system represented as a single flat 
matrix of sources and destinations, regardless of where in the routing system 
the actual sources and destination may be.

a. i.e., the 24 BNC outputs on a KXO-24Router card for a Kaleido-X (7RU), or the two RT OUT ports on a 
Kaleido-X16. The other multiviewer models do not have router outputs.

Term Description
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Router Control Configurations
Multiviewers can be configured for router control in five ways:

1 Kaleido-X (7RU) and Kaleido-X16 multiviewers allow direct control over their own 
internal router module.

2 All multiviewers allow direct control over an external router via a serial or TCP/IP 
connection.

3 All multiviewers allow control over a series of external routers in a cascade 
configuration: the Kaleido-X software sends a router command to one of the routers via 
a serial or TCP/IP connection, which then broadcasts it to the other routers in the 
cascade using an internal communications mechanism (e.g., MIDI). The router 
command contains an ID that causes it to be accepted by one router in the cascade, 
and ignored by the rest.

4 All multiviewers can be controlled by an external (push-button) control panel, via a 
serial or TCP/IP connection. Usually, such a panel is used to control either a simple 
external router (case 2, above) connected to the multiviewer, or the internal router 
module (case 1, above).

5 All multiviewers can be controlled by an intelligent router controller, via a serial or 
TCP/IP connection. The controller can issue commands to the multiviewer internal 
router module (if available), or to any external router connected to the multiviewer. The 
Kaleido-X software directs the commands to the designated device, and, as needed, 
translates the command to the required protocol.
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Router Configuration Scenarios

Controlling an external router

1 An operator chooses an assignment option on the monitor wall menu (e.g., “switch 
output 2 of external router A to QC monitor”).

2 The Kaleido-X software interprets the command, and sends it to the designated router 
over a serial or TCP/IP connection, using the appropriate router protocol.

3 The router receives the command and executes a crosspoint switch, either changing 
the signal on one of its connections to a multiviewer input, or…

4 …sending the signal to another device (e.g., vector scope, QC monitor, ISO recorder).

Note: In the same way, from the monitor wall, it is possible to change 
crosspoints on the multiviewer’s internal router (if available), when its 
physical levels are configured in the context of the KX Router logical router’s 
first level.
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Controlling external routers in a cascade

1 An operator chooses an assignment option on the monitor wall menu (e.g., “switch 
output 23 of external router A, Level 2 to QC monitor”).

2 The Kaleido-X software interprets the command, and sends it to the designated router 
over a serial or TCP/IP connection, using the appropriate router protocol.

3 The physical router receives the command, and then relays it to the other physical 
routers in the cascade using an internal communications mechanism (e.g., MIDI).

4 When the targeted Level receives the command, it executes a crosspoint switch, either 
changing the signal on one of its connections to a multiviewer input, or…

5 …sending the signal to another device (e.g., vector scope, QC monitor, ISO recorder).
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Translating commands from external router controllers

1 A system controller—e.g., Grass Valley (Miranda/NVISION) NV9000, SAM (Snell/Pro-Bel) 
Aurora, Nevion (Network Electronics) VikinX—sends a router command to an external 
router connected to the multiviewer.

2 The Kaleido-X software detects the command, translates it to the appropriate router 
protocol and, then sends it to the designated router over a serial or TCP/IP connection.

3 The router (or “Level” in a cascade) receives the command and executes a crosspoint 
switch, either changing the signal on one of its connections to a multiviewer input, 
or…

4 …sending the signal to another device (e.g., vector scope, QC monitor, ISO recorder).

Controlling the internal router by using a router control device or 
application
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1 An external router control device or application—e.g., SAM (Snell/Pro-Bel) Aurora, 
Nevion (Network Electronics) VikinX—or an automation system—e.g., Sundance 
Digital Titan—sends a command, over a serial or TCP/IP connection, to the multiviewer.

2 The Kaleido-X software detects the command, and executes a crosspoint switch on its 
internal router…

3 …sending the selected signal from the corresponding multiviewer input to another 
device (e.g., vector scope, QC monitor, ISO recorder).

Router Connections
To be able to control an upstream router from the monitor wall, or to control your 
multiviewer as a router from an external control panel, you must specify physical 
connections between a number of multiviewer inputs and external router outputs that 
feed them. This is equivalent to defining the tie lines between two routers: your upstream 
router and your multiviewer’s KX Router logical router. When two routers are 
interconnected, a tie-line manager module allows sources from the upstream router to be 
routed transparently to the selected destinations. For example, when you want to assign a 
source from the upstream router to a video monitor on the monitor wall, the Kaleido-X 
software uses this information to allocate a tie line (i.e. one of the multiviewer’s physical 
input connectors that you reserved for this purpose, and the upstream router’s output it is 
connected to), and initiate the appropriate crosspoint change on the upstream router.

Note: Tie lines between the multiviewer and an upstream router are meant 
to be used exclusively by the Kaleido-X software. You must not enable 
features such as destination lock at the router end of a tie line.
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1 An operator right-clicks a monitor and assigns a logical source by using the Assign 
Source window.

2 The Router connections tab in XEdit allows you to map physical connections between 
a number of INPUT connectors on the multiviewer and the upstream router’s OUTPUTs 
that feed them, which allows the Kaleido-X software to determine the crosspoint 
switch needed. See Configuring Router Connections on page 392 for details.

3 The multiviewer sends this command to the external router, over a serial or TCP/IP 
connection, using the appropriate protocol.

4 The external router redirects the specified source signal.
5 The new signal follows the physical connection to one of the multiviewer inputs 

reserved for this purpose, is processed, and appears on the monitor wall.

Note: It may also be possible to select a source from the Assign [router] 
input menu (see Changing an External Router Crosspoint on page 58). 
However, as of version 5.20 of the Kaleido-X software, Grass Valley strongly 
recommends configuring the KX Router logical router to cover all routing 
purposes within the multiviewer system.

Assign Source window on the 
monitor wall

DVI outputs to monitor wall

INPUTs 1 to 96 entering KXI 
cards

OUTPUTs 1 to N exiting router, 
some of which are physically 

connected to KXI INPUTs

SOURCES (e.g. CAM_1, SAT_1) 
entering router
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Optional Drivers for Controlling Routing Devices from the Multiviewer
Optional drivers are available to extend your Kaleido-X system with the ability to control 
routing devices that comply with the protocols listed in the following table. Contact your 
sales representative for details.

Company Protocol

Text 
database 
download Routers/Controllers

Datatek D-2815 Control Module 
Protocol

No

ETL ETL Matrix Yes ETL Matrix

Evertz Quartz Type 1 Yes EQX

Grass Valley 
(Miranda)

Densité Yes HRS-1801

No HCO-1821, HCO-1822

Grass Valley 
(Miranda/NVISION)

NVISION Ethernet protocol - 
Enterprise router (Logical)a

Yes NV9000 system controllers

NVISION Ethernet protocol - 
Enterprise router (Physical)b

Yes

NVISION Ethernet protocol - 
Enterprise router (Device ID 
based)c

Yes

NVISION Ethernet protocol - 
Compact router

No Compact router series

Grass Valley 
(Thomson/Philips)d

GVG 7000 Native Protocole Yes Concerto-series routers, 
Encore-series control panels

Jupiter ASCII 
communications protocol

No Jupiter VM-3000 system 
controller, Venus-series and 
Trinix-series routers

ES-Switch protocol (serial)f Yes Jupiter VM-3000 system 
controller

Imagine 
Communications 
(Harris/Leitch)

Harris XY Passthrough 
Protocol

No Platinum, Xplus, Integrator, 
Via-32, Panacea, Xpress

Lantronix (Lightwave) Matrix-Hub 
Protocol

No Matrix-Hub 1000

Nevion (Network 
Electronics)

Network Compact (serial) No VikinX Compact

Network Modular (Ethernet) No VikinX Modular

PESA USP (Unsolicited Status 
Protocol)

No Cheetah, Tiger, Jaguar, 
Cougar, Ocelot, Bobcat, 
TDM3000, PERC2000 system 
controller

CPU Link Protocol No.1 
(serial)

No
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Built-in Communications Protocols
The multiviewer itself can be controlled by external devices (e.g. Kaleido-RCP2, router 
control panels) or applications (e.g. router control software application, Remote Control 
Gateway) via built-in communications protocols. Such devices or applications can be used 
to command monitor wall operations (e.g. source assignment) or routing operations.

A router control device or application can control a Kaleido-X (7RU) or Kaleido-X16 
multiviewer’s internal router module, or any multiviewer’s logical sources and monitor wall 
destinations, via the KX Router logical router. It can also control other logical routers 
configured within your multiviewer system. In the case of the KX Router logical router, the 
device or application must support the NVISION Ethernet protocol - Compact router protocol.

The supported communications protocols are listed in the following table, with an 
indication of the supported connection types (TCP/IP or serial), and the dedicated port 
number on the multiviewer, in the case of a TCP/IP protocol.

Quintech XRM/SRM/MRF/MRM Series 
Protocol (serial) 

No SRM 2150 Matrix Switching 
Systems

SAM (Snell/Pro-Bel) General Switcher Protocol 
(SW-P-02)

No

General Remote Protocol 
(SW-P-08)

Yes Halo, Aurora and Sirius 
Controller (serial control)

Sony Sony HKSPC (GVGNP 
Emulator)

No Sony routers (requires HKSPC 
card); GVG routers (Ethernet)

Utah Scientific PL-160/PL-320 No AVS-1B

RCP-1 No SC-1, SC-2, SC-3 series

RCP-3 Yes SC-4 series (Ethernet only)

a. Deprecated. To be used with legacy configurations only.
b.To be used in most cases. Supports native locks, and aliases from router (provided system controller 

has NV9000 router control system version 6.0.6 or later)
c. To be used in very specific scenarios involving physical router interconnects with tie lines, or with hybrid 
router configurations. Contact Technical Support for more information (see Contact Us, on page 551).
d.Our current implementations of the protocols listed above for Grass Valley (Thomson/Philips) 

routers and controllers support neither the CM-4400 nor the CM-4000 system controllers.
e. For Thomson / Grass Valley Series 7000 devices, our current implementation of the Series 7000 

Native Protocol supports serial devices, in addition to some Encore system controller models, which 
are also supported over Ethernet. For other Series 7000 devices you wish to control via Ethernet, use 
Sony HKSPC (GVGNP Emulator).

f. In the case of the Kaleido-X, and Kaleido-X16 multiviewers, the ES-Switch protocol is only supported 
with a baud rate of 19200.

Company Protocol TCP/IP (port) Serial

Grass Valley (Miranda) Kaleido Remote Control Protocol Yes (13000) Yes

Grass Valley 
(Miranda/NVISION)

NVISION Ethernet protocol - Compact router Yes (5194) No

Company Protocol

Text 
database 
download Routers/Controllers
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Serial Connections
The physical cabling required to connect a multiviewer to an external serial device (such as 
a router, production switcher, or router controller) can vary from one device to another. It is 
important to check the manufacturer’s documentation to get the proper pinout so it 
matches up with the multiviewer.

The RS-422 ports at the back of a Kaleido-X16 multiviewer or at the back of a KXO-Dual or 
KXO-Dual3 card (in the case of the Kaleido-X multiviewer models) use an RJ45 connector. 
Grass Valley provides two adapters, which map the RS-422 signals to the more common DE-
9 form factor:

• To connect a serial device whose RS-422 port is wired to the SMPTE slave wiring 
specifications, use the straight adapter (Grass Valley part number 1737-3000-102).

• To connect a serial device whose RS-422 port is wired to the SMPTE master wiring 
specifications, use the crossover adapter (Grass Valley part number 1792-3700-100).

The DE-9S pinouts for these two adapters are as follows:

Nevion (Network 
Electronics)

Network Compact N.A. Yes

Network Modular Yes (4381) No

SAM (Snell/Pro-Bel) SW-P-08 Yes (14000) Yes

SW-P-02 Yes (2000) Yes

Pin
 Straight adapter 
(1737-3000-102)

Crossover adapter 
(1792-3700-100)

1 Not connected Not connected

2 RX– TX–

3 TX+ RX+

4 Not connected Not connected

5 Not connected Not connected

6 Not connected Not connected

7 RX+ TX+

8 TX– RX–

9 Not connected Not connected

Note: Some routers have RS-232 ports, which will require the use of a RS-
232 to RS-422 converter (externally powered ones work best).

Company Protocol TCP/IP (port) Serial
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Sample Third-Party Serial Pinouts
Example #1: Ross Synergy100 (RS-422)

The Grass Valley 1737-3000-102 (straight) adapter can be connected directly to the Ross 
Synergy 100:

Standard wiring between multiviewer and devices wired to SMPTE “slave” specification (e.g. most 
routers, Ross Synergy switchers, Nevion ETH-CON)

Example #2: Philips VM-3000 (RS-422)

The Grass Valley 1792-3700-100 (crossover) adapter can be connected directly to the 
Philips controller:

Standard wiring between multiviewer and devices wired to SMPTE “master” specification (e.g. Philips 
Jupiter router control system, Grass Valley Presmaster PCS)

Alternatively, use the Grass Valley 1737-3000-102 (straight) adapter but with a crossover 
cable between the multiviewer and the adapter.

1 Not connected 4 Ground 7 TX+

2 TX– 5 Ground 8 RX–

3 RX+ 6 Not connected 9 Not connected

1 Ground 4 Not connected 7 RX+

2 RX– 5 Not connected 8 TX–

3 TX+ 6 Not connected 9 Not connected

Pinout of an RS-422 
port’s RJ45 connector 

on the multiviewer

Pinout of straight adapter (Grass 
Valley part no. 1737-3000-102)

RJ45 DE-9 male DE-9 female
Pinout of RS-422 

connector on SMPTE 
slave device

Pinout of an RS-422 
port’s RJ45 connector 

on the multiviewer

RJ45 DE-9 male DE-9 female
Pinout of crossover adapter (Grass 

Valley part no. 1792-3700-100)
Pinout of RS-422 

connector on SMPTE 
master device
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Q: Is the internal router used to change inputs to the multiviewer in order to direct 
signals to the monitor wall?

A: No, an internal router card is not needed to display video on the monitor wall. The 
outputs of the internal router do not feed into the multiviewer’s inputs—they come 
from the multiviewer’s inputs via the midplane.

Q: What is the main purpose of having an internal router?

A: The internal router allows you to share the inputs connected to a Kaleido-X or 
Kaleido-X16 multiviewer with other equipment (e.g., QA monitors, vectorscopes), 
reducing or eliminating the need to have an expensive standalone external router. The 
internal router allows you to have one piece of equipment (the multiviewer) that serves 
two integrated purposes: displaying video inputs on the monitor wall, and sharing them 
with other equipment. For example, instead of having a router in front of the 
multiviewer to split feeds between the multiviewer and a vectorscope monitor, you can 
use the multiviewer as a router. Your feeds enter at a single point, and one of the outputs 
can go to a vectorscope or quality control (QC) monitor, so that instead of a large, 
expensive station router in front you can have a smaller one—you don’t lose outputs for 
QC. 

Q: Is there a matrix GUI available for controlling routers via the multiviewer?

A: Yes. The Kaleido-X software (version 4.00 and later) incorporates the single bus and 
matrix view from iControl Router Control Software.

Q: Is the “External Router” item in the Equipment library always used to add a router?

A: Yes. This is done for consistency with iControl. Other types of equipment (production 
switchers, controllers, tally boxes) have their own specific entries in the Equipment 
library.

Q: Can there be more than one external router?

A: Yes. Every router or router control panel that is connected to a serial port on the 
multiviewer corresponds to an External Router in XEdit. Similarly, every router with a 
unique IP address connected via TCP/IP to the multiviewer is considered a unique 
External Router. If the multiviewer is connected to a series of physical routers in a 
cascade configuration, the cascade corresponds to a single External Router in XEdit, 
where each router is a Level.

Q: Why was the iControl Router Manager integrated into XEdit version 3.00?

A: Previously, a version of the iControl Router Manager appeared as a separate 
application within XEdit. This could lead to some issues, such as two devices being 
configured on the same serial port. Since Router Manager is now integrated, XEdit is 
more “aware” of the router configuration information, and can prevent such 
misconfigurations.

Q: Is router management backward compatible?

A: Yes. Router configurations made in version 2.20 will be preserved when upgrading to 
version 3.00 (or later). However, even though this has been tested on a large number of 
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configurations, it is recommended that the router settings be reviewed before and after 
the upgrade in order to ensure that there are no errors.

Q: What is a “Network router”?

A: The phrase “Network router” has the obvious connotation of a router available on a 
network. However, in the context of Grass Valley’s Monitoring and Control applications, 
it can also refer to a device now manufactured by Nevion (www.nevion.com)—formerly 
Network Electronics Ltd.—such as a VikinX router.

Q: What are the three different Router Controller items (i.e. Network Compact and the 
two Pro-Bel items) in the Equipment library?

A: They are all used for controlling either the multiviewer’s internal router, or any logical 
router.3 The only difference is the protocol used to communicate with the multiviewer.

Q: My internal router card shows up in the Routers list in XEdit as “OPTION A (Video 
120 × 48)”. Does this mean it has 120 inputs and 48 outputs?

A: No. Each card can route up to 96 inputs to 24 physical outputs, and so has an actual 
size of 96 × 24. “120 × 48 “refers to the size of the router card when including other 
internal connections that are used for router expansion.

Detailed Directions

Importing Router Configurations from an NV9000 System Controller
XEdit can import router configurations from an NV9000 system controller and share its 
KX Router logical router’s configuration with iControl Application Servers and RCP-200 
Advanced Remote Control Panels. Refer to the “Component Compatibility” section of the 
Kaleido-X Release Notes for related version information.

Although it is possible to partly configure your system by using XEdit in offline mode, you 
must work in online mode, to import NV9000 router configurations (see Using XEdit Online 
on page 76).

To import external router configurations from an NV9000 system controller
1 In XEdit’s main window, click the System tab, and then click Router configurations on 

the second-level tab bar.
2 In the Tools pane, click the Physical routers folder.

3.Controlling a logical router from an upstream router control device or application is supported since 
version 3.00 of the Kaleido-X software.

Note: The Kaleido-X software does not officially support aliases. If you wish 
to include aliases from an NV9000 router configuration within your 
multiviewer configuration, please contact Technical Support (see Contact 
Us, on page 551).
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3 Click Import NVISION config.
The Import Configuration window appears.

4 In Import Configuration, type the host name or IP address of the NV9000 system 
controller, click Show only router profiles if appropriate, and then click Get router list.

All physical levels and profiles known to this NV9000 system controller appear under 
Import preview.

IMPORTANT
The number of outputs on a physical router may impact 
performance, both on the multiviewer and on the NV9000. 
If your physical routers have more than a few hundred outputs, 
Grass Valley recommends that you create profiles (see Profile on 
page 347), limited to the necessary outputs for your monitoring 
purposes, in NV9000-SE Utilities, and then import those profile 
configurations instead of the full router configuration into your 
multiviewer system configuration.
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The name of every NV9000 physical level or profile is followed with an ID, and 
dimensions. For example, in the case of NV32X8_PL1 (ID 6) [32x8] above, the part 
NV32X8_PL1 is the name of an NV9000 physical level, whose ID (internal to the NV9000 
system) is 6, and which has 32 sources and 8 destinations.

5 Select the router creation mode that best suits your purposes.
• By default, Create several routers with one level per router is selected, which 

means that XEdit will create one single-level physical router and one single-level 
logical router, for every selected router or profile. This is appropriate from most use 
cases.

• If you wish to have only one router with several levels instead, select Create one 
router with multiple levels.

6 Select the NV9000 physical levels or profiles you wish to control from your multiviewer, 
by clicking the corresponding check boxes.

Note: You can see these NV9000 physical level names and IDs in NV9000-SE 
Utilities PhysLevels table. Refer to the NV9000-SE Utilities User’s Guide, for 
more information.
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Example: Three routers will be created.

7 Click OK.
The selected router configurations are imported into your multiviewer system.

• If you selected Create several routers with one level per router, then, once the 
import has completed, your multiviewer’s configuration includes new external 
routers whose names are based on the NV9000 system controller’s IP address 
prefixed with N9000, and followed with the ID of the NV9000 physical level (e.g., 
“N9000 10.5.1.92 6,” where “10.5.1.92” is the controller’s IP address, and “6” is the 
NV9000 physical level ID).

Three external routers were added to the system.

The Routers list includes new physical, and logical routers with the same names. 
The new physical routers and associated logical routers have one level for every 
router you imported from the NV9000 system controller.

Example: One router with two levels 
will be created.

New external routers

NV9000 physical level ID
NV9000 system controller IP address

Prefix
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Three physical routers, and three logical routers were added, each with a single level whose 
name matches the name of the corresponding NV9000 physical level.

• If you selected Create one router with multiple levels, then, once the import has 
completed, your multiviewer’s configuration includes one new external router 
whose name is based on the NV9000 system controller’s IP address prefixed with 
N9000 (e.g., “N9000 10.6.0.81”).

One external router was added to the system.

The Routers list includes one new physical router, and one new logical router with 
the same name. The new physical router and associated logical router have one 
level for every router you imported from the NV9000 system controller.

New physical router imported from NV9000

New logical router
Logical level

Physical level

New external router

NV9000 system controller IP address
Prefix
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One physical router, and one logical router were added, each with two levels whose names 
match the names of the corresponding NV9000 physical levels.

If you intend to import other router configurations from the same NV9000 system 
controller, separately, then you must rename the physical router associated with 
the configuration you just imported. Otherwise, if you use the Create one router 
with multiple levels option again, then any configuration you import next will 
replace the current one. See Renaming Physical Routers below.

8 On the File menu, click Save.
9 Click the Channels/Sources tab.

10 In the filtered System list, right-click the external router you just imported, and then 
click Create logical sources on the menu.

The sources table now includes entries for your router sources.

New physical router

New logical router
Logical levels

Physical levels
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11 Sort the sources table as appropriate for your purposes, if you wish, and then define IDs 
for the new sources, using the incremental copy tool as needed. You may also want to 
set a category.

12 On the File menu, click Save, and then click the Destinations tab.
13 In the Destinations tab, adjust the number of destinations if you wish, by typing the 

desired number in the Size box, and then click Auto map if needed to configure all 
KX Router destinations as monitor wall destinations.

14 Click the System tab, and then click Router connections on the second-level tab bar.
15 Specify the appropriate physical connections between your multiviewer inputs and the 

external router outputs that feed them. See Configuring Router Connections on 
page 392, for details.

Note: If this router is subject to frequent dimension changes, then you may 
want to select Activate automatic sources creation (see step 10). When the 
router is reconfigured with larger dimensions in NV9000-SE Utilities, you will 
need to import the router configuration from the NV9000 again, but the 
appropriate number of sources will be automatically added to the sources 
table, at the same time, with their assignments based on the current 
template (see Defining Physical Assignments on page 203). On the other 
hand, if the number of sources for this router becomes smaller, then you will 
need to delete the unnecessary entries from the sources table manually.

Source IDs Category
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16 Click the Layouts tab.
17 Open the layout you wish to use, and then assign monitor wall destinations to monitors 

in your layout, as required. See Assigning Logical Sources or Monitor Wall Destinations 
to Monitors on page 252 for details.
You may also assign a logical source to each monitor, if you wish.

18 For every monitor to be used as a monitor wall destination, specify the appropriate text 
level, based on the information you wish the UMDs to display. See Configuring 
Dynamic UMD Text on page 293, for details.

19 On the File menu, click Save, and then click the LOAD button on the toolbar.
The layout appears on the monitor wall.

Renaming Physical Routers

To rename a physical router
1 In the Routers list, click the physical router you wish to rename.

2 In the Router configuration tab, type the new name in the Router name box, and then 
press Enter.
You may rename the associated logical router, for consistency.

Configuring an External Router
The process of creating and configuring an external router (e.g., a third-party router or 
router control panel) for use with your Kaleido-X system consists of 4 steps:

• defining the physical router
• adding one or more physical levels
• creating one or more logical routers
• adding one or more logical levels
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Step 1 – Defining a Physical Router

To configure an external router
1 Open XEdit and load the database associated with the multiviewer for which you wish 

to configure an external router.
2 Drag External Router from the Equipment library onto the root of the System 

hierarchical list in the Description/Calibrations pane.

3 Enter a descriptive name to act as a device identifier for the external (physical) router.

A new physical router appears in the System list.

4 Click the Interconnects tab, draw a line between the multiviewer and the External 
Router icons to establish a connection (i.e. add a connection properties entry to the 
database), and then click the line.

5 In the Properties pane, select the appropriate element from the Connect to list.

Click the line to configure
the connection properties
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This can be a serial connection, or a network (TCP/IP or UDP/IP) connection.

Depending on the multiviewer model (e.g., on a Kaleido-X, each output card has one 
RS-422 port, a Kaleido-X16 has one or two RS-422 ports), the available RS-422 ports are 
designated as follows:

At this point, there are still no properties associated with the new physical router.
6 Click the Router configurations tab.

Notice that, in the Routers list, under Physical routers, XEdit has added the new 
physical router.

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).
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7 Select the appropriate protocol in the Router protocol list.

Once you have chosen a protocol, you can click Help to view tips on its use.

• In the case of a serial connection, you can specify serial communication 
parameters: the bit rate (bps), the number of data bits, parity, stop bits and flow 
control.

Note: A physical router associated with the multiviewer’s own internal 
router module is also predefined. In the case of a multiviewer that does not 
have any router card, there will be no entries in the Levels list for this 
physical router).

Note: The connection type and serial port specified earlier (see step 5), if 
any, appear here automatically. These values can be changed, if necessary. 
Any changes will also appear in the Properties pane.
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• If the connection type is TCP/IP or UDP/IP, you must specify the router’s IP address 
and port number.

8 Click Use protocol defaults to specify the default parameters for the selected protocol 
(this can be useful to begin if you do not have access to your specific router’s 
documentation).
At this point, you have created a new physical router.

Step 2 – Adding Physical Levels
There is not always just one connection per router. Sometimes, the connection is to one of 
several routers in a cascade configuration. For example, in the case of Nevion (Network 
Electronics) VikinX routers, the multiviewer sends commands to one router in the cascade, 
which passes it on to the other routers via an internal communications mechanism (MIDI in 
this case). Each router in the cascade has an ID. To represent this arrangement in XEdit, the 
router connected to the multiviewer is considered the physical router, with all of the routers 
in the cascade represented by a physical level.

Even if the multiviewer is connected directly to a router (i.e. no intermediary device), you 
still use the mechanism of defining a physical level. The distinction here is that there would 
only be one physical level.

To add one or more physical levels
1 In the Router configurations tab, click Add level.
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2 In the Physical Level Configuration window, type a name in the Level name box (e.g., 
“Video”).

3 Type the appropriate value in the Level or frame ID box (whether a level ID or a frame ID 
is relevant depends on the protocol in use).

4 Click Edit.
5 In the Edit Level Size window, type the appropriate number of sources and 

destinations for this physical router.

6 Click OK, and then click OK again in the Physical Level Configuration window.

Note: This value identifies and must match the ID of the physical router in 
a cascade (there is sometimes a jumper on the router that is used to set its 
ID, or it may be done by changing a configuration setting using software 
that comes with the router). The Kaleido-X software uses this ID to issue a 
command via the serial port (e.g., “Change this crosspoint on router ID 2”). 
When the command is sent to routers on a MIDI bus, each router will 
examine the command, check its ID, and ignore it unless the ID matches its 
own.

Note: The three option buttons labeled Video, Audio and Other are used 
for Nevion (Network Electronics) routers only, for which levels must be 
classified as either Video or Audio. These settings are ignored by routers 
from other manufacturers.
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At this point, you have added a level to a physical router, which appears in the Levels 
list under the Router configurations tab, and in the Routers list in the Tools pane.

For example, if the physical router is a controller talking to a cascade of routers using a 
specified protocol, you might have defined one of these, a video router, as Level 0 in the 
cascade, with 16 sources and 16 destinations (16 × 16).

7 You can continue to add levels for other routers in the cascade. The screens below, for 
example, show how to define a 32 × 32 level for a Nevion (Network Electronics) audio 
router.

It is fairly typical to have an audio and a video router connected to the same serial port. 
When a crosspoint switch is sent out over the serial port, it addresses both routers, so 
that the audio follows the video switch.

Step 3 – Adding Logical Routers
Logical routers add another layer of refinement over the control of a router. In a typical 
situation, a very large router (e.g., 1024 × 1024) might be used to control a TV station. The 
station manager does not want just anyone to be able to change any source to any 
destination, because some of these destinations go straight to air. If someone accidentally 
changes a crosspoint on the monitor wall, and the feed goes live, the error could have 

New physical level
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serious consequences. To avoid such problems, it is desirable to give operators access only 
to those crosspoints they need, by creating logical routers.

To add a logical router
1 In the Routers list, click the Logical routers folder, and then click Add router under the 

Router configurations tab.

A new sub-folder is added to the Logical routers folder. This new folder is automatically 
selected, and a third-level tab bar appears under Router configurations, with the 
Configuration tab selected.

2 Type a name (e.g., “SmallLogicalRouter”) in the Logical router name box. This is the 
name that will appear on monitor wall in the Assign [router] input menu. Ignore the 
Logical router matrix ID box for now. Type the desired number of sources and 
destinations (e.g., 16 × 4).

Note: In the case of a multiviewer systems configured with an upstream 
router that has more than 288 sources, the Assign [router] input menu is not 
available, and you must manage the router’s physical sources as logical 
sources within the multiviewer system (see Logical source on page 195). 
Router sources can thus be assigned to monitor wall elements transparently, 
just as sources connected directly to the multiviewer’s inputs (see Assigning 
Sources to Monitors on page 52).

New logical router
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The subfolder that represents the new logical router is renamed automatically, 
reflecting your changes.

3 Click Add level.
4 In the Logical Level Configuration window, type a Logical level name (e.g., “Video”). 

The Logical level ID is not important at this point.

5 The logical level must be associated with a physical router level. Click Add, and then 
select the appropriate physical level from the list that appears.

IMPORTANT
Once you have configured the logical router, it is important not 
to change its name.
Doing so will disable any settings that refer to the existing router 
name, including:
• logical source assignments for source or destination label,
• external router connection configurations,
• monitors and background actions associated with the logical 

router,
• automatic crosspoint changes on video monitors (router source 

property).
If you change the name back to the original, everything should 
work as before.

Updated logical router
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6 Click OK, and then click OK again in the Logical Level Configuration window.
The new logical level appears in the Levels list, and also under the new sub-folder that 
represents the logical router in the Routers list.

Next, you must specify the relationship between the logical level destinations (4 in this 
example) and the physical destinations (16 in this example).

7 Click the Destination mapping tab.
The Destination mapping table includes rows for each of the logical destinations (4 in 
this example), with columns for entering a text label (e.g., “Main Out”, “Preview”, etc.) 
and the corresponding physical router destination (this column’s heading corresponds 
to the logical router level specified earlier–“[0] Video” in this example).

8 Click in a row in the physical level column.
A menu appears listing all of the available outputs associated with that physical level.

New logical level
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9 Choose a physical output for this logical destination, and then proceed in the same 
fashion for the other destinations, or click Auto map to automatically enter physical 
outputs, in sequential order, starting from the first one in the list.

• If you have already specified a physical output, the sequence starts from that one, 
then autofills from there.

• If the one you specified is in a row part way down the table, auto-mapping fills in 
the rows below, then continues the sequence starting at the top of the table.

This feature is particularly useful when mapping a large number of destinations.

10 To import labels from a CSV file (i.e. a comma-delimited file such as might be exported 
from an Excel spreadsheet), click Import labels, navigate to the CSV file that contains 
the labels you wish to import, select it, and then click Open.

Note: If you make a mistake, click Clear mapping, and then click Yes in the 
confirmation message that appears to delete the entries in the physical 
output column of the table. This does not affect the Labels column.

Note: The file must be formatted as three columns with no heading row. 
Column 1 should contain numbers from 1 to N (the number of sources), 
column 2 should contain the source labels, and column 3 should contain the 
destination labels. Columns are delimited by commas, without spaces. 
Sample label file:

1,VTR 1,OUT 1 
2,VTR 2,OUT 2 
3,CAM 1,OUT 3 
4,CAM 2,OUT 4 
5,SAT 1,PGM 
6,SAT 2,PVW

Auto map button Physical outputs are automatically populated
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Alternatively, select the Get labels from physical level check box, to import labels 
directly from a router at runtime.

As with destinations, the sources of the logical level must be associated with sources on 
the physical router.

11 Click the Source mapping tab. The table works in the same way as for destinations, 
except that the number of rows is determined by the number of sources specified 
when the logical level was created.
Auto mapping example: Specify Input 4 in Row 2, then click Auto map. The auto 
mapper starts by putting Input 1 in Row 1, detects the entry in Row 2, so picks up the 
sequence by putting Input 5 in Row 3, Input 6 in Row 4, etc.

Note: Labels are imported at runtime (i.e. they only appear on the monitor 
wall, not in XEdit). This feature applies to the following router protocols only:
• ETL Matrix
• Evertz Quartz Type 1
• HRS-1801
• NVISION Ethernet protocol - Enterprise router
• SAM (Snell/Pro-Bel) General Remote Control Protocol (SW-P-08)
• Thomson / Grass Valley GVG 7000 Native Protocol
• Utah Scientific RCP-3 Protocol
The list of supported protocols appears at the bottom of the Source 
mapping and Destination mapping tabs.

IMPORTANT
You can have the same physical sources and destinations mapped to 
multiple logical routers. The software does not prevent this. In the case of 
destinations, care must be taken to avoid conflicts when using auto 
mapping.
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At this point, you have completed the source and destination mapping for a logical 
level (e.g., “[0] Video”). Additional levels can be created. For example, it is often 
necessary to switch the audio at the same time as the video. If you have a video router 
and an audio router, and you select Video 2 on the former, you probably want the 
associated audio to switch as well. To accomplish this, define a new logical level for the 
audio.

12 Create a new logical level (e.g., “[1] Audio”), and associate it with a physical router Audio 
level.

The new level appears under the logical router in the Routers list.

13 Click the Destination mapping tab.
A new column appears, corresponding to the new logical Audio level. The audio 
destinations can be mapped to correspond to the video destinations. Use the Auto 
map button as needed.

14 Proceed in the same fashion with the source mapping.
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If the audio mapping mirrors the video mapping, then, when a video switch is made 
(e.g., from Video 1 to Video 2), the corresponding audio will follow (i.e. the same 
command will switch a crosspoint in both the physical video router and the physical 
audio router).

At this point, you have completed the definition of an external router.

Configuring a Router Controller
There are two categories of router controllers that can be used to control the routers 
connected to (controlled by) a multiviewer:

• Simple router controllers, such as the Nevion (Network Electronics) VikinX Compact, or 
devices that support the SAM (Snell/Pro-Bel) SW-P-02 protocol.

• Intelligent router controllers that support the SAM (Snell/Pro-Bel) SW-P-08 protocol.

Adding a Simple Router Controller
A VikinX Compact router controller, on any control panel that supports the SAM (Snell/Pro-
Bel) SW-P-02 protocol, can issue switching commands to a specific router connected to 
(controlled by) the multiviewer, which will act as a protocol translator.

Adding a VikinX Compact router controller

To add a VikinX Compact (or equivalent) router controller 
1 Click and drag Router controller (VikinX Compact) from the Equipment library to the 

System hierarchical list.

Note: Grass Valley’s Router Control Software includes applications for 
controlling routers (single bus and matrix) where you can operate in all 
follow mode (change all levels), or in breakaway mode.
The all follow mode is more typically used. An example of a breakaway 
would be switching Video 4 with Audio 5 instead of Audio 4 because Audio 
5 is in another language.
When you make a crosspoint change in a logical router, you can change all 
of the logical levels, or just specific ones. When controlling the monitor 
wall, only the “all follow” mode is supported. If you need to set up 
breakaway switches, you must use other software—e.g., Grass Valley’s 
Router Control Software—, or a router controller—e.g., a device that 
supports the SAM (Snell/Pro-Bel) SW-P-08 protocol.
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2 When prompted, type a name, and then click OK.

3 Click the Interconnects tab, draw a line between the multiviewer and the new router 
controller, and then click the line.

4 In the Properties pane, select the appropriate element from the RS-422 
communication port list.

Click the line to configure
the connection properties
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Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

5 In the Interconnects tab, click the router controller icon.
In the Properties pane, a list of settings appears, with default values for the serial 
communication parameters: the bit rate (bps), the number of data bits, parity, stop bits 
and flow control.

6 Select a logical router (e.g., SmallLogicalRouter) from the Router list.

This is the logical router that will be controlled by the router control panel. When the 
multiviewer receives commands over the serial port on the output card selected in 
step 4, it will know these are destined for the logical router corresponding to 
“SmallLogicalRouter”.

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).

Note: Simple router controllers can also communicate with Kaleido-X via 
TCP/IP. This type of connection is enabled automatically, and allows such 
controllers to issue commands to the multiviewer’s internal router module.

Note: The VikinX Compact protocol allows you to specify one logical router 
only (it is a one-to-one controller protocol).
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Adding a SAM (Snell/Pro-Bel) SW-P-02 router controller

To add a control panel that uses the SW-P-02 protocol
• Refer to procedure above but, at step 1, select Router controller (SW-P-02) from the 

Equipment library instead of Router controller (VikinX Compact).

Adding an Intelligent Router Controller
An intelligent router controller is one that can issue switching commands to any router 
connected to (controlled by) the multiviewer. In order to be able to do this, it must attach a 
unique identifier to each command that will allow the Kaleido-X software to direct the 
command to the appropriate device. This unique identifier is the “Logical router matrix ID”, 
which is similar to the “Level or frame ID” for a physical router, but identifies a logical router.

So, for example, if you press a button on the external panel that is set up to make a 
crosspoint change on logical router matrix ID 0, the Kaleido-X software will receive this 
command, look up matrix ID 0 to find the physical router it is mapped to, and then forward 
the crosspoint change to the physical router using the appropriate protocol. In such cases, 
the Kaleido-X software acts as a “protocol translator” for the control panel.

To add a SAM (Snell/Pro-Bel) SW-P-08 (or equivalent) router controller 
1 Click and drag Router controller (SW-P-08) from the Equipment library to the System 

hierarchical list.

2 When prompted, type a name for the router controller, and then click OK.

3 Click the Interconnects tab, draw a line between the multiviewer and the new router 
controller, and then click the line.
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4 In the Properties pane, select the appropriate element from the RS-422 
communication port list.

Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

5 In the Interconnects tab, click the router controller icon.

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).

Click the line to configure
the connection properties
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In the Properties pane, a list of settings appears, with default values for the serial 
communication parameters: the bit rate (bps), the number of data bits, parity, stop bits 
and flow control.

However, in this case, there is no Router box for specifying which logical router is to be 
controlled. This is because the SW-P-08 protocol allows the controller to pass the 
identifier for the logical router with a command (i.e. it tells the multiviewer to make a 
crosspoint change for logical router X). The ID that it passes is the logical router matrix 
ID (refer to Step 3 – Adding Logical Routers, on page 372).

6 Click the Router configurations tab to view (or set) the logical matrix ID.

Notes 

• The logical router matrix ID must be manually entered on the SAM 
(Snell/Pro-Bel) controller—this is usually done via a Web interface, but is 
sometimes done over a serial connection. Some controllers allow you to 
program individual buttons, or groups of buttons.

• The SAM (Snell/Pro-Bel) controller can also use the logical router level IDs 
(e.g., [0] Video, [1] Audio) when it sends commands, allowing you to target 
just video crosspoints, just audio crosspoints, or both.

IMPORTANT
You must always configure a logical router for a physical external router. There 
is no way to control a physical external router directly.
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Configuring a Multiviewer’s Internal Router
To control your multiviewer’s internal router, it must be configured in the context of the KX 
Router logical router.

Configuring the Internal Router in a Kaleido-X16

To configure a Kaleido-X16 multiviewer’s internal router
1 Click the Router configurations tab, and then navigate to the Kaleido-X16-D (Internal 

Router) or Kaleido-X16-S (Internal Router) folder under Physical routers, in the 
Routers list.

The router protocol, connection type, host name and levels are predefined (and cannot 
be modified). Under Kaleido-X16-D (or S) (Internal Router), the physical level ROUTER 
OUTPUTS (Video 16 × 2) or ROUTER OUTPUTS (Video 16 × 1) was automatically 
created and configured to the right size.

2 Navigate to the KX Router folder, under Logical routers, and then click the [0] Video 
level.

Notes 

• The following ports are always active and can be used for controlling a 
Kaleido-X over TCP/IP, via the associated protocols:
• port 14000 (SW-P-08)
• port 2000 (SW-P-02)
• port 4381 (VikinX Modular)
• port 5194 (NVISION Ethernet protocol - Compact router)

• When controlling a multiviewer, by using one of the TCP/IP router 
protocols, the router level to be controlled must be configured in XEdit 
(see step 6 under Creating a Single Multiviewer System, on page 85). No 
other communication configuration is required in XEdit.
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In a factory-default configuration, the physical level ROUTER OUTPUTS is automatically 
included in the KX Router logical level [0] Video.

3 If the physical level is not included—for example, someone may have removed it from 
your configuration—, then you must add it to this logical level. In the Router 
configurations tab, click Add.

The Select Levels window appears, listing all available physical levels.

4 Select the physical levels you wish to add to KX Router’s first logical level, and then click 
OK.
The selected levels appear in the Physical levels list.

5 Click the [1] KX Router (16 × 34) folder under Logical routers in the Routers list.
The third-level tab bar appears under Router configurations, with the Configuration 
tab selected.

IMPORTANT
Controlling the multiviewer’s internal router by using any other logical router 
than KX Router is not supported. The ROUTER OUTPUT physical level must be 
added to the first level (i.e. [0] Video), under KX Router.
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6 Source and destination mapping is not done automatically. Click the Source mapping 
tab, click a cell in the [0] Video logical level column, and then choose an input from the 
list.

7 To import labels from a CSV file (i.e. a comma-delimited file such as might be exported 
from an Excel spreadsheet), click Import labels, navigate to the CSV file that contains 
the labels you wish to import, select it, and then click Open.

Auto map works as described in Step 3 – Adding Logical Routers, on page 372.

KX Router also has a Logical router matrix ID, which can be used by an external router 
control device or application to control the internal router modules.

Configuring the Internal Router in a Kaleido-X (7RU)

To configure a Kaleido-X (7RU) multiviewer’s internal router cards
1 Make sure that the System list reflects your multiviewer’s router card configuration. To 

add an internal router card, right-click OPTION A or OPTION B in the System list, and 
then click Insert KXO-24Router on the menu.

Note: The file must be formatted as three columns with no heading row. 
Column 1 should contain numbers from 1 to N (the number of sources), 
column 2 should contain the source labels, and column 3 should contain the 
destination labels. Columns are delimited by commas, without spaces. 
Sample label file:

1,VTR 1,OUT 1 
2,VTR 2,OUT 2 
3,CAM 1,OUT 3 
4,CAM 2,OUT 4 
5,SAT 1,PGM 
6,SAT 2,PVW

Note: The Get labels from physical level feature is not yet supported for 
internal router cards.

Logical router matrix ID
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A KXO-24Router card fills the selected slot.

2 Click the Router configurations tab, and then navigate to the Kaleido-X (7RU) 
(Internal Router) folder under Physical routers, in the Routers list.
The router protocol, connection type, host name and levels are predefined (and cannot 
be modified).
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3 Click OPTION A (or B) under Kaleido-X (7RU) (Internal Router) in the physical routers 
list. Note that the physical levels are automatically created—OPTION A (Video 120 × 48) 
and OPTION B (Video 120 × 48)—and configured to the right size.

4 Navigate to the KX Router folder, under Logical routers, and then click the [0] Video 
level.

In a factory-default configuration, the physical levels OPTION A and OPTION B are 
automatically included in the KX Router logical level [0] Video. If the physical levels 
(OPTION A, or B) for your actual router cards are not included—for example, this would 

Notes 

• The following ports are always active and can be used for controlling a 
Kaleido-X over TCP/IP, via the associated protocols:
• port 14000 (SW-P-08)
• port 2000 (SW-P-02)
• port 4381 (VikinX Modular)
• port 5194 (NVISION Ethernet protocol - Compact router)

• When controlling a multiviewer, by using one of the TCP/IP router 
protocols, the router level to be controlled must be configured in XEdit 
(see step 6 under Creating a Single Multiviewer System, on page 85). No 
other communication configuration is required in XEdit.

Note: “120 × 48” refers to the physical router size including internal 
connections used for router expansion. The actual size of each router card is 
96 × 24. Refer to Configuring Router Card Expansion in the Kaleido-X (7RU) 
Hardware Description & Installation Manual, for more information.
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be the case if you just added a router card to your system configuration—, then you 
must add them to this logical level.

5 In the Router configurations tab, click Add.

The Select Levels window appears, listing all available physical levels.

6 Select the physical levels you wish to add to KX Router’s first logical level, and then click 
OK.
The selected levels appear in the Physical levels list.

7 Click the [1] KX Router (96 × 80) folder under Logical routers in the Routers list.
The third-level tab bar appears under Router configurations, with the Configuration 
tab selected.

8 Source and destination mapping is not done automatically. Click the Source mapping 
tab, click a cell in the [0] Video logical level column, and then choose an input from the 
list.

9 To import labels from a CSV file (i.e. a comma-delimited file such as might be exported 
from an Excel spreadsheet), click Import labels, navigate to the CSV file that contains 
the labels you wish to import, select it, and then click Open.

IMPORTANT
Controlling the multiviewer’s internal router by using any other logical router 
than KX Router is not supported. The physical levels OPTION A and OPTION B 
must be added to the first level (i.e. [0] Video), under KX Router.
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Auto map works as described in Step 3 – Adding Logical Routers, on page 372.
It is also useful to have manual control over the source/destination mapping in the 
event a router card is removed.

KX Router also has a Logical router matrix ID, which can be used by an external router 
control device or application to control the internal router modules.

Configuring the Internal Router in a Kaleido-X (14RU)
Once two Kaleido-X (7RU) systems are in a Kaleido-X (14RU) expansion configuration, 
thereby giving you access to any source from either frame in your layouts, their respective 
router cards are not automatically shared between the system’s Frame A and Frame B. To be 
able to choose a source from one frame and send it to a router output on the other frame, 
you must have connected the router cards of one frame to those of the other using special 
cables plugged into the expansion ports on the router cards themselves, and then, in XEdit, 
you must have specified how the cards are connected. Refer to “Configuring Router Card 
Expansion” in the Kaleido-X (7RU) Hardware Description & Installation Manual, for details.

Note: The file must be formatted as three columns with no heading row. 
Column 1 should contain numbers from 1 to N (the number of sources), 
column 2 should contain the source labels, and column 3 should contain the 
destination labels. Columns are delimited by commas, without spaces. 
Sample label file:

1,VTR 1,OUT 1 
2,VTR 2,OUT 2 
3,CAM 1,OUT 3 
4,CAM 2,OUT 4 
5,SAT 1,PGM 
6,SAT 2,PVW

Note: The Get labels from physical level feature is not yet supported for 
internal router cards.

Note: In the case of a Kaleido-X (7RU), signals entering the input cards are 
made available to the internal router cards via the midplane (i.e. there is no 
cabling between the BNC outputs on the router cards and the BNC inputs on 
the KXI cards).

Logical router matrix ID
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Configuring Router Connections
To configure router connections

1 Click the Router connections tab, which lists all multiviewer inputs and, for each, the 
associated output connector from a router. For each multiviewer input you wish to 
connect to an external router (e.g., INPUT A – Video 01), click the first menu (under 
Router) and choose a physical router level (e.g., “MyRouter” – Video).

2 Click the second menu and choose the appropriate output (e.g., “Output 1 [1]”).

In this example, the Kaleido-X software registers that Output 1 from the router has a 
cable that connects to the BNC connector corresponding to Video 1 on the 
multiviewer’s INPUT A module. This means that when you select a router source to be 
assigned to a monitor on the monitor wall, the Kaleido-X software will be able to 
determine whether the multiviewer’s INPUT A – Video 01 connector is available, and, if 
so, request the appropriate crosspoint change for “Output 1” of “MyRouter”.

3 Use the incremental copy tool to assign the next router outputs to contiguous 
multiviewer inputs.

Note: Unconnected means that this multiviewer input is not connected to a 
router output. For example, the input might be directly connected to a 
source signal.

Maps to BNC 
connectors on the 

multiviewer

The name of 
the physical 

router

Maps to OUTPUT 
BNC connectors on 
the physical router
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Notes 

• Using the incremental copy tool in the Router column only copies the 
selected router to the next rows.

• Using the incremental copy tool in the Port column inserts the next output 
ports from the selected router in sequence, based on their Destination ID, 
until the last output port has been mapped, at which point using the 
incremental copy tool further will clear the subsequent cells.

• When using the tool in the Port column, the Router column is populated 
accordingly.

• It is possible to select the same output port more than once.

• You can resize the router connections table by dragging column 
boundaries, or by using the double or triple click features described in the 
Logical Sources chapter. See Resizing the Sources Table’s Columns on 
page 209, for details.

• In the case of a Kaleido-Modular-X multiviewer connected to an NV8576 
router that has M3 output cards, if an M3 output card is installed in the 
lower output bays of the NV8576 router frame, its backplane is upside down 
and the ordering of its ports differs from when the backplane is installed in 
the upper bays (right side up) of an NV8576 frame. Refer to NV8500 M3 
Backplane Connections, in the Kaleido-Modular-X Hardware Description & 
Installation Manual to determine the correct mapping between router 
outputs and multiviewer inputs, when using the M3 cable.
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This chapter describes how multiviewers can be configured to receive dynamic labels and 
status from tally interface devices, timer, time code and status information from a timer 
system, or status from a GPI module.
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Plura (Alpermann+Velte) Studio Production Timer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
GPI-1501 General Purpose Interface I/O Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 402
Configuring Serial Tally Systems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407
Ross Video Production Switcher  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409
Sony Production Switcher  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 414
Kahuna Production Switcher  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 418
Kayak Production Switcher  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 424
Kayenne Production Switcher  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 431
K-Frame Switchers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439
Zodiak Production Switcher  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 447
Daktronics Scoreboards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 454
Serial Port Test Agent . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 459

Overview
Kaleido multiviewer systems support most production switchers and other tally interface 
devices such as UMD controllers and automation systems, via a serial or network 
connection. Some timer systems and GPI I/O modules are also supported via a network 
connection. The multiviewer can dynamically update monitor wall elements to reflect text 
and status updates from the devices.

Key Concepts

Optional Drivers for Controlling Tally Interface Devices from the 
Multiviewer
Optional drivers are available to extend your Kaleido-X system with the ability to control 
tally interface devices such as the ones listed in the tables below. Contact your sales 
representative for more information.
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Production Switchers 

Company Device/System

Grass Valley (Thomson) Kayenne K-Frame, Karrera K-Frame, Kayenne, Kalypso, Zodiak, 
KayakDD, Kayak SD/HD, DD35, XtenDD HD/SD series

Ross Acuity, Synergy, and Vision Tritium series (via the Kalypso Serial 
Tally Protocol)

SAM (Snell & Wilcox) Kahuna

Sony DVS-9000, MVS-8000, MFS-2000

UMD controllers 

Company Device/System

Grass Valley (Thomson) Andromeda UMD Controller

Image Video TSI-1000 Tally System Interface (requires option from Image 
Video)

TSL UMD Controller (serial, TCP/IP or UDP/IP)

Scoreboards 

Company Device/System Sport Protocol version

Daktronics All Sport scoreboard controllers Basketball ED-16593, Rev 0–1

Football ED-16098, Rev 0–1

Baseball DD1492305, Rev 0

Soccer ED-16804, Rev 0–1

Volleyball ED-19266, Rev 0

Hockey ED-16092, Rev 0

Timer systems 

Company Device/System

Plura (Alpermann+Velte) Studio Production Timer (SPT)

Automation systems 

Company Device/System

Imagine Communications 
(Harris/Encoda)

D-Series Playout Automation, A7500 Dual Master Automation

Sundance Digital Fastbreak NXT Automation (requires option from Sundance 
Digital)
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Serial-to-TCP/IP Dispatcher
The Serial-to-TCP/IP Dispatcher is a piece of software designed to run on a separate PC or 
embedded into a product (e.g., a Kaleido multiviewer) and act as a bridge between a serial 
device and the TCP/IP network.

Detailed Directions

Plura (Alpermann+Velte) Studio Production Timer

For your multiviewer to receive time code information from a Plura (Alpermann+Velte) 
Studio Production Timer (SPT) system, and to display the system’s contribution on the 
monitor wall, you need to configure your multiviewer’s Plura SPT service, by performing the 
following tasks in XEdit:

1 Add the Plura (Alpermann+Velte) SPT timer system to your multiviewer system 
configuration, and set up the communication parameters (see Adding a Timer System 
to your Multiviewer Configuration on page 397).

2 Add logical sources and configure them by assigning alarms (or text elements) from the 
SPT system to the logical sources’ alarm (or text) levels (see Assigning Timer System 
Information to Logical Sources on page 399).

3 Assign the appropriate alarm and text levels from logical sources, to layout elements 
such as time code monitors, UMDs or alarm monitors (see Configuring Layout Elements 
on page 400).

Adding a Timer System to your Multiviewer Configuration

To add a Plura (Alpermann+Velte) SPT system to your multiviewer configuration
1 Open XEdit.
2 Connect to the multiviewer, if you wish to apply your changes in real time 

(see Connecting to a Multiviewer on page 77).

3 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

Note: For more information, refer to the Serial-to-TCP/IP Dispatcher Protocol 
guide, available from Grass Valley’s Technical Support (see Contact Us, on 
page 551).

Note: The Kaleido-X software supports Plura (Alpermann+Velte) Studio 
Production Timer (SPT) systems that comprise a Rubidium series IE 
module with firmware version 2.14.24 or later, and option R (Timer 
Request Protocol) enabled. Only the Basic timer format mode is available.

Note: If this step is omitted, then you will need to export the database to 
apply the changes.
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4 Drag the Plura (Alpermann+Velte) SPT device from the equipment library onto the 
root of the System hierarchical list.

Alternatively, right-click the list root, and then click Insert Plura (Alpermann+Velte) 
SPT on the menu.
A window appears, prompting you for a device identifier.

5 In Device Identifier, type a name for the timer system, and then click OK.

The timer system is added to the system list.

6 Click the Interconnects tab.
7 Position the pointer over the multiviewer icon, then click and drag towards the timer 

system icon.
A line representing the connection between the multiviewer and the device appears.

8 Click the connection line between multiviewer and device.
9 In the Properties pane, select Network (TCP/IP) from the Transport type list.

10 In the Interconnects tab, click the timer system icon.
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11 In the Properties pane, type the IP address of your timer system.

You are now ready to add information from the timer system to logical sources.

Assigning Timer System Information to Logical Sources

To configure your logical sources
1 In the Channels/Sources tab, add the required number of logical sources for your 

purposes (see Manually adding a Logical Source on page 199).
2 Add the required number of text and alarm levels for your purposes (see Adding a level 

on page 200).
For example, you might add one text level named Timer, and one alarm level named 
Timer status.

3 Click a cell that corresponds to the appropriate text level of a logical source you wish to 
configure.

4 In the filtered System list, navigate to the text element you wish to monitor, and drag it 
onto the selected cell.

5 If your logical sources include more text levels to be associated with the timer system, 
then repeat step 3 and step 4 for the current logical source’s remaining text levels.

6 Click a cell that corresponds to the appropriate alarm level of a logical source you wish 
to configure.

7 In the filtered System list, navigate to the alarm element you wish to monitor, and drag 
it onto the selected cell.
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8 If your logical sources include more alarm levels to be associated with the timer system, 
then repeat step 6 and step 7 for the current logical source’s remaining alarm levels.

9 Repeat step 3–step 8 for any remaining logical sources you wish to configure with 
information from the timer system.

10 On the File menu, click Save.
Changes to the sources table are saved.

Configuring Layout Elements
You can now assign the logical sources you previously configured (see Assigning Timer 
System Information to Logical Sources on page 399) to UMDs or other monitors that can 
display text or alarms (e.g., time code monitors, alarm monitors) in a layout. Depending on 
your purposes, you will assign the appropriate text or alarm levels to specific components 
within the monitors.

For example, you might configure the assignments for an alarm monitor, by replacing the 
default alarm level and text label level assignments (both set to GlobalAlarm, by default) 
with an alarm level associated with the timer system, and the corresponding text level, 
respectively.

The procedure below explains how to configure a UMD to report timer text and status.

To configure a UMD for dynamic reporting of text and status from a timer system
1 Click the Layouts tab, and then open the desired layout.
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2 Add a UMD from the set of predefined UMDs available in the Tools pane (e.g., umd2), or 
use the UMD button on the toolbar (see Configuring UMDs, on page 288, and 
Working with Composite Monitors, on page 310, if needed).

3 In the Tools pane, select one of the logical sources you previously configured 
(see Assigning Timer System Information to Logical Sources on page 399) from the 
filtered Channels/Sources list, and then drag it onto the UMD.

4 In the Properties pane, click the Text label level box, and then select the text level you 
wish to monitor (e.g., the Timer level you previously configured).

5 Click the UMD alarm level box, and then select the alarm level you wish to monitor 
(e.g., the Timer status level you previously configured).

6 Select a monospace font for the text:
a Click the Text font box, and then click the button that appears inside the box to 

open the font picker window.
b In Select a Font, click a monospace font (e.g., Lucida Sans Typewriter), and then 

click OK to close the window.
Alternatively, set the text to be left-aligned by clicking the Text horizontal alignment 
box, and then selecting Left from the list.

7 Click outside the composite to lock it, if applicable.
8 On the File menu, click Save.
9 If you have been working in offline mode, then export the database to your 

multiviewer (see Exporting a Database on page 81).

On the monitor wall, you can now load the layout containing the monitors that were 
assigned information from the Plura (Alpermann+Velte) SPT system. Text and status 
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information from the device will be visible on the monitor wall. Any changes made by the 
device’s operator will be immediately reflected on the monitor wall.

GPI-1501 General Purpose Interface I/O Module
The GPI-1501 is a 2RU Densité card that provides 20 dedicated GPI (General Purpose 
Interface) inputs plus eight terminals that can be individually configured as either a GPI 
input or GPI output. You may add one or more GPI-1501 modules to your multiviewer 
configuration to supplement the multiviewer’s existing GPI interface or, in the case of a 
Kaleido-Modular-X system, to provide such an interface. Kaleido-MX, and Kaleido-MX 4K 
multiviewers ship with a pre-configured GPI-1501 card.

For example, you may resort to the GPI interface to receive tally information from a switcher 
whose specific protocol the multiviewer does not support, assuming the switcher is 
capable of communicating via GPI.

For your multiviewer to receive status information from a GPI-1501 module, and to display 
the module’s contribution on the monitor wall as visual tally information, you need to 
configure your multiviewer’s GPI-1501 service, by performing the following tasks in XEdit:

1 Add the GPI-1501 module to your multiviewer system configuration, and set up the 
communication parameters (see Adding a GPI-1501 Module to your Multiviewer 
Configuration on page 402).

2 Configure logical sources by assigning GPI alarms from the GPI-1501 module to the 
logical sources’ alarm levels (see Assigning GPI Status Information to Logical Sources on 
page 405).

3 Assign alarm levels from logical sources, to layout elements such as UMDs or alarm 
monitors (see Configuring Layout Elements on page 406).

Adding a GPI-1501 Module to your Multiviewer Configuration

To add a GPI-1501 module to your multiviewer system configuration
1 Open XEdit.
2 Connect to the multiviewer, if you wish to apply your changes in real time 

(see Connecting to a Multiviewer on page 77).

3 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

4 Drag the GPI-1501 device from the equipment library onto the root of the System 
hierarchical list. Alternatively, right-click the list root, and then click Insert GPI-1501 on 
the menu.

Note: If this step is omitted, then you will need to export the database to 
apply the changes.
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A window appears, prompting you for a device identifier.
5 In Device Identifier, type a name for the GPI-1501, and then click OK.

The GPI-1501 is added to the system list.

6 Click the Interconnects tab.
7 Position the pointer over the multiviewer icon, then click and drag towards the 

GPI-1501 icon.
A line representing the connection between the multiviewer and the device appears.

8 Click the connection line between multiviewer and device.
9 In the Properties pane, select Network (TCP/IP) from the Transport type list.

Note: In the case of a system with several GPI-1501 modules, some of which 
you do not necessarily use all the time, you may choose to momentarily 
disconnect those that are not in use, when you need to reduce network 
traffic, by selecting Disconnected from the Transport type list.
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10 In the Interconnects tab, click the GPI-1501 icon.
11 In the Properties pane, type the number of the slot where your GPI-1501 card is located 

in its housing frame, directly in the Slot number box, or use the slider to set it.

• In the case of a Kaleido-Modular-X multiviewer, if the GPI-1501 card and your 
multiviewer’s output cards all share the same housing frame, then select the 
Single-frame system check box.

• Kaleido-MX, and Kaleido-MX 4K multiviewers being single-frame systems, with a 
GPI-1501 card included, keeping the Single-frame system check box selected 
allows you to change the CPU-ETH2 controller’s network settings, when needed, 
without having to revise communication parameters.

• In all other cases, enter the IP address of the Densité frame housing the GPI-1501 
(use the IP address associated with the CPU-ETH2 controller card’s ETH1 port).

12 If you wish to configure the GPI-1501 itself, click the Description/Calibrations tab, and 
then expand the appropriate GPI-1501 module in the System list.

a Click one of the eight configurable I/O terminals.

b In the Properties pane, select the appropriate value from the GPI IO direction list, 
to configure the GPI line’s direction (input or output).

c In the case of a GPI output line, if you wish to set its ON/OFF state manually for test 
purposes, then select either ON or OFF from the GPI output control list.

Note: GPI-1501 configuration is only available when XEdit is connected to 
the multiviewer. If you were working in offline mode up to this point, you 
must now export the database to the multiviewer (see Exporting a Database 
on page 81), and then switch to online mode (see Connecting to a 
Multiviewer on page 77).
404



Kaleido-X
User’s Manual
d To configure the source of timestamp information, click the Timestamp element in 
the System list, and then, in the Properties pane, select the appropriate value from 
the Timestamp source list.

• None: No timestamping.
• CPU: Timestamping will be based on the Densité CPU-ETH2 controller card’s 

real time clock.
• LTC: Timestamping will be based on the LTC signal at GPI input 20 if available. 

Selecting LTC as the timestamp source renders GPI input 20 unavailable for GPI 
purposes.

• URS: Timestamping will be based on the time information carried in the URS 
signal internal to the Densité housing frame. The URS is generated by a 
reference module (REF-1801) which must be installed in the frame for the URS 
to be available.

e If you selected LTC, then you may enable SMPTE ST 309 support.

You are now ready to add information from the GPI-1501 to logical sources.

Assigning GPI Status Information to Logical Sources

To configure your logical sources
1 In the Channels/Sources tab, add the required number of alarm levels for your 

purposes (see Creating and Configuring Logical Sources on page 196). For example, 
you might add one alarm level named On-air tally.

2 Click a cell that corresponds to the appropriate alarm level of a logical source you wish 
to configure.

3 In the filtered System list, navigate to the GPI element you wish to monitor, and drag it 
onto the selected cell.

New alarm level
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4 If your logical sources include more alarm levels to be associated with the GPI-1501, 
then repeat step 2 and step 3 for the current logical source’s remaining alarm levels.

5 Make corresponding assignments to other logical sources by incremental copy, if 
desired (see Making Further Assignments by Incremental Copy on page 207).

6 On the File menu, click Save.
Changes to the sources table are saved.

Configuring Layout Elements
You can now assign the logical sources you previously configured (see Assigning GPI Status 
Information to Logical Sources on page 405) to monitors that can display text or alarms 
(e.g., UMD, video, text alarm status) in a layout. Depending on your purposes, you will 
assign the appropriate text or alarm levels to specific components within the monitors. For 
example, you might select an alarm level as the source for an alarm monitor, and the 
GlobalAlarm level (see Global Alarms on page 170) as the text label level. The procedure 
below explains how to configure a UMD to report the On-air tally status.

To configure layout elements for dynamic text and tally reporting
1 Click the Layouts tab, and then open the layout you wish to configure.
2 In the Tools pane, select one of the logical sources you previously configured 

(see Assigning GPI Status Information to Logical Sources on page 405) from the filtered 
Channels/Sources list, and then drag it onto the appropriate monitor.

3 Repeat step 2 until you have assigned all the sources you wish to monitor to the 
appropriate monitors in your layout.

4 Click a UMD whose tally reporting behavior you wish to set, after unlocking the 
composite monitor that contains it if applicable (see Unlocking a Composite Monitor 
on page 316).

5 In the Properties pane, click the Right tally source level box, and then select the alarm 
level you wish to monitor (e.g., the On-air tally level you previously configured).

Alarm level based on status 
information from the GPI-1501
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6 Click outside the composite to lock it, if applicable.
7 Repeat step 4 and step 5 until you have configured all UMDs that are to display tally 

status when this layout is loaded on the monitor wall.
8 On the File menu, click Save.
9 If you have been working in offline mode, then export the database to your 

multiviewer (see Exporting a Database on page 81).

On the monitor wall, you can now load the layout containing the monitors that were 
assigned tally information provided by the GPI-1501. Tally status from the device (e.g., a 
switcher) feeding the GPI-1501 module will be visible on the monitor wall. Any changes 
made by the device’s operator will be immediately reflected on the monitor wall.

Configuring Serial Tally Systems
This section covers the configuration of the Kalypso, Andromeda, Encoda, Serial to TCP/IP 
Dispatcher (see Serial-to-TCP/IP Dispatcher on page 397), and TSL serial devices, which can 
be added to a multiviewer system to receive and interpret serial tally information from 
peripheral devices. The illustrations, options or properties shown below may vary, 
depending on your actual system.

To configure a serial tally system
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

2 Drag the appropriate peripheral device from the equipment library onto the root of the 
System hierarchical list. Alternatively, right-click the list root, and then click the 
appropriate peripheral device on the menu.
A window appears, prompting you for a device identifier.

3 Type a name for the peripheral device, and then click OK.
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4 Click the Interconnects tab.
5 Click the multiviewer icon and hold the mouse button, while dragging the pointer 

towards the peripheral device icon.
A line representing the connection between the multiviewer and the device appears.

Connection between the multiviewer and the device (example using Kalypso, same for all 
devices)

6 Click the connection line between the multiviewer and the device.
7 In the Properties pane, select the appropriate element from the RS-422 

communication port list.

Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).
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8 Click the peripheral device icon in the Interconnects tab.
9 In the Properties pane, set the serial communications properties for the device.

The set of properties will vary, depending on the device. Refer to the manufacturer’s 
documentation for your specific device as needed.

Serial communications properties examples

10 On the File menu, click Save.

Ross Video Production Switcher
A multiviewer can receive dynamic source names and tally information from a Ross Video 
production switcher (Synergy 2, 3, 4 SD/MD and Vision models). The procedures below 
describe how to set up the multiviewer to interface with a Ross Video switcher.

To set up the Ross Video production switcher
1 Enable the contribution serial tally interface on one of the switcher’s ports, by using the 

switcher’s installation menu: from the HOME menu, press More > Setup > Installation 
> Comm Setup, and then configure the serial tally device as follows:

Example showing the default 
properties for the Kalypso device

Example showing the properties 
for an Encoda device, configured 
to reflect the current settings on 

an actual A7500 automation 
system

Example showing the default 
properties for the Andromeda 

device (the Encoda device has the
same default properties)

Menu Field Value Sub-value

Type Com Port [any REMOTE or 
PERIPH port 
(depending on 
device), or the 
EDITOR port (on a 
Synergy 100 panel)]

Device Serial Tally

SelectDevice Device Contrib

Comm Setting Baud 38 400-115 200

Parity NONE

Comm Type Type RS-422
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2 Physically connect one end of an RJ-45 straight-through cable to the multiviewer’s 
RS-422 port.

3 Using the straight DE-9S-to-RJ45 adapter (part no. 1737-3000-102), connect the other 
end of the cable to the enabled serial tally port on the switcher.
Since the protocol is unidirectional, only the transmit pins are required from the 
switcher’s remote port. See RS-422 Connection Diagram on page 27 for pinouts on the 
multiviewer.

To set up the multiviewer
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

3 Drag the Kalypso device from the equipment library onto the root of the System 
hierarchical list. Alternatively, right-click the list root, and then click Insert Kalypso on 
the menu.

A window appears, prompting you for a device identifier.

4 Type a name for the Kalypso device, and then click OK.
5 Click the Interconnects tab.

Extra Option Option Rate 26

Option Data Txfr Complete

Option Start None

Option At Black All Off

Note: For more information on installing port devices, please refer to your 
Ross switcher documentation. The communication parameters listed above 
are recommended values. Other values may also work, but remember that 
both the switcher and the multiviewer must be configured with the same 
values.

Required pins Signal

7 TX+

2 TX-

Note: On the multiviewer, Kalypso is the module that receives and 
interprets serial tally information from Ross Video production switchers.

Menu Field Value Sub-value
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6 Position the pointer over the multiviewer icon, then click and drag towards the Kalypso 
device icon.
A line representing the connection between the multiviewer and the device appears.

Connection between the multiviewer and the device

7 Click the connection line between the multiviewer and the device.
8 In the Properties pane, select the appropriate element from the RS-422 

communication port list.

Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

9 In the Interconnects tab, click the Kalypso device icon.

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).
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10 In the Properties pane, set the serial communications properties for the remote port 
on the Ross Video switcher as follows:

11 In the Channels/Sources tab, configure logical sources using text sources and system 
tallies from the Kalypso serial tally device.

Baud rate 38 400-115 200

Data bits 8

Parity NONE

Stop bits 1

Note: Refer to the table below for a list of valid source IDs and their 
meaning in the context of the Kalypso serial tally protocol.

Source IDs Kalypso

1 - 92 Inputs 1 - 92

93 M/E 1 PGM A

94 M/E 1 PGM B

95 M/E 1 PGM C

96 M/E 1 PGM D

97 M/E 1 PVW A

98 M/E 1 PVW 2

99* M/E 2 PGM A

100* M/E 2 PGM B

101* M/E 2 PGM C

102* M/E 2 PGM D

103* M/E 2 PVW A

104* M/E 2 PVW 2
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* 2-M/E systems do not have these sources.
12 In the Layouts tab, create layouts and assign logical sources created in step 11 to 

monitors that can display text (e.g., UMD) and alarms (e.g., UMD, video, text alarm).

13 On the File menu, click Save.
14 On the Configure menu, point to Database, and then click Export to export the 

database to your multiviewer.

105* M/E 3 PGM A

106* M/E 3 PGM B

107* M/E 3 PGM C

108* M/E 3 PGM D

109* M/E 3 PVW A

110* M/E 3 PVW 2

111 Pgm-Pst PGM A

112 Pgm-Pst PGM B

113 Pgm-Pst PGM C

114 Pgm-Pst PGM D

115 Pgm-Pst PVW A

116 Pgm-Pst PVW 2

117 Test Signal

118 Black

119 Background 1

120 Background 2

121 Still Store 1

122 Still Store 2

123 Still Store 3

124 Still Store 4

125 Still Store 5

126 Still Store 6

127 Still Store 7

128 Still Store 8

Source IDs Kalypso
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15 On the multiviewer, load the layout containing the monitors assigned to dynamic text 
and tallies coming from the Ross Video switcher.
You should see source names and tallies from the Ross Video switcher on the monitor 
wall.

Sony Production Switcher
A multiviewer can receive dynamic source names and tally information from a Sony 
switcher. The procedure below describes how to set up a multiviewer to interface with a 
Sony production switcher (DVS-9000 series, MVS-8000 series or MFS-2000 series).

Setting Up a Sony Switcher

To set up a Sony switcher
1 Enable serial tally on one of the switcher’s ports (refer to your Sony Production Switcher 

System User’s Guide for details).

2 Physically connect one end of an RJ-45 straight cable to the multiviewer’s RS-422 port.
3 Using a DE-9S-to-RJ45 crossover adapter (Grass Valley part no. 1792-3700-100), 

connect the other end of the cable to the enabled serial tally port on the Sony switcher. 
See RS-422 Connection Diagram on page 27 for pinouts on the multiviewer.

DVS-9000 switchers

Since there are no serial tally connections on the DVS-9000 switcher, you will need an 
additional device—either a Device Control Unit (DCU) or a System Control Unit (SCU)—
between this switcher model and the multiviewer. Use a DCU model MKS-8700 or DCU-
8000, or an SCU model MKS-8010A or MKS-8010B.

• On a DCU (MKS-8700 or DCU-8000), use the connectors labeled Serial Tally 1 and Serial 
Tally 2.

Sony Device Control Unit Pack (DCU-8000)

Note: There are no serial tally connections on the Sony switcher model 
DVS-9000. See DVS-9000 switchers on page 414 for details.

Note: MKS-2700: The 1 RU DCU model MKS-2700 does not have a serial 
tally connection, so serial tally must come from a MKS-8010A or MKS-8010B 
SCU.

Serial Tally 2
Serial Tally 1
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• On an SCU (MKS-8010A or MKS-8010B), use the 15-pin connector labeled EDITOR 
PANEL, with an adapter.

 

Sony System Control Unit (MKS-8010A)

Sony System Control Unit (MKS-8010B)

To use a serial tally from an SCU model MKS-8010A or MKS-8010B, a 15-pin-to-9-pin 
adapter is required, with pinouts as follows:

No adapter is required for SCU model MKS-8010, which has a DE-9 connector with the 
following pinout:

In addition, on Sony menu page 7367, you must enable R and G serial tallies on the SCU 
port.

MKS-8010A or MKS-8010B 
(15-pin)

SCU 
(Signal)

Serial tally device 
(9-pin)

2 RX- 2

3 TX+ 3

10 RX+ 7

11 TX- 8

4 GND 4

MKS-8010 
(9-pin)

SCU 
(Signal)

2 RX-

3 TX+

7 RX+

8 TX-

4 GND

Note: See RS-422 Connection Diagram on page 27 for pinouts on the 
multiviewer.

EDITOR PANEL

EDITOR PANEL
415



Tally Interface Devices &Timer Systems
Sony Production Switcher
Setting Up a Multiviewer to Interface with a Sony Production Switcher

To set up the multiviewer to interface with the Sony production switcher
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

3 Drag the Sony production switcher device from the equipment library onto the root of 
the System hierarchical list. Alternatively, right-click the list root, and then click Insert 
Sony serial tally on the menu.
A window appears, prompting you for a device identifier.

4 Type the name of the Sony production switcher, and then click OK.
5 Click the Interconnects tab.
6 Position the pointer over the multiviewer icon, then click and drag towards the Sony 

production switcher icon.
A line representing the connection between the multiviewer and the device appears.

Connection between the multiviewer and the device

7 Click the connection line between the multiviewer and the device.
8 In the Properties pane, select the appropriate element from the RS-422 

communication port list.

Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:
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9 In the Interconnects tab, click the Sony production switcher icon.
10 In the Properties pane, set the serial 

communications properties for the Sony device as 
follows:

11 In the Channels/Sources tab, create logical sources using text and alarms levels 
coming from the Sony serial tally device.

12 In the Layouts tab, create layouts and assign logical sources created in step 11 to 
monitors that can display text (e.g., UMD) and alarms (e.g., UMD, video, text alarm).

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).

Baud Rate 38 400

Data Bits 8

Parity ODD

Stop bits 1
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13 On the File menu, click Save.
14 On the Configure menu, point to Database, and then click Export to export the 

database to your multiviewer.
15 On the multiviewer, load the layout containing the monitors assigned to dynamic text 

and tallies coming from the Sony switcher.
You should see source names and tallies from the Sony switcher on the monitor wall.

Kahuna Production Switcher
A multiviewer can receive dynamic source names and tally information from a Kahuna 
production switcher. The procedures below describe how to set up a multiviewer to 
interface with a Kahuna switcher.

To set up the Kahuna switcher
1 Physically connect one end of an RJ-45 straight cable to the multiviewer’s RS-422 port.
2 Using a DE-9S-to-RJ45 crossover adapter (Grass Valley part no. 1792-3700-100), 

connect the other end of the cable to the appropriate RS-422 control port on the 
Kahuna switcher. See RS-422 Connection Diagram on page 27 for pinouts on the 
multiviewer. The illustration below shows the location of the RS-422 ports on an 11RU 
Kahuna switcher. The RS-422 ports (highlighted) are numbered 1 – 8, from right to left. 
Refer to the Kahuna Install Manual for more details on the RS-422 control ports.4

4.The Kahuna Install Manual is available here: 
https://kahuna.snellgroup.com/kahunaclub/kahunacare/documents.php
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The Kahuna has DE-9 connectors with the following pinout:

3 On the Kahuna switcher’s GUI panel, press the ENG CONFIG button.
The Engineering Config menu appears on the touch screen.

4 Touch the Protocols button on the screen to bring up the Engineering Config – Serial 
Port Protocols menu.

5 In the list of RS-422 ports, select the one to which you connected the crossover cable.
6 Set the communications parameters for the selected port as follows, using the rotary 

controls on the right of the GUI panel:

9-pin Signal

2 RX-

3 TX+

7 RX+

8 TX-

4 GND

Note: See RS-422 Connection Diagram on page 27 for pinouts on the 
multiviewer.

Protocol Serial Tally

Baud Rate 115 200

RS-422 ports 
(1 – 8)
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7 On the Kahuna switcher’s GUI panel, press the PERIPH button
The Peripherals menu appears.

8 Touch the Tally Control button on the screen to bring up the Peripherals – Tally 
Protocol menu.

9 Select the RS-422 port that is connected to the multiviewer, and set its serial protocol 
options as follows:

To set up the multiviewer
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

3 Drag the Kahuna production switcher device from the equipment library onto the root 
of the System hierarchical list. Alternatively, right-click the list root, and then click Insert 
Kahuna on the menu.
A window appears, prompting you for a device identifier.

4 Type a name for the Kahuna production switcher, and then click OK.
5 Click the Interconnects tab.
6 Position the pointer over the multiviewer icon, then click and drag towards the Kahuna 

production switcher icon.
A line representing the connection between the multiviewer and the device appears.

Parity NONE

Data Bits 8

Stop bits 1

Port Type Master

Extension Enable On

Full Table Enable On

Notes 

• Refer to the Kahuna User Instruction Manual for further details on setting up 
the port protocols and tally protocol parameters (see 
https://kahuna.snellgroup.com/kahunaclub/kahunacare/docu
ments.php).

• Although it is possible to define “user configuration” source names on the 
Kahuna switcher, these are not transmitted over the serial tally interface. 
The switcher only transmits the “engineering configuration” source names.
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Connection between the multiviewer and the device

7 Click the connection line between multiviewer and device.
8 In the Properties pane, select the appropriate element from the RS-422 

communication port list.

Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

9 In the Interconnects tab, click the Kahuna production switcher icon.

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).
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10 In the Properties pane, set the serial 
communications properties for the Kahuna device as 
follows:

11 In the Channels/Sources tab, create logical sources 
using Text and Alarm elements coming from the 
Kahuna’s serial tally information.

Baud Rate 115200

Data Bits 8

Parity NONE

Stop bits 1

Note: Refer to the table below for a list of valid source IDs and their 
meaning in the context of the Kahuna serial tally protocol.

Source IDs Kahuna

1 - 80 Inputs 1 - 80

81 Store 9

82 Store 10

83 Store 11

84 Store 12

85 Store 13

86 Store 14

87 Store 15

88 Store 16

89 DVE 1 Output 1

90 DVE 1 Output 2

91 DVE 1 Output 3

92 DVE 1 Output 4

93 M/E 1 Output 1

94 M/E 1 Output 2

95 M/E 1 Output 3

96 M/E 1 Output 4
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12 In the Layouts tab, create layouts and assign logical sources created in step 11 to 
monitors that can display text (e.g., UMD) and alarms (e.g., UMD, video, text alarm).

97 Unused

98 Unused

99 M/E 2 Output 1

100 M/E 2 Output 2

101 M/E 2 Output 3

102 M/E 2 Output 4

103 Unused

104 Unused

105 M/E 3 Output 1

106 M/E 3 Output 2

107 M/E 3 Output 3

108 M/E 3 Output 4

109 Unused

110 Unused

111 Pgm-Pst Output 1

112 Pgm-Pst Output 2

113 Pgm-Pst Output 3

114 Pgm-Pst Output 4

115 Unused

116 Unused

117 DVE 2 Output 1

118 DVE 2 Output 2

119 DVE 2 Output 3

120 DVE 2 Output 4

121 Store 1

122 Store 2

123 Store 3

124 Store 4

125 Store 5

126 Store 6

127 Store 7

128 Store 8

Source IDs Kahuna
423



Tally Interface Devices &Timer Systems
Kayak Production Switcher
13 On the File menu, click Save.
14 On the Configure menu, point to Database, and then click Export to export the 

database to your multiviewer.
15 On the multiviewer, load the layout containing the monitors assigned to dynamic text 

and tallies coming from the Kahuna switcher.
You should see source names and tallies from the Kahuna switcher on the monitor wall.

Kayak Production Switcher
A multiviewer can receive dynamic source names and tally information from Thomson 
Grass Valley production switchers that support the ACOS protocol, including the KayakDD, 
Kayak HD/SD, DD35, and XtenDD HD/SD series. The procedures below describe how to set 
up a multiviewer to interface with these Thomson Grass Valley switchers, for which the 
generic name Kayak switcher will be used.

Configuring the Kayak Switcher
Once you have established a serial connection between the switcher and your multiviewer, 
you will need to enable the ACOS protocol on the switcher’s serial port by using the 
Sidepanel software.ß

To set up the Kayak switcher
1 Physically connect one end of an RJ-45 straight cable to the multiviewer’s RS-422 port.
2 Using a DE-9S-to-RJ45 crossover adapter (Grass Valley part no. 1792-3700-100), 

connect the other end of the cable to one of the RS-422 control ports on the Kayak 
switcher. The illustration below shows the location of the RS-422 ports on a 4RU 
Kayak HD switcher. The RS-422 ports (highlighted) are numbered 1 – 8, in reading 
order. Refer to your switcher’s Installation and Service Manual for more details.5

Note: The on-air tally feature was introduced in version 6.9.3 of the ACOS 
protocol, which is only available with the Kayak series of Grass Valley 
production switchers. Other features such as retrieving dynamic source or 
destination names, and changing crosspoints are available on all ACOS-
enabled production switchers.

5.Manuals and Release Notes for all Grass Valley production switchers are available here: 
http://www.grassvalley.com/docs/all_switchers.html#manuals
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The Kayak switcher’s 8 control ports have DE-9 female 
connectors with the following pinout:

3 Install the Sidepanel software (available on the Kayak Software CD) on a PC or laptop, if 
you have not already done so. (Refer to your switcher’s Release Notes for installation 
instructions.)

4 Launch the Sidepanel software, and navigate to the Install > E-Box menu.
5 Click the Router tab.
6 Under Automation Control 1, select the appropriate serial port (i.e., the one to which 

the multiviewer is connected) and the protocol type (only “acos_vxxx” should be 
available).
This completes the configuration required on the switcher. The ACOS protocol is now 
enabled on the serial port used for the connection between the switcher and the 
multiviewer. The multiviewer system will be able to send commands to the switcher, 
and the switcher will respond accordingly.

Configuring the Multiviewer
For your multiviewer to receive tally status, input names and output names from a Kayak 
switcher, and to display the switcher’s contribution on the monitor wall as visual tally and 

Pin Signal

1 and 9 Chassis Ground

2 RX-

3 TX+

7 RX+

8 TX-

4 and 6 Signal Ground

Note: See RS-422 Connection Diagram on page 27 for pinouts on the 
multiviewer.
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dynamic text information, you need to configure your multiviewer’s Kayak serial tally 
service, by performing the following tasks in XEdit:

• set up the communication parameters for the serial connection;
• configure logical sources by assigning input names, output names, and tally status 

from the switcher to the logical sources’ text or alarm levels;
• assign alarm and text levels from logical sources to layout elements such as UMDs or 

alarm monitors.

Establishing serial communication between the Kayak switcher and the 
multiviewer

To set up the multiviewer’s communication parameters
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

3 Drag the Kayak production switcher device from the equipment library onto the root 
of the System hierarchical list. Alternatively, right-click the list root, and then click Insert 
Kayak on the menu.
A window appears, prompting you for a device identifier.

4 Type a name for the Kayak production switcher, and then click OK.
5 Click the Interconnects tab.
6 Position the pointer over the multiviewer icon, then click and drag towards the Kayak 

production switcher icon.
A line representing the connection between the multiviewer and the device appears.

Connection between the multiviewer and the device

7 Click the connection line between multiviewer and device.
8 In the Properties pane, select the appropriate element from the RS-422 

communication port list.
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Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

9 In the Interconnects tab, click the Kayak production switcher icon.
10 In the Properties pane, set the serial 

communications properties for the Kayak device as 
follows:

Assigning Kayak tallies, input names, and output 
names to logical sources

To configure your logical sources
• In the Channels/Sources tab, configure logical sources using text sources and system 

tallies from the Kayak’s serial interface.

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).

Baud Rate 38400

Data Bits 8

Parity NONE

Stop bits 1
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Notes 

• Kayak devices provide up to 512 text sources, and up to 256 × 5 system 
tally sources.

• The current version of the XtenDD HD/SD switchers software does not 
provide tally sources.

• DD35 and the Kayak series switchers only provide RED (On Air) tally 
sources. This is a limitation in the current version (6.9.3) of the ACOS 
protocol. 

• Refer to the table below for a list of valid sources, depending on your 
switcher model, and their meaning in the context of the ACOS protocol.

Input 
Number DD35 XtenDD HD XtenDD SD KayakDD Kayak SD/HD 

0x00 BLACK BLACK BLACK BLACK BLACK 

0x01..0x60 Input1...62 
(0x01..0x3E) 

Input 1..90 
(0x01..0x5A) 

Input 1..90 
(0x01..0x5A) 

Input 1..32 
(0x01..0x20) 

Input 1..96 
(0x01..0x60) 

0x80 VideoStore     

0x81 Montage 
processor 1 

    

0x82 Montage 
processor 2 

    

0x85 DVX1 DVX1 DVX1   

0x86 DVX2 DVX2 DVX2   

0x87 DVX3 DVX3 DVX3   

0x88 DVX4 DVX4 DVX4   

0x89  RamRec1 RamRec1 RamRec1 RamRec1 

0x8A  RamRec2 RamRec2 RamRec2 RamRec2 

0x8B  RamRec3 RamRec3 RamRec3 RamRec3 

0x8C  RamRec4 RamRec4 RamRec4 RamRec4 
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0x8D     RamRec5 

0x8E     RamRec6 

0x90 ColorBGD1 ColorBGD1 ColorBGD1 ColorBGD1 ColorBGD1 

0x91 ColorBGD2 ColorBGD2  ColorBGD2 ColorBGD2 

0x92 ColorBGD3   ColorBGD3 ColorBGD3 

0x98   ColorBGD ME   

0x99     ColorBGDTest 

0xA0 PP-Main PP-Main PP-Main PP A PP A 

0xA1 ME1-Main ME1-Main ME1-Main M1 A M1 A 

0xA2 ME2-Main ME2-Main ME2-Main  M2 A 

0xA3 ME3-Main ME3-Main ME3-Main  M3 A 

0xA4     MEhA 

0xA8   PP_UTIL_D   

0xA9   PP_UTIL_E   

0xAA   ME1_UTIL_D   

0xAB   ME1_UTIL_E   

0xAC   ME2_UTIL_D   

0xAD   ME2_UTIL_E   

0xAE   ME3_UTIL_D   

0xAF   ME3_UTIL_E   

0xB0 PP-PVW PP-PVW PP-PVW PPp1 PPp1 

0xB1 ME1-PVW ME1-PVW ME1-PVW M1p1 M1p1 

0xB2 ME2-PVW ME2-PVW ME2-PVW M2p1 M2p1 

0xB3 ME3-PVW ME3-PVW ME3-PVW M3p1 M3p1 

0xB4     Mhp1 

0xB8  VideoStore1 VideoStore1   

0xB9  VideoStore2 VideoStore2   

0xBA  VideoStore3 VideoStore3   

0xBB  VideoStore4 VideoStore4   

0xBC  VideoStore5 VideoStore5   

0xBD  VideoStore6 VideoStore6   

0xC0     PP C 

0xC1 Layer ME1    PP D 

0xC2 Layer ME2    M1 C 

Input 
Number DD35 XtenDD HD XtenDD SD KayakDD Kayak SD/HD 
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0xC3 Layer ME3    M1 D 

0xC4     M2 C 

0xC5     M2 D 

0xC6     M3 C 

0xC7     M3 D 

0xC8  PPKey PPKey   

0xC9  ME1Key ME1Key   

0xCA  ME2Key ME2Key   

0xCB  ME3Key ME3Key   

0xD0 PP Clean PP Clean PP Clean PP B (PP 
Clean) 

PP B 

0xD1 ME1 Clean ME1 Clean ME1 Clean M1 B (ME1 
Clean) 

M1 B 

0xD2 ME2 Clean ME2 Clean ME2 Clean  M2 B 

0xD3 ME3 Clean ME3 Clean ME3 Clean  M3 B 

0xD4  PP UtilA PP UtilA PPp2 (PP 
Clean 
Preview) 

MEh B 

0xD5  PP UtilB PP UtilB   

0xD6  PP UtilC PP UtilC   

0xD7  ME1 UtilA ME2 UtilA M1p2 (ME1 
Clean 
Preview) 

 

0xD8  ME1 UtilB ME1 UtilB  PPp2 

0xD9  ME1 UtilC ME1 UtilC  M1p2 

0xDA  ME2 UtilA ME2 UtilA  M2p2 

0xDB  ME2 UtilB ME2 UtilB  M3p2 

0xDC  ME2 UtilC ME2 UtilC  Mhp2 

0xDD  ME3 UtilA ME3 UtilA   

0xDE  ME3 UtilB ME3 UtilB   

0xDF  ME3 UtilC ME3 UtilC   

0xE0..0xEF Virtual Input 
00...15 

Virtual Input 
00...15 

Virtual Input 
00...15 

Virtual Input 
00...15 

Virtual Input 
00...15 

0xF0 WHITE WHITE WHITE WHITE WHITE 

Input 
Number DD35 XtenDD HD XtenDD SD KayakDD Kayak SD/HD 
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To configure layout elements 
1 In the Layouts tab, create layouts and assign the logical sources you configured 

(see Assigning Kayak tallies, input names, and output names to logical sources on 
page 427) to monitors that can display text (e.g., UMD) or alarms (e.g., UMD, video, text 
alarm status).

2 Depending on your purposes, assign the appropriate text or alarm levels to specific 
components within the monitors (e.g., assign an alarm level to a tally component in a 
UMD, or a text level to the UMD text component).

3 On the File menu, click Save.
4 On the Configure menu, point to Database, and then click Export to export the 

database to your multiviewer.

On the monitor wall, you can now load the layout containing the monitors that were 
assigned dynamic text and tallies provided by the Kayak switcher. Input and output names, 
as well as tally status from the Kayak switcher will be visible on the wall. Any changes made 
by the switcher’s operator will be immediately reflected.

Kayenne Production Switcher
A multiviewer can receive dynamic source names and tally information from a Grass Valley 
Kayenne Video Production Center. The procedures below describe how to set up a 
multiviewer to interface with this family of production switchers.

Configuring the Kayenne Switcher
To establish a serial connection between the switcher and your multiviewer, you need to 
identify the serial port you wish to use for tally contribution in the switcher’s Engineering 
Setups, by using the Kayenne touch screen menu panel or the Kayenne Menu application.

To set up the Kayenne switcher
1 Physically connect one end of an RJ-45 straight cable to the multiviewer’s RS-422 port.
2 Using a DE-9S-to-RJ45 crossover adapter (Grass Valley part no. 1792-3700-100), 

connect the other end of the cable to one of the 8 RS-422 control ports on the Kayenne 
Video Processor Frame. The illustration below shows the location of the RS-422 ports 
on a 4RU Kayenne frame. The RS-422 ports (highlighted) are numbered 1 – 8, from top 
to bottom.
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The 8 RS-422 control ports at the back of a Kayenne Video 
Processor frame have DE-9 female connectors. When any of 
them is designated as the tally contribution port, it is 
automatically configured with the following pinout:

3 On the Kayenne touch screen menu panel, touch the Eng Setup menu button, the 
Ports & Devices category button, and then the Serial Tally Ports tab.
The Serial Tally Ports menu appears.

4 In the port selection area, touch the port you wish to use as the tally contribution port.
5 In the Baud Rate / Parity area, touch 115.2k, and None.

This sets the baud rate to 115,200 and the parity to None.

Assuming the required sources and outputs have been defined, this completes the 
configuration required on the switcher. The multiviewer system will be able to send 
commands to the switcher, and the switcher will respond accordingly. Refer to the Kayenne 
Installation and Service Manual for more details.6

Pin Signal

1 and 9 Chassis Ground

2 RX-

3 TX+

7 RX+

8 TX-

4 and 6 Signal Ground

Note: See RS-422 Connection Diagram on page 27 for pinouts on the 
multiviewer’s side.

6.Manuals and Release Notes for all Grass Valley production switchers are available here: 
http://www.grassvalley.com/apps/doc_prodlist?super=broadcast&set=switchers
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For your multiviewer to receive tally status, source names and output names from a 
Kayenne switcher, and to display the switcher’s contribution on the monitor wall as visual 
tally and dynamic text information, you need to configure your multiviewer’s Kayenne 
serial tally service, by performing the following tasks in XEdit:

• set up the communication parameters for the serial connection;
• configure logical sources by assigning input names, output names, and tally status 

from the switcher to the logical sources’ text or alarm levels;
• assign alarm and text levels from logical sources to layout elements such as UMDs or 

alarm monitors.

Establishing serial communication between the Kayenne switcher and the 
multiviewer

To set up the multiviewer’s communication parameters
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

3 Drag the Kayenne production switcher device from the equipment library onto the 
root of the System hierarchical list. Alternatively, right-click the list root, and then click 
Insert Kayenne on the menu.
A window appears, prompting you for a device identifier.

4 Type a name for the Kayenne production switcher, and then click OK.
5 Click the Interconnects tab.
6 Position the pointer over the multiviewer icon, then click and drag towards the 

Kayenne production switcher icon.
A line representing the connection between the multiviewer and the device appears.

7 Click the connection line between multiviewer and device.
8 In the Properties pane, select the appropriate serial port from the RS-422 

communication port list.
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Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

9 In the Interconnects tab, click the Kayenne production switcher icon.
10 In the Properties pane, set the serial 

communications properties for the Kayenne device 
as follows:

11 Set the appropriate output numbers to use for tally 
calculation, based on your switcher’s configuration.
The current version of the Kaleido-X software supports monitoring of up to 6 tallies 
from a Kayenne Video Processor Frame. By default, in XEdit, Tally 1 corresponds to the 
Kayenne’s output 1 (which typically carries the Program signal), and Tally 2 corresponds 
to the Kayenne’s output 5 (typically the Preview signal). The following table lists the 
default output assignments on a Kayenne Video Processor Frame. Refer to the Kayenne 
Installation and Service Manual for more details.7

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).

Baud Rate 115200

Data Bits 8

Parity NONE

Stop bits 1
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The Kayenne contribution tally protocol provides information on up to 96 external sources, 
up to 4 eDPM video/key pairs, up to 6 image store outputs, up to 48 programmable 
switcher outputs, up to 2 complete operator suites with the associated alternative source 
names, and a few more signals from the Kayenne Video Processor Frame. In XEdit’s 
Channels/Sources tab, configure logical sources using text sources and system tallies from 
the Kayenne’s serial interface. You will find these elements by expanding the filtered system 
list that appears in the Tools pane.

To configure your logical sources
1 In the Channels/Sources tab, add the required number of text and alarm levels for your 

purposes (see Creating and Configuring Logical Sources on page 196).
You may, for example, add one text level to monitor source labels from the Kayenne 
switcher, and two alarm levels to monitor Program and Preview tallies.

2 Click a cell that corresponds to the appropriate text level of a logical source.
3 In the filtered System list, navigate to the text element you wish to monitor, and drag it 

onto the selected cell.

7.Manuals and Release Notes for all Grass Valley production switchers are available here: 
http://www.grassvalley.com/docs/all_switchers.html#manuals

ME A ME B ME C ME D

Output # Signal Output # Signal Output # Signal Output # Signal

1 Pgm A 13 ME1 A 25 ME2 A 37 ME3 A

2 Pgm B 14 ME1 B 26 ME2 B 38 ME3 B

3 Pgm C 15 ME1 C 27 ME2 C 39 ME3 C

4 Pgm D 16 ME1 D 28 ME2 D 40 ME3 D

5 Pgm pA 17 ME1 pA 29 ME2 pA 41 ME3 pA

6 Pgm p2 18 ME1 p2 30 ME2 p2 42 ME3 p2

7 Aux 1 19 Aux 4 31 Aux 8 43 Aux 14

8 Aux 1 20 Aux 4 32 Aux 9 44 Aux 15

9 Aux 2 21 Aux 5 33 Aux 10 45 Aux 16

10 Aux 2 22 Aux 6 34 Aux 11 46 Aux 17

11 Aux 3 23 Aux 7 35 Aux 12 47 Aux 18

12 Aux 3 24 Sw Pvw 36 Aux 13 48 Aux 19
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Kayenne elements available from the filtered System list, for assignment to text levels in the 
sources table

In the case of the Kayenne Output 1 to Output 48, from which elements can be 
assigned to text levels in your multiviewer’s logical sources, the Kaleido-X software 
supports 4 display modes for the labels:

All other Kayenne signals represented in the filtered System list, are associated with a 
single Input label.

4 If your logical sources include more text levels to be associated with the Kayenne 
switcher, then repeat step 2 – step 3 for the current logical source’s remaining text 
levels.

5 Click a cell that corresponds to the appropriate alarm level of the current logical source.
6 In the filtered System list, navigate to the tally element you wish to monitor, and drag it 

onto the selected cell.

Level 1 The label represents the initial background feed.

Level 2 The label represents the initial and the previous 
background feed

Level 3 The label represents the previous background feed

Level 4 The label represents the current background feed 
(not yet supported)
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sources table

7 If your logical sources include more alarm levels to be associated with the Kayenne 
switcher, then repeat step 5 – step 6 for the current logical source’s remaining alarm 
levels.

8 Make corresponding assignments to other logical sources by incremental copy, if 
desired (see Making Further Assignments by Incremental Copy on page 207).

9 On the File menu, click Save.
Changes to the sources table are saved.

Configuring layout elements

You can now assign the logical sources you previously configured (see Assigning Kayenne 
tallies, input names, and output names to logical sources on page 435) to monitors that can 
display text (e.g., UMD) or alarms (e.g., UMD, video, text alarm status) in a layout. Depending 
on your purposes, you will assign the appropriate text or alarm levels to specific 
components within the monitors (e.g., assign an alarm level to tally components in a UMD, 
or a text level to the UMD text component).

Note: In the case of a Kayenne system involving ISO recorders controlled 
via GPI, when a GPI command is used to take a recorder off air, related tallies 
may not be updated on the multiviewer side. In addition, the following 
Kayenne features are not supported:
• Pgm-Pst Look Ahead Preview (LAP) tallies (“Next On Air”)
• Bus tallies
• Tracing of upstream tally tributaries

Text level based on dynamic 
labels from Kayenne sources

Alarm levels based on tallies 
from the Kayenne device
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To configure layout elements for dynamic text and tally reporting
1 Click the Layouts tab, and then open the layout you wish to configure.
2 In the Tools pane, select one of the logical sources you previously configured 

(see Assigning Kayenne tallies, input names, and output names to logical sources on 
page 435) from the filtered Channels/Sources list, and then drag it onto the 
appropriate monitor.

3 Repeat step 2 until you have assigned all the sources you wish to monitor to the 
appropriate monitors in your layout.

4 Click the first UMD whose dynamic text and tally reporting behavior you wish to set, 
after unlocking the composite monitor that contains it if applicable (see Unlocking a 
Composite Monitor on page 316).

5 In the Properties pane, click the Left tally source level box, and then select the alarm 
level you wish to monitor.

Alarm level selection for the left tally in a UMD

6 Click the Right tally source level box, and then select the appropriate alarm level, if 
applicable.

7 Click the Text label level box, and then select the text level you wish to monitor.
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8 Click outside the composite to lock it, if applicable.
9 Repeat step 4 – step 8 until you have configured all UMDs that are to display dynamic 

text and tally status when this layout is loaded on the monitor wall.
10 On the File menu, click Save.
11 If you are working in offline mode, then you must export the database to your 

multiviewer: on the Configure menu, point to Database, and then click Export.

On the monitor wall, you can now load the layout containing the monitors that were 
assigned dynamic text and tallies provided by the Kayenne switcher. Input or output 
names, as well as tally status from the Kayenne switcher will be visible on the monitor wall. 
Any changes made by the switcher’s operator will be immediately reflected on the monitor 
wall.

K-Frame Switchers
A multiviewer can receive dynamic source names and tally information from Grass Valley 
K-Frame production switchers, such as Kayenne K-Frame or Karrera K-Frame Video 
Production Center systems. The procedures below describe how to set up a multiviewer to 
interface with this family of production switchers.

Configuring the K-Frame Switcher
To establish tally contribution from the switcher to your multiviewer, you need to identify 
the multiviewer as a tally client, by using the switcher’s touch screen menu panel or the 
K-Frame Menu application.

To set up the K-Frame switcher
1 On the K-Frame touch screen menu panel, touch the Eng Setup menu button, the 

Ports & Devices category button, and then the Tally Ports tab.
The Tally Ports menu appears.
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2 Enter your multiviewer’s IP address in one of the two tally ports, and then touch the 
Enable button for the selected port.
The connection status indicator turns red, since the connection has yet to be 
established on the multiviewer side.

Assuming the required sources and outputs have been defined, this completes the 
configuration required on the switcher. The multiviewer system will be able to send 
commands to the switcher, and the switcher will respond accordingly. Refer to your 
switcher’s Installation and Service Manual for more information.8

Configuring the Multiviewer
For your multiviewer to receive tally status, and source names from a K-Frame switcher, and 
to display the switcher’s contribution on the monitor wall as visual tally and dynamic text 
information, you need to configure your multiviewer’s K-Frame tally service, by performing 
the following tasks in XEdit:

• set up the communication parameters;
• configure logical sources by assigning source names and tally status from the switcher, 

to the logical sources’ text or alarm levels;
• assign alarm and text levels from logical sources to layout elements such as UMDs or 

alarm monitors.

Establishing communication between the K-Frame switcher and the multiviewer

To set up the multiviewer’s communication parameters
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

3 Drag the K-Frame switcher device from the equipment library onto the root of the 
System hierarchical list. Alternatively, right-click the list root, and then click Insert 
K-Frame on the menu.
A window appears, prompting you for a device identifier.

8.Manuals and Release Notes for all Grass Valley production switchers are available here: 
http://www.grassvalley.com/apps/doc_prodlist?super=broadcast&set=switchers
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4 Type a name for the K-Frame production switcher, and then click OK.
The device is added to your system configuration.

5 Click the Interconnects tab.
6 Position the pointer over the multiviewer icon, then click and drag towards the K-Frame 

production switcher icon.
A line representing the connection between the multiviewer and the device appears.

7 Click the connection line between multiviewer and device.
8 In the Properties pane, select Network (TCP/IP) from the Transport type list.

9 In the Interconnects tab, click the K-Frame production switcher icon.
10 In the Properties pane, enter the K-Frame switcher’s IP address, and set the appropriate 

output numbers to use for tally calculation, based on your switcher’s configuration.
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By default, in XEdit, Tally 1 corresponds to the K-Frame switcher’s output 1 (which 
typically carries the Program signal), and Tally 2 corresponds to the K-Frame switcher’s 
output 5 (typically the Preview signal).

11 On the File menu, click Save.
This establishes communication between the multiviewer and the switcher. On the 
touch screen menu panel (or in K-Frame Menu) you may notice that the status 
indicators turned green in the Tally Ports menu, and your multiviewer is now listed in 
the Tally Clients list.

Assigning K-Frame tallies and input names to logical sources

The K-Frame contribution tally protocol provides information on up to 192 inputs, up to 96 
outputs, the full set of fixed sources internal to the K-Frame system, and up to 2 complete 
operator suites. In XEdit’s Channels/Sources tab, configure logical sources using input 
names and system tallies from the K-Frame. You will find these elements by expanding the 
filtered system list that appears in the Tools pane.

• For every input, 6 tallies, and 2 text labels (the engineering name and the OLED name) 
are available. When the OLED name is not defined for an input, both text labels contain 
the engineering name. A tally status indicates whether the input contributes to the 
output associated with the tally (see step 10, under Establishing communication 
between the K-Frame switcher and the multiviewer, on page 440). For example, if 
Tally 1 has been configured to match Output 1, then the Tally 1 status of an input 
indicates whether this input contributes to Output 1.

• For every physical output of the K-Frame, the (static) name of the output is available.
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• Within the operator suites, 6 tally statuses are available for every video processing 
engine (VPE) output. The tally status indicates whether the VPE output contributes to 
the switcher output associated with the tally.

To configure your logical sources
1 In the Channels/Sources tab, add the required number of text and alarm levels for your 

purposes (see Creating and Configuring Logical Sources on page 196).
You may, for example, add two text levels to monitor source labels from the K-Frame 
switcher, and two alarm levels to monitor Program and Preview tallies.

2 Click a cell that corresponds to the appropriate text level of a logical source.
3 In the filtered System list, navigate to the text element you wish to monitor, and drag it 

onto the selected cell.
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K-Frame elements available from the filtered System list, for assignment to text levels in the 
sources table

4 If your logical sources include more text levels to be associated with the switcher, then 
repeat step 2 – step 3 for the current logical source’s remaining text levels.

5 Click a cell that corresponds to the appropriate alarm level of the current logical source.
6 In the filtered System list, navigate to the tally element you wish to monitor, and drag it 

onto the selected cell.

K-Frame elements available from the filtered System list, for assignment to alarm levels in the 
sources table

7 If your logical sources include more alarm levels to be associated with the K-Frame 
switcher, then repeat step 5 – step 6 for the current logical source’s remaining alarm 
levels.

8 Make corresponding assignments to other logical sources by incremental copy, if 
desired (see Making Further Assignments by Incremental Copy on page 207).
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9 On the File menu, click Save.
Changes to the sources table are saved.

Configuring layout elements

You can now assign the logical sources you previously configured (see Assigning K-Frame 
tallies and input names to logical sources on page 442) to monitors that can display text 
(e.g., UMD) or alarms (e.g., UMD, video, text alarm status) in a layout. Depending on your 
purposes, you will assign the appropriate text or alarm levels to specific components within 
the monitors (e.g., assign an alarm level to tally components in a UMD, or a text level to the 
UMD text component).

To configure layout elements for dynamic text and tally reporting
1 Click the Layouts tab, and then open the layout you wish to configure.
2 In the Tools pane, select one of the logical sources you previously configured 

(see Assigning K-Frame tallies and input names to logical sources on page 442) from 
the filtered Channels/Sources list, and then drag it onto the appropriate monitor.

3 Repeat step 2 until you have assigned all the sources you wish to monitor to the 
appropriate monitors in your layout.

4 Click the first UMD whose dynamic text and tally reporting behavior you wish to set, 
after unlocking the composite monitor that contains it if applicable (see Unlocking a 
Composite Monitor on page 316).

5 In the Properties pane, click the Left tally source level box, and then select the alarm 
level you wish to monitor.

Text levels based on dynamic 
K-Frame source labels

Alarm levels based on tallies 
from the K-Frame switcher
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6 Click the Right tally source level box, and then select the appropriate alarm level, if 
applicable.

7 Click the Text label level box, and then select the text level you wish to monitor.

Text level selection for the text label in a UMD

8 Click outside the composite to lock it, if applicable.
9 Repeat step 4 – step 8 until you have configured all UMDs that are to display dynamic 

text and tally status when this layout is loaded on the monitor wall.
10 On the File menu, click Save.
11 If you are working in offline mode, then you must export the database to your 

multiviewer: on the Configure menu, point to Database, and then click Export.

On the monitor wall, you can now load the layout containing the monitors that were 
assigned dynamic text and tallies provided by the K-Frame switcher. Input names, and tally 
status from the switcher will be visible on the monitor wall. Any changes made by the 
switcher’s operator will be immediately reflected on the monitor wall.
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A multiviewer can receive dynamic source names and tally information from a Grass Valley 
Zodiak Digital Production Switcher. The procedures below describe how to set up a 
multiviewer to interface with this family of production switchers.

Configuring the Zodiak Switcher
To establish a serial connection between the switcher and your multiviewer, you need to 
identify the serial port you wish to use for tally contribution in the switcher’s Engineering 
Setups, by using the Zodiak touch screen menu panel or the Zodiak Menu application. You 
also need to configure or take note of the communications settings and use the same 
values on the multiviewer’s side. The procedure below is an example using the default 
values typically used on Grass Valley production switchers.

To set up the Zodiak switcher
1 Physically connect one end of an RJ-45 straight cable to the multiviewer’s RS-422 port.
2 Using a DE-9S-to-RJ45 crossover adapter (Grass Valley part no. 1792-3700-100), 

connect the other end of the cable to one of the 4 RS-422 control ports on the Zodiak 
Video Processor Frame. The illustration below shows the location of the RS-422 ports 
on a Zodiak frame. The RS-422 ports (highlighted) are labeled Serial 1 – 4 (J4 – J7).

The 4 RS-422 control ports at the back of a Zodiak Video Processor frame have DE-9 
female connectors with the following pinout:

Pin Signal

1, 4, 6, and 9 Chassis ground

2 RX-

3 TX+

7 RX+

8 TX-

Note: See RS-422 Connection Diagram on page 27 for pinouts on the 
multiviewer’s side.
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3 From the Zodiak Home menu, touch the Eng Setup menu button, and then the Ports & 
Devices category button.
The Physical Serial Port Assignment menu appears.

4 In the port selection area, touch the port you wish to use as the tally contribution port.
5 In the Baud Rate area, touch 38.4k.
6 In the Parity area, touch None.

This sets the baud rate to 38,400 and the parity to None.

Assuming the required sources and outputs have been defined, this completes the 
configuration required on the switcher. The multiviewer system will be able to send 
commands to the switcher, and the switcher will respond accordingly. Refer to the Zodiak 
Installation and Service Manual for more details.9

Configuring the Multiviewer
For your multiviewer to receive tally status, source names and output names from a Zodiak 
switcher, and to display the switcher’s contribution on the monitor wall as visual tally and 
dynamic text information, you need to configure your multiviewer’s Zodiak serial tally 
service, by performing the following in XEdit:

• set up the communication parameters for the serial connection;
• configure logical sources by assigning input names, output names, and tally status 

from the switcher to the appropriate logical sources’ text and alarm levels;
• assign alarm and text levels from logical sources to layout elements such as UMDs or 

alarm monitors.

Establishing serial communication between the Zodiak switcher and the 
multiviewer

To set up the multiviewer’s communication parameters
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

3 Drag the Zodiak production switcher device from the equipment library onto the root 
of the System hierarchical list. Alternatively, right-click the list root, and then click Insert 
Zodiak on the menu.
A window appears, prompting you for a device identifier.

4 Type a name for the Zodiak production switcher, and then click OK.
5 Click the Interconnects tab.

9.Manuals and Release Notes for all Grass Valley production switchers are available here: 
http://www.grassvalley.com/docs/all_switchers.html#manuals
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6 Position the pointer over the multiviewer icon, then click and drag towards the Zodiak 
production switcher icon.
A line representing the connection between the multiviewer and the device appears.

7 Click the connection line between multiviewer and device.
8 In the Properties pane, select the appropriate serial port from the RS-422 

communication port list.

Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

9 In the Interconnects tab, click the Zodiak production switcher icon.

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).
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In the Properties pane, the serial communications 
properties for the Zodiak device are the following, 
by default:

10 Set these properties to match the values used on 
the switcher.

11 Select the appropriate outputs to use for the Preview Out and Program Out tally 
calculation, based on your switcher’s configuration.

The current version of the Kaleido-X software supports monitoring of one Preview 
output and one Program output from any of the Zodiak switcher’s physical or internal 
M/E units (Pgm-Pst PVW A, and B; M/E 1 PVW, M/E 2 PVW, M/E 3 PVW; Pgm-Pst PGM A, 
and B; M/E 1 PGM, M/E 2 PGM, M/E 3 PGM), from up to 13 Aux bus outputs, or from the 
additional switched preview output.

Assigning Zodiak tallies, input names, and output names to logical sources

The Zodiak contribution tally protocol provides information on up to 128 external sources, 
up to 13 Aux bus outputs, and the switched preview output from the Zodiak Video 
Processor Frame, in addition to the Preview and Program outputs you selected (see step 11 
of Establishing serial communication between the Zodiak switcher and the multiviewer, on 
page 448). In XEdit’s Channels/Sources tab, configure logical sources using text sources 
and system tallies from the Zodiak’s serial interface. You will find these elements by 
expanding the filtered system list that appears in the Tools pane.

To configure your logical sources
1 In the Channels/Sources tab, add the required number of text and alarm levels for your 

purposes (see Creating and Configuring Logical Sources on page 196).
You may, for example, add one text level to monitor source labels from the Zodiak 
switcher, and two alarm levels to monitor Program and Preview tallies.

Baud Rate 38400

Data Bits 8

Parity NONE

Stop bits 1
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2 Click a cell that corresponds to the appropriate text level of a logical source.
3 In the filtered System list, navigate to the text element you wish to monitor, and drag it 

onto the selected cell.

Zodiak elements available from the filtered System list, for assignment to text levels in the sources 
table

In the case of the Zodiak outputs (the Preview and Program Outputs you selected, Aux 
Output 1 to Aux Output 13, and the Switched Preview Output), from which elements 
can be assigned to text levels in your multiviewer’s logical sources, the Kaleido-X 
software supports 4 display modes for the labels:

The Zodiak external sources represented in the filtered System list (Input 1 to Input 
128), are associated with a single Input label.

4 If your logical sources include more text levels to be associated with the Zodiak 
switcher, then repeat step 2 – step 3 for the current logical source’s remaining text 
levels.

5 Click a cell that corresponds to the appropriate alarm level of the current logical source.
6 In the filtered System list, navigate to the tally element you wish to monitor, and drag it 

onto the selected cell.

Level 1 The label represents the initial background feed.

Level 2 The label represents the initial and the previous 
background feed

Level 3 The label represents the previous background feed

Level 4 The label represents the current background feed 
(not yet supported)
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7 If your logical sources include more alarm levels to be associated with the Zodiak 
switcher, then repeat step 5 – step 6 for the current logical source’s remaining alarm 
levels.

8 Make corresponding assignments to other logical sources by incremental copy, if 
desired (see Making Further Assignments by Incremental Copy, on page 207).

9 On the File menu, click Save.
Changes to the sources table are saved.

Configuring layout elements

You can now assign the logical sources you previously configured to monitors that can 
display text (e.g., UMD) or alarms (e.g., UMD, video, text alarm status) in a layout. Depending 
on your purposes, you will assign the appropriate text or alarm levels to specific 
components within the monitors (e.g., assign an alarm level to tally components in a UMD, 
or a text level to the UMD text component).

To configure layout elements for dynamic text and tally reporting
1 Click the Layouts tab, and then open the layout you wish to configure.
2 In the Tools pane, select one of the logical sources you previously configured 

(see Assigning Zodiak tallies, input names, and output names to logical sources on 
page 450) from the filtered Channels/Sources list, and then drag it onto the 
appropriate monitor.

3 Repeat step 2 until you have assigned all the sources you wish to monitor to the 
appropriate monitors in your layout.

Text level based on dynamic 
labels from Zodiak sources

Alarm levels based on tallies 
from the Zodiak device
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4 Click the first UMD whose dynamic text and tally reporting behavior you wish to set, 
after unlocking the composite monitor that contains it if applicable (see Unlocking a 
Composite Monitor on page 316).

5 In the Properties pane, click the Left tally source level box, and then select the alarm 
level you wish to monitor.

Alarm level selection for the left tally in a UMD

6 Click the Right tally source level box, and then select the appropriate alarm level, if 
applicable.

7 Click the Text label level box, and then select the text level you wish to monitor.

Text level selection for the text label in a UMD

8 Click outside the composite to lock it, if applicable.
9 Repeat step 4 – step 8 until you have configured all UMDs that are to display dynamic 

text and tally status when this layout is loaded on the monitor wall.
10 On the File menu, click Save.
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11 If you are working in offline mode, then you must export the database to your 
multiviewer: on the Configure menu, point to Database, and then click Export.

On the monitor wall, you can now load the layout containing the monitors that were 
assigned dynamic text and tallies provided by the Zodiak switcher. Input or output names, 
as well as tally status from the Zodiak switcher will be visible on the monitor wall. Any 
changes made by the switcher’s operator will be immediately reflected on the monitor wall.

Daktronics Scoreboards
For your multiviewer to receive scoreboard information from a Daktronics system, and to 
display the system’s contribution on the monitor wall, you need to configure your 
multiviewer by performing the following tasks in XEdit:

1 Add the Daktronics scoreboard to your multiviewer system configuration, and set up 
the communication parameters (see Adding a Daktronics Scoreboard to your 
Multiviewer Configuration on page 454).

2 Add logical sources and configure them by assigning text elements from the 
scoreboard system to the logical sources’ text levels (see Assigning Scoreboard 
Information to Logical Sources on page 456).

3 Assign the appropriate text levels from logical sources, to layout elements such as 
UMDs, or alarm monitors (see Configuring Layout Elements on page 457).

Adding a Daktronics Scoreboard to your Multiviewer Configuration

To add a Daktronics scoreboard to your multiviewer configuration
1 Open XEdit.
2 Connect to the multiviewer, if you wish to apply your changes in real time 

(see Connecting to a Multiviewer on page 77).

3 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

4 Drag the Daktronics device from the equipment library onto the root of the System 
hierarchical list.

Alternatively, right-click the list root, and then click Insert Daktronics on the menu.

Note: If this step is omitted, then you will need to export the database to 
apply the changes.
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A window appears, prompting you for a device identifier.
5 In Device Identifier, type a name for the scoreboard, and then click OK.

The scoreboard is added to the system list.

6 Click the Interconnects tab.
7 Position the pointer over the multiviewer icon, then click and drag towards the 

scoreboard device icon.
A line representing the connection between the multiviewer and the device appears.

8 Click the connection line between multiviewer and device.
9 In the Properties pane, select the appropriate element from the RS-422 

communication port list.

Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D
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10 In the Interconnects tab, click the scoreboard device icon.
11 In the Properties pane, set the serial communications 

properties for the scoreboard device as follows:

You are now ready to add information from the Daktronics 
scoreboard system to logical sources.

Assigning Scoreboard Information to Logical Sources

To configure your logical sources
1 In the Channels/Sources tab, add the required number of logical sources for your 

purposes (see Manually adding a Logical Source on page 199).
If you plan to monitor scoreboard data during a hockey game, for example, you might 
add one logical source for every element you wish to monitor (e.g., the game clock, the 
period number, the home and guest teams’ scores).

2 Add the required number of text levels for your purposes (see Adding a level on 
page 200).
For example, you might add one text level named Scoreboard.

3 Click a cell that corresponds to the appropriate text level of a logical source you wish to 
configure.

4 In the filtered System list, navigate to the text element you wish to monitor, and drag it 
onto the selected cell.

5 If your logical sources include more text levels to be associated with the timer system, 
then repeat step 3 and step 4 for the current logical source’s remaining text levels.

6 Repeat step 3–step 5 for any remaining logical sources you wish to configure with 
scoreboard information.

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).

Baud Rate 9600

Data Bits 8

Parity NONE

Stop bits 1
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Sample Daktronics configuration, to monitor scoreboard information for a hockey game

7 On the File menu, click Save.
Changes to the sources table are saved.

Configuring Layout Elements
You can now assign the logical sources you previously configured (see Assigning 
Scoreboard Information to Logical Sources on page 456) to UMDs or alarm monitors in a 
layout. The procedure below explains how to configure UMDs to report scoreboard 
information.

To configure UMDs for dynamic reporting of scoreboard text from a Daktronics system
1 Click the Layouts tab, and then open the desired layout.
2 Drag the third predefined UMD (umd2), from the set of predefined UMDs available in 

the Tools pane, onto your layout, and then adjust its size and position as needed.

3 In the Tools pane, select one of the logical sources you previously configured 
(see Assigning Scoreboard Information to Logical Sources on page 456), from the 
filtered Channels/Sources list, and then drag it onto the UMD.

4 In the Layouts tab, click the UMD, if it is not already selected.
5 In the Properties pane, click the Text label level box, and then select the text level you 

wish to monitor (e.g., the Scoreboard level you previously configured).

Note: The third predefined UMD (umd2) is configured not to show tallies or 
alarm latches, which makes it the convenient choice for displaying text 
information only.
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6 Select a monospace font for the text:
a Click the Text font box, and then click the button that appears inside the box to 

open the font picker window.

b In Select a Font, click a monospace font (e.g., Lucida Sans Typewriter).
c Set the font style and size, as needed.
d Click OK to close the window.

7 Set the text alignment to match your scoreboard behavior if desired, by clicking the 
Text horizontal alignment box, and then selecting Left, or Right, for example, from the 
list.

8 If you wish to add a text label for this information (e.g., GUEST, HOME, PERIOD, etc.), add 
another UMD (again, by using umd2 from the set of predefined UMDs), and type the 
desired text (see Configuring Static UMD Text on page 293, if needed).

9 Repeat step 2–step 8 until you have added UMDs for all the scoreboard data you wish 
to monitor.

Click this button to open Select a Font
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10 On the File menu, click Save.
11 If you have been working in offline mode, then export the database to your 

multiviewer (see Exporting a Database on page 81).

On the monitor wall, you can now load the layout containing the monitors that were 
assigned information from the scoreboard system. Text information from the device will be 
visible on the monitor wall. Any changes made by the device’s operator will be immediately 
reflected on the monitor wall.

Serial Port Test Agent
During a setup, it is sometime not clear if the wiring between the multiviewer and a 
peripheral device is correct or if the peripheral device sends the expected data. One can 
connect a serial-port test agent as a peripheral device in XEdit, export the database to the 
multiviewer, and then read, on a Web page, the data received on the serial port.

To use a serial port test agent
1 Select the Serial port test device in the equipment library and drag it onto the root of 

the System hierarchical list. Alternatively, right-click the list root, and then click Insert 
Serial port test on the menu. 

2 Click the Interconnects tab in the main window.
3 To connect the test device to the multiviewer, click the multiviewer’s icon, or the 

device’s, and drag the pointer towards the other.
4 Click the test device’s icon, and adjust the port settings to match those of the actual 

peripheral device you wish to test.
5 Click the connection line between the device and the multiviewer.
6 In the Properties pane, select the appropriate element from the RS-422 

communication port list.
Depending on the multiviewer model, the available RS-422 ports are designated as 
follows:

KMV-3901/3911 RS-422

Kaleido-X16 Port 1, and Port 2

Kaleido-X (14RU) Frame A – Output A, B, and C; Frame B – Output A, B, and C

Kaleido-X (7RU) Output A, B, C, and D

Kaleido-X (4RU) Output A, and B

Kaleido-MX, 
Kaleido-MX 4K

Output A, and B
Note: The Kaleido-MX (1RU) 16 × 4, and the Kaleido-MX 4K 
16 × 1 models have only one RS-422 port, which is physically 
connected to output card A.

Kaleido-Modular-X Output A, and B
Note: KMX-3901-OUT output cards with a single rear 
connector panel (KMX-3901-OUT-D-3+SRP) do not have RS-
422 ports. To support a serial device, your Kaleido-Modular-X 
system must have at least one output card with a double rear 
connector panel (KMX-3901-OUT-D-3DRP).
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When connected, the serial-port test agent will log all data received from the serial port 
to a file that you can read using a Web browser.
Once the database is exported to the multiviewer, the serial-port test agent starts. The 
agent opens the serial port and start writing to a log file the data that is received on the 
port. To access the log file, point your browser to http://[IP 
address]/logs/comm.log.

Note: The part [IP address] represents the IP address of the output card 
(or of the multiviewer itself, depending on the model) where the test agent 
is connected. You can find the IP address on XAdmin’s System Configuration 
page (see Configuring a Multiviewer’s IP Settings on page 478).
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This chapter explains how to configure the Kaleido-X network communications, and how to 
enable hardware and software options. It also describes where to find system status and 
version information, for troubleshooting or servicing purposes.

Key Concepts

Default IP Settings
Multiviewers are shipped with the following IP settings.

Term Description

Kaleido-RCP2 The Kaleido-RCP2 is a multi-function remote control panel designed for 
use with Kaleido multiviewers. Ethernet connectivity allows multiple 
RCP users to access multiple Kaleido-X systems, allowing convenient 
access to real-time operating features.

RCP-200 The RCP-200 advanced remote control panel for Densité cards, Kaleido 
multiviewers, and NVISION/third party routers provides a highly intuitive 
graphical interface. It simplifies video/audio signal processing and 
control in both single and multi-user environments.

Audio Bridge 
Terminal

The Audio Bridge Terminal (ABT) is an external audio 
multiplexer/serializer for the Kaleido multiviewers.

XEdit XEdit is a client application used to create layouts for the monitor wall, 
and to configure the multiviewer, from your PC or laptop.

XAdmin XAdmin is a Web client that your system administrator uses to manage 
the multiviewer system.

System snapshot The Kaleido-X software generates data to keep track of certain events. 
This data is stored as log files that can be extracted from the system as a 
compressed ZIP archive created when requested by the user for specific 
purposes (e.g., troubleshooting). This ZIP archive is called a system 
snapshot.

System status A system status refers to a live summary from within XAdmin. This 
summary is based on the health status of each module in your 
multiviewer system (see Viewing a Multiviewer’s Status Information on 
page 536).

Version Each software, firmware, and hardware release for the various elements 
that constitute your Kaleido-X system (e.g., XEdit, XAdmin, etc.) is 
associated with a version number (see Viewing Version Information on 
page 537).
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Kaleido-IP default IP settings

Kaleido-MX, Kaleido-Modular-X default IP settings

Kaleido-MX 4K default IP settings

Kaleido-IP-6 Kaleido-IP-4 Kaleido-IP-2

Management IP address (LAN1) 10.0.3.70 10.0.3.70 10.0.3.70

Network mask 255.255.0.0 255.255.0.0 255.255.0.0

Default gateway 10.0.0.1 10.0.0.1 10.0.0.1

Data port 1 IP address (LAN2) 172.30.3.70 172.30.3.70 172.30.3.70

Network mask 255.255.0.0 255.255.0.0 255.255.0.0

Gateway None None None

Data port 2 IP address (LAN3) 172.30.3.71 172.30.3.71

Network mask 255.255.0.0 255.255.0.0

Gateway None None

Data port 3 IP address (LAN4) 172.30.3.72 172.30.3.72

Network mask 255.255.0.0 255.255.0.0

Gateway None None

Data port 4 IP address (LAN5) 172.30.3.73

Network mask 255.255.0.0

Gateway None

Data port 5 IP address (LAN6) 172.30.3.74

Network mask 255.255.0.0

Gateway None

Dual Quad

System IP address 192.168.3.31 192.168.3.30

Network mask 255.255.255.0 255.255.255.0

Gateway 0.0.0.0 0.0.0.0

Output A IP address 192.168.3.31 192.168.3.31

Output B IP address — 192.168.3.32

System IP address 192.168.3.30

Network mask 255.255.255.0

Gateway 0.0.0.0

Output A IP address 192.168.3.31

Output B IP address 192.168.3.32
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KMX-4911 default IP settings

KMV-3901/3911 default IP settings

CPU-ETH3 controller default IP settings

CPU-ETH2 controller default IP settings

Kaleido-X16 default IP settings

Kaleido-X default IP settings

System IP address 192.168.3.30

Network mask 255.255.255.0

Gateway 0.0.0.0

System IP address 192.168.3.31

Network mask 255.255.255.0

Gateway 192.168.3.1

IP address 192.168.3.1

Network mask 255.255.0.0

Gateway 0.0.0.0

IP address 1 192.168.3.1

Network mask 255.255.255.0

Gateway 0.0.0.0

IP address 2 0.0.0.0

Network mask 0.0.0.0

Gateway 0.0.0.0

System IP address 10.0.3.70

Network mask 255.255.0.0

Gateway 10.0.0.1

4RU 7RU
14RU 
(expansion)

System IP address 10.0.3.70 10.0.3.70 10.0.3.70

Network mask 255.255.0.0 255.255.0.0 255.255.0.0

Gateway 10.0.0.1 10.0.0.1 10.0.0.1

Output A 10.0.3.69 10.0.3.66 10.0.3.66

Output B 10.0.3.68 10.0.3.67 10.0.3.67

Output C — 10.0.3.68 10.0.3.68
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Hardware and Software Options
You can purchase various software and hardware options to expand your multiviewer’s 
capabilities. The following tables list options that can be enabled and disabled via the 
XAdmin Status and Options page (see Enabling Options on page 493).

KMX-4911 output option

Kaleido-MX input options

Output D/EXP — 10.0.3.69 —

Output A (Frame B) — — 10.0.3.61

Output B (Frame B) — — 10.0.3.62

Output C (Frame B) — — 10.0.3.63

Note: If the IP address of the multiviewer has been changed (i.e., it no 
longer corresponds to the as-shipped configuration), it is still possible to 
determine the current setting. To determine the IP address of your 
multiviewer, see Finding a Multiviewer’s System IP Address and Application 
Version, on page 481.

4RU 7RU
14RU 
(expansion)

Note: The Kaleido-IP currently supports extraction of CC/subtitling and 
XDS data (1 license/program), and display rotation. It is not yet possible to 
enable or verify these options in XAdmin’s Status and Options page, for this 
multiviewer model. Contact Technical Support for activation and 
configuration instructions (see Contact Us, on page 551).

Option Part No. Feature

Additional 
Head 
Activation

KMX-4911-OPT-OP2 Additional head output enable license. In a 
multi-card system, one option key is required for 
each card. If a card does not have this option 
enabled, then there is no video output to the 
system’s heads A2, B1, and B2.

Option Part No. Feature

3G KMX-IN-8-OPT-3GBPS 3 Gbps signal format license (8 inputs)

KMX-IN-16-OPT-3GBPS 3 Gbps signal format license (16 inputs)

CC/XDS KMX-IN-8-OPT-CSX CC/subtitling and XDS data license (8 inputs)

KMX-IN-16-OPT-CSX CC/subtitling and XDS data license (16 inputs)

Dolby E KMX-IN-8-OPT-DOLBY Dolby metadata extraction license (8 inputs)

KMX-IN-16-OPT-DOLBY Dolby metadata extraction license (16 inputs)
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Kaleido-MX output options

Kaleido-MX 4K input options

Kaleido-Modular-X input options

Kaleido-Modular-X output options

Option Part No. Feature

Second Head 
Activation

KMX-OUT-OPT-OP2 Second head output enable license for KALEIDO-
MX-8X1, KALEIDO-MX-16X1 and KALEIDO-MX-
24x1

Display 
90-Degree 
Rotation

KMX-OUT-OPT-ROT-S Single head rotation license for KALEIDO-MX-
8X1, KALEIDO-MX-16X1 and KALEIDO-MX-24x1

KMX-OUT-OPT-ROT-D Dual head rotation license. 1 license required for 
dual head units — 2 licenses required for quad 
head units.

Option Part No. Feature

3G KMX-IN-16-OPT-3GBPS 3 Gbps signal format license (16 inputs)

CC/XDS KMX-IN-16-OPT-CSX CC/subtitling and XDS data license (16 inputs)

Dolby E KMX-IN-16-OPT-DOLBY Dolby metadata extraction license (16 inputs)

Option Part No. Feature

3G KMX-IN-8-OPT-3GBPS 3 Gbps signal format license (8 inputs) for KMX-
3901-IN-8-D, and for KMX-3901-IN-IP

KMX-IN-16-OPT-3GBPS 3 Gbps / 4K UHDa signal format license 
(16 inputs) for KMX-3901-IN-16-D and KMX-
3901-IN-16-Q

a. 4K UHD support requires a minimum of 2 licenses: 1 for the prescaler card, and 1 for every KMX-
3901-IN input card connected to the prescaler card.

CC/XDS KMX-IN-8-OPT-CSX CC/subtitling and XDS data license (8 inputs) for 
KMX-3901-IN-8-D

KMX-IN-16-OPT-CSX CC/subtitling and XDS data license (16 inputs) 
for KMX-3901-IN-16-D and KMX-3901-IN-16-Q

Dolby E KMX-IN-8-OPT-DOLBY Dolby metadata extraction license (8 inputs) for 
KMX-3901-IN-8-D

KMX-IN-16-OPT-DOLBY Dolby metadata extraction license (16 inputs) for 
KMX-3901-IN-16-D and KMX-3901-IN-16-Q

Option Part No. Feature

Second Head 
Activation

KMX-OUT-OPT-OP2 Second head output enable license for KMX-
3901-OUT-S
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KMV-3901/3911 input options

KMV-3901/3911 output options

Display 
90-Degree 
Rotation

KMX-OUT-OPT-ROT-S Single head rotation license for KMX-3901-OUT-S

KMX-OUT-OPT-ROT-D Dual head rotation license for KMX-3901-OUT-D

Option Part No. Feature

3G KMV-39N1-8XN-OPT-
3GBPS

3Gbps signal decoding option (8 inputs)

KMV-39N1-4XN-OPT-
3GBPS

3Gbps signal decoding option (4 inputs)

Embedded 
Audio 

KMV-39N1-8XN-OPT-AUD Embedded audio extraction license (8 inputs)

KMV-39N1-4XN-OPT-AUD Embedded audio extraction license (4 inputs)

Additional 
Inputs

KMV-3911-4X1-OPT-4IN KMV-3911-4x1 additional inputs 5-8 license

Option Part No. Feature

Second Head 
Activation

KMV-39N1-NX1-OPT-OP2 Output two enabled license

SDI 
Monitoring 
Output

KMV-3911-NX1-OPT-SDI 
O/P

SDI monitoring output for KMV-3911 (1 output)

KMV-3911-NX2-OPT-SDI 
O/P

SDI monitoring output for KMV-3911 (2 outputs)

3Da

a. After enabling the 3D support option in XAdmin, refresh the current layout or load another one, for 
the change to be reflected on the monitor wall.

KMV-39NN-8x2-OPT-3DLA Stereoscopic display license (line alternate 
mode) for KMV-3901/3911-8x2

KMV-39NN-8x1-OPT-3DLA Stereoscopic display license (line alternate 
mode) for KMV-3901/3911-8x1

KMV-39NN-4X2-OPT-3DLA Stereoscopic display license (line alternate 
mode) for KMV-3911-4x2

KMV-39NN-4X1-OPT-3DLA Stereoscopic display license (line alternate 
mode) for KMV-3911-4x1

Option Part No. Feature
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Kaleido-X (4RU, 7RU, and 14RU) output options

Kaleido-X16 input options

Option Part No. Feature Notes

3G KXS-3Gbps 3Gbps format license One 3G option key is needed per 
input card.

CC/XDS KXS-CSX CC/subtitling and XDS 
data license

One CC/XDS option key is needed per 
input card. Extraction of CC 608, 
CC 708, XDS and Subtitling WST 
metadata is activated as a single 
option.

Dolby E KXS-Dolby Dolby metadata 
extraction license

One Dolby E option key is needed per 
input card.

Embedded 
Audio

KXS-HD-EMB HD/SD-SDI embedded 
audio license

One HD/SD-SDI embedded audio 
option key is needed per input card.

KXS-SD-EMB SD-SDI embedded 
audio license

One SD-SDI embedded audio option 
key is needed per input card.

Loudness KXS-Loudness Loudness level 
measurement license

One Loudness option key is needed 
per input card.

Option Part No. Feature Notes

Display 90-
Degree 
Rotation

KXS-Rotator Display rotation 
license

One Display 90-Degree Rotation 
option key is needed per output card.

3Da

a. After enabling the 3D support option in XAdmin, refresh the current layout or load another one, for 
the change to be reflected on the monitor wall.

KXS-3DLA Stereoscopic display 
license (line alternate 
mode) for Kaleido-X

One 3D option key is needed per 
output card.

Option Part No. Feature

3G KXS-X16-3Gbps 3Gbps format license (1/frame)

CC/XDS KXS-X16-CSX CC/subtitling and XDS data license (1/frame)

Dolby E KXS-X16-Dolby Dolby metadata extraction license (1/frame)

Embedded 
Audio

KXS-X16-HD-EMB HD/SD-SDI embedded audio license (1/frame)

KXS-X16-SD-EMB SD-SDI embedded audio license (1/frame)

Loudness KXS-X16-Loudness Loudness level measurement license (1/frame)
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Kaleido-X16 output options

Kaleido-X16 router options

Dashboard Messages
The following tables explain messages that may appear in the Status dashboard (lower right 
corner) and in the Upgrade dashboard (lower left corner), on the Monitor wall. An “x” in a 
column indicates that the message applies to the multiviewer models designated by the 
column header, namely:

Option Part No. Feature

Display 90-
Degree 
Rotation

KXS-X16-Rotator-S Rotation license for Kaleido-X16-S

KXS-X16-Rotator-D Rotation license for Kaleido-X16-D

SDI 
Monitoring 
Output

KXS-X16-HDM-S SDI monitoring output for Kaleido-X16-S

KXS-X16-HDM-D SDI monitoring output for Kaleido-X16-D

3Da

a. After enabling the 3D support option in XAdmin, refresh the current layout or load another one, for 
the change to be reflected on the monitor wall.

KXS-X16-3DLA-S Stereoscopic display license (line alternate mode) for 
Kaleido-X16-S

KXS-X16-3DLA-D Stereoscopic display license (line alternate mode) for 
Kaleido-X16-D

Option Part No. Feature

SDI Router 
Output 

KXS-X16-RTR16x2 Dual router output option (1/frame)

Kaleido-X 7RU Kaleido-X (7RU), and Kaleido-X (14RU)

Kaleido-X 4RU Kaleido-X (4RU)

Kaleido-X16 Kaleido-X16

KMV-3901/3911 KMV-3901, KMV-3911, Kaleido-XQUAD, and Kaleido-XQUAD Dual

Kaleido-MX Kaleido-MX, Kaleido-MX 4K, and Kaleido-Modular-X

KMX-4911 KMX-4911

Notes 

• There are no dashboard messages for the Kaleido-IP.

• Messages in the upgrade dashboard (see Upgrade dashboard messages on 
page 471) apply to the Kaleido-X only.
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Message Description Ka
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PSU A absent PSU A is absent, overheating, has a DC circuitry 
fault condition, or no current is drawn from it.

x

PSU B absent PSU B is absent, overheating, has a DC circuitry 
fault condition, or no current is drawn from it.

x

PSU A 48 V PSU A is absent, overheating, has a DC circuitry 
fault condition, or no current is drawn from it.

x

PSU B 48 V PSU B is absent, overheating, has a DC circuitry 
fault condition, or no current is drawn from it.

x

PSU A 48 V Fuse PSU A fuse is broken. x x

PSU B 48 V Fuse PSU B fuse is broken. x x

PSU A 12 V PSU A is absent, overheating, has a DC circuitry 
fault condition, or no current is drawn from it.

x

PSU B 12 V PSU B is absent, overheating, has a DC circuitry 
fault condition, or no current is drawn from it.

x

PSU A AC PSU A power cord is unplugged. x

PSU B AC PSU B power cord is unplugged. x

Duplicate IP Address 
Detected 

Another equipment on the network shares the 
same IP address as an output card.

x x x x x x

Duplicate frame IP address Another equipment on the network shares the 
same IP address as the multiviewer system (in 
a multiple output card setup).

x x

Ethernet Link Down The output card to which this display monitor 
is connected has lost its network connection.

x x x x x x

Fan 1 (replace whole 
module if in error) 

Fan 1 is running too low or is broken. x

Fan 2 (replace whole 
module if in error) 

Fan 2 is running too low or is broken. x

Fan 3 (replace whole 
module if in error) 

Fan 3 is running too low or is broken. x

Fan 4 (replace whole 
module if in error) 

Fan 4 is running too low or is broken. x

Fan 5 (replace whole 
module if in error) 

Fan 5 is running too low or is broken. x

Fan 6 (replace whole 
module if in error) 

Fan 6 is running too low or is broken. x

Fan 7 (replace whole 
module if in error) 

Fan 7 is running too low or is broken. x
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Fan 8 (replace whole 
module if in error) 

Fan 8 is running too low or is broken. x

Fan 9 (replace whole 
module if in error) 

Fan 9 is running too low or is broken. x

Rear Fan 1 (replace whole 
module if in error)

Fan 1 is running too low or is broken. x

Rear Fan 2 (replace whole 
module if in error)

Fan 2 is running too low or is broken. x

Rear Fan 3 (replace whole 
module if in error)

Fan 3 is running too low or is broken. x

Rear Fan 4 (replace whole 
module if in error)

Fan 4 is running too low or is broken. x

Rear Fan 5 (replace whole 
module if in error)

Fan 5 is running too low or is broken. x

Rear Fan 6 (replace whole 
module if in error)

Fan 6 is running too low or is broken. x

Board temperature high This warning means that a card is warmer than 
normal and that you should verify cooling and 
ventilation (e.g., check for anything 
obstructing the ventilation openings).

x x

Board temperature critical This alarm means that a card is overheating, 
which might result in decreased system 
performance (e.g., green dots, flickering, card 
not starting). You should halt operations until 
the overheating problem is resolved.

x x

Blower 1 (replace whole 
module if in error)

Blower 1 is running too low or is broken. x

Blower 2 (replace whole 
module if in error)

Blower 2 is running too low or is broken. x

Blower 3 (replace whole 
module if in error)

Blower 3 is running too low or is broken. x

Blower 4 (replace whole 
module if in error)

Blower 4 is running too low or is broken. x

Card temperature critical Card is overheating, which might result in 
decreased system performance (e.g., green 
dots, flickering, card not starting). You should 
halt operations until the overheating problem 
is resolved.

x x x x

Status dashboard messages (continued)
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Card temperature high Temperature warning, which indicates that the 
card is warmer than normal and that you 
should verify cooling and ventilation (e.g., 
check for anything obstructing the ventilation 
openings).

x x x x

Critical voltage upper limit 
reached

One of the voltages is above the critical 
threshold.

x

Critical voltage lower limit 
reached

One of the voltages is below the critical 
threshold.

x

Critical current upper limit 
reached

Current or power is above the critical 
threshold.

x

Hardware failure Voltage, current or power is above or below 
the critical threshold.

x

FPGA fan failed FPGA fan failed x x

Firmware status Tells whether firmware is running properly on 
the card.

x x

HDMI 0 power failed HDMI output for first head has a power failure. x

HDMI 1 power failed HDMI output for second head has a power 
failure.

x

Upgrade dashboard messages 

Message Description Ka
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Error during firmware 
upgrade. Firmware 
upgrade cannot proceed 
until legacy KXO (<3.00) 
are removed from 
frame B.

This message will appear on an expansion frame with 
expansion enabled and with cards in Frame B running 
software or firmware older than version 3.00. To upgrade 
these cards, transfer them to Frame A.

x

Error during firmware 
upgrade. Card presence 
from frame B could not be 
verified.

This message will appear as a side effect of the presence 
of cards in Frame B running a version older than version 
3.00. The upgrade will not be permitted on any card in the 
frame until these cards are removed from Frame B. To 
upgrade these cards, transfer them to Frame A.

x

Status dashboard messages (continued)
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Error during firmware 
upgrade. Duplicate IP has 
been detected. We cannot 
continue checking the 
Firmware version.

This message will appear if duplicate IP addresses are 
detected between different KXO cards in the frame. As 
long as this is the case, no upgrade is possible. You must 
resolve the duplicate IP address issue before resuming 
the upgrade.

x x

Error during firmware 
upgrade. The current 
firmware version could 
not be verified.

This message will appear if software cannot retrieve 
firmware version from the cards. This may indicate an 
issue with the hardware.

x x

Error during safemode 
upgrade. The current 
safemode version could 
not be verified.

This message will appear if software cannot retrieve 
safemode version from the cards. This may indicate an 
issue with the hardware.

x x

Error during safemode 
upgrade. Card presence 
from frame B could not be 
verified.

This message will appear as a side effect of the presence 
of cards in Frame B running a version older than version 
3.00. The upgrade will not be permitted on any card in the 
frame until these cards are removed from Frame B. To 
upgrade these cards, transfer them to Frame A.

x

Cannot upgrade card in 
this slot (if any). Please 
remove card from [slot 
number].

This message will appear on an expansion frame if 
Frame B contains cards running software or firmware 
older than version 3.00. The upgrade will not be 
permitted on any card in the frame until these cards are 
removed from Frame B. To upgrade these cards, transfer 
them to Frame A.

x

Cannot upgrade card in 
this slot. Move card to 
frame A or swap with card 
in frame A. Upgrade will 
proceed after current 
upgrade.

This message will appear on an expansion frame if 
Frame B contains cards running software or firmware 
older than version 3.00. The upgrade will not be 
permitted on any card in the frame until these cards are 
removed from Frame B. To upgrade these cards, transfer 
them to Frame A.

x

Cannot continue the 
upgrade until card in this 
slot is moved to frame A.

This message will appear on an expansion frame with 
expansion enabled and with cards in Frame B running 
software or firmware older than version 3.00. To upgrade 
these cards, transfer them to Frame A.

x

Upgrade dashboard messages (continued)
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Network Considerations

Kaleido-X, Kaleido-X16, Kaleido-Modular

Kaleido-X, Kaleido-X16, and Kaleido-Modular multiviewers generate a low to moderate 
amount of client-to-server data traffic, and therefore have a minimal bandwidth impact on 
a network.

Kaleido-IP

In the case of a Kaleido-IP multiviewer, it is possible to add and configure up to 6000 logical 
sources without exceeding the network’s bandwidth or the unit’s decoding resources.10

The Kaleido-IP multiviewer supports concurrent decoding of video programs from multi-
program and single-program MPEG transport streams, over UDP or RTP Multicast/Unicast. 
The following table shows the number of HD or SD programs that can be decoded 
concurrently, depending on the transport stream type and Kaleido-IP model.

The Kaleido-IP supports concurrent decoding of up to 512 elementary streams within a 
program.

The Kaleido-IP supports layouts using up to 600 Mbps of streaming bandwidth. However, 
when using a layout touring application, the total bandwidth usage per layout should be 
limited to 400 Mbps across all network interfaces, and the touring period should be at least 
30 seconds. In the case of the Kaleido-IP-6, layout touring should be avoided (a source 
cycling application should be preferred when required). Implementing a source cycling or 
layout touring configuration requires iControl.

The Kaleido-IP supports streaming over wide area networks (WAN), which are subject to 
packet delay variation (jitter), latency, packet reordering, and packet loss. It also supports 
encoders that transmit in bursts or with long delays between packets. The Kaleido-IP can 
handle transmission delays matching the encoder’s video buffer delay, and, in the case of 
RTP streams, up to ±120 ms of packet delay variation.

The Kaleido-IP functions as a fully compliant MPEG-2 decoder as per ISO/IEC 13181-2. It is 
capable of detecting impairments caused by non-compliant encoding, or corruption 
resulting from transmission failures, and recovers from such situations.

10.In the case of a Kaleido-IP X300 model, to support more than 1500 sources, the multiviewer’s RAM must 
be upgraded to 24 GB. Refer to the Kaleido-IP X300 Memory Modules section, in the Kaleido-X Release Notes, 
for installation instructions. The Kaleido-IP X100 is limited to 1500 sources.

Kaleido-IP X310 Kaleido-IP X110 Kaleido-IP X300 Kaleido-IP X100

HD SD HD SD HD SD HD SD

MPEG-2, DCIIa

a. Only unencrypted Digicipher 2 (DCII) transport streams are supported.

64 128 16 48 24 64 8 24

H.264 32 64 12 24 16 32 6 12
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The Kaleido-IP multiviewer joins a multicast group only when decoding is required, that is 
when a source is being monitored on the wall. In addition, streams that are not decoded are 
joined momentarily in a polling manner—one stream at a time—to update the PMT and 
PAT information. The Kaleido-IP leaves the multicast group as soon as a change of layout 
implies that a different set of streams must be decoded.

However, if your situation involves frequent changes of layout (e.g., loading a new layout to 
the monitor wall every minute), then, when you are creating or editing a layout, make sure 
to terminate XEdit’s connection to the Kaleido-IP once configuration tasks are completed 
(see Disconnecting from a Multiviewer on page 78).

TCP/UDP Port Usage
The various Kaleido-X services require access to specific ports. In networks where a firewall 
is present between device A and device B, the ports used to communicate from device A to 
device B must be open on the incoming (external) side of the firewall.

From client to multiviewer

The following ports must be open on the Client (e.g., workstation running XEdit):

From multiviewer to client

Note: All necessary ports are open by default on the multiviewer. There is 
no mechanism provided for changing the default settings.

Service Port Transport Notes

HTTPS 443 TCP Used by XAdmin for secure access

HTTP 7 TCP Used by XEdit for ping probing

80 TCP Used by XEdit and XAdmin

5122 TCP Used by XEdit for keepalive (heartbeat)

5432 TCP Used by XEdit for export operations

13000 TCP Online connection

13100 TCP Used for calibration data from XEdit

RCP2 5120 TCP Used to listen for Kaleido-X discovery packets

10000 TCP For RCP2 protocol

10001 TCP For RCP2 protocol

5120 UDP On multicast 230.8.8.9 for RCP2 protocol

5121 UDP For RCP2 protocol

Service Port Transport Notes

Java RMI 1024–5000a 
49152-65535b

a. For Windows XP and earlier

TCP Remote Method Invocation (client/server 
communication). Dynamic Allocation of 
ports. Required for communication 
between client and Application Server.
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From multiviewer to multiviewer

The following ports, used for inter-frame communications, are open by default on all 
Kaleido-X systems:

From iControl to multiviewer

Between multiviewer and remote control panel

The following ports, used for communications to/from RCP-200 and Kaleido-RCP2 control 
panels, are open by default on all Kaleido-X systems:

b.For Windows 7 and later

Service Port Transport Notes

SSH 22 TCP Secure Shell Login is required to login to a 
multiviewer for maintenance.

Java Jini 4160 TCP Responsible for discovery and communications 
between devices/services on a network.

HTTP 8080 TCP

8082 TCP Internal communication

8083 TCP Internal communication

8084 TCP Internal communication

8085 TCP Internal communication

8086 TCP Internal communication

8087 TCP Used for debugging purposes

8090 TCP Web service

32769 TCP filenet-rpc

5120 UDP On multicast 230.8.8.9 for RCP2 

7572 UDP On multicast 230.8.8.8 for “keep-alive” (heartbeat)

7571 UDP For “keep-alive” (heartbeat)

Densité 5100 TCP Internal communication within a Kaleido-MX, 
Kaleido-MX 4K, or Kaleido-Modular-X multiviewer 
system; communication with modules housed in a 
Densité frame.

Service Port Transport Notes

Java Jini 4160 TCP Responsible for discovery and communications 
between devices/services on a network.

Java RMI 32768–65535 TCP Remote Method Invocation (client/server 
communication). Dynamic Allocation of ports. 
Required for communication between client and 
Application Server. This range can be restricted to 
match specific security requirements. A minimum of 
4000 ports should be allocated.
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From multiviewer to peripheral devices

From peripheral devices to multiviewer

The following ports must be open on peripheral devices (e.g., router controllers):

Router drivers also use default ports:

Service Port Transport Notes

RCP2 5120 TCP Used to listen for Kaleido-X discovery packets

10000 TCP For RCP2 protocol

10001 TCP For RCP2 protocol

5120 UDP On multicast 230.8.8.9 for RCP2 protocol

5121 UDP For RCP2 protocol

HTTP 80 TCP Used by the RCP-200 to obtain information 
from the multiviewer’s system database

13000 TCP Used by the RCP-200 to control the multiviewer 
via the gateway

Service Port Transport Notes

SMTP 25 TCP Simple Mail Transfer Protocol, for e-mail alerts.

Alpermann+Velte 8851 TCP Used to obtain information from Plura 
(Alpermann+Velte) Studio Production Timer 
(SPT) systems.

GPI-1501 5100 TCP Used to obtain information from GPI-1501 
General Purpose Interface I/O modules.a

a. See also: From multiviewer to multiviewer, on page 475.

TSL (network) 8910b

b.Configurable.

TCP Used to obtain information from TSL devices 
that use the TSL UMD version 5.0 protocol.

Port Transport Notes

2000 TCP Used to control the Kaleido-X internal router via the SAM 
(Snell/Pro-Bel) SW-P-02 protocol

4381 TCP Used to control the Kaleido-X internal router via the 
Nevion (Network) protocol 

5194 TCP Used to control the Kaleido-X internal router via the 
NVISION Ethernet protocol - Compact router protocol.

14000 TCP Used to control the Kaleido-X internal router via the SAM 
(Snell/Pro-Bel) SW-P-08 protocol
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Between multiviewer and NTP server

The following ports, used for communications to/from Network Time Protocol servers, are 
open by default on all Kaleido-X systems:

Detailed Directions

Assigning an IP Address to Each Device in your System
Multiviewers and most peripheral devices that are part of a Kaleido-X system communicate 
through a TCP/IP network. Configuring your system’s network parameters includes the 
following:

Driver Port Transport Notes

ETL 4000 TCP

GVG 7000 Native 12345 TCP

NVISION Ethernet protocol - Enterprise router 9193 TCP

VikinX Modular 4381 TCP

Quintech 9100 TCP

Sony HKSPC 12345 TCP GVGNP Emulator

Utah RCP-3 5001 TCP SC-4 Ethernet

SAM (Snell/Pro-Bel) SW-P-02 2000 TCP

SAM (Snell/Pro-Bel) SW-P-08 14000 TCP

Note: This is configurable in XEdit—you can choose any UDP or TCP/IP port 
to use for communications between the multiviewer and an external router.

Service Port Transport Notes

SNMP 161 UDP Used for SNMP (Simple Network Management Protocol) 
communications between external SNMP managers and a 
multiviewer (e.g., sending get, get-next, and set messages 
to a multiviewer’s SNMP agent, and receiving the response).

1161 UDP Used for SNMP (Simple Network Management Protocol) 
communications between external SNMP managers and a 
Kaleido-IP multiviewer (e.g., sending get, get-next, and set 
messages to a multiviewer’s SNMP agent, and receiving the 
response).

Service Port Transport Notes

NTP 123 TCP Used for Network Time Protocol synchronization. 
Port needs to be open in both directions.
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• Assigning an IP address, and specifying the appropriate network mask, gateway 
address, and a system name for each multiviewer. Refer to Default IP Settings, on 
page 461, and to Configuring a Multiviewer’s IP Settings, on page 478.

• Configuring the RCP-200, or Kaleido-RCP2, if available. Refer to Configuring the RCP-
200, on page 484, or to Configuring the Kaleido-RCP2, on page 488.

• Configuring the Audio Bridge Terminal (ABT), if available. Refer to Configuring an Audio 
Bridge Terminal, on page 491.

Configuring a Multiviewer’s IP Settings

To change your system’s IP address and other parameters
1 Open XAdmin. See Opening XAdmin on page 509.
2 Click System configuration, in the navigation area on the left of the page.

The System Configuration page appears, showing the current system name, IP settings, 
as well as the date and time settings.

3 Type a different name for your system if you wish.
If there are more than one multiviewer in the same network environment, it is 
important to assign each a unique system name, so that you can tell them apart (for 
example, when using a remote control panel such as the Kaleido-RCP2 or RCP-200).

Notes
• In the case of a Kaleido-IP multiviewer, the system name must comply 

with RFC 1123, because it is also used as the device’s host name. Up to 8 
characters are allowed, limited to A-Z, a-z, 0-9, and the hyphen. The system 
name cannot start or end with an hyphen.

• For the other multiviewer models, only lower-ASCII characters are allowed 
in the system name. Braces and tilde are not allowed.
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In the absence of a reference signal, a Kaleido-X or Kaleido-X16 will process its video 
inputs at a default frame rate of 59.94 Hz.

4 If your system requires a 50 Hz frame rate, to match the input signal data sampling rate, 
in the absence of a reference signal, then select the corresponding check box.

5 Adjust the date and time settings, as required.
Clocks in your layouts will then display date and time in the applicable format.

6 Enter the appropriate IP information: frame or card IP addresses, network mask, and 
default gateway.

7 In the case of a Kaleido-IP, to omit network configuration for an unused data port, clear 
the corresponding Enabled check box.
By default, all network adapters are set to auto-negotiate. The connection speed and 
duplex mode will be set automatically based on the corresponding port settings on the 
associated switch. The current speed and link mode are displayed next to Detected link 
mode, for every network adapter.

8 Should your network configuration require specific speed and duplex mode settings, 
select the appropriate value from the Configured link mode list.

9 Click Save.
The new settings are saved locally.

10 Click OK.
The Apply settings button becomes available.

Note: The 50 Hz system frame rate option applies to the Kaleido-X and 
Kaleido-X16 multiviewers only.

Note: As required by the IEEE-802.3 standard, section 28D.5, 1000 Mbps 
full-duplex communication is only supported via auto-negotiation.
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11 Click Apply settings.
The Kaleido-X system must be restarted for changes to the network configuration to 
take effect. A message appears prompting you to reboot the system immediately.

12 Click OK.

Remember to change your client PC’s IP address to one that matches the new subnet 
(see Changing the Client PC’s IP Address on page 482). You will also need to edit the 
XAdmin URL in your Web browser's address bar, in order to log on to the multiviewer 
again.

Configuring a Multiviewer’s IP Settings Without a Client PC

With a Kaleido-X, or Kaleido-X16, you can set the IP address, system name, and other 
parameters via a control panel, directly on the monitor wall.

To change the multiviewer’s system IP address, and adjust your system’s configuration
1 Connect a mouse to any USB port on the multiviewer.
2 Right-click anywhere on the monitor wall. On the menu, point to Monitor wall, and 

then click System Configuration.

Note: Settings cannot be applied to a multiviewer system while an 
upgrade is in progress. If the multiviewer does not reboot after 10 seconds 
or so, try clicking Apply settings again after a minute or two, until the 
multiviewer reboots.

Notes 

This section does not apply to the KMV-3901/3911, Kaleido-XQUAD, 
Kaleido-MX, Kaleido-MX 4K, Kaleido-Modular-X, and KMX-4911. For these 
multiviewers, you can configure the network settings by using XAdmin, the 
Densité controller’s local control panel, or a control panel in iControl, if 
available. See Configuring a Multiviewer’s IP Settings on page 478, or refer to 
the Quick Start Guide for your multiviewer, for details.

In the case of a Kaleido-IP, changing the multiviewer’s network settings from 
the monitor wall is not yet supported.
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.

3 Change the configuration settings as necessary, and then click OK.

.

4 Click Yes when prompted to restart the system.

Finding a Multiviewer’s System IP Address and Application Version

To find the system IP address, system name and application version
• Right-click anywhere on the monitor wall. On the menu, point to Monitor wall, and 

then click Show dashboard to display the dashboard associated with the current 
output head.
A small window appears, revealing the system IP address and the system version.
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Partial view of a monitor wall display showing dashboard at the bottom right

Enlarged view of dashboard.

Changing the Client PC’s IP Address
Both the client computer you use to communicate with the multiviewer (e.g., via XAdmin, 
and XEdit), and the multiviewer itself must have IP addresses within the same subnet. 
Kaleido multiviewers are shipped with the default IP settings listed under Default IP 
Settings, on page 461. The following procedure applies to a typical Windows 7 or 
Windows 8 system. For Windows XP, see Changing an IP address on Windows XP, on 
page 484.

Changing an IP address on Windows 7 or Windows 8

To change the IP address of a client PC that has Windows 7 or Windows 8
1 Press the Windows key on your keyboard, type “control panel” and then press Enter.
2 In the search box, type “adapter”, and then, under Network and Sharing Center, click 

View network connections.
3 In Network Connections, right-click the network adapter you wish to configure (e.g., 

Local Area Connection, or Ethernet), and then click Properties. If the system prompts you 

Application version

System IP address

System name Room name
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for an administrator password or confirmation, type the password or provide 
confirmation.
The Properties window for the selected network adapter opens.

4 On the Networking tab, under This connection uses the following items, click 
Internet Protocol Version 4 (TCP/IPv4), and then click Properties.
The Internet Protocol Version 4 (TCP/IPv4) Properties window opens.

5 On the General tab, click Use the following IP address.

6 Type an IP address in the same range as the multiviewer’s current IP address.
For example, if the multiviewer’s IP address is 192.168.3.31, then the IP address of your 
client PC could be 192.168.3.123. If you are unsure, contact your network administrator.

7 Type a subnet mask in the same range as that of the multiviewer.
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8 Click OK.
9 In Local Area Connection Properties, click Close.

Changing an IP address on Windows XP

To change the IP address of a client PC that has Windows XP
1 On the Start menu, point to Control Panel, right-click Network Connections, and then 

click Open on the menu.
2 In Network Connections, right-click Local Area Connection, and then click Properties 

on the shortcut menu.
3 In Local Area connection Properties, select Internet Protocol (TCP/IP) from the list on 

the General tab, and then click Properties.
The Internet Protocol (TCP/IP) Properties window opens.

4 On the General tab, click Use the following IP address.
5 Type an IP address in the same range as the multiviewer’s current IP address.

For example, if the multiviewer’s IP address is 10.0.3.70, then the IP address of your 
client PC could be 10.0.3.123. If you are unsure, contact your network administrator.

6 Type a subnet mask in the same range as that of the multiviewer.
7 Click OK.
8 In Local Area Connection Properties, click Close.

Configuring the RCP-200
The RCP-200 is shipped with an IP address of 10.0.3.200. On installation, you should consult 
your system administrator and replace this address with an appropriate address for your 
local network configuration (see Configuring the RCP-200’s IP settings on page 484). Once 
your RCP-200 has an active connection to the network, you must then register the 
multiviewers you wish to operate from the RCP-200 (see Specifying multiviewers for the 
RCP-200 on page 485), and their respective KX Router logical routers (see Specifying lookup 
servers for the RCP-200 on page 485). Once this is completed, you will be able to control the 
monitor wall from the RCP-200 (see Logging on to the RCP-200 on page 485).

Configuring the RCP-200’s IP settings

To assign an IP address to the RCP-200
1 Press the CONFIG button, located between the two screens on the front of the RCP-200.
2 Touch the COMM category at the top of the right-hand screen.
3 Touch the ETHERNET tab on the right-hand screen.
4 In the SELECT area, rotate the leftmost control knob to select IP ADDRESS.
5 Use the four control knobs in the CHANGE area to set the new address.

The current address is displayed in the CURRENT box for reference, and the new 
address you are setting appears in the MODIFIED box, as well as at the controls.

6 Press the SAVE control knob to store the new address.
7 Repeat from step 4 to configure the NETWORK MASK and GATEWAY settings.
8 Press the RESTART control knob to apply the changes.

The panel will go dark for about 15 seconds before the startup screens appear.
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Specifying multiviewers for the RCP-200

To specify a multiviewer for the RCP-200
1 Press the CONFIG button, located between the two screens on the front of the RCP-200.
2 Touch the COMM category on the right-hand screen.
3 Touch the KALEIDO DISCOVERY tab on the right-hand screen.
4 Use the four control knobs in the ADD TO LIST area to dial in the IP address of the 

multiviewer you wish to operate.
The address appears in the TO ADD box.

5 Press the ADD control knob.
The multiviewer’s IP address appears in the LOOKUP LIST area.

6 Press the CONFIG button, located between the two screens on the front of the RCP-200 
to end the configuration process and return to normal operation.

Specifying lookup servers for the RCP-200

The RCP-200 needs to connect to a lookup server in order to control devices, including a 
multiviewer’s KX router logical router.

To specify a lookup server for the RCP-200
1 Press the CONFIG button, located between the two screens on the front of the RCP-200.
2 Touch the COMM category on the right-hand screen.
3 Touch the DISCOVERY tab on the right-hand screen.
4 Use the four control knobs in the ADD TO LIST area to dial in the IP address of the 

multiviewer you wish to operate.
The address appears in the TO ADD box.

5 Press the ADD control knob.
The multiviewer’s IP address appears in the LOOKUP LIST area.

6 Press the CONFIG button, located between the two screens on the front of the RCP-200 
to end the configuration process and return to normal operation.

Logging on to the RCP-200

Note: In a default system configuration, a multiviewer’s video outputs are 
assigned to specific rooms:

• On a Kaleido-X (7RU), the two DVI/VGA outputs from each of the dual-
head output cards A, B, C and D are assigned to ROOM1, ROOM2, ROOM3 
and ROOM4 respectively.

• On a Kaleido-X (4RU), the two DVI/VGA outputs from each of the dual-
head output cards A and B are assigned to ROOM1 and ROOM2 
respectively.

• On a Kaleido-X (14RU) expansion system, the two DVI/VGA outputs from 
each of the dual-head output cards A, B and C of each of Frame A and 
Frame B are assigned to ROOM1, ROOM2, ROOM3, ROOM4, ROOM5 and 
ROOM6 respectively.
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To log on to a Kaleido-X room from the RCP-200
1 On an RCP-200 with an active connection to the network, press the LIST button.

All devices, and Kaleido-X rooms, detected by the RCP-200 appear on the left screen. 
Kaleido-X rooms are listed in the form [multiviewer name]\[room name].
If a room belongs to a cluster system, its name appears once for each of the member 
multiviewers (e.g., if two multiviewers, KX1 and KX2, are configured as a cluster, and 
ROOM1 includes displays fed by both multiviewers, then both KX1\ROOM1 and 
KX2\ROOM1 will be listed. To determine the one you should select, review the 
following:

• Has the RCP user configuration you wish to use been replicated on every member 
of the cluster (see Replicating RCP Users Across a Cluster System on page 94)?

• Do you need to control an external router whose configuration is available only 
from one or some specific members of the cluster?

• Does your system configuration include actions that were configured only on one 
or some specific members of the cluster?

• Do you need to control a timer from the monitor wall in a cascade room?
If any of the above elements is available only from one or some specific members, then 
make sure you select the room name prefixed with the appropriate multiviewer name. 
In the case of a cascade room, unless you remember which multiviewer you were 
connected to when you added the timer you need to control, you will have to proceed 
by trial and error.

2 Touch the room you wish to access (press the DOWN or UP soft keys to scroll the list as 
needed).
The list of users assigned to this room appears on the right-hand screen.

3 Touch the user name under which you wish to log on, enter your password, and then 
touch LOG IN.

The following message appears on the right-hand screen: PLEASE SELECT A ROUTER 
FROM THE LEFT-HAND SCREEN, prefixed with the name of the multiviewer that 
appeared before the room name you selected in step 2.

4 In the list on the left-hand screen, touch the KX Router logical router associated with the 
same multiviewer (you can see the multiviewer name, its IP address, and the size of that 
particular KX Router).

• On a Kaleido-X16-D, the HDMI outputs from each of the output modules 
are assigned to ROOMX16.

• On a Kaleido-X16-S, the HDMI output is assigned to ROOMX16.

• On a KMV-3901/3911, Kaleido-XQUAD, or Kaleido-XQUAD-DUAL, the 
HDMI outputs are assigned to ROOM1.

• On a Kaleido-IP, the multiviewer outputs are assigned to ROOM.

• On a Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X, the outputs are 
assigned to ROOM1.

Note: By default, the user “Admin” has no password.
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5 Touch the Video level, in the area to the right of the router list, if it is not selected 
already, and then push SELECT.
The room’s monitor wall control panel appears on the right-hand screen, with the 
ASSIGN CHANNEL category selected. If a mouse is connected to the RCP-200, then after 
touching WALL MOUSE you should be able to see and move the mouse pointer on the 
monitor wall.

• If the room you selected belongs to a cascade system, touch a monitor showing a 
source you can identify as coming from a different multiviewer than the one indicated 
with the room name you selected in step 2.

• If the room you selected belongs to a cluster system, rotate the HEAD knob (or touch 
the DISPLAY SELECT category) to display a head view from a different member of the 
cluster, and then touch a monitor.
The ROUTER SELECT category becomes selected instead of ASSIGN CHANNEL, and the 
right-hand screen shows the message prompting you to select a router from the left-
hand screen, prefixed with the name of the multiviewer, which means that you still 
need to complete the correlation between some monitor wall destinations and the 
representation of the KX Router logical router for this multiviewer. See Correlating 
Monitor Wall Destinations and KX Router Logical Routers for the RCP-200 on page 487. 
Repeat this for one head, with one layout, for every multiviewer that is part of the 
cluster of cascade. If you need to connect to a different instance of the same room then 
you will have to establish the correlation again, to be able to operate the monitor wall 
from the different context.

For more information on the RCP-200, please refer to the RCP-200 Guide to Installation and 
Operation, available from the Documentation Library section of Grass Valley’s website.

Correlating Monitor Wall Destinations and KX Router Logical Routers for 
the RCP-200
To operate the monitor wall from the RCP-200’s category/index router view, your system 
must have been configured to be controlled as a router. In a layout, the RCP-200 can only 
control monitors that have been assigned a monitor wall destination. The first time you log 
on to a room from the RCP-200, you will be prompted to select a router from the left-hand 
screen. By selecting the appropriate KX Router logical router, you will establish the 
correlation between your multiviewer’s monitor wall destinations and the RCP-200’s 
representation of the multiviewer’s KX Router logical router. In the case of a cluster or 
cascade system, you will also be prompted to select a router, the first time to try to assign a 
source to a monitor located in a part of the layout that belongs to a different member of the 
cluster or cascade. You only need to do this once, for every multiviewer that is part of a 
cluster (or cascade).

Notes
• The RCP-200 will remember your user credentials until you log out 

explicitly (by touching LOG OUT at the upper-right corner of the control 
panel).

• The pointer may flicker when two RCP users access displays fed by the 
same multiviewer output.

• Two users accessing the same display will be limited to sharing a single 
pointer.
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To correlate a monitor wall destination in a layout and the corresponding KX Router 
logical router

1 In the list on the left-hand screen, touch the KX Router logical router associated with the 
multiviewer whose name was indicated in the message prompting to select a router 
(you can see the multiviewer name, its IP address, and the size of that particular KX 
Router).

2 Touch the Video level, in the area to the right of the router list, if it is not selected 
already, and then push SELECT.
The RCP-200 will remember the association with the KX Router logical router’s 
destinations for the current multiviewer’s monitor wall destinations.

Configuring the Kaleido-RCP2
The Kaleido-RCP2 is a multi-function remote control panel designed for use with Kaleido 
multiviewers. Ethernet connectivity allows multiple RCP users to access multiple Kaleido-X 
systems, allowing convenient access to the real-time operating features. When logged on 
to a Kaleido multiviewer via its Ethernet connection, the RCP user can control various 
operating features.

Before you can use the Kaleido-RCP2 to operate your Kaleido-X, you must set up the 
Ethernet connection between the two devices. By default, the Kaleido-RCP2 is shipped with 
DHCP enabled, so it will automatically be assigned an IP address by a DHCP server. If no 
DHCP server is present on the network, the Kaleido-RCP2 will default to the static IP address 
10.0.3.191.

Notes
• The Kaleido-RCP2 is powered through the RJ45 Ethernet connector. There 

is no power ON/OFF button, so the device is ON whenever a powered 
Ethernet cable is connected.

• If you purchased more than one Kaleido-RCP2 units, keep in mind that 
they all ship with the same default static IP address. Make sure to assign 
them different static IP addresses before connecting them to the network 
if DHCP is not used.

• The time-out period before the Kaleido-RCP2 defaults to its static address 
is 1 minute. To speed up the initialization, disable the DHCP option.
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Assigning a static IP address to the Kaleido-RCP2

To assign a static IP address to the Kaleido-RCP2
1 Press and hold the ENTER button until the ESC button lights up, to display the 

configuration menu.
2 Press the 8 key (to move down the list) until ETHERNET OPTIONS appears on the LCD 

display.
3 Press the ENTER key to display the ETHERNET OPTIONS menu.
4 Select the IP ADDRESS menu using the 2 key (to move up in the list) or the 8 key (to 

move down the list), and then press ENTER.
5 Using the numeric keypad, type the chosen IP address, and then press ENTER.
6 Select the NETWORK MASK menu using the 2 key (to move up in the list) or the 8 key 

(to move down the list), and then press ENTER.
7 Using the numeric keypad, type the chosen network mask, and then press ENTER.

You have assigned a static IP address to the Kaleido-RCP2.

Selecting a room for the Kaleido-RCP2

To select a room for the Kaleido-RCP2
1 Press and hold the ENTER button until the ESC button lights up, to display the 

configuration menu.
2 In the ROOM SELECTION display, press ENTER again to get the room list from the 

Kaleido-X systems that are currently available on the network.
3 In the room list, select the room you wish to access by pressing the 2 key (to move up in 

the list) or the 8 key (to move down the list).

Note: By default, a multiviewer’s video outputs are assigned to specific 
rooms:

• On a Kaleido-X (7RU), the two DVI/VGA outputs from each of the dual-
head output cards A, B, C and D are assigned to ROOM1, ROOM2, 
ROOM3 and ROOM4 respectively.

• On a Kaleido-X (4RU), the two DVI/VGA outputs from each of the dual-
head output cards A and B are assigned to ROOM1 and ROOM2 
respectively.

• On a Kaleido-X (14RU) expansion system, the two DVI/VGA outputs 
from each of the dual-head output cards A, B and C of each of Frame A 
and Frame B are assigned to ROOM1, ROOM2, ROOM3, ROOM4, ROOM5 
and ROOM6 respectively.

• On a Kaleido-X16-D, the HDMI outputs from each of the output 
modules are assigned to ROOMX16.

• On a Kaleido-X16-S, the HDMI output is assigned to ROOMX16.

• On a KMV-3901/3911, Kaleido-XQUAD, or Kaleido-XQUAD-DUAL, the 
HDMI outputs are assigned to ROOM1.

• On a Kaleido-IP, the multiviewer outputs are assigned to ROOM.
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4 When the appropriate room name is highlighted, press ENTER to accept the new 
selection.

5 When prompted, log on to the selected room. See Logging on to the Kaleido-RCP2 on 
page 490.

Connecting the Kaleido-RCP2 to Other Kaleido-X Systems
The unicast IP feature enables a Kaleido-RCP2 to find up to three Kaleido-X systems on 
different subnets and connect to them (via network gateways), while maintaining 
connections to Kaleido-X systems in its own subnet.

To configure a unicast IP address on the Kaleido-RCP2
1 Press and hold the ENTER button until the ESC button lights up, to display the 

configuration menu.
2 Select ETHERNET OPTIONS on the LCD display, and then press ENTER.
3 Select Unicast host IP, and then press ENTER.
4 Select Enable IP 1, and then press ENTER.

The Enable IP x parameter instructs the Kaleido-RCP2 to query the selected IP address 
for a list of rooms.

5 Select Host IP ADDR, and then press ENTER.
6 Using the numeric keypad, type the IP address of a Kaleido-X on a remote subnet, and 

then press ENTER.
7 Repeat step 4 to step 6 to add unicast IP addresses for up to three remote Kaleido-X 

systems.

Logging on to the Kaleido-RCP2
As a network device, the Kaleido-RCP2 provides access to any room configuration on any 
Kaleido-X system on the network. As a security measure, access is controlled by a login 
procedure.

To log on to a Kaleido-X system from the Kaleido-RCP2
1 Press the LOGIN key.

The following message will appear on the LCD display:
LOGIN Position 
Admin 

2 Press ENTER to select “Admin”.
A message prompting you to enter a password will appear on the LCD display.

• On a Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X, the outputs are 
assigned to ROOM1.

Notes
• To navigate the Kaleido-RCP2 menu, press the 2 key to move up, or the 8 

key to move down.
• There is no need to configure unicast IP addresses for Kaleido-X systems 

on the same subnet as the Kaleido-RCP2.
490



Kaleido-X
User’s Manual
3 Press ENTER again (by default, there is no password). 
The message “Access granted” will appear on the LCD display if the login is successful. If 
a mouse is connected to the Kaleido-RCP2, then you should be able to see and move 
the mouse pointer on the monitor wall.

For more information, refer to the Kaleido-RCP2 Guide to Installation and Operation, available 
from the Documentation Library section of Grass Valley’s website.

Configuring an Audio Bridge Terminal

The Audio Bridge Terminal (ABT) is an external audio multiplexer/serializer for Kaleido 
multiviewers. The ABT provides connector space for audio signal inputs, and multiplexes all 
the audio signals into combined serial feeds on coaxial cables that connect to the 
multiviewer’s input modules.

To configure the IP address and other network settings of the ABT
1 Connect a PC to a switch.
2 Referring to Changing the Client PC’s IP Address, on page 482, configure the PC with 

the following network settings:

Note: If at any time the message “Target system is offline” or “No login list 
available” appears on the LCD display, press the ESC, ENTER and DEL keys 
simultaneously and go back to step 1.

Note: The KMV-3901/3911, and Kaleido-IP multiviewers are not compatible 
with the Audio Bridge Terminal.

Note: The ABT is powered through the RJ45 Ethernet connector. There is no 
power ON/OFF button, so the device is ON whenever a powered Ethernet 
cable is connected.

DHCP Off

Static IP address 10.0.0.1
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3 Apply power to the Audio Bridge Terminal and make sure it is connected to the same 
switch as the PC. If the switch is Power over Ethernet (PoE) enabled, simply connect it to 
the unit using an Ethernet cable. If not, PoE mid-span (“inserter”) equipment must be 
placed between the switch and the Audio Bridge Terminal.

4 Press the RESET button (located on the right-hand side of the ABT rear panel beside the 
ETHERNET/POWER RJ45 connector) for at least 1 second. The Audio Bridge Terminal will 
reboot with the following static network configuration:

5 Using a Web browser on the PC, connect to the ABT using the following address: 
10.0.3.190.
The home page of the ABT’s built in Web server is displayed.

6 Click Network Configuration (in the navigation pane).
The Network Configuration page is displayed.

7 Change the ABT’s network settings, as necessary, and then click Apply & Reboot.

For more information, please refer to the Audio Bridge Terminal Guide to Installation and 
Operation, available from the Documentation Library section of Grass Valley’s website.

Subnet mask 255.255.0.0

Default gateway 10.0.0.1

DHCP OFF

Static IP address 10.0.3.190

Subnet mask 255.255.0.0

Default gateway 10.0.0.1

Note: If you purchased more than one Audio Bridge Terminal unit, keep in 
mind that they all ship with the same default static IP address. Make sure to 
assign each of them a different static IP address before connecting them to 
the network, if DHCP is not used.

DHCP Off
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Enabling Options
To enable options on a multiviewer

1 Open XAdmin. See Opening XAdmin on page 509.
The XAdmin Status and Options page appears.

2 Click the arrow button at the end of the heading row that corresponds to the module 
for which you wish to enable an option.

3 Locate the entry for the option you wish to enable.
For example, to activate the Extraction of CC, Subtitling and XDS metadata option 
(CC/XDS Option) for a Kaleido-X input card, you would need to locate the appropriate 
card in XAdmin’s Status and Options page, expand it, and then locate the 
KXI-16-CC/XDS option line.

4 Click the Enable button.
A window appears prompting you for the option key.

5 Enter the key for the specific option in the box, and then click OK.

Click to expand

Click to collapse
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Once the option is enabled, the key is displayed, and a Disable button replaces the 
Enable button.

Installing Kaleido-X Client Applications
In addition to the XAdmin Web client, which does not require installation, the Kaleido-X 
software includes the following client applications:

• XEdit is a client application used to create layouts for the monitor wall, and to configure 
your multiviewer system, from your PC or laptop. When the computer with XEdit is 
connected to the multiviewer through a TCP/IP network, you can use XEdit to modify 
layouts and settings directly on the multiviewer, or you can work locally on the 
computer and then export your changes to the multiviewer.

• If you have only one multiviewer (or if you have more than one but you intend to 
always have the same version of the Kaleido-X software on all of them), download 
the XEdit installer file from the multiviewer’s home page. Whenever you install a 
new version of the Kaleido-X software on the multiviewer, the next time you open 
XEdit, your copy of the application will be automatically updated from the 
multiviewer. See Installing XEdit from your Multiviewer’s Home Page on page 495.

• If you need to keep different versions of XEdit on the same PC or laptop (for example, 
you may have multiple multiviewers, some of which may not always have the same 
version of the Kaleido-X software as the others), use a versioned XEdit installer file, 
available from the Downloads section of Grass Valley’s website. When you use the 
standalone installer, XEdit is not automatically updated. See Installing a Specific 
Version of XEdit on page 498.

• The Router Control Software Single Bus and Matrix View applications (also part of the 
iRouter Router Control Software packaged with iControl Application Servers) can be 
used to control your multiviewer’s logical sources and monitor wall destinations, via 
the KX Router logical router, or to control other logical routers configured within your 
multiviewer system. See Installing Router Control on page 503.

• Signal Path Viewer opens as a standalone panel, updated in real time, showing 
assignment information between router sources and multiviewer inputs. Signal Path 
Viewer is available for all multiviewer models, except Kaleido-IP (for which it is not 

Notes 

• The Kaleido-IP currently supports extraction of CC/subtitling and XDS data 
(1 license/program), and display rotation. It is not yet possible to enable or 
verify these options in XAdmin’s Status and Options page, for this 
multiviewer model. Contact Technical Support for activation and 
configuration instructions (see Contact Us, on page 551).

• One CC/XDS Option key is needed per input card, and the extraction of CC 
608, CC 708, XDS and Subtitling WST metadata are all activated as a single 
option.

• After enabling the 3D Support option in XAdmin, refresh the current layout 
or load another one, for the change to be reflected on the monitor wall.

• For a complete list of the options that can be enabled and disabled via the 
XAdmin Status and Options page, see Hardware and Software Options, on 
page 464.
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relevant). See Installing Signal Path Viewer on page 506.

Installing XEdit from your Multiviewer’s Home Page

To install XEdit from your multiviewer’s home page
1 From a workstation on the same subnet as the multiviewer, open a Web browser 

window and type the multiviewer’s IP address in the address bar.
The multiviewer’s home page appears.

2 Click the XEdit button.
The browser prompts you to save an executable file to your hard drive (Kaleido-
windows32-online.exe11). This file is an online installer, which will download XEdit 
and other companion elements from your multiviewer, and install them. Some 
browsers may allow you to run the file directly. Depending on your browser’s security 
features, warnings may appear, which you may safely dismiss.

3 Unless your browser let you run the file (and you chose to do so), navigate to the 
location were you saved the installer file and open it.
More security warnings or prompts may appear, which you may safely dismiss or 
accept.
A window appears, showing the download and installation progress.

11.Installers for Linux or Mac OS X are not yet available.
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At the end of the installation process:
• If you have Windows 7, or Windows XP, shortcuts ( ) are added to your desktop 

and to the Start menu (under All Programs).

• If you have Windows 8.1, or Windows 8, XEdit will appear on your desktop, in the 
Apps view with all the other applications on your PC (Windows 8.1), or in your Start 
screen (Windows 8).

Once the installation has completed, the XEdit startup screen appears.
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Depending on your Windows Firewall settings, a security alert may appear.
• Click Allow access to unblock the application.

If XEdit cannot find all of the fonts it needs already on your PC or laptop, it downloads 
them from the multiviewer automatically, in which case a message will appear to 
confirm the font update, and instruct you to restart the application.

• Click OK to continue, and then open XEdit again, by using the shortcut on your 
desktop, in your Apps view (Windows 8.1) or Start screen (Windows 8), or from the 
Start menu (Windows 7, Windows XP).

4 When prompted to specify a database, choose one from the Path list, or click Browse to 
navigate to the database you wish to use as your local workspace, and then click OK.

Once the database has completed loading, XEdit’s main application window appears.
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Installing a Specific Version of XEdit
Versioned XEdit installers are available from the Downloads section of Grass Valley’s 
website. The installer file name (of the form Kaleido X.XX_build_XXXX-windows32-
offline.exe) indicates the Kaleido-X software version and build number, and the target 
operating system.12

To install a specific version of XEdit
1 Save a copy of the versioned installer file you wish to use to your hard drive (e.g., 

Kaleido 8.20_build_1234-windows32-offline.exe).
2 Open the installer file.

Security warnings or prompts may appear, which you may safely dismiss or accept.
A progress indicator window appears while XEdit is installed.

Note: Once it has been installed from the multiviewer, XEdit remains on 
your PC or laptop, and can be launched from the  shortcut that was added 
to your desktop, Apps view, or Start screen (see page 496), or from the Start 
menu. Whenever you install a new version of the Kaleido-X software on the 
multiviewer, the next time you open XEdit, your installed copy of the 
application will be automatically updated from the multiviewer.

12.Installers for Linux or Mac OS X are not available.
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At the end of the installation process,
• if you have Windows 7, or Windows XP, shortcuts ( ) are added to your desktop 

and to the Start menu (under All Programs);

• if you have Windows 8.1, or Windows 8, XEdit will appear on your desktop, in the 
Apps view with all the other applications on your PC (Windows 8.1), or in your Start 
screen (Windows 8).

Once the installation has completed, the XEdit startup screen, and Database Location 
window appear.

Notes 

• Depending on your Windows Firewall settings, a security alert may appear.
• Click Allow access to unblock the application.
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3 In Database Location, choose a database from the Path list, or click Browse to navigate 
to the database you wish to use as your local workspace, and then click OK.

4 Once the database has completed loading, XEdit’s main application window appears.

• If the installer cannot find all of the fonts it needs already on your PC or 
laptop, it adds them automatically to the install folder, in which case a 
message will appear to confirm the font update, and instruct you to restart 
the application.

• Click OK to continue, and then open XEdit again, by using the shortcut 
on your desktop, in your Apps view (Windows 8.1) or Start screen 
(Windows 8), or from the Start menu (Windows 7, Windows XP).

Notes (continued)
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Uninstalling XEdit
With recent versions of XEdit, an uninstall program is available from the Windows Start 
menu.

• If you installed XEdit from your multiviewer’s home page, see Uninstalling XEdit 
(Dynamic Version 7.20 or Later), on page 501.

• If you chose to install specific versions of XEdit by using the appropriate versioned 
installers (available from the Downloads section of Grass Valley’s website) — for 
example, you have more than one multiviewer system, and they have different versions 
of the Kaleido-X software —, see Uninstalling XEdit (Static Version 7.20 or Later), on 
page 502. 

If you have been using XEdit versions earlier than 7.20 you may want to uninstall them, by 
clearing the Java cache, on your PC or laptop. See Uninstalling XEdit (Version 7.11 or Earlier) 
on page 503.

Uninstalling XEdit (Dynamic Version 7.20 or Later)

To uninstall XEdit (dynamic version 7.20 or later)
1 Close all XEdit windows you may have open.
2 Locate the Uninstall XEdit shortcut.

• If you have Windows 7, or Windows XP: Open the Start menu, click All Programs, 
scroll to the Grass Valley (or Miranda Technologies13) folder, and then expand the 
Kaleido folder.

• If you have Windows 8.1, or Windows 8: Switch to the App view or your Start 
screen.

3 Click Uninstall XEdit.
An uninstall screen appears.

Note: Once it has been installed from the multiviewer, XEdit remains on 
your PC or laptop, and can be launched from the  shortcut that was added 
to your desktop, Apps view, or Start screen, or from the Start menu.
If you have installed multiple versions of XEdit, the 
shortcut on your desktop opens the last version 
you installed. To open a specific version of XEdit, 
use the shortcut on the Start menu (under All 
Programs) or in your Apps view or Start screen.

13.Launcher icons for versions 7.20–7.52 would have been installed in the Miranda Technologies folder.
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4 Click Uninstall.
This removes XEdit, including all shortcuts, launchers, and other elements that were 
installed with it, from your system.

Uninstalling XEdit (Static Version 7.20 or Later)

To uninstall XEdit (static version 7.20 or later)
1 Close all XEdit windows you may have open.
2 Locate the Uninstall XEdit shortcut for the version you wish to uninstall.

• If you have Windows 7, or Windows XP: Open the Start menu, click All Programs, 
scroll to the Grass Valley (or Miranda Technologies14) folder, and then expand the 
Kaleido folder matching the version you wish to uninstall.

• if you have Windows 8.1, or Windows 8: Switch to the App view or your Start 
screen.

3 Click Uninstall XEdit.
An uninstall screen appears.

14.Launcher icons for versions 7.20–7.52 would have been installed in the Miranda Technologies folder.
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4 Click Uninstall.
This removes the selected version XEdit, including all shortcuts, launchers, and other 
elements that were installed with it, from your system.

Uninstalling XEdit (Version 7.11 or Earlier)

To uninstall XEdit (version 7.11 or earlier)
1 Close all Java applications you may have open.
2 On the Start menu, click Control Panels, and then click Java (32-bit).

Java Control Panel opens.
3 In the General tab, click Settings.
4 In Temporary Files Settings, click Delete Files.
5 In Delete Files and Applications select all the check boxes, and then click OK.
6 Close Temporary Files Settings, and then Java Control Panel, by clicking their OK 

button.

Installing Router Control

To install Router Control from your multiviewer’s home page
1 From a workstation on the same subnet as the multiviewer, open a Web browser 

window and type the multiviewer’s IP address in the address bar.
The multiviewer’s home page appears.

2 Click the Router Control button.
The browser prompts you to save an executable file to your hard drive 
(Kaleido__RouterControl-windows32-online.exe15). This file is an online installer, 
which will download Router Control and other companion elements from your 
multiviewer, and install them. Some browsers may allow you to run the file directly. 
Depending on your browser’s security features, warnings may appear, which you may 
safely dismiss.

3 Unless your browser let you run the file (and you chose to do so), navigate to the 
location were you saved the installer file and open it.

15.Installers for Linux or Mac OS X are not available.
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More security warnings or prompts may appear, which you may safely dismiss or 
accept.
A window appears, showing the download and installation progress.

At the end of the installation process:
• If you have Windows 7, or Windows XP, shortcuts ( ) are added to your desktop 

and to the Start menu (under All Programs).

• If you have Windows 8.1, or Windows 8, Router Control will appear on your 
desktop, in the Apps view with all the other applications on your PC (Windows 8.1), 
or in your Start screen (Windows 8).

Once the installation has completed, the Router Control main application window 
appears. The application automatically connects to your multiviewer. The main 
window lists all logical routers configured within your multiviewer system, in addition 
to the KX Router logical router.

4 In Router Control, click the router you wish to control, and then click Open.
Depending on your Windows Firewall settings, a security alert may appear.

• Click Allow access to unblock the application.
The Matrix View application window opens.
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On the Help menu, click Help to access the online documentation, or refer to the 
iControl Router User Guide, available from the Documentation Library section of Grass 
Valley’s website.

Uninstalling Router Control

To uninstall Router Control (Windows 7, Windows XP)
1 Close all Router Control windows you may have open.
2 Locate the Uninstall Router Control shortcut.

Notes 

• Once it has been installed from the multiviewer, Router Control remains on 
your PC or laptop, and can be launched from the  shortcut that was 
added to your desktop, Apps view, or Start screen (see page 504), or from 
the Start menu. Whenever you install a new version of the Kaleido-X 
software on the multiviewer, the next time you open Router Control, your 
installed copy of the application will be automatically updated from the 
multiviewer.

• Router Control can also connect to other Kaleido multiviewers or iControl 
Application Servers, and control their routers.

• Routers configured within a Kaleido multiviewer system are compatible 
with the Router Control modules packaged with iControl Application 
Servers version 6.10 and later.

• When Router Control is connected to an Application Server, a router 
manager configuration application is available from the main application 
window. When Router Control is connected to a Kaleido multiviewer, this 
router manager configuration application is not available (router 
configuration is performed with XEdit, in this case).
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• If you have Windows 7, or Windows XP: Open the Start menu, click All Programs, 
scroll to the Grass Valley folder, and then expand the Kaleido folder.

• If you have Windows 8.1, or Windows 8: Switch to the App view or your Start 
screen.

3 Click Uninstall Router Control.
An uninstall screen appears.

4 Click Uninstall.
This removes Router Control, including all shortcuts, and other elements that were 
installed with it, from your system.

Installing Signal Path Viewer

To install Signal Path Viewer from your multiviewer’s home page
1 From a workstation on the same subnet as the multiviewer, open a Web browser 

window and type the multiviewer’s IP address in the address bar.
The multiviewer’s home page appears.

2 Click Launch the Signal Path Viewer.
The browser prompts you to save an executable file to your hard drive 
(Kaleido__SignalPathViewer-windows32-online.exe16). This file is an online 
installer, which will download Signal Path Viewer from your multiviewer, and install it. 
Some browsers may allow you to run the file directly. Depending on your browser’s 
security features, warnings may appear, which you may safely dismiss.

16.Installers for Linux or Mac OS X are not available.
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3 Unless your browser let you run the file (and you chose to do so), navigate to the 
location were you saved the installer file and open it.
More security warnings or prompts may appear, which you may safely dismiss or 
accept.
A window appears, showing the download and installation progress.

At the end of the installation process:
• If you have Windows 7, or Windows XP, shortcuts ( ) are added to your desktop 

and to the Start menu (under All Programs).

• If you have Windows 8.1, or Windows 8, Signal Path Viewer will appear on your 
desktop, in the Apps view with all the other applications on your PC (Windows 8.1), 
or in your Start screen (Windows 8).

Once the installation has completed, the Signal Path Viewer panel appears. Depending 
on your Windows Firewall settings, a security alert may also appear.

• Click Allow access to unblock the application.
The application automatically connects to your multiviewer.
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For each multiviewer input, the panel displays, in real time, the current router source 
assignment, the corresponding router destination, as well as router status information. 
In the case of a Kaleido-X multiviewer model, it also indicates if an input card has been 
removed.

Uninstalling Signal Path Viewer

To uninstall Signal Path Viewer (Windows 7, Windows XP)
1 Close all Signal Path Viewer windows you may have open.
2 Locate the Uninstall Signal Path Viewer shortcut.

• If you have Windows 7, or Windows XP: Open the Start menu, click All Programs, 
scroll to the Grass Valley folder, and then expand the Kaleido folder.

Notes 

• Signal Path Viewer is available for all multiviewer models, except Kaleido-IP 
(for which it is not relevant).

• Once it has been installed from the multiviewer, Signal Path Viewer 
remains on your PC or laptop, and can be launched from the  shortcut 
that was added to your desktop, Apps view, or Start screen (see page 507), 
or from the Start menu. Whenever you install a new version of the 
Kaleido-X software on the multiviewer, the next time you open Signal Path 
Viewer, your installed copy of the application will be automatically 
updated from the multiviewer.

• Should you need Signal Path Viewer to connect to a different multiviewer, 
then you must install it again, from the other multiviewer’s home page.

• In the case of a Kaleido-X multiviewer, if you remove or reseat output cards, 
Signal Path Viewer may stop displaying real-time updates, in which case 
close the application and then open it again.
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• If you have Windows 8.1, or Windows 8: Switch to the App view or your Start 
screen.

3 Click Uninstall Signal Path Viewer.
An uninstall screen appears.

4 Click Uninstall.
This removes Signal Path Viewer, including all shortcuts, and other elements that were 
installed with it, from your system.

Opening XAdmin
There are two ways to access the XAdmin Web client: from a Web browser (see Opening 
XAdmin from a Browser on page 509), and from XEdit (see Opening XAdmin from XEdit on 
page 510). The first time you access XAdmin for a multiviewer (and every time the 
multiviewer’s IP address has changed), you may see a security warning or a certificate error 
message. The procedures below include instructions on how to address these messages 
(see Registering your Multiviewer's Security Credentials with your Browser on page 511). 
Internet Explorer users may also need to enable compatibility view (see Enabling the 
Compatibility View in Internet Explorer on page 519).

Opening XAdmin from a Browser

To open XAdmin from a browser
1 Configure your client PC with an IP address in the same range as the IP address of the 

multiviewer, if needed (see Changing the Client PC’s IP Address on page 482).
2 Open a Web browser window and enter the multiviewer’s IP address in the address bar.

The Kaleido-X home page appears.
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3 Click the XAdmin button.
4 If you see a security warning, or a certificate error message, then refer to Registering 

your Multiviewer's Security Credentials with your Browser, on page 511.
5 If the “Log in to XAdmin” page appears, type the password, and then click Log in.

6 Internet Explorer users: If a blank page appears, then refer to Enabling the 
Compatibility View in Internet Explorer, on page 519.
The XAdmin Status and Options page appears. You can access all XAdmin features, by 
clicking the links, in the navigation area on the left of the page.

Opening XAdmin from XEdit

To open XAdmin from XEdit
1 On the Configure menu, click Use XAdmin.

XEdit prompts you for the IP address of the multiviewer you wish to access.
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2 Type the IP address, and then click OK.
Your default Web browser opens.

3 If you see a security warning, or a certificate error message, then refer to Registering 
your Multiviewer's Security Credentials with your Browser, on page 511.

4 If the “Log in to XAdmin” page appears, type the password, and then click Log in.

5 Internet Explorer users: If a blank page appears, then refer to Enabling the 
Compatibility View in Internet Explorer, on page 519.
The XAdmin Status and Options page appears. You can access all XAdmin features, by 
clicking the links, in the navigation area on the left of the page.

Registering your Multiviewer's Security Credentials with your Browser
When you open your multiviewer’s home page, or try to access XAdmin, your browser may 
report a certificate error (Internet Explorer), warn you about the site’s security certificate 
(Chrome), or report an untrusted connection (Firefox). Follow the appropriate procedure 
below to register your multiviewer’s security credentials with your browser:

• Suppressing untrusted connection warning in Firefox, on page 511
• Suppressing certificate error in Internet Explorer or Chrome, on page 512

You will be then able to access your multiviewer’s client applications without seeing the 
error message again, as long as the multiviewer’s IP address does not change.

Suppressing untrusted connection warning in Firefox

The first time you try to access XAdmin in Firefox, the browser may display the following 
page instead, prompting you to confirm the multiviewer’s security credentials.
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To register your multiviewer’s security credentials with Firefox
1 Click I understand the Risks, at the bottom of the page.

The message expands.

2 Click Add Exception.
3 In Add Security Exception, click Confirm Security Exception.

Your multiviewer's home page appears. You will now be able to access your 
multiviewer's client applications without seeing the warning. This will remain effective 
until the multiviewer's IP address is changed, in which case you will need follow the 
procedure again.

Suppressing certificate error in Internet Explorer or Chrome

The first time you try to access XAdmin in Internet Explorer or Chrome, the browser may 
prompt you to confirm the multiviewer’s security credentials.
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Internet Explorer’s security warning

Chrome’s security warning
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Clicking Continue to this website (not recommended) (Internet Explorer), or Proceed 
anyway (Chrome) will let you access XAdmin but the browser’s address bar will keep 
indicating that the multiviewer’s identity is not verified. To suppress this warning, you need 
to perform the following, in Internet Explorer, even if your preferred browser is Chrome.

To register your multiviewer’s security credentials with Internet Explorer
1 Click Continue to this website (not recommended).

The address bar now indicates the certificate error.

2 Click Certificate error.
3 In Untrusted Certificate, click View certificates.

4 In Certificate, click Install Certificate.

Special notes for users of Internet Explorer 

• If you see a blank page instead of XAdmin’s Status and Options page, then 
see Enabling the Compatibility View in Internet Explorer, on page 519.

• You must have administrator status to accept the certificate error. If your 
user account does not have administrator status, then close your browser 
and, before you open it again, right-click the Internet Explorer icon, and 
then click Run as administrator:
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5 In Certificate Import Wizard, click Next.

6 In Certificate Import Wizard, click Place all certificates in the following store, and 
then click Browse.
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7 In Select Certificate Store, select Trusted Root Certification Authorities, and then click 
OK.

8 Back in Certificate Import Wizard, click Next.
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9 Click Finish.

A security warning appears.
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10 Click Yes.
11 Certificate Import Wizard reports that the import was successful.

12 Click OK to dismiss the message, and then click OK to close the Certificate window.
13 Close all Internet Explorer (and Chrome, if any) windows, and then open your browser 

again.
You should now be able to access XAdmin, from your multiviewer home page without 
ever seeing the security warning again, unless the multiviewer’s IP address is changed, 
in which case you will want to repeat this procedure.

Special note for users of Chrome 

Kaleido-X, Kaleido-X16, and KMV-3901/3911 multiviewers currently use an 
older version of Java to generate their certificate. For this reason, every time 
you open Chrome and try to access XAdmin, you may see a warning about the 
site’s security certificate. Click Proceed anyway.
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Enabling the Compatibility View in Internet Explorer
When you try to access XAdmin, from your multiviewer’s home page, in Internet Explorer 8, 
9, or 10, you may see a blank page instead of XAdmin’s Status and Options page.17

To enable the compatibility view for your multiviewer’s XAdmin Web client
• Click the Compatibility View  button at the end of your browser’s address bar.

XAdmin’s Status and Options page appears

17.Should this happen with Internet Explorer 11, refer to Fix site display problems with Compatibility View, at 
http://windows.microsoft.com/en-us/internet-explorer/use-compatibility-view#ie=ie-11

Special note for users of Chrome (continued)
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The Compatibility View mode will remain enabled for this multiviewer as long as its 
IP address does not change.

XAdmin Access Control
XAdmin supports a simple authentication mechanism to prevent unauthorized users from 
modifying a multiviewer’s system configuration.

Enabling XAdmin Access Control

To enable access control in XAdmin
1 Open XAdmin. See Opening XAdmin on page 509.
2 Click Access control, in the navigation area on the left of the page.

The Access Control page appears.

3 Type the password you wish to enforce in both the New password and the Confirm 
boxes.
The password must contain between 6 and 20 alphanumeric characters or symbols.

4 Click Save.
A confirmation message appears.

5 Click OK to close the message window.
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The Apply settings button becomes available.

6 Click Apply settings.
XAdmin must upload the password to the multiviewer, for password enforcement to 
take effect. A progress indicator appears momentarily, followed by a confirmation 
message.

7 Click OK.
The Log in to XAdmin page appears. Other XAdmin sessions open against the same 
multiviewer are also redirected to the login page.

8 Type the password, and then click Log in.
The XAdmin Status and Options page appears.

9 Click Log out, when you are ready to close you session.

A confirmation message appears.

10 Click OK.
The login page appears. Only authorized users have access to XAdmin.
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Changing the XAdmin Password

To change the password used to prevent access to your multiviewer from XAdmin
1 Open XAdmin. See Opening XAdmin on page 509.
2 Click Access control, in the navigation area on the left of the page.

The Access Control page appears.

3 Type the new password you wish to enforce in both the New password and the 
Confirm boxes.
The password must contain between 6 and 20 alphanumeric characters or symbols.

4 Click Save.
A confirmation message appears.

5 Click OK to close the message window.
The Apply settings button becomes available.

6 Click Apply settings.
XAdmin must upload the password to the multiviewer, for the password change to take 
effect. A progress indicator appears momentarily, followed by a confirmation message.

7 Click OK.
The Log in to XAdmin page appears. Other XAdmin sessions open against the same 
multiviewer are also redirected to the login page.
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Disabling XAdmin Access Control

To disable access control in XAdmin
1 Open XAdmin. See Opening XAdmin on page 509.
2 Click Access control, in the navigation area on the left of the page.

The Access Control page appears.

3 Click Disable access control.
A confirmation message appears.

4 Click OK to close the message window, and then click Apply settings.
A progress indicator appears momentarily, followed by a confirmation message.

5 Click OK.
Unrestricted access to XAdmin is restored, for this multiviewer.

Closing a Password-Protected XAdmin Session

To close your XAdmin session
1 Click Log out, in the navigation area on the left of the current page, when you are ready 

to close you session.
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A confirmation message appears.

2 Click OK.
The login page appears. Only authorized users have access to XAdmin for this 
multiviewer.

Restarting and Shutting Down a Kaleido-IP Multiviewer

Restarting the Monitor Wall Software

To restart the monitor wall software
1 Open XAdmin. See Opening XAdmin on page 509.

The XAdmin Status and Options page appears.

2 Click Restart / Shut down in the navigation area on the left of the page.
The Restart / Shut down page appears.
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3 Click Restart software.
The system prompts you to confirm.

4 Click Yes to proceed.
Your multiviewer’s operating system will shut down, and then start again. This may take 
a while.

Once the monitor wall software has restarted, the system notifies you.

5 Click OK.
The XAdmin Status and Options page appears.

Restarting a Kaleido-IP Multiviewer

To restart a Kaleido-IP multiviewer
1 Open XAdmin. See Opening XAdmin on page 509.

The XAdmin Status and Options page appears.

2 Click Restart / Shut down in the navigation area on the left of the page.
The Restart / Shut down page appears.
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3 Click Restart unit.
The system prompts you to confirm.

4 Click Yes to proceed.
Your multiviewer will shut down, and then start again, during which time you can 
observe messages associated with the Linux shutdown and boot sequences on the 
monitor wall display connected to Head 1. This may take a while.

Once the multiviewer has restarted, the system notifies you.

5 Click OK.
The XAdmin Status and Options page appears.

Shutting Down a Kaleido-IP Multiviewer

To shut down a Kaleido-IP multiviewer
1 Open XAdmin. See Opening XAdmin on page 509.

The XAdmin Status and Options page appears.

Note: Clicking the “Reset multiviewer” button on the Status and Options 
page for a Kaleido-IP is equivalent to the above procedure except that, in the 
first case, you get no feedback from XAdmin.

Note: The Kaleido-X software does not support activating a soft shutdown 
from the Kaleido-IP frame’s power button. Should you be unable to access 
XAdmin, then perform a hard shutdown by pressing and holding the power 
button.
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2 Click Restart / Shut down in the navigation area on the left of the page.
The Restart / Shut down page appears.

3 Click Shut down.
The system prompts you to confirm.

4 Click Yes to proceed.
Your multiviewer will perform a clean shut down, during which time you can observe 
messages associated with the Linux shutdown sequence on the monitor wall display 
connected to Head 1.

5 Click OK to dismiss the confirmation message.

Configuring Head Streaming on a Kaleido-IP

Note: The Kaleido-IP supports head streaming, as an option. It is not yet 
possible to enable or verify options in XAdmin’s Status and Options page, for 
Kaleido-IP multiviewers. Contact Technical Support for activation and 
configuration instructions (see Contact Us, on page 551).
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To configure head streaming
1 Open XAdmin (see Opening XAdmin, on page 509).
2 Click Head streaming, in the navigation area on the left of the page.

The Head Streaming Configuration page appears.

3 Expand the streaming options section for the head you wish to configure.

4 Select Enable streaming and configure the appropriate parameters for your purposes:
a Select the desired output resolution, encoding format, encoding mode, streaming 

mode.
b Type the appropriate bit rate.
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c Configure multicast options if needed.
5 Click Apply configuration.

A message appears confirming that the configuration has been applied.
6 Click OK to dismiss the message.

Configuring Virtual Network Adapters on a Kaleido-IP
To add virtual network adapters on a Kaleido-IP

1 Open XAdmin (see Opening XAdmin on page 509).
2 Click System configuration, in the navigation area on the left of the page.

The System Configuration page appears.

Notes 

• If the streaming output is meant to feed a Kaleido-IP multiviewer, the 
following output resolution / bit rate combinations should ensure good 
video quality on the monitor wall:
• 1920 × 1080 at 15000 kbps
• 1280 × 720 at 11000 kbps
• 960 × 540 at 8000 kbps
• 720 × 480 at 8000 kbps
• 720 × 576 at 8000 kbps
• 480 × 270 at 3500 kbps

• In CBR mode, the minimum bit rate is:
• 3500 kbps for MPEG2
• 1500 kbps for H.264
XAdmin does not prevent you from specifying a lower bit rate but the 
Kaleido-X software will ignore lower values and enforce the appropriate 
minimum listed above.
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3 Click Configure, under Virtual LAN configuration.
The “Virtual LAN adapters configuration” page appears.

4 Edit the VLAN configuration file as required. Refer to the Help pane for guidelines, if 
needed.
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5 Click Apply configuration. 
A message appears prompting you to restart the software.

6 Click Yes.
A message appears confirming that the software has restarted.

7 Click OK to dismiss the message.

Adding Fonts to a Kaleido-IP
To add fonts on a Kaleido-IP

1 Open XAdmin (see Opening XAdmin on page 509).
2 Click System configuration, in the navigation area on the left of the page.

The System Configuration page appears.
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3 Click Configure, under Font configuration.
The “Font configuration” page appears.

4 Click Choose a font to upload.
A file chooser window appears.

5 Navigate to the font file you wish to upload, select it, and then click Open.

A progress indicator appears momentarily, followed by a confirmation message.

6 Click Restart unit.
The system prompts you to confirm.

7 Click Yes to proceed.
Your multiviewer will shut down, and then start again. This may take a while.

Once the multiviewer has restarted, the system notifies you.

8 Click OK.
The XAdmin Status and Options page appears.

9 Make sure the same font is available on the client PC or laptop where you use XEdit. (To 
install a font on Windows 7, right-click the TTF file, and then click Install.)

10 Close XEdit and then open it again (see Opening the XEdit Software on page 73).
The new fonts are now available, if you:

• Connect XEdit to the multiviewer (see Using XEdit Online on page 76).

Note: The Kaleido-X software supports true type fonts (TTF) only.
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• Download the database from the multiviewer to your local workspace 
(see Importing a Database on page 80).

Configuring Power Supply Redundancy on a Kaleido-X16
Power supply redundancy is an option on the Kaleido-X16, which can ship with a single 
PSU. In order to avoid having the system dashboard display unnecessary alarms, there is a 
check box in XAdmin to indicate the presence of the second PSU. By default, this option is 
selected (both PSUs are monitored). Removing the check mark will stop the monitoring of 
alarms for PSU B (its status is set to disabled, and therefore will not appear on the 
dashboard).

Location of Slot A and Slot B in the front of the Kaleido-X16 frame

To configure the PSU B Installed option in XAdmin
1 Open XAdmin. See Opening XAdmin on page 509.

The XAdmin Status and Options page appears.

2 In the SYSTEM heading row, click the Expand details arrow ( ).
A list of system details and statuses appears below the System heading row.

3 At the top of the list, select or clear PSU B Installed, as required.

IMPORTANT
Upgrading or reinstalling the Kaleido-X software removes all additional fonts 
you may have uploaded to the multiviewer. In such case, you will need to 
repeat this procedure.

Slot A Slot BPSU A removed 
from Slot A
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The change is applied immediately. The Power Supply B Status indicator turns gray, 
indicating that probing is disabled for this alarm.

Obtaining EDID Data from Displays when Using the DXF-100 Interface
The DXF-100 is a transmitter/receiver combination that allows a digital flat panel display to 
be located up to 1,000 meters (3,300 feet) away from the signal source. The transmitter and 
receiver are interconnected by a single multimode optical fiber, and connect to the source 
and display using DVI connectors.

The DXF-100 must be configured for its target display, before it is connected to the 
multiviewer, otherwise the Extended display identification data (EDID) information listed in 
XAdmin’s Status and Options page for the corresponding output card will not reflect the 
actual values for the target display. XAdmin would not be reporting the actual timing data 
from the display, but default values corresponding to the maximum resolution supported 
by the DXF-100, i.e., 1920 × 1200. The DXF-100 interface is unidirectional from the 
transmitter (multiviewer) to the receiver (display). For XAdmin to show timing data from the 
display, the EDID information needs to be transmitted in the reverse direction: from the 
display to the multiviewer.

IMPORTANT
The system behavior after selecting or clearing the PSU B Installed 
check box is as follows:
• When you select the PSU B Installed check box, the system 

publishes a warning that PSU B has failed if there is no PSU in 
Slot B. Do this when you have two PSUs installed in your frame.

• When you clear the PSU B Installed check box, the system does 
not generate a warning that PSU B has failed if there is no PSU in 
Slot B. Do this when you have only one PSU installed in your 
frame.
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To obtain a display’s timing information in XAdmin
• Connect the display directly to the DVI output of the multiviewer, by using a copper 

cable. (This is not always practical, since the display can be far or mounted on a wall.)
• Alternatively, connect the DXF-100 transmitter to the DVI input connector on the 

display, and then connect it to its power supply. The LED will flash for a few seconds 
while the transmitter reads and stores the EDID information from the display. When the 
LED stops flashing, disconnect the transmitter from the display and reconnect it to the 
multiviewer. The EDID information from the display will now be visible in XAdmin. The 
EDID information from the display will now be visible to the multiviewer. If the 
multiviewer is configured to adapt itself to the native resolution of the display, the 
resolution for the output will change automatically.

For more information on the DXF-100 interface, refer to the DXF-100 DVI Fiber Optic Interface 
User’s Manual (part no. M792-9500-101).

Servicing

Generating a System Snapshot

To generate a system snapshot
1 Open XAdmin. See Opening XAdmin on page 509.

The XAdmin Status and Options page appears.

2 Click the Technical support link in the navigation pane.
The Contact Technical Support page appears.

Notes 

• Grass Valley offers a more versatile bidirectional interface, the DXF-200 
DVI/HDMI Optical Extension System, which has superseded the DXF-100 
interface. For more information on the DXF-200, contact your Grass Valley 
sales representative.

• As of Kaleido-X version 4.10, the EDID auto-detection feature is enabled by 
default in order to facilitate the initial setup of a Kaleido-X system.

• Prior to Kaleido-X v. 3.00, EDID information was only reported for the 
master KXO-Dual card. In more recent versions, every KXO-Dual/KXO-
Dual3 card reports the EDID information for its associated displays.
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3 Click system snapshot.
The system snapshot generation may take a few moments, after which your browser 
prompts you to save the resulting compressed folder to your hard drive.

4 Browse to the location where you wish to save the ZIP file, and then click Save.
The compressed system snapshot folder contains information that can be used by 
Technical Support for troubleshooting purposes.

Viewing a Multiviewer’s Status Information

To view the status information for a multiviewer
1 Open XAdmin. See Opening XAdmin on page 509.

The Status and Options page appears, displaying a list of all cards and their statuses.

• In the case of a Kaleido-X (7RU) or Kaleido-X (14RU), cards are presented in the 
order they appear, from left to right when looking at the front of the chassis.

• In the case of a Kaleido-X (4RU), cards are presented in the order they appear, 
starting from the top left corner down, and again from the top right corner, when 
looking at the front of the chassis.

• Some heading rows may show a card type, serial number, firmware and safe mode 
versions, a module status indicator, and input signal status indicators.

• The module status indicator shows whether the card (or module) is running 
normally (green) or in safe mode (red).

Click here
... or here
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• The signal status indicators reveals the presence of a valid input signal at the 
corresponding connector.

2 Move the pointer to an input signal status indicator to view the associated signal 
format.

3 Click the arrow button at the end of each heading row to view detailed information 
about the associated module.

In the case of a Kaleido-X, Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X 
multiviewer model, you can identify which output card currently assumes the software 
master role (and is thus assigned the multiviewer’s IP address) by looking for the word 
“master” next to the card’s identifier, for example: “OUTPUT A (master)”.

Viewing Version Information

To view your multiviewer’s system and software version information
1 Open XAdmin. See Opening XAdmin on page 509.

The XAdmin Status and Options page appears.
• The Kaleido-X software version appears on the Web browser’s title bar or tab label.

Note: The Kaleido-X software does not distinguish between 1080PsF25 and 
1080i50, and neither between 1080PsF29.97 and 1080i59.94. Both 
1080PsF25 and 1080i50 are reported as 1080i50, and both 1080PsF29.97 and 
1080i59.94 are reported as 1080i59.94, on the monitor wall and in XAdmin’s 
Status and Options page.

Card type Serial number

Version information
Input signal status

Input signal format

Status indicator

Expand details
Refresh
Reset card

Master card status
indicator
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• In the case of a Kaleido-X or Kaleido-X16 multiviewer, the firmware and safe mode 
package numbers appear both in the relevant heading row, and within the 
detailed status information.

Status and Option page for a Kaleido-X (7RU) multiviewer

Status and Option page for a Kaleido-X (4RU) multiviewer

Firmware version 
information in 
module heading

Kaleido-X software 
version number on 
browser title bar or 
tab label

Firmware version 
information in 
module heading

Firmware version 
information in 
detailed status 
breakdown
538



Kaleido-X
User’s Manual
Status and Option page for a Kaleido-X16 multiviewer

Upgrading your Multiviewer System
For information on upgrading your multiviewer system, please refer to the Release Notes 
published with the Kaleido-X software version you wish to use. In addition to the latest 
Kaleido-X documentation you can download Release Notes for previous versions of the 
Kaleido-X software, from the Documentation Library section of Grass Valley’s website.

Firmware version 
in system heading
539





IndexIndex
0–9
0 VU  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145–146
3D monitoring  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
4K  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212, 239

A
ABT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 461
AC-3 metadata  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
Access control

XAdmin  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 520
XEdit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78–79

Actions
assigned to monitors . . . . . . . . . . . . . . . . . . . . 325
background actions . . . . . . . . . . . . . . . . . . . . . 327
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 323
trigger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61, 324
trigger audio monitoring . . . . . . . . . . . . . .63, 65

AFD
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 265

Alarm monitors
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 295

Alarms
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
browser  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
debouncing, about  . . . . . . . . . . . . . . . . . . . . . 128
debouncing, configuration . . . . . . . . . . . . . . 137
global  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
GSM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
latch, about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
levels, in logical source . . . . . . . . . . . . . . . . . . 204
logging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
lookup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
monitor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
providers  . . . . . . . . . . . . . . . . . . . . . 167, 170, 205
reporting behavior . . . . . . . . . . . . . . . . . . . . . . 295
scheduling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
SNMP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172, 190
status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168

Alarms (continued)
status indicator . . . . . . . . . . . . . . . . . . . . . . . . . 172
sub-alarms  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
threshold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
virtual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167, 171

ALM. See Audio monitors.
Alpermann+Velte  . . . . . . . . . . . . . . . . . . . . . . . . . . 397
Andromeda . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407
Any-source multicast transport stream . . . . . . 100
ASM transport streams  . . . . . . . . . . . . . . . . . . . . . 100
Aspect ratio

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125, 235
AFD  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265
automatic  . . . . . . . . . . . . . . . . . . . . . . . . . 235, 265
calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
changing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
of a room display  . . . . . . . . . . . . . . . . . . . . . . . 227
subtitling monitor  . . . . . . . . . . . . . . . . . . . . . . 302
WSS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265

Assigning
alarms to logical sources . . . . . . . . . . . . . . . . 204
audio outputs to RCP users . . . . . . . . . . . . . . 341
colors to logical sources . . . . . . . . . . . . . . . . . 206
full screen layouts to RCP users . . . . . . . . . . 340
logical sources to monitors . . . . . . . . . . . . . . . 52
room layouts to RCP users  . . . . . . . . . . . . . . 339
timers to RCP users  . . . . . . . . . . . . . . . . . . . . . 342
timers to rooms . . . . . . . . . . . . . . . . . . . . . . . . . 338

Audio
level meter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
metadata . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
monitor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
monitoring delay  . . . . . . . . . . . . . . . . . . . . . . . 160
output, assigning to RCP users  . . . . . . . . . . 341
reference level . . . . . . . . . . . . . . . . . . . . . 145–146

Audio Bridge Terminal  . . . . . . . . . . . . . . . . 461, 491
Audio level meters, scale  . . . . . . . . . . . . . . . . . . . 278
Audio monitoring

triggered by actions  . . . . . . . . . . . . . . . . . . 63, 65
triggered from the Kaleido-RCP2  . . . . . . . . . 64
triggered from the RCP-200  . . . . . . . . . . . . . . 64

Audio monitors
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
541



Index
Audio monitors (continued)
scale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278

Audio profiles
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
calibrations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

Audio programs
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

Audio scales
backup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
configuration . . . . . . . . . . . . . . . . . . . . . . 277–278

Auto-layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251
Automatic aspect ratio  . . . . . . . . . . . . . . . . . . . . . 265

B
Background actions  . . . . . . . . . . . . . . . . . . . . . . . . 327
Background images

clock logo  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309
custom safe area . . . . . . . . . . . . . . . . . . . . . . . . 260
DVI input  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255
on layouts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

Backup
audio scales  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
creating  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
resolutions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
retrieving . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

C
CAD. See Metadata monitors.
Calibrating

0 VU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145–146
audio metadata . . . . . . . . . . . . . . . . . . . . . . . . . 145
audio monitoring delay  . . . . . . . . . . . . . . . . . 160
audio programs . . . . . . . . . . . . . . . . . . . . . . . . . 138
automatic aspect ratio  . . . . . . . . . . . . . . . . . . 147
brightness . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
closed captioning . . . . . . . . . . . . . . . . . . . . . . . 149
color saturation . . . . . . . . . . . . . . . . . . . . . . . . . 158
contrast  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
detail enhancement . . . . . . . . . . . . . . . . . . . . . 148
DVI keying mode . . . . . . . . . . . . . . . . . . . . . . . . 159
dynamic range . . . . . . . . . . . . . . . . . . . . . . . . . . 148
GPI lines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
loudness (audio programs) . . . . . . . . . . . . . . 139
loudness (legacy)  . . . . . . . . . . . . . . . . . . . . . . . 143
metadata holding time . . . . . . . . . . . . . . . . . . 151

Calibrating (continued)
router field selection switching . . . . . . . . . . 163
router output signal reclocking . . . . . . . . . . 164
subtitling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Calibration
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Cards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Cascade  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13, 72
CC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Certificate error  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 511
Channels. See Sources.
Chrome, certificate error . . . . . . . . . . . . . . . . . . . . 512
Clear duration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Client PC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 482
Clocks

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 306
logo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309

Closed captions
calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 269
holding time  . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
standards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
switching on/off . . . . . . . . . . . . . . . . . . . . . . . . . 48
text mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Cluster
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13, 72
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
rooms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217

Color levels, in logical source  . . . . . . . . . . . . . . . 206
Color saturation . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
Composite monitors

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 310
creating  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310
resizing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315
unlocking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316

Configuring
alarm thresholds . . . . . . . . . . . . . . . . . . . . . . . . 131
aspect ratio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265
Audio Bridge Terminal  . . . . . . . . . . . . . . . . . . 491
audio scales  . . . . . . . . . . . . . . . . . . . . . . . 277–278
client PC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 482
IP address  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 477
IP settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 477
Kaleido-RCP2 . . . . . . . . . . . . . . . . . . . . . . . . . . . 488
Kaleido-X . . . . . . . . . . . . . . . . . . . . . . . 94, 477, 480
networking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 482
RCP-200 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 484
542



Kaleido-X
User’s Manual
Configuring (continued)
router output signal reclocking . . . . . . . . . . 164
routers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 345
serial devices  . . . . . . . . . . . . . . . . . . . . . . . . . . . 407
static UMD text  . . . . . . . . . . . . . . . . . . . . . . . . . 288
system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94, 480
UMD text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288

Contact Grass Valley . . . . . . . . . . . . . . . . . . . . . . . . 551
Content advisory descriptor. See Metadata 

monitors.
Control panel

Kaleido-RCP2  . . . . . . . . . . . . . . . . . . . . . . . . . . . 461
RCP-200  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 461

Corporate office, contact  . . . . . . . . . . . . . . . . . . . 551
Countdown timers  . . . . . . . . . . . . . . . . . . . . 282, 285
Cropping

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
custom  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Crosspoints  . . . . . . . . . . . . . . . . . . . . . . . . . . 55, 57–58
Customer support . . . . . . . . . . . . . . . . . . . . . . . . . . 551

D
Daktronics scoreboards . . . . . . . . . . . . . . . . . . . . . 454
Dashboard

disabling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
showing on wall  . . . . . . . . . . . . . . . . . . . . . . . . . 39

Database
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
backup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
location  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
recommended workflow . . . . . . . . . . . . . . . . 119
retrieving backup . . . . . . . . . . . . . . . . . . . . . . . . 84

Debouncing
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

Default layouts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Detail enhancement

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Diagonal size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
Dialnorm . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143, 175
Digital content advisory descriptor . . . . . . 33, 303
Display libraries

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
closing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 232
managing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230

Display libraries (continued)
opening . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 232

Displays
adding to room . . . . . . . . . . . . . . . . . . . . . . . . . 215
aspect ratio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
dashboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
diagonal size  . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
full screen zone . . . . . . . . . . . . . . . . . . . . . . . . . 218
height . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
position  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229
properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220
resolution  . . . . . . . . . . . . . . . . . 31, 220, 223, 225
rotation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
width . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228

Dolby E metadata . . . . . . . . . . . . . . . . . . . . . . . . . . 175
Dolby VANC

dialnorm  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
loudness  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

DTVCC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Dual system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
DVB subtitling  . . . . . . . . . . . . . . . . . 33, 49, 234, 298
DVI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255
DVI keying  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
DVTCC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Dynamic range

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

E
EDID . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
E-mail address  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 551
Encoda  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407
Expansion system . . . . . . . . . . . . . . . . . . . . . . . . . 6, 69
Extended Data Services. See Metadata monitors.

F
Factory defaults . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Fax number . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 551
Firefox untrusted connection warning  . . . . . . 511
Floating actions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327
Frame

options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 493
status information  . . . . . . . . . . . . . . . . . 461, 536
version information . . . . . . . . . . . . . . . . 461, 537

Full screen layouts
assigning to RCP user  . . . . . . . . . . . . . . . . . . . 340
543



Index
Full screen layouts (continued)
creating  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247

Full screen zones
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 218
operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

G
Gateway  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325
General status managers. See GSM.
Global alarms  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
GPI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62, 164
GPI-1501 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 402
Graphical layout elements . . . . . . . . . . . . . . . . . . 233
Grass Valley, contact . . . . . . . . . . . . . . . . . . . . . . . . 551
GSM

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
alarm browser  . . . . . . . . . . . . . . . . . . . . . . . . . . 168
alarm logging . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
sources, from external provider . . . . . . . . . . 205

H
HD closed captions . . . . . . . . . . . . . . . . . . . . . . . . . 174
Height  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
HLS streams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

I
iControl application server

alarm consumer  . . . . . . . . . . . . . . . . . . . . . . . . 168
alarm provider . . . . . . . . . . . . . . . . . . . . . . . . . . 170

Incremental copy
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
using  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

Input method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Internal router . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347
Internet Explorer

certificate error  . . . . . . . . . . . . . . . . . . . . . . . . . 512
compatibility view  . . . . . . . . . . . . . . . . . . . . . . 519

IP settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 477

K
Kahuna  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 418

Kaleido Remote Control Protocol (Gateway) . 325
Kaleido-IP

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10, 71
cascade  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13, 72
layout touring  . . . . . . . . . . . . . . . . . . . . . . . . . . 473
multicast join and leave . . . . . . . . . . . . . . . . . 473
network considerations . . . . . . . . . . . . . . . . . 473
restart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 524
shut down . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 524
streams, ASM . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
streams, HLS . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
streams, importing from spreadsheet  . . . . 96
streams, modifying  . . . . . . . . . . . . . . . . . . . . . 109
streams, preparing spreadsheet . . . . . . . . . . 98
streams, removing . . . . . . . . . . . . . . . . . . . . . . 111
streams, RTSP . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
streams, SSM/SFM  . . . . . . . . . . . . . . . . . . . . . . 102
streams, unicast  . . . . . . . . . . . . . . . . . . . . . . . . 105

Kaleido-Modular
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
KMV-3901/3911  . . . . . . . . . . . . . . . . . . . . . . . . . 70
network considerations . . . . . . . . . . . . . . . . . 473

Kaleido-Modular-X
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12, 70
M3 module connections  . . . . . . . . . . . . . . . . 392

Kaleido-MX 4K, about  . . . . . . . . . . . . . . . . . . . . 12, 69
Kaleido-MX, about  . . . . . . . . . . . . . . . . . . . . . . . 11, 69
Kaleido-RCP2

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333, 461
adding users . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334
audio monitoring . . . . . . . . . . . . . . . . . . . . . . . . 64
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 488
layout presets  . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
login  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35–36, 490
removing users . . . . . . . . . . . . . . . . . . . . 334–335
user preferences . . . . . . . . . . . . . . . . . . . . . . . . 338

Kaleido-X
14 RU frame  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
4 RU frame  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
7 RU frame  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
cascade  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13, 72
cluster system  . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
configuration . . . . . . . . . . . . . . . . . . . 94, 477, 480
expansion system . . . . . . . . . . . . . . . . . . . . . . 6, 69
frame status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 536
internal router . . . . . . . . . . . . . . . . . . . . . . . . . . 347
network considerations . . . . . . . . . . . . . . . . . 473
version information . . . . . . . . . . . . . . . . . . . . . 537
544



Kaleido-X
User’s Manual
Kaleido-X16
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7, 70
cascade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13, 72
internal router  . . . . . . . . . . . . . . . . . . . . . . . . . . 347
network considerations  . . . . . . . . . . . . . . . . . 473

Kaleido-XQUAD, about  . . . . . . . . . . . . . . . . . . .10, 71
Kalypso  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407, 409
Kayak  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 424
Kayenne  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 431
Keyboard input method  . . . . . . . . . . . . . . . . . . . . . 51
Keying mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
K-Frame . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439
KMV-3901/3911

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
cascade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13, 72
network considerations  . . . . . . . . . . . . . . . . . 473

KMX-4911, about . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
KX Router logical router  . . . . . . . . . . . . . . . . . . . . 346

L
Languages, input method  . . . . . . . . . . . . . . . . . . . 51
Layouts

4K UHD upscale . . . . . . . . . . . . . . . . . . . . . . . . . 243
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
assigning to RCP users  . . . . . . . . . . . . . . . . . . 339
automatically populated grid . . . . . . . . . . . . 251
background image . . . . . . . . . . . . . . . . . . . . . . 253
background keying  . . . . . . . . . . . . . . . . . . . . . 159
clocks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 306
closing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 242
countdown timers  . . . . . . . . . . . . . . . . . . . . . . 285
digital content advisory descriptor  . . . . . . 303
duplicating  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251
DVI background input . . . . . . . . . . . . . . . . . . . 255
foreground keying . . . . . . . . . . . . . . . . . . . . . . 159
full screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
loading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19, 41
management  . . . . . . . . . . . . . . . . . . . . . . . . . . . 240
Metadata monitor  . . . . . . . . . . . . . . . . . . . . . . 234
monitors, adding  . . . . . . . . . . . . . . . . . . . . . . . 249
opening  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240
pan view, in XEdit . . . . . . . . . . . . . . . . . . . . . . . 256
presets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
refreshing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
room layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 242
source assignment . . . . . . . . . . . . . . . . . . . . . . 252
subtitling monitor  . . . . . . . . . . . . . . . . . . . . . . 298
timers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285

Layouts (continued)
V-chip monitor  . . . . . . . . . . . . . . . . . . . . . . . . . 304
XDS metadata  . . . . . . . . . . . . . . . . . . . . . . .33, 303
zoom, in XEdit  . . . . . . . . . . . . . . . . . . . . . . . . . . 256

Levels
GlobalAlarm  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
in logical source  . . . . . . . . . . . . . . . . . . . . . . . . 200
in router . . . . . . . . . . . . . . . . . . 346, 384–385, 389

Libraries
displays  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
layout elements  . . . . . . . . . . . . . . . . . . . . . . . . 235

Loading layouts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Logical sources. See Sources.
Login, monitor wall  . . . . . . . . . . . . . . . . . . . . . .35–36
Lookup services . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Loudness

calibration (audio program) . . . . . . . . . . . . . 139
calibration (legacy)  . . . . . . . . . . . . . . . . . . . . . 143
microphone  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Loudness monitors
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 276

LTC over IP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280

M
M3 modules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
Markers, safe area  . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Matrix ID . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346, 384
Metadata

AC-3  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
closed captions . . . . . . . . . . . . . . . . . . . . . . . . . 174
display  . . . . . . . . . . . . . . . . . . . . . . . . . 33, 234, 303
Dolby E . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
holding time  . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
SCTE 35  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
subtitles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
teletext . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

Metadata monitors
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .33, 234
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 303

Microphone loudness measurement . . . . . . . . 177
Monitor libraries

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 320

Monitor wall
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
dashboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
destinations  . . . . . . . . . . . . . . . . . . . . . 53, 55, 252
545



Index
Monitor wall (continued)
disabling dashboard  . . . . . . . . . . . . . . . . . . . . 227
full screen zones  . . . . . . . . . . . . . . . . . . . . . . . . . 43
loading layouts  . . . . . . . . . . . . . . . . . . . . . . . . . . 19
login  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35–36
menu font size . . . . . . . . . . . . . . . . . . . . . . . . . . 337
mouse pointer, locating . . . . . . . . . . . . . . . . . . 38
mouse pointer. large . . . . . . . . . . . . . . . . . . . . 337
restarting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 524
timers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Monitors
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
alarm . . . . . . . . . . . . . . . . . . . . . . . . . 172, 234, 295
audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
clock  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235, 306
composite . . . . . . . . . . . . . . . . . . . . 233, 310, 315
duplicating  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
loudness . . . . . . . . . . . . . . . . . . . . . . . . . . . 234, 276
Metadata  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
monitor wall destination  . . . . . . . . . . . . . . . . 252
replication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251
resizing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315
source assignment . . . . . . . . . . . . . . . . . . 52, 252
subtitling . . . . . . . . . . . . . . . . . . . . . . .33, 234, 298
time code . . . . . . . . . . . . . . . . . . . . . . . . . . 234, 280
timer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234, 285
UMD  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
V-chip  . . . . . . . . . . . . . . . . . . . . . . . . . .33, 235, 304
video . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233, 257
XDS metadata  . . . . . . . . . . . . . . . . . . . . . . 33, 303

Mouse
large pointer . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337
locating on monitor wall  . . . . . . . . . . . . . . . . . 38
RCP-200  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Multicast transport stream
any source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
source filtered  . . . . . . . . . . . . . . . . . . . . . . . . . . 102
specific source . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Multiviewer
cascade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
cluster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
expansion system . . . . . . . . . . . . . . . . . . . . . . . . 69
Kaleido-IP . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10, 71
Kaleido-Modular . . . . . . . . . . . . . . . . . . . . . . . . . 70
Kaleido-Modular-X . . . . . . . . . . . . . . . . . . . . . . . 12
Kaleido-MX  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Kaleido-MX 4K  . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Kaleido-X (14RU) . . . . . . . . . . . . . . . . . . . . . . . 6, 69
Kaleido-X (4RU)  . . . . . . . . . . . . . . . . . . . . . . . . 4, 69
Kaleido-X (7RU)  . . . . . . . . . . . . . . . . . . . . . . . . 5, 69

Multiviewer (continued)
Kaleido-X16  . . . . . . . . . . . . . . . . . . . . . . . . . . . 7, 70
Kaleido-XQUAD . . . . . . . . . . . . . . . . . . . . . . . . . . 71
KMV-3901/3911  . . . . . . . . . . . . . . . . . . . . . . . . . . 9
options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 493
status information  . . . . . . . . . . . . . . . . . 461, 536
version information . . . . . . . . . . . . . . . . . . . . . 461

N
Network impact . . . . . . . . . . . . . . . . . . . . . . . . . . . . 473
Networking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 482
Nominal level  . . . . . . . . . . . . . . . . . . . . . . . . . 145–146
NV8576 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
NV9000 router control system

importing configurations  . . . . . . . . . . . . . . . 359
profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347

O
OP-47 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 464, 493
Overscan

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 263

P
Panning  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256
Passthrough  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
PC configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . 482
Peripheral devices . . . . . . . . . . . . . . . . . . . . . . .73, 407
Phase locking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226
Phone numbers . . . . . . . . . . . . . . . . . . . . . . . . . . . . 551
Plura SPT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
Port usage

client PC to multiviewer . . . . . . . . . . . . . . . . . 474
e-mail alerts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 476
iControl to multiviewer  . . . . . . . . . . . . . . . . . 475
multiviewer to client PC or laptop  . . . . . . . 474
multiviewer to multiviewer  . . . . . . . . . . . . . 475
router controller to multiviewer . . . . . . . . . 476
timer systems . . . . . . . . . . . . . . . . . . . . . . . . . . . 476
to/from NTP server . . . . . . . . . . . . . . . . . . . . . . 477
to/from remote control panel  . . . . . . . . . . . 475
to/from SNMP managers . . . . . . . . . . . . . . . . 477

Preferences, RCP user  . . . . . . . . . . . . . . . . . . . . . . 338
546



Kaleido-X
User’s Manual
Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Processing delay  . . . . . . . . . . . . . . . . . . . . . . . . . . . 226
Production switchers . . . . . . . . . . . . . . . . . . . . . . . 395

Kahuna . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 418
Kalypso . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409
Kayak . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 424
Kayenne . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 431
K-Frame  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439
Ross Video . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409
SAM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 418
Sony . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 414
Zodiak . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 447

Profiles
about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
calibrations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
creating  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
deleting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
NV9000 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347

Program config . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
Programs, audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

R
RCP2. See Kaleido-RCP2.
RCP-200

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 461
audio monitoring  . . . . . . . . . . . . . . . . . . . . . . . . 64
category/index panel  . . . . . . . . . . . . . . . . . . . . 53
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 484
login  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

RDD 8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Reclocking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
Reference levels . . . . . . . . . . . . . . . . . . . . . . . 145–146
Refreshing layouts . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Region editor  . . . . . . . . . . . . . . . . . . . . . . . . . 316–317
Remote control panel

Kaleido-RCP2  . . . . . . . . . . . . . . . . . . . . . . . . . . . 461
RCP-200  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 461

Resolutions
automatic detection  . . . . . . . . . . . . . . . . . . . . . 31
backup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
changing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
custom, creating . . . . . . . . . . . . . . . . . . . 220, 223

Restoring
database backup . . . . . . . . . . . . . . . . . . . . . . . . . 84
factory defaults  . . . . . . . . . . . . . . . . . . . . . . . . . 115

Rooms
4K UHD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212

Rooms (continued)
4K UHD upscale layouts . . . . . . . . . . . . . . . . . 243
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
assigning layouts to RCP users  . . . . . . . . . . 339
closing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
cluster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217
creating  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
dashboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
deleting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
display aspect ratio  . . . . . . . . . . . . . . . . . . . . . 227
display diagonal size . . . . . . . . . . . . . . . . . . . . 227
display height  . . . . . . . . . . . . . . . . . . . . . . . . . . 228
display position . . . . . . . . . . . . . . . . . . . . . . . . . 229
display properties  . . . . . . . . . . . . . . . . . . . . . . 220
display resolution . . . . . . . . . . . . . .220, 223, 225
display rotation . . . . . . . . . . . . . . . . . . . . . . . . . 228
display width . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
displays  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
full screen layouts  . . . . . . . . . . . . . . . . . . . . . . 247
full screen zone . . . . . . . . . . . . . . . . . . . . . . . . . 218
layouts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 242
mouse pointer . . . . . . . . . . . . . . . . . . . . . . . . . . 337
opening . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214
pan view, in XEdit . . . . . . . . . . . . . . . . . . . . . . . 256
zoom view, in XEdit . . . . . . . . . . . . . . . . . . . . . 256

Ross Video production switchers  . . . . . . . . . . . 409
Rotation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Router Control, installation  . . . . . . . . . . . . . . . . . 494
Router controllers . . . . . . . . . . . . . . . . . . . . . . . . . . 345
Routers

cards, SDI signal reclocking  . . . . . . . . . . . . . 164
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 345
connections  . . . . . . . . . . . . . . . . . . . . . . . 352, 392
crosspoints . . . . . . . . . . . . . . . . . . . . . . . 55, 57–58
field selection switching  . . . . . . . . . . . . . . . . 163
importing from NV9000 . . . . . . . . . . . . . . . . . 359
internal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347
KX Router  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346
levels . . . . . . . . . . . . . . . . . . . . . . . . . .384–385, 389
logical levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346
M3 modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
matrix ID  . . . . . . . . . . . . . . . . . . . . . . . . . . 346, 384
physical levels  . . . . . . . . . . . . . . . . . . . . . . . . . . 346
tie lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352, 392

RTSP streams  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
547



Index
S
Safe area

free-form  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
markers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
markers, toggling  . . . . . . . . . . . . . . . . . . . . . . . . 45

Scoreboards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 454
SCTE 27 subtitling  . . . . . . . . . . . . . . 33, 49, 234, 298
SCTE 35

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
profiles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

SDI monitoring output
format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
phase locking . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

Serial devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407
Serial port test agent  . . . . . . . . . . . . . . . . . . . . . . . 459
Serial to TCP/IP Dispatcher . . . . . . . . . . . . . . . . . . 407
Servicing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 535
Set duration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
SFM transport streams . . . . . . . . . . . . . . . . . . . . . . 102
Signal Path Viewer, Installation  . . . . . . . . . . . . . 494
Slots, virtual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
SMPTE ST 2031 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Snapshot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 461
Snell & Wilcox production switcher. See Kahuna.
SNMP traps  . . . . . . . . . . . . . . . . . . . . . . . . . . . 172, 190
Sony production switchers  . . . . . . . . . . . . . . . . . 414
Source-filtered multicast transport streams . . 102
Sources

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72, 195
alarm levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204
assigning to monitors . . . . . . . . . . . .52–53, 252
color levels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 196
EXT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
external providers  . . . . . . . . . . . . . . . . . . . . . . 205
full screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
template  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203

Sources table
filtering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208
resizing columns . . . . . . . . . . . . . . . . . . . . . . . . 209
sorting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208

Spanning
4K UHD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239
layout elements . . . . . . . . . . . . . . . . . . . . . . . . . 237

SSM transport streams . . . . . . . . . . . . . . . . . . . . . . 102
Status

alarm . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168

Status (continued)
information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 461
system  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Subtitling
calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 269
holding time  . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
standards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
text mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Subtitling monitors
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .33, 234
aspect ratio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 298

Support, contact  . . . . . . . . . . . . . . . . . . . . . . . . . . . 551
Switchers. See Production switchers.
System

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
cascade  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13, 72
cluster . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13, 72, 89
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
creation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
dual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
expansion  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6, 69
Kaleido-IP  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10, 71
Kaleido-Modular . . . . . . . . . . . . . . . . . . . . . . . . . 70
Kaleido-X (14RU) . . . . . . . . . . . . . . . . . . . . . . . 6, 69
Kaleido-X (4RU) . . . . . . . . . . . . . . . . . . . . . . . . 4, 69
Kaleido-X (7RU) . . . . . . . . . . . . . . . . . . . . . . . . 5, 69
Kaleido-X16  . . . . . . . . . . . . . . . . . . . . . . . . . . . 7, 70
Kaleido-XQUAD . . . . . . . . . . . . . . . . . . . . . . . . . . 71
KMV-3901/3911  . . . . . . . . . . . . . . . . . . . . . . . . . . 9
options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 493
phase locking . . . . . . . . . . . . . . . . . . . . . . . . . . . 226
retrieving backup . . . . . . . . . . . . . . . . . . . . . . . . 84
snapshot  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 535
status information  . . . . . . . . . . . . . . . . . . . . . . 536
verification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
version information . . . . . . . . . . . . . . . . . . . . . 537

T
Tally interface devices . . . . . . . . . . . . . . . . . . . . . . 395
Technical support . . . . . . . . . . . . . . . . . . . . . . . . . . 551
Teletext, about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Teletext profiles

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
calibrations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

Template  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
548



Kaleido-X
User’s Manual
Text mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47, 269
Third-party devices

serial port test  . . . . . . . . . . . . . . . . . . . . . . . . . . 459
TSL (serial) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407

Tie lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352, 392
Time code monitors

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 280

Timer systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
Timers

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
assigning to RCP users  . . . . . . . . . . . . . . . . . . 342
assigning to rooms . . . . . . . . . . . . . . . . . . . . . . 338
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 282
monitor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285
operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Transport stream profile, calibrations  . . . . . . . 130
Transport streams

ASM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
HLS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
RTSP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
SFM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
SSM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
unicast  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Traps, SNMP . . . . . . . . . . . . . . . . . . . . . . . . . . . 172, 190
Troubleshooting, system snapshot . . . . . 461, 535
TSL, serial devices  . . . . . . . . . . . . . . . . . . . . . . . . . . 407

U
UHD  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212, 239
UMD

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
editing text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
static text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
text font  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288

Under monitor displays. See UMD.
Underscan

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 263

Untrusted connection warning  . . . . . . . . . . . . . 511
Upgrading  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 539

V
V-chip monitors

about . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33, 235
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 304

Version information . . . . . . . . . . . . . . . . . . . 461, 537
Video monitors

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
aspect ratio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 257
cropping  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
full screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
overscan  . . . . . . . . . . . . . . . . . . . . . . . . . . . .44, 263
resizing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
safe area . . . . . . . . . . . . . . . . . . . . . . . . . . . . .45, 260
underscan . . . . . . . . . . . . . . . . . . . . . . . . . . .44, 263
zooming  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263

Video profiles
about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
calibrations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

Virtual card slots  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
VLAN  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100, 102, 529

W
Website . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 551
Widgets. See Monitors.
Width, display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Workflow, database management  . . . . . . . . . . 119
WSS

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 265

WST  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

X
XAdmin

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 461
access control  . . . . . . . . . . . . . . . . . . . . . . . . . . 520
options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 464
virtual card slots  . . . . . . . . . . . . . . . . . . . . . . . . . 73

XDS. See Metadata monitors.
XEdit

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71, 461
access control  . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 494
opening . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
shortcuts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
virtual card slots  . . . . . . . . . . . . . . . . . . . . . . . . . 73
549



Index
Z
Zero VU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145–146

analog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
digital  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Zodiak  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 447
Zooming

configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
layout, in XEdit . . . . . . . . . . . . . . . . . . . . . . . . . . 256
operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
550



Contact Us
Grass Valley Technical Support
For technical assistance, contact our international support center, at 
1-800-547-8949 (US and Canada) or +1 530 478 4148.

To obtain a local phone number for the support center nearest you, please consult the 
Contact Us section of Grass Valley’s website (www.grassvalley.com).

An online form for e-mail contact is also available from the website.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec  H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com


	New Features
	Getting Started
	About this Document
	System Overview
	Kaleido-X (4RU)
	Kaleido-X (7RU)
	Kaleido-X (14RU) Expansion
	Kaleido-X16
	Kaleido-Modular KMV-3901/3911
	Kaleido-XQUAD
	Kaleido-IP
	Kaleido-MX
	Kaleido-MX 4K
	Kaleido-Modular-X
	KMX-4911
	Cluster
	Cascade

	Detailed Directions
	Verifying your System Configuration
	Verifying a Multiviewer’s Internal Statuses and Options
	Verifying a Kaleido-RCP2
	Verifying an RCP-200
	Verifying an Audio Bridge Terminal

	Loading a Layout

	Cabling Diagrams
	Kaleido-IP
	Kaleido-MX
	Kaleido-MX 4K
	Kaleido-Modular-X
	KMV-3901/3911
	Kaleido-X16
	Kaleido-X (4RU)
	Kaleido-X (7RU)
	Kaleido-X (14RU)

	RS-422 Connection Diagram
	XEdit Application Shortcuts

	Operation of the Monitor Wall
	Key Concepts
	Detailed Directions
	Logging on to the Monitor Wall Using a Remote Control Panel
	Logging on to the Monitor Wall Using the Kaleido-RCP2
	Logging on to the Monitor Wall Using the RCP-200

	Using On-Screen Wall Control
	Locating the Mouse Pointer on the Monitor Wall
	Using On-Screen Wall Control from the RCP-200
	Synchronizing the RCP-200’s Head View with the Monitor Wall

	Displaying the Dashboard
	Hiding the Dashboard
	Loading Layouts
	Loading a Layout by Using the Mouse
	Loading a Layout by Using the Kaleido-RCP2
	Using Layouts Presets
	Loading a Layout by Using the RCP-200
	Refreshing a Layout

	Displaying a Source in Full Screen Mode
	Changing a Source’s Aspect Ratio
	Video Cropping/Zooming
	Toggling Safe Area Markers
	Displaying Subtitles and Closed Caption Text
	Setting the Text Mode
	Switching Closed Captioning On/Off
	Setting the DVB Subtitling Language from the Monitor Wall
	Setting the SCTE 27 Subtitling Language from the Monitor Wall
	Selecting a Teletext/Subtitling Page from the Monitor Wall

	Editing UMD Text
	Selecting an Input Method
	Assigning Sources to Monitors
	Assigning a Logical Source to a Monitor by Using the Kaleido-RCP2
	Assigning a Logical Source to a Monitor by Using the RCP-200
	Assigning a Logical Source to a Monitor by Using the Mouse

	Changing Crosspoints
	Changing Logical Sources Assignments on a Kaleido-X Configured as a Router
	Viewing Assignment Information
	Changing an Internal Router Crosspoint
	Changing an External Router Crosspoint

	Using Timers
	Controlling a Timer by Using the Timer Monitor’s Buttons and the Menu
	Controlling a Timer by Using an External Numeric Keypad

	Triggering Actions
	Triggering an Action from the RCP-200
	Triggering an Action from the Monitor Wall

	Triggering GPI Output Events
	Acknowledging Alarms
	Acknowledging Alarms on the Monitor Wall
	Acknowledging Alarms by Using an Action

	Triggering Audio Monitoring
	Triggering Audio Monitoring by Using the mouse, the RCP-200, or the Kaleido-RCP2
	Controlling the Volume at the Analog Audio Monitoring Output
	Controlling the volume from the Kaleido-RCP2
	Controlling the volume from the RCP-200

	Triggering Audio Monitoring by Using an Action

	Setting a Display Monitor’s Output Resolution
	Specifying a Display Output Resolution from the Monitor Wall
	Enabling EDID Auto-Detection from the Monitor Wall

	Changing the IP Address of a Multiviewer from the Monitor Wall


	Managing Kaleido-X Systems
	Key Concepts
	Detailed Directions
	Opening the XEdit Software
	Using XEdit Online
	Connecting to a Multiviewer
	Disconnecting from a Multiviewer
	Enabling Access Control in XEdit
	Disabling Access Control in XEdit

	Importing a Database
	Exporting a Database
	Exporting a Single-Multiviewer Database
	Exporting a Cluster Database

	Creating a Backup
	Backing Up the Current Database
	Backing Up Resolutions
	Backing Up Audio Scales

	Restoring a Backup
	Restoring a Database from a Backup
	Restoring Resolutions or Audio Scales from a Backup

	Creating a Single Multiviewer System
	Creating a Cluster
	Adding Multiviewers to a Cluster
	Creating a cluster in online mode
	Creating a cluster in offline mode

	Creating Rooms for a Cluster System
	Creating Layouts for a Cluster System
	Replicating RCP Users Across a Cluster System
	Repairing a Cluster System

	Configuring the System Representation
	Managing Transport Streams in a Kaleido-IP System Representation
	Importing a stream lineup
	Preparing a spreadsheet with stream lineup information
	Adding any-source multicast transport streams
	Adding source-specific or source-filtered multicast transport streams
	Adding unicast transport streams
	Adding HLS playlists
	Adding RTSP transport streams
	Modifying transport streams and HLS playlists
	Removing transport streams and HLS playlists

	Managing Cards in a Kaleido-X or KMX-3901 System Representation
	Emptying card slots
	Populating card slots


	Restoring Factory Defaults
	Restoring the XEdit Factory Defaults for a Multiviewer
	Restoring Factory Defaults from a Specific Multiviewer
	Restoring Factory Defaults from a Sample Database

	Managing Multiple Databases Efficiently
	Working online
	Working offline
	Applying a backup database to the multiviewer



	Calibrating the Kaleido-X
	Key Concepts
	Profiles
	Multiviewer Output Calibrations
	Multiviewer Input Calibrations
	Router Output Calibrations
	GPI/Genlock Calibrations
	Alarm Debouncing

	Detailed Directions
	Managing Calibration Profiles
	Creating Calibration Profiles
	Deleting Calibration Profiles
	Configuring Calibration Profiles
	Assigning Calibration Profiles

	Configuring Alarm Thresholds
	Configuring Alarm Debouncing
	Multiviewer Input Calibrations
	Configuring Audio Programs
	Calibrating Loudness Measurement
	Navigating to the loudness calibration in a Kaleido-IP calibration profile
	Navigating to the loudness calibration in a Kaleido-X16 or Kaleido-X System list

	Calibrating Loudness Probe Assignments
	Calibrating Dolby Dialog Loudness Measurement
	Configuring Sources for Dolby E Audio Metadata
	Calibrating Zero VU Reference Levels for Embedded Audio Sources
	Calibrating Zero VU Reference Level for an ABT Audio Source
	Calibrating Aspect Ratio Decoding
	Calibrating Detail Enhancement and Dynamic Range
	Calibrating Subtitling/Closed Captioning
	Configuring Teletext/Subtitling Page Selection for a Kaleido-IP
	Configuring Teletext/Subtitling Page Selection for a Kaleido-X, Kaleido-X16, Kaleido-MX, Kaleido-MX 4K, or Kaleido-Modular-X

	Calibrating Metadata Holding Time
	Calibrating DTMF Tone Sequences
	Calibrating SCTE 35 Event Reporting Duration

	Multiviewer Output Calibrations
	Calibrating the Brightness and Contrast
	Calibrating Color Saturation
	Calibrating the DVI Keying Mode
	Calibrating the Audio Monitoring Delay
	Calibrating the Audio Monitoring Color

	Router Output Calibrations
	Calibrating Switch Field Selection
	Calibrating SDI Signal Reclocking

	GPI/Genlock Calibrations


	Configuring Alarms
	Key Concepts
	Alarm
	General Status Manager (GSM)
	Alarm Logging
	Alarm Browser
	Alarm Status
	External Alarm Provider
	Lookup Service
	Alarm Suppression
	Global Alarms
	Virtual Alarm
	Sub-Alarm
	Alarm Monitor
	Simple Network Management Protocol (SNMP)
	Teletext, Subtitles, and Closed Captions
	Dolby E/AC-3 Metadata
	Definitions
	Audio Format
	Audio Metadata
	Logical Source Assignment

	Microphone Loudness Measurement
	SCTE 35 Digital Program Insertion (DPI) Signaling
	Bit Rate Measurement
	Transport Stream Monitoring

	Detailed Directions
	Managing Alarm Providers
	Managing Virtual Alarms
	Creating Virtual Alarms
	Modifying Virtual Alarms
	Deleting Virtual Alarms

	Managing Alarm Logging
	Publishing Alarms to SNMP Managers
	Identifying Target SNMP Managers
	Enabling SNMP Traps



	Logical Sources
	Key Concepts
	Detailed Directions
	Creating and Configuring Logical Sources
	Automatically Adding Logical Sources
	Managing Logical Sources Associated with Programs in a Transport Stream
	Adding logical sources for new programs in a transport stream
	Removing logical sources for removed programs in a transport stream

	Manually adding a Logical Source
	Managing Levels
	Adding a level
	Configuring an alarm level’s contribution

	Defining Physical Assignments
	Configuring text level assignments
	Configuring alarm level assignments
	Configuring logical sources based on external alarm providers
	Configuring color level assignments

	Making Further Assignments by Incremental Copy
	Sorting the Sources Table
	Filtering the Sources Table
	Resizing the Sources Table’s Columns

	Monitoring Internal-Router Outputs on the Monitor Wall (Sample Scenario)


	Setting Up Rooms
	Key Concepts
	Detailed Directions
	Managing Rooms
	Creating a Room
	Creating a 4K UHD Room
	Opening Rooms
	Closing Rooms
	Deleting Rooms
	Adding Displays
	Removing Displays
	Adding Full Screen Zones
	Removing Full Screen Zones

	Configuring Displays
	Viewing Room Display Properties
	Enabling EDID Auto-Detection in XEdit
	Configuring Custom Resolutions from the Tools Menu
	Configuring a Custom Resolution from a Specific Display in a Room
	Changing Room Display Resolutions
	Configuring the SDI Monitoring Output Format
	Enabling Phase Locking at the SDI Monitoring Output
	Disabling the Dashboard
	Changing a Display’s Aspect Ratio
	Changing a Display’s Diagonal Size
	Changing a Display’s Height
	Changing a Display’s Width
	Changing a Display’s Rotation
	Changing a Display’s Position

	Managing Display Libraries
	Creating Custom Display Libraries
	Adding Displays to Custom Libraries
	Removing Displays from Custom Libraries
	Closing Display Libraries
	Opening Display Libraries



	Creating Layouts
	Key Concepts
	Layouts and Layout Elements
	Aspect Ratio
	Cropping Mode
	Spanning
	4K UHD Spanning

	Detailed Directions
	Managing Layouts
	Opening Layouts
	Loading a Layout on the Monitor Wall
	Closing Layouts
	Creating Room Layouts
	Creating 4K UHD Upscale Layouts
	Creating Layouts to Monitor 4K UHD Quad Link Sources
	Creating Full Screen Layouts
	Deleting Layouts
	Adding Monitors to a Layout
	Removing Monitors
	Duplicating Monitors
	Automatically Populating a Grid-Type Layout
	Copying layouts
	Assigning Logical Sources or Monitor Wall Destinations to Monitors
	Selecting a Background Image for a Layout
	Setting up a Layout for Background Keying from the DVI Input
	Zooming and Panning a View
	Showing and Hiding the Layout Navigator

	Configuring Video Monitors
	Setting Monitored Levels for a Video Monitor
	Resizing a Video Monitor
	Setting a Video Monitor’s Aspect Ratio
	Adding Safe Area Markers
	Adding a Custom Safe Area Image
	Video Cropping/Zooming
	Configuring Automatic Aspect Ratios
	Configuring the default aspect ratio for HD and SD signals

	Configuring a Video Monitor’s Alarm Reporting Behavior
	Configuring a Video Monitor’s Source Reporting Behavior
	Setting a Video Monitor’s Text Mode

	Configuring Audio Monitors
	Configuring Loudness Monitors
	Configuring Audio Scales
	Configuring Audio Scales from the Tools Menu
	Configuring an Audio Scale from a Specific Audio Monitor
	Removing Audio Scales from the System

	Configuring Time Code Monitors
	Configuring Timers
	Adding Timers to the System
	Adding a Timer Monitor to a Layout

	Configuring UMDs
	Setting Monitored Alarm and Text Levels for a UMD
	Configuring a UMD’s Alarm Reporting Behavior
	Configuring a UMD’s Source Reporting Behavior
	Configuring Static UMD Text
	Configuring Dynamic UMD Text
	Setting the Text Font

	Configuring Alarm Monitors
	Configuring an Alarm Monitor’s Source Reporting Behavior

	Configuring Subtitling Monitors
	Configuring Metadata Monitors
	Configuring V-Chip Monitors
	Configuring Clocks
	Inserting a Clock Logo

	Working with Composite Monitors
	Creating a Composite Monitor
	Resizing a Composite Monitor
	Unlocking a Composite Monitor

	Using the Region Editor
	Opening the Region Editor
	Configuring a Monitor’s Position Using the Region Editor
	Configuring a Monitor’s Dimensions Using the Region Editor

	Format Painting
	Copying Properties from one Monitor to Another
	Copying Size from one Monitor to Another
	Copying Actions from one Monitor to Another

	Managing Monitor Libraries
	Creating a Monitor Library
	Closing a Monitor Library
	Opening a Monitor Library



	Creating Actions
	Overview
	Key Concepts
	Detailed Directions
	Creating Monitor Wall Actions
	Creating Background Actions
	Creating a Background Action from the Actions Tab
	Creating a Background Action from the System List
	Creating an Action that can be Triggered via a Gateway Command
	Editing an Action
	Removing Action Items from an Action
	Deleting an Action



	Managing RCP Users
	XEdit Quick Start Task List
	Key Concepts
	Kaleido-RCP2
	RCP-200
	Gateway

	Detailed Directions
	Managing RCP Users
	Adding RCP Users
	Removing RCP Users from the System

	Managing Room Access
	Granting Room Access to RCP Users
	Removing RCP Users from Rooms

	Setting Room Preferences
	Assigning Room Layouts to the Kaleido-RCP2 Preset buttons
	Assigning an Audio Output to the Remote Control Panel’s AUDIO MONITORING Button
	Enabling the Large Mouse Pointer for a Room
	Assigning a Timer to a Room

	Setting RCP User Preferences
	Assigning Room Layouts to a Kaleido-RCP2 User’s Presets
	Assigning a Full Screen Layout to an RCP User
	Assigning Audio Output to an RCP User
	Setting the Keyboard Language
	Assigning a Timer to an RCP User
	Changing an RCP User’s Name or Password



	Routers & Kaleido-X
	Overview
	Key Concepts
	Router Control Configurations
	Router Configuration Scenarios
	Controlling an external router
	Controlling external routers in a cascade
	Translating commands from external router controllers
	Controlling the internal router by using a router control device or application

	Router Connections
	Router Protocols
	Optional Drivers for Controlling Routing Devices from the Multiviewer
	Built-in Communications Protocols
	Serial Connections
	Sample Third-Party Serial Pinouts

	Q & A

	Detailed Directions
	Importing Router Configurations from an NV9000 System Controller
	Renaming Physical Routers

	Configuring an External Router
	Step 1 – Defining a Physical Router
	Step 2 – Adding Physical Levels
	Step 3 – Adding Logical Routers

	Configuring a Router Controller
	Adding a Simple Router Controller
	Adding a VikinX Compact router controller
	Adding a SAM (Snell/Pro-Bel) SW-P-02 router controller

	Adding an Intelligent Router Controller

	Configuring a Multiviewer’s Internal Router
	Configuring the Internal Router in a Kaleido-X16
	Configuring the Internal Router in a Kaleido-X (7RU)
	Configuring the Internal Router in a Kaleido-X (14RU)

	Configuring Router Connections


	Tally Interface Devices &Timer Systems
	Overview
	Key Concepts
	Optional Drivers for Controlling Tally Interface Devices from the Multiviewer
	Serial-to-TCP/IP Dispatcher

	Detailed Directions
	Plura (Alpermann+Velte) Studio Production Timer
	Adding a Timer System to your Multiviewer Configuration
	Assigning Timer System Information to Logical Sources
	Configuring Layout Elements

	GPI-1501 General Purpose Interface I/O Module
	Adding a GPI-1501 Module to your Multiviewer Configuration
	Assigning GPI Status Information to Logical Sources
	Configuring Layout Elements

	Configuring Serial Tally Systems
	Ross Video Production Switcher
	Sony Production Switcher
	Setting Up a Sony Switcher
	DVS-9000 switchers

	Setting Up a Multiviewer to Interface with a Sony Production Switcher

	Kahuna Production Switcher
	Kayak Production Switcher
	Configuring the Kayak Switcher
	Configuring the Multiviewer
	Establishing serial communication between the Kayak switcher and the multiviewer
	Assigning Kayak tallies, input names, and output names to logical sources
	Configuring layout elements


	Kayenne Production Switcher
	Configuring the Kayenne Switcher
	Configuring the Multiviewer
	Establishing serial communication between the Kayenne switcher and the multiviewer
	Assigning Kayenne tallies, input names, and output names to logical sources
	Configuring layout elements


	K-Frame Switchers
	Configuring the K-Frame Switcher
	Configuring the Multiviewer
	Establishing communication between the K-Frame switcher and the multiviewer
	Assigning K-Frame tallies and input names to logical sources
	Configuring layout elements


	Zodiak Production Switcher
	Configuring the Zodiak Switcher
	Configuring the Multiviewer
	Establishing serial communication between the Zodiak switcher and the multiviewer
	Assigning Zodiak tallies, input names, and output names to logical sources
	Configuring layout elements


	Daktronics Scoreboards
	Adding a Daktronics Scoreboard to your Multiviewer Configuration
	Assigning Scoreboard Information to Logical Sources
	Configuring Layout Elements

	Serial Port Test Agent


	Administration and Servicing
	Key Concepts
	Default IP Settings
	Hardware and Software Options
	Dashboard Messages
	Network Considerations & Port Usage
	Network Considerations
	Kaleido-X, Kaleido-X16, Kaleido-Modular
	Kaleido-IP

	TCP/UDP Port Usage
	From client to multiviewer
	From multiviewer to client
	From multiviewer to multiviewer
	From iControl to multiviewer
	Between multiviewer and remote control panel
	From multiviewer to peripheral devices
	From peripheral devices to multiviewer
	Between multiviewer and SNMP managers
	Between multiviewer and NTP server



	Detailed Directions
	Assigning an IP Address to Each Device in your System
	Configuring a Multiviewer’s IP Settings
	Configuring a Multiviewer’s IP Settings Without a Client PC
	Finding a Multiviewer’s System IP Address and Application Version
	Changing the Client PC’s IP Address
	Changing an IP address on Windows 7 or Windows 8
	Changing an IP address on Windows XP

	Configuring the RCP-200
	Configuring the RCP-200’s IP settings
	Specifying multiviewers for the RCP-200
	Specifying lookup servers for the RCP-200

	Logging on to the RCP-200
	Correlating Monitor Wall Destinations and KX Router Logical Routers for the RCP-200
	Configuring the Kaleido-RCP2
	Assigning a static IP address to the Kaleido-RCP2
	Selecting a room for the Kaleido-RCP2

	Connecting the Kaleido-RCP2 to Other Kaleido-X Systems
	Logging on to the Kaleido-RCP2
	Configuring an Audio Bridge Terminal

	Enabling Options
	Installing Kaleido-X Client Applications
	Installing XEdit from your Multiviewer’s Home Page
	Installing a Specific Version of XEdit
	Uninstalling XEdit
	Uninstalling XEdit (Dynamic Version 7.20 or Later)
	Uninstalling XEdit (Static Version 7.20 or Later)
	Uninstalling XEdit (Version 7.11 or Earlier)

	Installing Router Control
	Uninstalling Router Control
	Installing Signal Path Viewer
	Uninstalling Signal Path Viewer

	Opening XAdmin
	Opening XAdmin from a Browser
	Opening XAdmin from XEdit
	Registering your Multiviewer's Security Credentials with your Browser
	Suppressing untrusted connection warning in Firefox
	Suppressing certificate error in Internet Explorer or Chrome

	Enabling the Compatibility View in Internet Explorer

	XAdmin Access Control
	Enabling XAdmin Access Control
	Changing the XAdmin Password
	Disabling XAdmin Access Control
	Closing a Password-Protected XAdmin Session

	Restarting and Shutting Down a Kaleido-IP Multiviewer
	Restarting the Monitor Wall Software
	Restarting a Kaleido-IP Multiviewer
	Shutting Down a Kaleido-IP Multiviewer

	Configuring Head Streaming on a Kaleido-IP
	Configuring Virtual Network Adapters on a Kaleido-IP
	Adding Fonts to a Kaleido-IP
	Configuring Power Supply Redundancy on a Kaleido-X16
	Obtaining EDID Data from Displays when Using the DXF-100 Interface
	Servicing
	Generating a System Snapshot
	Viewing a Multiviewer’s Status Information
	Viewing Version Information

	Upgrading your Multiviewer System


	Index
	Contact Us

